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iIM 04L41B01-01E
 IntroductionThank you for purchasing the Daqstation DX1000 (hereafter referred to as “DX”).This User’s Manual explains how to use the DX. To ensure correct use, please read this manual thoroughly before operation.The following manuals are provided for the DX:
 • PaperManualManual Title Manual No. DescriptionDX1000 Operation Guide IM 04L41B01-02E Explains the basic operations of the DX.Control of Pollution Caused by the Product
 IM 04L41B01-91C Gives a description of pollution control.
 About the Usage of Open Source Software
 IM 04L41B01-81Z1 Gives a description of the licenses.
 • ElectronicManualsManual Title Manual No. DescriptionDX1000/DX1000NOperation Guide
 IM 04L41B01-02E This is the electronic version of the paper manual.
 DX1000/DX1000NUser’s Manual
 IM 04L41B01-01E Describes how to use the DX. The communication and network functions, custom display functions, and some of the options are excluded.
 DX1000/DX1000N/DX2000Multi Batch (/BT2)User’s Manual
 IM 04L41B01-03E Describes how to use the multi batch function (/BT2 option).
 DX1000/DX1000N/DX2000Custom DisplayUser’s Manual
 IM 04L41B01-04E Describes how to use the custom display function.
 DX1000/DX1000N/DX2000 Advanced Security Function (/AS1) User’s Manual
 IM 04L41B01-05EN Describes how to use the advanced security function (/AS1 option).
 DX1000/DX1000N/DX2000Communication InterfaceUser’s Manual
 IM 04L41B01-17E Describes how to use communication functions through an Ethernet or serial interface.
 DX1000/DX1000N/DX2000 EtherNet/IPCommunication InterfaceUser’s Manual
 IM 04L41B01-18E Describes how to use communication functions through an EtherNet/IP interface.
 DX1000/DX1000N/DX2000PROFIBUS-DP (/CP1)Communication InterfaceUser’s Manual
 IM 04L41B01-19E Describes how to use communication functions through the PROFIBUS-DP interface (/CP1 option).
 • DAQSTANDARDManuals All manuals other than IM 04L41B01-66EN are contained in the DAQSTANDARD CD.
 Manual Title Manual No.DAQSTANDARD Data Viewer User’s Manual IM 04L41B01-63ENDAQSTANDARD Hardware Configurator User’s Manual IM 04L41B01-64ENDAQSTANDARD DX100P/DX200P Configurator User’s Manual IM 04L41B01-65ENInstalling DAQSTANDARD IM 04L41B01-66EN
 8th Edition: March 2016 (YK)All Rights Reserved, Copyright © 2005, Yokogawa Electric Corporation
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ii IM 04L41B01-01E
 Notes• Thecontentsofthismanualaresubjecttochangewithoutpriornoticeasaresultof
 continuing improvements to the instrument’s performance and functions.• Everyefforthasbeenmadeinthepreparationofthismanualtoensuretheaccuracy
 ofitscontents.However,shouldyouhaveanyquestionsorfindanyerrors,pleasecontact your nearest YOKOGAWA dealer.
 • CopyingorreproducingalloranypartofthecontentsofthismanualwithoutYOKOGAWA’s permission is strictly prohibited.
 • TheTCP/IPsoftwareofthisproductandthedocumentconcerningtheTCP/IPsoftware have been developed/created by YOKOGAWA based on the BSD Networking Software, Release 1 that has been licensed from the Regents of the University of California.
 Trademarks• vigilantplant,DAQSTATION,Daqstation,andDXAdvancedareregisteredtrademarks
 of Yokogawa Electric Corporation.• MicrosoftandWindowsareregisteredtrademarksortrademarksofMicrosoft
 Corporation in the United States and/or other countries.• AdobeandAcrobatareregisteredtrademarksortrademarksofAdobeSystems
 Incorporated.• KerberosisatrademarkoftheMassachusettsInstituteofTechnology(MIT).• Companyandproductnamesthatappearinthismanualareregisteredtrademarksor
 trademarks of their respective holders.• Thecompanyandproductnamesusedinthismanualarenotaccompaniedbythe
 registered trademark or trademark symbols (® and ™).
 Revisions1st edition: December 20052nd edition: October 20063rd edition: April 20074th edition: December 20075th Edition: November 20086th edition: March 20107th edition: December 20108th edition: March 2016
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iiiIM 04L41B01-01E
 DX’s Version and Functions Described in This Manual
 The contents of this manual corresponds to the DX1000 with release number 4 and style number 4., and the DX1000N with release number 4 and style number 3.
 DX’s Version and FunctionsFor the procedure to check the version, see section 2.5.
 Edition DX Additionandchangetofunctions Referto2 Version
 1.11(Added) German, French, and Chinese as display language. Section 2.6(Added) Modbus client connection retry interval: 10 s, 20 s, and
 30 s.Section 1.0 in IM04L41B01-17E
 (Added) 24 VDC/AC power supply (/P1 option). IM04L41B01-02EVersion1.21
 (Added) Tab key on the USB keyboard corresponds to arrow keys.
 Section 2.11
 (Added) Operations to request and release network information. Section 1.3 in IM04L41B01-17E(Changed) Modbus client: Function to connect a server with a unit
 number is changed. Section 1.10 in IM04L41B01-17E
 (Added) Modbus client: Connection timeout value. Section 1.10 in IM04L41B01-17E(Added) Modbus registers (floating point type for communication
 input data).Section 6.3 in IM04L41B01-17E
 (Added) A data output format (Skip or OFF channel data not output).
 Section 3.7 in IM04L41B01-17ECB command
 (Changed) Error messages 105, 221, and 222 are added. Section 10.1(Changed) Error messages 215, 218, and 536 are changed. Section 10.1
 3 Releasenumber 2(Version 2.0x)
 (Added) Improvement to the operability on the historical trend display.
 Section 4.3
 (Changed) Displaying the date in the grid time of the trend display when the trend interval is greater than or equal to 1 h/div.
 Sections 1.3 and 2.4
 (Added) Improvement to the display group setup operation. Section 5.1(Added) Addition of the Upper and Lower settings to the bar
 graph base position.Section 5.11
 (Added) Addition of the relay action when alarm ACK is executed to the alarm output relay settings.
 Sections 1.2, 3.5, and 3.8
 (Added) Ability to reset the computed value during computation. Section 9.4(Changed) Changes to how the data files are named. Section 1.4(Added) Sorting the files by the update date/time. Sections 6.7, 6.8, and 6.9(Added) Storage method for constantly retaining the most
 recent data files in the CF card (Media FIFO).Sections 1.4 and 6.2
 (Added) Progress display when saving all data of the internal memory.
 Sections 4.8
 (Changed) Changing the initial display selection menu. Sections 4.8 and 5.17(Changed) Improvement to the data save operation to the USB
 flash memory.Sections 2.12 and 5.17
 (Changed) Retaining the state of the CapsLock and NumLock keys on the USB keyboard.
 Section 2.11
 (Changed) Changing the default setting of the web server function. IM04L42B01-02E, Section 1.5 in IM04L41B01-17E
 (Added) Error messages, 513, 514, 515, and 516 have been added.
 Section 10.1
 Style number 2
 (Added) The waterproof construction of the DX front panel complies with the NEMA4 standard.
 Section 12.6
 4 Same as edition 3
 Added explanations. Fixed explanations. -Changed the direction of the clamp input terminal (/H2 option). IM04L4101-02E
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iv IM 04L41B01-01E
 Edition DX Additionandchangetofunctions Referto5 Release
 number 3(Version 3.0x)
 Divided the setting mode displays with tabs. All setting displaysAdded method for switching from setting mode to basic setting mode.
 Section 2.14
 Improved numeric input operation. Numeric input displayAdded the ability to input the following characters: [ ] and :. Character string input displayAdded new input type (GOST; /N3 option). Section 3.3Increased measurement range for TC Type N. Section 12.5Custom display. IM04L41B01-04E.Multi Batch (/BT2 option). IM04L41B01-03EAlarm level display. Section 3.7Alarm annunciator. Section 3.12Common alarm (/F1 option). Section 2.932-character tag comments and 16-character tag numbers. Section 5.2Faster display update interval. Section 3.1Secondary trend interval changeable during recording. Section 5.3Added 15-, 20-, and 30-minute event data sample rates. Section 6.1Fine grid. Sections 4.2 and 4.3Auto zone display. Sections 4.2 and 4.3Indication that the DX is waiting for a trigger. Section 1.3Decimal point types “Point” and “Comma”. Section 2.13Added favorite key operations. Section 5.15Data searching with date and time. Section 4.3Historical trend relative time display, auto span display, and top channel display.
 Section 4.3
 Number of batch text fields changed to 24. Section 6.3The start recording screen appears when you press the start key while using the batch function.
 Section 6.3
 Changed contents of the system and network information displays. Section 2.5Limits on setting load function. Section 8.1Event switch. Section 7.1Added “CommentDisplay” and “FavoriteDisplay” actions to the event action function.
 Section 7.1
 Remote control contact input changed from operating on Close to operating on Open (/R1 and /PM1 options).
 Section 7.1
 Match time timer reset (/M1 and /PM1 Options). Section 7.1Added “Year” to match time timer conditions (/M1 and /PM1 options) Section 7.1Match time timer usable for TLOG computation (/M1 and /PM1 options).
 Section 9.1
 Stacked bar graphs for report data (/M1 and /PM1 options). Section 4.10Added recording condition variables to equations (/M1 and /PM1 options).
 Section 1.8
 Added USB barcode reader support (/USB1 option). Section 2.11Saving of data from the internal memory to USB flash memory or a CF card (/USB1 option).
 Section 2.12
 Added data searching, report layout display, a print button, and an FTP link to the Web server function.
 Section 1.5 in IM04L41B01-17E
 Modbus register map expansion and floating-point data writing. Section 6.3 in IM04L41B01-17EOnly send alarm e-mails when an alarm has occurred. Section 1.4 in IM04L41B01-17EAdded tag and channel number to alarm e-mails. Section 1.4 in IM04L41B01-17EE-mail transfer authentication (Pop Before SMTP). Section 1.4 in IM04L41B01-17E“°C” displayed in e-mails and the Web settings. Section 1.5 in IM04L41B01-17EAdded the ability to input the square and cube characters (² and ³) in communications (only for English, German, and French).
 Appendix 3 in IM04L41B01-17E
 Added FTP data transfer wait operation. Section 1.7 in IM04L41B01-17EFTP server directory output format can be set to MS-DOS and UNIX.
 Section 1.6 in IM04L41B01-17E
 EtherNet/IP. IM04L41B01-18EPROFIBUS-DP (/CP1 option). IM04L41B01-19E
 Style number 3
 Changed the boot ROM. -
 DX’s Version and Functions Described in This Manual
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vIM 04L41B01-01E
 DX’s Version and Functions Described in This Manual
 Edition DX Additionandchangetofunctions Reference6 Release
 number 4(Version 4.0x)Style number 3
 Advanced security function (/AS1 option). IM04L41B01-05ENReport template (/M1 and /PM1 options). Section 9.6Added the “Seprt2” report file separation method. Section 9.5Calibration management (/CC1 option). Section 3.13Added functions and improvements to the custom display. The main changes are listed below.
 IM04L41B01-04E
 The status display section can be hidden.Items have been added (system icons, group names, memory bar, date and time labels, batch group numbers, batch names, Modbus input).Custom grids can be displayed on the trend display.The bitmap data of the INTERNAL 1 to 3 screens is saved to internal memory.Labels and tags can be displayed vertically.Additional types of current value marks for the scale have been added.The scale unit indication can be hidden.Time can be displayed on all grids on the trend display.Group switching can be stopped.
 Added an alarm sound to the Web server function. Section 1.5 in IM04L41B01-17EThe DX outputs the Modbus input value specified in the custom display. The “E-M” command has been added for the Modbus client and master.
 Sections 1.10 and 2.6 in IM04L41B01-17EIM04L41B01-04E
 Authenticated e-mail transmission (Authentication SMTP). Section 1.4 in IM04L41B01-17EA switch from on to off can be specified as an event. Section 7.1The duration for which the reflash relays are deactivated can be set to 500 ms, 1 s, or 2 s.
 Section 3.5
 Added new input type (Pt200(WEED); /N3 option). Section 3.3Text fields can be input when the batch function is being used and recording starts.
 Section 6.3
 The length of the user password that can be registered with the login function has been extended to 20 characters.
 Section 8.2
 Operations can be assigned to the output relays (/F1 and /F2 options). Section 2.9Models with 400 MB of internal memory have been added (internal memory size suffix code: “-3”).
 IM04L41B01-02E MODEL and SUFFIX Code
 7 Same as edition 6
 Additions and improvements to explanations. -
 8 Release number 4(Version 4.0x)Style number, DX1000: 4DX1000N: 3
 Additions and improvements to explanations. -NLF is supported. IM04L41B01-02EUser’s manuals are supplied by downloading them on the web site. IM04L41B01-02EDX1000 : A 5.7-inch LCD with LED back light replaced a 5.5-inch LCD with CFL back light.
 IM04L41B01-02E Recommended Replacement Periods for Worn Parts
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vi IM 04L41B01-01E
 How to Use This Manual
 StructureoftheManualReadtheOperationGuidefirsttofamiliarizeyourselfwiththebasicoperation,and then read this manual. For a description of the communication function and the accompanying software program, DAQSTANDARD, read the respective manual.This user’s manual consists of the following sections.
 Chapter Title and Contents1 OverviewofFunctions
 Describes the functions of the DX.2 CommonOperations
 Describes the procedure to set the time and the operating procedure using the remote control terminal (/KB1 or /KB2 option) and keyboard (/USB1 option).
 3 MeasurementChannelsandAlarmsDescribes how to set the measurement conditions and alarms.
 4 SwitchingOperationScreensDescribes the operations on the operation screen.
 5 OperationsforChangingtheDisplayedContentsDescribes how to change the displayed contents on the operation screen and how to write messages.
 6 SavingandLoadingDataDescribes how to acquire and store the data. Also describes the procedure to load measured data/setup data on the CF card or the USB flash memory (/USB1 option).
 7 CustomizingActionsUsingtheEventActionandRemoteControlFunctions(/R1and/PM1Options)Describes how to carry out specific actions when a given event occurs, when a remote control signal is applied, and when the USER key is pressed.
 8 UsingtheSecurityFunctionDescribes how to use the key lock function and the function that allows only registered users to operate the DX.
 9 ComputationandReportFunctions(/M1and/PM1Options)Describes how to use computation channels and how to create reports such as hourly, daily, weekly, and monthly reports.
 10 TroubleshootingDescribes error messages and troubleshooting.
 11 MaintenanceDescribes periodic inspection and calibration.
 12 SpecificationsLists the specifications of the DX.
 Appendix Describes how to estimate the file size, the types of data that the DX can generated and how to use them, the data format of text files, etc.
 Index
 Note• Thisuser’smanualcoversinformationregardingDX1000sthathaveasuffixcodefor
 language “-2” (English).• Fordetailsonsettingthedisplaylanguage,seesection2.6,“ChangingtheDisplayed
 Language.”
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viiIM 04L41B01-01E
 ConventionsUsedinThisManual
 Unit Denotes 1024. Example: 768 KB (file size) Denotes 1000. Markings
 WARNING
 Procedure
 Setup Screen
 Setup Items
 Explanation
 CAUTION
 Improper handling or use can lead to injury to the user or damage to the instrument. This symbol appears on the instrument to indicate that the user must refer to the user's manual for special instructions. The same symbol appears in the corresponding place in the user's manual to identify those instructions. In the manual, the symbol is used in conjunction with the word “WARNING” or “CAUTION.” Calls attention to actions or conditions that could cause serious or fatal injury to the user, and precautions that can be taken to prevent such occurrences. Calls attentions to actions or conditions that could cause light injury to the user or damage to the instrument or user’s data, and precautions that can be taken to prevent such occurrences. Calls attention to information that is important for proper operation of the instrument.
 Note
 Indicates character types that can be used. Carry out the procedure according to the step numbers. All procedures are written with inexperienced users in mind; depending on the operation, not all steps need to be taken. Explanation gives information such as limitations related the procedure. Indicates the setup screen and explains the settings. A detailed description of the function is not provided in this section. For details on the function, see chapter 1.
 Subheadings
 A a # 1 A a #
 1
 Uppercase alphabet, lowercase alphabet, symbols, numbers.
 Bold characters Denotes key or character strings that appear on the screen.Example: Volt
 K k
 How to Use This Manual
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1-1IM 04L41B01-01E
 Overview
 of Functions
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 1.1 InputSection
 Measurement Channel• NumberofMeasurementChannelsandScanInterval The DX samples the input signals on the measurement channels at the scan interval
 to obtain the measured values. The table below shows the relationship between the number of measurement channels and the scan interval.
 DX1002, DX1002NDX1004, DX1004NDX1006, DX1006NDX1012, DX1012N
 25 ms125 ms, 250 ms
 2 s, 5 s 125 ms1 s, 2 s, 5 s
 24612
 Fast Sampling Mode*Normal ModeNo. ofMeasurementChannels
 ModelScan Interval
 A/D Converter Integration Time 60 Hz/50 Hz/100 ms60 Hz/50 Hz 600 Hz (fixed)
 * When using the multi batch function (/BT2) the DX do not have a fast sampling mode.For the setting procedure, see section 3.1.
 • IntegrationTimeoftheA/DConverter The DX uses an A/D converter to convert the sampled analog signal to a digital
 signal. By setting the integration time of the A/D converter to match the time period corresponding to one cycle of the power supply or an integer multiple of one cycle, the power supply frequency noise can be effectively eliminated.• Because100msisanintegermultipleof16.7msand20ms,thissettingcanbeusedto
 eliminate the power frequency noise for both frequency, 50 Hz and 60 Hz.• Infast sampling mode, the performance of eliminating power frequency noise is worse than in
 normal mode. We recommend that you use normal mode when making measurements in an environment affected by power frequency noise.
 For the setting procedure, see section 3.1.
 InputTypeandComputationYou can make measurements using the following input types.
 Input Type DescriptionDC voltage You can measure DC voltages in the range of ±20 mV to ±50 V.DC current You can measure a DC current signal by converting it to a voltage signal using a shunt*1 resistor attached to the input terminal. The converted signal can be measured within the DC voltage range (see above).Thermocouple You can measure temperatures corresponding to these thermocouple types: R, S, B, K, E, J, T, N, W, L, U, and WRe3-25. It is also possible to measure using other thermocouples, such as PR40-20 and PLATINEL.*2
 RTD You can measure temperatures using RTD types Pt100 and JPt100. It is also possible to measure using other RTD types such as Cu10, Cu25,*3
 Pt50, and Ni100.*2
 ON/OFF input You can display contact input or voltage input signals correlated to 0% or 100% of the display range. Contact input: A closed contact is on (1). An open contact is off (0). Voltage input: Less than 2.4 V is off (0). 2.4 V or more is on (1).Pulse input*4 You can count pulses.*1 Item sold separately. For example, you can use a 250-Ω shunt resistor to convert a 4- to 20-mA signal to a 1- to 5-V signal.*2 /N3 option*3 /N1 option*4 /PM1 option
 Chapter1 OverviewofFunctions
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 The following input processing and computation are available.
 DC Voltage
 DC current Shunt resistor
 1 - 5 V Burnout detection
 Burnout detection
 RJC
 Square root computation
 Thermocouple
 RTD
 Pulse
 (/PM1 option)
 ON/OFF input
 Convert to number of pulses over 1 second
 Moving average Linear scaling
 Calibration correction
 (/CC1 option)
 Difference computation
 Low cut Measured value
 Dotted lines indicate that the function can be selected.
 √
 Measured value
 Moving Average
 External reference junction
 Internal reference junction
 Performs reference junction compensation on the thermocouple.
 Reference Junction Compensation Burnout DetectionDetects and indicates a burnout in the sensor.
 1 - 5 VDetected on the 1-5 V value.
 Burnout
 For the setting procedure, see section 3.2. For the setting procedure, see section 3.2.
 For the setting procedure, see section 3.4.
 Burnout
 Indicated as Burnout.
 Indicated as Burnout.
 Thermoelectromotive force
 123
 10.0 mV5.0 mV0.0 mV
 5.0 mV
 15.0 mV10.0 mV5.0 mV
 10.0 mV
 10.0 mV15.0 mV10.0 mV
 11.7 mVClear
 nth time n + 1th time n + 2th time
 Clear(Moving average)
 New sampled data
 New sampled data
 Operation example when the number of moving average data points is 3
 Number of moving average data points: 2 to 400Sampling data
 in the buffer
 Sampling
 Eliminates noise.
 DX
 Thermocouple
 Thermocouple
 1.1InputSection
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 Difference computation
 Low-cut
 Square Root Computation
 Calibration Correction (/CC1 Option)
 Input value
 Measured value
 Measured value
 Input value
 Input value
 Input value
 Input value
 Measured value
 Measured value
 Measured value on the reference channel
 –
 The measured value of the channel is set to the difference with respect to the measured value of the reference channel.
 Converts the unit to obtain the measured value. Takes the square root of the input value and converts the unit to obtain the measured value.
 Corrects the input value with the characteristics specified by segments to obtain the measured value.
 Number of break points: Up to 16
 Pulse Input (/PM1 Option)
 Linear Scaling
 10 V
 0 V
 300 °c
 –100 °c
 a
 b
 x
 a b
 B
 B
 X
 A
 A X = (B – A) + A
 x – a
 b – a
 The contact changes from open to close. The signal level at the input terminal changes from high to low.
 5 ms or more
 100 Hz or less Pulse
 Contact
 or
 Open collector
 Pulse that can be counted Input to the DX
 Count on the DX
 Measured value
 Output value
 For square root computation, measured values below the specified value are cut. For 1-5 V input, values below 0 % are cut.
 Result of square root computation
 Low-cut value
 DX
 For the setting procedure, see section 3.3. For the setting procedure, see section 3.3.
 For the setting procedure, see section 3.9. For the setting procedure, see section 3.3.
 For the setting procedure, see section 3.3. For the setting procedure, see section 3.10.
 ( )
 NoteDifference computation is executed even if the input type or range is not the same between the difference computation channel and the reference channel. The difference is computed discarding the decimal place and unit, and the decimal place and unit of the difference computation channel are applied.
 Example 1: If the input value of the difference computation channel is 10.00 and the measured value of the reference channel is 100.0, the computed result is 10.00 – 100.0 = –90.00.
 Example 2: If the input value of the difference computation channel is 10.00 V and the measured value of the reference channel is 5.00 mV, the computed result is 10.00 V – 5.00 mV = 5.00 V.
 CalibrationManagement(/CC1option;releasenumbers4andlater)You can use this function to make sure that calibration is performed regularly.When you enable calibration management, a screen (the calibration notification screen) appears to notify you in advance that the calibration due date is approaching.For the setting procedure, see section 3.13.
 1.1InputSection
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 1.2 Alarms
 This function generates an alarm when the measured data meets a certain condition. Up to four alarms can be set for each channel.
 AlarmTypeYou can use the alarms shown below. The character inside the parentheses is the symbol denoting each alarm.For the alarm setting procedure, see section 3.7.
 High Limit Alarm (H)
 Alarm value
 Alarm output ON Alarm output ON
 Alarm output ON Alarm output ON
 Alarm value
 HysteresisMeasured value Measured value HysteresisLow Limit Alarm (L)
 Alarm output ON Alarm output ON
 Delay time Delay time
 Alarm valueAlarm valueMeasured value Measured value
 Delay High Limit Alarm (T) Delay Low Limit Alarm (t)
 High Limit on Rate-of-Change Alarm (R) Low Limit on Rate-of-Change Alarm (r)
 Alarm valueAlarm value
 Hysteresis HysteresisDifference in the measured values of two channels Difference in the measured values of two channels
 Difference High Limit Alarm (h) Difference Low Limit Alarm (l)
 Change in the measured value
 Change in the measured value
 Measured value Measured value
 Time TimeInterval (t2-t1) Interval (t2-t1)
 Amount of change in the setting| |
 T2
 T1
 t1 t2
 T2
 T1
 t1 t2
 T2-T1Amount of change in the setting
 |T2-T1
 • AlarmHysteresis You can set a width (hysteresis) to the value used to activate and release alarms.
 • DelayHighLimitAlarmandDelayLowLimitAlarm An alarm occurs when the measured value remains above or below the alarm value
 foraspecifiedtimeperiod(delayperiod).
 • HighLimitonRate-of-ChangeAlarmandLowLimitonRate-of-ChangeAlarm
 The rate-of-change of the measured values is checked over a certain time (interval). An alarm occurs if the rate-of-change of the measured value in the rising/falling directionisgreaterthanorequaltothespecifiedvalue.
 The alarm value of the rate-of-change alarm is set using an absolute value. The interval is derived using the following equation and set using the number of samples.
 Interval=thescaninterval×thenumberofsamples For the setting procedure, see section 3.5.
 • DifferenceUpperLimitAlarmandDifferenceLowerLimitAlarm An alarm occurs when the difference in the measured values of two channels is
 greater/lessthanorequaltothespecifiedvalue.Thesealarmscanbespecifiedonmeasurement channels set to difference computation.
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 AlarmIndicationThe alarm conditions are displayed as alarm icons in the status display section and on the operation screen such as the trend, digital, bar graph, overview displays. Detailed information about the alarms is displayed in the alarm summary.• AlarmLevelsandColors(Releasenumber3orlater) You can set separate levels and colors for the four alarms on a single channel. When
 multiple alarms occur, the DX gives higher priority to the display of alarms with higher levels. It is easy to understand what processes are taking place when alarms occur if you associate an alarm’s color with its level. Level and color settings are the same for each channel.• Intheoverviewdisplay,thechanneldisplayareaappearsinthecolorofthealarm
 that has occurred.
 • Thefollowingitemsalsoappearinthecolorofthealarmthathasoccurred. • Alarmmarksinthetrend,digital,andbargraphdisplays • Thealarmpointmarksonscales(whentheyaresetto“Alarm”) • Thealarmoccurrencemarkinthealarmsummary
 When multiple alarms occur on the same channel, the various displays respond as described below:• Intheoverviewdisplay,thechanneldisplayareaisdisplayedusingthecolorofthe
 alarm with the highest priority level.• Inthetrendanddigitaldisplays,thealarmtypeisdisplayedusingthesymbolfor
 the alarm with the highest priority level.• Intheannunciatordisplay,thedisplaywindowisdisplayedusingthecolorofthe
 alarm with the highest priority level. For the setting procedure, see section 3.7.
 • Alarm-ActivatedTextDisplay(Releasenumber3orlater) Using the Event Action function, you can display a previously set string of text (comment
 text block) when an alarm occurs. For the procedure to set comment text blocks and event action, see sections 5.18 and
 7.1, respectively.
 • Hold/Non-holdofIndicationsThe alarm indication can be set to operate in the following fashion when the condition is no longer met.• Clearthealarmindication(non-hold).• HoldthealarmindicationuntilthealarmACKoperationisexecuted(hold).The default setting is non-hold.
 For the setting procedure, see section 3.5.
 • AlarmHideFunction No indication is made when an alarm occurs. The alarm is also not recorded in the
 alarm summary. The alarm is output to the relay (/A[ ] option) or internal switch. This function can be set for each channel and each alarm.
 For the setting procedure, see section 3.6.
 1.2Alarms

Page 18
						

1-6 IM 04L41B01-01E
 1.2Alarms
 AlarmOutputRelayOperationContact signals can be generated from alarm output relays (/A_ option) when alarms occur. The alarm output relay operation can be changed.For the setting procedure, see section 3.5.
 Alarm
 Alarm output relay(Reflash on)
 Alarm output relay(Reflash off)
 Channel 1
 Channel 3Channel 2
 Energize or De-energize
 AND/OR
 AlarmChannel 1
 AND
 Channel 2
 OR
 Alarm output relayorinternal switch
 NOEnergize
 De-energize
 C NC NO C NC NO C NC
 NO C NC NO C NCNO C NC
 When poweris shut down
 NO: Normally OpenedC: CommonNC: Normally Closed
 Normaloperation
 When an alarmis occurring
 Alarm
 Normal
 Alarm
 Normal
 Reflash
 (You can set AND/OR for the alarm output relay and internalswitch. For details about the internal switch, see the next page.)
 (when a relay is set to OR logic)
 Nor
 mal
 Res
 etR
 elay
 Act
 ion
 on A
 CK
 R
 elay
 Act
 ion
 on A
 CK
 Occurrence
 Activated
 Deactivated
 Activated
 Deactivated
 Activated
 Deactivated
 Release
 or
 Activated
 Deactivated
 or
 Dis
 play
 Ala
 rmH
 old
 Non
 -hol
 dA
 larm
 out
 put r
 elay
 Hol
 dN
 on-h
 old
 Hol
 dN
 on-h
 old
 Non-hold/Hold
 Relay is activatedat the next scaninterval.
 Relay is activatedwhen the nextalarm occurs.
 Alarm ACKAlarm ACK
 500 ms, 1 s, or 2 s
 • Reflash Whenmultiplealarmsareassignedtoonealarmoutputrelay,thisfunctionnotifiesthe
 occurrenceofsubsequentalarmsaftertherelayisactivatedbythefirstalarm.Whensubsequent alarms occur, the output relay is released temporarily.The duration for which the relays are deactivated can be set to 500 ms, 1 s, or 2 s.
 Thereflashfunctionissetonthefirstthreeoutputrelays.* I01 to I03. I01 and I02 for the /A1 option.
 NoteWhen reflash is enabled, the first three output relays are used exclusively as reflash relays. The first three output relays are set to OR logic and de-energize operation regardless of the AND/OR and energize/de-energize settings explained below.
 • AND/OR When multiple alarms are assigned to one alarm output relay, the condition for
 activating the output relay can be selected from the following: You can select AND operation also for the internal switch.• AND: Activatedwhenallassignedalarmsareoccurringsimultaneously.• OR: Activatedwhenanyofthespecifiedalarmsisoccurring.
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 • EnergizeorDe-energizeOperation You can select whether the alarm output relay is energized or de-energized when an
 alarm occurs. If de-energized is selected, the status of the alarm output relay when an alarm occurs is the same as the status that results when the DX power is shut down. The setting applies to all alarm output relays.
 • Non-Hold/Hold The alarm output relay can be set to operate in the following fashion when the alarm
 condition is no longer met.• TurnOFFtherelayoutput(non-hold).• HoldtherelayatONuntilthealarmACKoperationisexecuted(hold).The setting applies to all alarm output relays.
 • AlarmACKOperation The alarm acknowledge (alarm ACK) operation releases all alarm indications and
 relay outputs. For the action of alarm indication and alarm output relay when you carried out the alarm ACK operation, see the previous page.
 • IndividualAlarmACKOperation(OnlyonDXswiththe/AS1advancedsecurityoption)
 This operation releases the relay output of individual alarms. This operation is referred to as “individual alarm ACK.” For information about how alarm display and output relay operations respond to an individual alarm ACK, see the previous page. You can perform individual alarm ACK from the overview display.
 For operating instructions, see section 4.4.
 NoteWhen you enter the basic setting mode, the hold/non-hold condition of the alarm output relay immediately before is retained. In the basic setting mode, alarms are not detected, and you cannot acknowledge alarms.
 InternalSwitchThe alarm status can be output to software switches (30 internal switches). The values of the internal switch are shown below. Like the alarm output relay, you can specify AND/OR operation (see the previous page). The internal switches cannot be operated other than for alarm output.
 Alarm
 Alarm occurrence
 Alarm release
 Internal switch1
 0
 The internal switches can be used events of the event action function (see section 1.6). In addition, the internal switches can be written in calculation expressions of computation channels (/M1 or /PM1 option).
 1.2Alarms
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 1.2Alarms
 AlarmAnnunciatorFunction(Releasenumber3orlater)You can use the DX as an alarm annunciator. No lock-in, lock-in, and double lock-in sequences are supported. The alarm display and alarm output relay operations follow the annunciator sequence.
 For the setting procedure, see section 3.12.
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 1.3 Display
 CommonItemsRelatedtotheDisplay• TFTColorLCDandtheScreenConfiguration The DX has a TFT color LCD (240 × 320 dot resolution). The screen consists of the
 status display section and the data display section.
 Status display section
 Data display section
 • StatusDisplaySection The status display section shows the display name, date/time, batch name (when
 using the batch function), user name (when using the login function), usage of the internal memory or CF card, alarm occurrence, computation status (/M1 or /PM1 option), and usage of key lock or e-mail transmission.
 • DataDisplaySection The data display section shows the measured data using numeric values,
 waveforms, and bar graphs. It also shows the setup screen when setting functions.
 • GroupDisplay On the trend, digital, and bar graph displays, the data of channels is displayed by
 groups that are set in advance. Up to 10 groups can be registered, and up to six channels can be assigned to each group. Groups are common to the trend, digital, and bar graph displays.
 Thedisplayedgroupcanbeswitchedautomaticallyataspecifiedtimeinterval(5sto1 min).
 For the setting procedure, see section 5.1.
 • ChannelNumberDisplayandTagDisplay You can choose to label displayed channels according to their tags or according
 to their channel numbers. In the tag display, you can display tag numbers and comments. This setting applies to all channels.
 For the setting procedure, see section 5.2. For the tag number and tag comment display example, see section 4.2.
 • UpdateIntervalofMeasuredValues The values are updated every second. However, if the scan interval is greater than 1 s,
 the values are updated at the scan interval. For the setting procedure, see section 5.3.
 • AlarmIndication Alarms that are set for each channel are checked at all times and are indicated with
 the symbol representing the alarm type on each display.
 High limit on rate-of-change alarmLow limit on rate-of-change alarmDelay high limit alarmDelay low limit alarm
 RrTt
 Alarm Type Symbol Alarm Type SymbolHigh limit alarmLow limit alarmDifference high limit alarmDifference low limit alarm
 HLhl
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 StatusDisplaySectionThe following information is displayed in the status display section during operation mode or setting mode.
 Memory sampling status
 Error in internal memory. Contact your nearest YOKOGAWA dealer for repairs.
 Memory sampling icon
 Data typeDISP: Display dataEVENT: Event data
 Memory sampling progressDisplays the progress using a green bar graph. The frame indicates the file save interval (display data) or the data length (event data).
 Displays the remaining memory sampling time for the left bar graph.
 Memory sampling stopped
 Memory sampling in progress
 If the “batch number-lot number” exceeds 20 characters, the “date and time” position is used to display the “batch number-lot number.”
 Batch name and the display name are shown alternately.
 Name of the user logged in
 Batch name, the display name, and date and time areshown alternately.
 Date and timeDisplayed in yellow while the time is being corrected.
 Display name or group nameFor all channel display on the trend display, “All” is displayed.
 When using the login function
 When using the batch function
 Date and time
 Name of the user logged inWhen using the login and batch functions
 Date and time and the display name are shown alternately.
 Displayed when any alarm is activated.Blinks when there are alarms that are occurring but have not been acknowledged.
 All alarms have been released after they have occurred, but there are alarms that have not been acknowledged.
 The status assigned to the status output (/F1 option) is occurring.
 CF card icon
 Keys are locked.
 E-mail transmission is enabled.
 White icon: Computation started
 Yellow icon: Computation data dropout occurred
 CF card is being accessed.
 Waiting.
 Light blue icon: CF card in the slot is not recognized. Remove and reset it. CF card error.Carry out the procedure below to reset the CF card icon to normal.• Remove the CF card, and then reinsert it.• Replace the CF card with a normal one.• Format the CF card on the DX (the data on the CF card will be erased).
 Alarm icon
 Status icon
 Computation icon (/M1 or /PM1 option)
 (Red)
 (Green)
 The green level display indicates the amount of CF card used. If Media FIFO* is not enabled and the free space on the CF card falls below 10%, the level indicator changes to red.* See section 1.4, in the DX1000/DX1000N User's Manual. Media FIFO is a function available on release number 2 or later.
 User locked icon (/AS1 option)Displayed when the user is locked.
 BarGraphWhen event data recording is set to pretrigger, the DX will start recording pretrigger data after you press the START key. “Waiting” appears in the bar graph (release number 3 or later). At this time, the progress bar will turn orange. After the pretrigger time elapses, the length of the bar fixed at that point. However, the relevant data is updated until the trigger condition is met. When the trigger condition is met, the bar turns green, and data is recorded after the data in the pretrigger section.
 1.3Display
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 TrendDisplay(T-Y)Measured data is displayed in a waveform. For the operating procedure, see section 4.2.
 Horizontal displayDisplay layout
 Horizontal wide display
 Trend interval
 Current value mark
 Scale
 Color scale band
 Alarm point mark
 Current value indicatedby bar
 Alarm markAlarm type
 Tag or channel number,measured value, unit, and specified alarm
 1 division(30 dots)
 Maximum value
 Trend Space functionInserts a division-widespace here.
 Minimum value
 1 dot
 Displays the maximum and minimum values sampled in the time corresponding to one dot.
 Waveform (displayed with the set channel color)To change channel colors, see section 5.5.To change waveform line width, see section 5.10.To display every channel's waveform, see section 4.2.
 See section 5.8
 See section 5.7
 See section 5.10
 See section 4.2
 Time at the grid positionEither displays the time,or the date and time.
 See sections 2.4 and 5.3
 GridSee section 5.10
 See section 5.3
 Trip line (up to four lines)See section 5.1
 See section 5.7
 See section 5.8
 Numeric display sectionSee section 4.2
 Horizontal split display (displays two groups)The waveforms of two consecutive groups are displayed. The numeric display sections show the data for the first four channels in their groups.
 1.3Display
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 • UpdatingoftheWaveform On the screen, 30 dots along the time axis is represented by a unit called division (see
 thefigureonthepreviouspage).Thedisplayedwaveformisupdatedatanintervalcorresponding to one dot. This interval is determined by the time corresponding to one division (referred to as the trend interval). The relationship between the trend interval and the speed of movement of waveforms on the screen is as follows:Trendinterval(/DIV) 5 s*1 10 s*1 15 s*2 30 s 1 minTimecorrespondingtoonedot(inseconds) 0.125 0.25 0.5 1 2Speedofwaveformmovement(approximationinmm/h) 10000 5000 2500 1250 625Trendinterval(/DIV) 2 min 5 min 10 min 15 min 20 minTimecorrespondingtoonedot(inseconds) 4 10 20 30 40Speedofwaveformmovement(approximationinmm/h) 312 156 78 42 31Trendinterval(/DIV) 30 min 1 h 2 h 4 h 10 hTimecorrespondingtoonedot(inseconds) 60 120 240 480 1200Speedofwaveformmovement(approximationinmm/h) 21 10 5.2 2.6 1.0*1 40 dots per division. Selectable on the DX1002, DX1002N, DX1004, and DX1004N
 (release number 3 or later). *2 Selectable on the DX1006, DX1006N, DX1012, and DX1012N when the scan
 interval is set to fast sampling mode (release number 3 or later).
 SwitchingtheTrendInterval You can switch from the normal trend interval to the secondary trend interval during
 memory sampling and vice versa. For the operating procedure, see section 5.3.
 • WritingMessages
 Preset messages
 Free message Set the message when writing the message
 1 2 3 4
 Start Material 1
 Trend display
 PresetMessages Preset messages are recalled and written. The number of messages that you can use are 100 (message 1 to 10 are shared with
 free messages). For the operating procedure, see section 5.4
 FreeMessages Messages are entered when you need to enter them. The number of messages that
 you can use are 10. For the operating procedure, see section 5.4.
 AutomaticMessageWriting• Amessageiswrittenwhenthetrendintervalisswitchedduringmemorysampling.
 For the setting procedure, see section 5.3.• Amessageiswrittenwhenthepowerrecoversfromapowerfailureduringmemory
 sampling. For the operating procedure, see section 5.16.• Amessageiswrittenwhenthesettingmodesetupitemsarechangedduring
 memory sampling (only on DXs with the /AS1 advanced security option).
 1.3Display
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 Messagedisplaymethod• Exceptfortheverticaldisplay,youcansetthedirectioninwhichmessagesare
 displayed to horizontal or vertical. For the setting procedure, see section 5.10.• Messagescanbedisplayedconsolidatedattheupperleftofthescreen(list
 display). For the operating procedure, see section 4.2.
 List display
 Vertical display
 • ZoneDisplay Youcandisplaychannelsinspecifiedzones.Thisfunctioncanbeusedtokeepthe
 waveforms from overlapping for easier view. In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the
 30 to 60% zone, and channel 3 in the 60 to 100% zone.
 100%0%
 Channel3Channel2Channel1
 100%30%0% 60%Zone 3Zone 2Zone 1
 Normal display Zone display
 For the setting procedure, see section 5.6.
 AutoZone(Releasenumber3orlater) You can divide the waveform display area evenly between each channel in a group.
 For operating instructions, see section 4.2.
 1.3Display
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 • PartialExpandedDisplay By compressing a section of the waveform display range, the rest of the section is
 expanded. In the example below, 0 V (boundary value) is moved to the 30% position of
 the display range (new boundary position). The 30% area below the boundary corresponds to “– 6 V to 0 V” and 70% area above the boundary corresponds to “0 V to 6 V.”
 100100 30
 0
 50
 0 6V6V
 0
 –6V–6V
 0
 Partial Expanded DispalyNormal DisplayExpanded portionCompressed portion
 % of full display span
 Measured valueMeasured value For the setting procedure, see section 5.9.
 • AlarmIndication Alarm mark, alarm type, and measured value are displayed as follows according to
 the alarm status. When you use the alarm annunciator function (release number 3 or later), the alarm mark follows the annunciator sequence.
 AlarmRelease
 Red None RedNone Red RedNone None None None None
 Alarm ACK Alarm ACKOccurrence
 When indication is set to non-hold
 When indication is set to hold
 Alarm type
 Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured value
 Blinking red
 Blinking green
 Blinking red
 Green Red RedGreen Green GreenGreen GreenAlarm mark
 1.3Display
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 DigitalDisplayDisplays the measured data numerically using large numbers. For the operating procedure, see section 4.2.
 Unit
 Tag or channel number
 Alarm mark
 Measured value
 Note• Numericdisplayofmeasurementchannels If a measured value of a measurement channel is over range (see below), the measured
 value is indicated as “+Over” or “–Over.” If a burnout is detected on a channel whose burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric value is displayed.
 Overrangeofmeasurementchannels• ForDCvoltageinput,overrangeoccurswhenthemeasuredvalueofthemeasurement
 channel exceeds ±5% of the measurable range. For example, the measurable range when the measurement range is 2 V is –2.000 to 2.000 V. If the measured value exceeds 2.200 V, + over range occurs; if the measured value falls below –2.200 V, – over range occurs.
 • ForthermocoupleorRTDinput,overrangeoccurswhenthemeasuredvalueexceedsapproximately ±10°C of the measurable range. For example, the measurable range when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds approximately 1770.0°C, + over range occurs; if the measured value falls below approximately –10.0°C, – over range occurs.
 • Forchannelsthatarelinearlyscaled,+overrangeoccurswhenthevalueexceeds30000 excluding the decimal point; – over range occurs when the value falls below –30000. However, + over range can be changed to greater than or equal to 105% of the scale width and – over range to less than or equal to –5% of the scale width within ±30000. For the setting procedure, see section 3.11.
 • Numericdisplayofcomputationchannels See section 1.8, “Computation and Report Function (/M1 and /PM1 Options)
 • AlarmIndication Alarm mark and measured value are displayed as follows according to the alarm
 status. When you use the alarm annunciator function (release number 3 or later), the alarm mark follows the annunciator sequence.
 AlarmRelease
 Alarm ACK Alarm ACKOccurrence
 When indication is set to non-hold
 When indication is set to hold
 Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured value
 Blinking red
 Blinking green
 Blinking red
 Green Red RedGreen Green GreenGreen GreenAlarm mark
 1.3Display
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 BarGraphDisplayWaveform data is displayed in a bar graph. For the operating procedure, see section 4.2.
 Horizontal
 Vertical
 Alarm point mark
 Scale marks
 Bar (displayed withthe set channel color)
 Measured value
 Unit of measurementand lower limit
 Upper limit
 Tag or channel numberAlarm mark
 Bar graph base position is set toNormal, Lower, or Upper.You can select Lower or Upper on a DXwith release number 2 or later.
 Bar graph base position is set toCenter.
 See section 5.7
 See section 5.11
 See section 5.10
 See section 5.11
 Bar graph base position is set to Center.See section 5.11
 See section 5.11
 • UpdatingoftheBarGraph The bar graph is updated at the same interval as numeric values.
 • AlarmIndication Alarm mark, alarm point mark, and measured value are displayed as follows according
 to the alarm status. When you use the alarm annunciator function (release number 3 or later), the alarm marks and alarm point marks follow the annunciator sequence.
 AlarmRelease
 Red Green RedGreen Red RedGreen Green Green Green Green
 Alarm ACK Alarm ACKOccurrence
 When indication is set to non-hold
 When indication is set to hold
 Point mark
 Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured value
 Blinking red
 Blinking green
 Blinking redGreen Red RedGreen Green GreenGreen GreenAlarm mark
 1.3Display
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 1.3Display
 HistoricalTrendDisplayThe waveform of the past measured data (display or event data) in the internal memory or external storage medium can be displayed. This function is called Historical trend.• MethodsofDisplayingtheHistoricalTrend There are four methods to display the historical trend of the measured data in the
 internal memory.• Displayfromthealarmsummary.Fortheoperatingprocedure,seesection4.6.• Displayfromthemessagesummary.Fortheoperatingprocedure,seesection4.7.• Displayfromthememorysummary.Fortheoperatingprocedure,seesection4.8.• Recallfromthedisplayselectionmenu.Fortheoperatingprocedure,seesection4.3.
 Measured data on an external storage medium can also be displayed as historical trend. For the operating procedure, see section 6.8.
 • DisplayedContents
 Cursor
 Historical trend
 Present trend
 Message
 Measured values (maximum andminimum values for the entire display)*1
 Measured values (maximum andminimum values at the cursor position)*1
 Waveform (channel display color)Background color(changeable)
 Location of the mostrecent data
 Date and time at the left end of the time axis*2
 Half screen display
 Trip line
 Date and time at the right end of the timeaxis*2, or the time at the cursor locationThe time at the cursor location issurrounded by a yellow square.
 Unit
 Tag or channel number(channel display color)
 *1 You can also view a digital display of just the value at the cursor position (release number 3 or later).*2 You can also display the relative time from the start of recording (release number 3 or later).
 Item DescriptionAlarm summary Displays an alarm summary of the displayed data.Message summary Displays a message summary of the displayed data.Data information Shows information about the displayed data (file name, sample start time, end time, etc.).
 • AddedMessagesAdded messages can be written. For the operating procedure, see section 5.4.
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 • AutoSpanDisplay(Releasenumber3orlater) TheDXcanautomaticallyadjustthedisplayspanoftheselectedchannel.*It sets the
 span based on the maximum and minimum displayed historical data values. This setting is deactivated when you switch to another group.
 * Auto span affects channels that are in the same scale position as the selected channel.
 When the maximum or minimum values are outside of the set display span
 00
 Time axis
 Time axisAuto
 span
 When the maximum or minimum values are within the set display span
 00
 Time axis
 Time axisAuto
 span
 If the maximum or minimum data value falls outside the maximum selectable display span,theDXadjuststhedisplayspantothemaximumorminimumpossiblevalue.TheDXrespondsinthesamewaywhenitencountersoverflowdata.
 • TopChannelDisplay(Releasenumber3orlater) Displays the selected channel’s historical trend waveform in front of all of the others.
 This setting is deactivated when you switch to another group.
 • Signature(OnlyonDXswiththe/AS1advancedsecurityoption) See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 1.3Display
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 OverviewDisplayDisplays a list of the statuses of all channels.You can move the cursor to select a channel and display the trend, digital, or bar graph of the group containing the selected channel.For the operating procedure, see section 4.4.
 Measured value and unit
 Cursor
 Tag or channel number
 Alarm type
 Channels on which an alarm is occurring are indicated in red
 • AlarmIndication Channel display area, tag/channel number, alarm type, and measured value
 are displayed as follows according to the alarm status. When you use the alarm annunciator function (release number 3 or later), the displays of the previously listed items follow the annunciator sequence.
 AlarmRelease
 Blinking white
 Blinking black
 Blinking white
 Black White WhiteBlack Black Black Black Black
 Alarm ACK Alarm ACKOccurrence
 When indication is set to non-hold
 When indication is set to hold
 Tag/Channel
 White None WhiteNone White WhiteNone None None None NoneAlarm type
 White Black WhiteBlack White WhiteBlack Black Black Black BlackMeasured value
 Red Green RedGreen Red RedGreen Green GreenGreen GreenChannel area
 1.3Display
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 AlarmSummaryDisplays a list of the most recent alarms.• Upto1000alarmscanbedisplayed.• Youcanselectarbitraryalarminformationandrecallthehistoricaltrendofthedisplay
 data or event data that contains the alarm information.For the setting procedure, see section 4.6.
 To the historical trend display
 The alarm information number displayed on the screen's bottom lineand the internal memory alarm information number.
 Cursor (selects an alarm)
 : Alarm occurrence ( blinks until the AlarmACK operation is carried out if Indicator is set to Hold.)
 ChannelAlarm level number (1, 2, 3, or 4) and type(H, L, h, l, R, r, T, or t)
 Date and time of alarm occurrence/release
 : Alarm release: Alarm output release (when blinking is cleared through the AlarmACK operation)
 When you use the alarm annunciator function (release number 3 or later), the alarm occurrence mark follows the annunciator sequence. If the alarm sequence is no lock-in (ISA-A-4):• Thealarmoccurrencemarkdoesnotblink.• “ACK”isrecordedwhenthealarmisreleased.
 1.3Display
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 MessageSummaryDisplays a list of written messages and the time the messages were written.• Upto450messagescanbedisplayed.• Upto50messagesthatareaddedtothepastdatasection(addedmessages)canbe
 displayed.• Youcanselectarbitrarymessageinformationandrecallthehistoricaltrendofthe
 display data or event data that contains the message.For the setting procedure, see section 4.7.
 To the historical trend display
 Number of the message displayed on the bottom line/number of messages in the internal memory
 Cursor (selects the message)
 Message Added message (displayed in blue)
 Date/Time when the message was written
 Destination group to write the messageAll groups “A”or a group number, or the second of the date/time when the message was written.
 • SwitchingoftheDisplayItems You can switch between two sets of display contents.
 • Message,timewhenthemessagewaswritten,andgrouptowhichthemessagewas written or second of the time when the message was written
 • Message,usernamethatwrotethemessage
 1.3Display
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 MemorySummaryDisplays the information pertaining to the display data and event data in the internal memory.• Byselectingthedisplaydataoreventdata,thehistoricaltrenddisplaycanberecalled.• Thenumberofmanualsampleddataandreportdata(/M1and/PM1options)inthe
 internal memory is displayed.
 For the operating procedure, see section 4.8.• Youcandisplayfileinformation(onlyonDXswiththe/AS1advancedsecurityoption). See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 To the historical trend display
 Cursor (selects the file) Date/Time of memory start
 Date/Time of memory stop
 Sampling count Status
 Number of data points in the internal memory/maximum number of data points that can be recorded in the internal memory
 Date/Time of the most recent data
 Data type • Display data • Event data
 • SwitchingoftheDisplayItems You can switch between two display methods.
 • Displaythestartandendtimes• Displaythefilename
 • SavingtheData ThedataintheinternalmemorycanbesavedtoaCFcardorUSBflashmemory
 (/USB1 option).
 1.3Display

Page 35
						

1-23IM 04L41B01-01E
 Overview
 of Functions
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 ReportData(/M1and/PM1Options)Report data residing in the internal memory can be displayed.For the operating procedure, see section 4.5.
 Number of the displayed report data/number of report data in the internal memory
 Start: Start date/time Timeup: Report date/time
 Channel number
 Unit
 Report data status Indicates that the following occurred between the report interval. E: Error data O: Over data P: Power failure C: Time change B: Burnout
 Average, maximum, minimum, sum, or instantaneous value
 Report type
 StackedBarGraph(/M1and/PM1options)You can display the report data (that is stored in the internal memory) of each report group in a stacked bar graph.For operating instructions, see section 4.10.For information about report groups, see section 9.5.
 • TypesofDisplayedData The type of displayed data is determined by the report kind, which is set using the
 report function.ReportKind DisplayedReportDataHour, H + D Sums for each hour and sums for the dayDay + Week Sums for each day and sums for the weekDay, D + M Sums for each day and sums for the month
 Daily sums of each channel and thedaily sums of all channels of the report groupIf you select a bar graph, the sumof the hour selected with the cursoris displayed.
 Hourly report group sums (bar graph)
 Sums for the day (bar graph) of a report group
 Example: Hourly + daily display
 • DisplayModes You can switch the bar graph between single graph and dual graph display.
 Single graph displayDual graph display (Shows the data from two consecutive periods)
 1.3Display
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 StatusDisplayThe following displays are available.For the operating procedure, see section 4.5.• RelayStatusDisplay Displays the status of the alarm output relay and internal switch.
 • ModbusClientStatusDisplayandModbusMasterStatusDisplay Displays the command status.
 • EventLevelSwitchStatus(Releasenumber3orlater) Displays the status of the event level switches.
 LogDisplayDisplays various logs (operation log).For the operating procedure, see section 4.9.
 LogType DescriptionLogin*1 Log of login/logout, log of time setting, and log of power failureError Log of error messagesCommunications Log of communication commandsFTP transfer Log of FTP transfersWEB Log of Web operationsE-mail transmission Log of e-mail transmissionsSNTP Log of accesses to the SNTP serverDHCP Log of accesses to the DHCP serverMODBUS Log of communications using Modbus client or Modbus masterOperation*2 Log of operationsChange settings*2 Log of setting changes*1 Only on DXs without the /AS1 advanced security option*2 Only on DXs with the /AS1 advanced security option
 OtherUsefulFunctions• AutomaticallyRevertingtotheSpecifiedDisplay Showapresetdisplaywhenthereisnooperationforaspecifictime. For the setting procedure, see section 5.14.
 • FavoriteKey Register a frequently used display to the Favorite key and enable the display to be
 shown through simple operation. For the setting procedure, see section 5.15.
 • CustomizingtheMenus Change the FUNC key menu that appears when the FUNC key is pressed and the
 screen menu that appears when the DISP/ENTER key is pressed. For the setting procedure, see section 5.17.
 1.3Display
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 SettingtheDisplayConditionsoftheLCDThedisplayconditionsoftheLCDcanbeconfigured.
 DisplayAttribute SettingBackground color of the The background color of the display can be set to white or black. The operation display default value is White. For the setting procedure, see section 5.12.Background color of the You can select white, cream, black, or light gray for the background historical trend screen color of the screen. The default value is Black. For the setting procedure, see section 5.12.LCD brightness The brightness of the LCD can be set among eight levels. The default brightness is 2. For the setting procedure, see section 2.7.Backlight saver The lifetime of the LCD backlight can be extended by automatically turning OFF or dimming the light when there is no key operation for a specified amount of time. The display returns to the original brightness with a key operation or an alarm occurrence. By default, the backlight saver is disabled. For the setting procedure, see section 2.7.
 1.3Display
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 1.4 DataStorageFunction
 This section explains the types of data that the DX can record and how to store them.ForinformationaboutthedatastoragefunctiononDXswiththe/AS1advancedsecurityoption,seetheAdvanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.
 DataTypesThe types of data that the DX can record are as follows:DataType DescriptionDisplay data • Waveformdatadisplayedonthetrenddisplay.Themeasureddataisrecorded
 as a specified sampling interval. The sampling interval is specified using the trend interval.
 • Theminimumandmaximumvaluesamongthemeasureddatawithinthesampling interval are saved.
 • Aheaderstring(commontootherfiles)canbewritteninthefile.• Thedisplaydatacontainsalarmandmessageinformation.• Dataformat:Binary(Undisclosed)
 Event data • Measureddatathatisrecordedataspecifiedsamplinginterval.Therearetwomodes. One mode starts recording when a trigger event occurs. The other mode records at all times.
 • Aheaderstring(commontootherfiles)canbewritteninthefile.• Theeventdatacontainsalarmandmessageinformation.• Dataformat:Binary(Undisclosed)
 Manual sampled data
 • Instantaneousvalueofthemeasureddatawhenamanualsampleoperationisexecuted.
 • Aheaderstring(commontootherfiles)canbewritteninthefile.• Dataformat:Text
 Report data (/M1 and /PM1 options)
 • Hourly,daily,weekly,andmonthlyreportdata.Reportdataiscreatedataninterval that is determined by the report type (one hour for hourly reports, one day for daily reports, and so on).
 • Aheaderstring(commontootherfiles)canbewritteninthefile.• Dataformat:Text• ThedatacanbeconvertedtoXMLspreadsheetdata(releasenumbers4and
 later).Snapshot data (screen image data)
 • TheimagedataoftheDXscreenwhenthesnapshotoperationisexecuted.• ThedatacanbesavedtoaCFcard.• Dataformat:PNG
 Setup data • ThesetupdataoftheDX.• Dataformat:Binary(Undisclosed)
 Custom Display Setup Data
 • ThecustomdisplaysetupdataoftheDX.• Dataformat:text
 • Displaydataandeventdata Display data can be likened to the conventional recording on the chart sheet and
 are useful for long-term recording. Event data is useful when you wish to record the measured data in detail.
 Measured data per scan interval
 Display data
 Event data
 Sampling interval of display data
 Scan interval Time
 Sampling interval of event data
 Maximum value per sampling intervalMinimum value per sampling interval
 Instantaneous value during sampling
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 FlowofDataRecordingandStorageMeasured data is recorded once to the internal memory and then saved to the external storage medium.
 Measurement channel
 Computation channel
 ......
 Data of another device (via communication)
 Display/Event data
 CF card USB memory (/USB1 option)
 External storage medium
 Setup dataDisplay
 Internal memory
 FTP server on the network
 Sampling
 Save the dataScreen image data
 Save
 Load
 InternalMemoryDisplay data and event data are held in files in the internal memory. The data area also stored on the external storage medium in files.
 Save the data
 Directory on the external storage medium
 Manual sampled data Report dataDisplay data and event data
 FTP server on the network
 Internal memory
 File
 ......
 ......
 Sampling
 1.4DataStorageFunction
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 RecordingMethodofDisplayDataandEventDataFor the setting procedure, see section 6.1.• TypesofDatatoBeAcquired Select display data only, display data and event data, or event data only. DecidingtheDatatoBeRecorded Record the data that suits your application. Refer to the following examples. Example 1: Continuously record the waveform data as with the conventional chart
 recorder. Record the display data. Example 2: Record waveform data under normal conditions but record details around
 the point of alarm occurrence when alarms occur. Continuously record display data and record event data when alarms
 occur. Example 3: Only record the most-detailed data at all times. Record event data by specifying the sampling interval. Example 4: No need to continuously record data. Record data only when alarms
 occur. Record event data only when alarms occur.
 • InternalMemory Therecordedmeasureddataisdividedataspecifictimeintervalandsavedtofiles.
 Iftheinternalmemoryisfullorifthenumberofdisplaydatafilesandeventdatafilesexceeds400,filesareoverwrittenfromtheoldestfile.
 • RecordingConditionsofDisplayDataItem DescriptionSource channels Select from measurement channels and computation channels.Sampling interval Specify the sampling interval with the trend interval (see the table
 below). You cannot specify a sampling interval that is faster than the scan interval.
 File creation Files are created at the specified file save interval.
 Time
 File File File Adding data
 Files are also created in the following cases. • Whenafileiscreatedmanually. • Whenthememorysamplingisstopped. • Whenfilecreationisexecutedwiththeeventactionfunction. • Afterrecoveringfromapowerfailure.
 Memory start/stop Press the START key to start recording (memory start) and the STOP key to stop the recording (memory stop).
 Trend interval and the sampling interval of display dataTrendinterval 5 s*1 10 s*1 15 s*2 30 s 1 minSamplerate 125 ms 250 ms 500 ms 1 s 2 sTrendinterval 2 min 5 min 10 min 15 min 20 minSamplerate 4 s 10 s 20 s 30 s 40 sTrendinterval 30 min 1 h 2 h 4 h 10 hSamplerate 1 min 2 min 4 min 8 min 20 min*1 Selectable on the DX1002, DX1002N, DX1004, and DX1004N (release number 3 or later).*2 Selectable in fast sampling mode on the DX1006, DX1006N, DX1012, and DX1012N (release
 number 3 or later).
 1.4DataStorageFunction
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 • RecordingConditionsofEventDataItem DescriptionSource channels Same as the display data.Sampling interval Select from the available settings between 25 ms to 30 min. However,
 you cannot specify an interval that is faster than the scan interval.File creation A file is created when the specified data length is reached. Files are also created in the following cases. • Whenafileiscreatedmanually. • Whenthememorysamplingisstopped. • Whenfilecreationisexecutedwiththeeventactionfunction. • Afterrecoveringfromapowerfailure.Mode The available modes are Free (continuously record), Single, and
 Repeat. The recording operation varies depending on the mode as follows:
 Free Press the START key to start recording (memory start) and the STOP
 key to stop the recording (memory stop) .
 Time
 File File File Adding data Single Pressing the START key places the DX in the trigger-wait state. When
 the trigger condition is met, the DX records data for a specified time (data length) and stops. From this point, the DX does not record even if the trigger condition is met.
 Time
 File
 Trigger condition met
 Repeat Pressing the START key places the DX in the trigger-wait state. When
 the trigger condition is met, the DX records data for a specified time (data length) and stops. The DX enters the trigger-wait sate again and keeps recording the data for a specified time (data length) each time the trigger condition is met. To stop the recording of the event data, press the STOP key.
 Time
 File File
 Trigger condition met Trigger condition met
 PretriggerofEventData Thepretriggercanbespecifiedintriggermode. This function is used to save the data before the point where the trigger condition
 is met as event data. This function is convenient when you wish to record the data before the occurrence of a certain event such as when an alarm occurs.
 Specify the pretrigger as a percentage (0, 5, 25, 50, 75, 95, or 100%) of the recording time (data length) of the event data. If set to 0%, the data after the trigger condition is met is recorded.
 Time
 Trigger condition met
 Data before the trigger
 Data after the trigger
 TriggerforStartingtheEventDataRecording When set to trigger mode, you can set various conditions for starting the recording. Example:Keyoperation,alarmoccurrence,specifictime,orremotecontrol
 1.4DataStorageFunction
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 • CreatingFilesthroughKeyOperation Files can be created using keys.
 Time
 Previous files
 Key operation
 FileFile FileCurrent file
 For operating instructions, see “Saving the Display Data or Event Data during Memory Sampling through Key Operation” in section 6.4.
 ManualSampledData Manual sampled data is recorded to the internal memory. When the number of manual
 sampled data exceeds 400, the data is overwritten from the oldest data.
 Time
 Manual sampled data
 ReportData Report data is recorded to the internal memory. When the number of report data
 exceeds 100, the data is overwritten from the oldest data.
 Time
 Report data
 1.4DataStorageFunction
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 SavingDatatotheExternalStorageMediumFor the setting and operating procedure, see sections 6.2 and 6.4 respectively.• TypeofExternalStorageMedium
 • CFcard(32MBormore)• USBflashmemory(/USB1option)
 • AutoSave Have the CF card inserted in the slot at all times. The data in the internal memory is
 automatically saved to the CF card. AutoSaveTiming
 DataType DescriptionDisplay data The file is saved when the file is created.
 Time
 Save to the CF card
 File File File
 Event data Same as the display data.Manual sampled data The first time manual sample is executed, a manual sampled data file is created on the CF card. The
 data is appended to this file for each subsequent manual sample operation. A new file is created after manual sampled data has been stored 100 times. For operating instructions, see section 6.5.
 Report data The first time report data is generated, a report data file is created on the CF card and report data is stored. The report data is appended to this file every time of report.DividingofthereportfilesThe appending of the report data to the file is stopped at a specified time, and subsequent reports are saved to a new file. The file is divided in the unit shown in the table below. Also, when recording is stopped (memory stop), all report files are divided.ReportTemplate(Releasenumbers4andlater)When the report file is divided, a report data file of the format specified by the XML spreadsheet template is created. This function is disabled in the cases listed under “Seprt2” below.For the setting procedure, see section 9.5.
 ReportType ReportFileFile for Each Type One File Seprt2*1
 Hourlyreport hourly reports of a day hourly reports of a day hourly reports for a dayDailyreport daily reports for a month daily reports for a month daily reports for a monthHourlyanddailyreports
 a file for each daily report hourly reports for a day and a daily report
 daily reports for a month hourly reports of a day hourly reports for a day
 Dailyandweeklyreports
 a file for each weekly report daily reports for a week and a weekly report
 weekly report (not divided)*2
 daily reports for a week daily reports for a weekDailyandmonthlyreports
 a file for each monthly report daily reports for a month and a monthly report
 monthly report (not divided)*2
 daily reports for a month daily reports for a month
 *1 Available for release numbers 4 and later.*2 When media FIFO is enabled, files are divided at approximately every 100 KB.
 SaveDestination CF card.
 DataSaveDestinationDirectory You can set the data save destination directory name (DATA0 by default). The
 specifieddirectoryiscreatedontheCFcard,andthedataissavedinthedirectory.
 SaveOperation(IfMediaFIFOIsDisabled) Thedataintheinternalmemorycanbesavedonlyifthereissufficientfreespaceon
 the CF card. Replace the CF card and save the data before the data in the internal memory is overwritten.
 1.4DataStorageFunction
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 SaveOperation(ConstantlyRetainingtheMostRecentDataFilesUsingMedia FIFO)(ReleaseNumber2orLater)
 Whensavingthedatafilesautomatically,youcansavethedatasothatthemostrecentdatafilesareconstantlyretainedintheCFcard.Thismethodallowyoutousethe DX continuously without having to replace the CF card.
 • Operation
 File 1 File 2 File 3 File 4Deleted Saved
 Update date
 Medium
 Old New
 IfnotenoughfreespaceisavailablewhensavinganewdatafiletotheCFcard,filesaredeletedinorderfromtheoldestdataupdatedate/timetosavethenewfile.This operation is referred to as FIFO (First In First Out).• TheFIFOoperationiscarriedoutonlywhensavingthefollowingfiles
 automatically.Itisnotcarriedoutwhensavingfilestothesavedestinationdirectoryusinganothermethod.Displaydatafiles,eventdatafiles,reportdatafiles,manualsampledatafiles,andsnapshotdatafiles
 • Filesthataredeleted Allthefilesinthesavedestinationdirectoryareapplicabletobedeleted.
 However,thefollowingfilesareexcluded.Hiddenfiles,read-onlyfiles,filesinthe subdirectory within the save destination directory
 • Themostrecent1000filesareretained.Ifthenumberoffilesinthesavedestinationdirectoryexceeds1000,thenumberoffilesisheldat1000bydeletingoldfilesevenifthereisenoughfreespace.
 • ftherearemorethan1000filesalreadyinthesavedestinationdirectory,oneormorefilesarealwaysdeletedbeforesavingthenewfile.Thenumberoffilesisnot kept within 1000 in this case.
 • ManualSave(CollectivelyStoringUnsavedData) Unsaveddataintheinternalmemoryisstoredinunitoffilestotheexternalstorage
 medium when an external storage medium is inserted and a given operation is carried out.
 Time
 Saved the previous time
 Save operation
 FileFile File
 Saved this time
 When using manual save, it is important that you save the data in the internal memory to the external storage medium before the data is overwritten. Determine the usage condition of the internal memory and save the data to the external storage medium at appropriate times.
 SaveDestination YoucanselectaCFcardorUSBflashmemory(/USB1option).
 DataSaveDestinationDirectory You can set the data save destination directory name (DATA0 by default).
 1.4DataStorageFunction
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 • FileName You can select the filenameconfigurationfromthreetypes.
 Date
 Serial
 Batch name
 Display dataEvent dataManual sampled dataSnapshot data
 Report data
 Display dataEvent dataManual sampled dataSnapshot data
 Report data
 .
 .
 .
 .
 .
 .
 Display dataEvent data
 Report data
 Manual sampled dataSnapshot data
 .
 Specified string
 Date
 Date
 Type
 Type
 TypeDate
 Extension
 Extension
 Extension
 Extension
 Extension
 Extension
 ExtensionDate
 Specified string
 Specified string
 Specified string
 Batch name
 Ex.: 000123_AAAAAAAAAAA050928_174633.DAD
 Ex.: 000123_AAAAAAAAAAA.DAD
 Ex.: 000123_AAAAAAAAAAA0HD.DAR
 Ex.: 000123_BBBBBBBBBBBBBBBBBBBBB.DAD
 Ex.: 000123_050928_174633HD.DAR
 Ex.: 000123_050928_174633.DAM
 Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR
 Item
 Date YYMMDD_hhmmss YY: Year (lower two digits), MM: Month, DD: Dayhh: Hour, mm: Minute, ss: Second
 Specified string AAAAAAAAA•••A Up to 16 alphanumeric characters can be usedBatch name BBBBBBBBBBB•••B Up to 40 alphanumeric characters can be used
 7-digit6-digitnumber
 A sequence number in the order of occurrence. The number ranges from 000001 to 999999. If the number reaches 999999, it returns to 000000.Starts with ‘_’ and takes on the following values: A to Z and 0 to 9.If a file with the same name exists in the specified directory, the file is saved by changing the delimiter to prevent overwriting.Example: If a file named “000123_AAAAAAAAAAA.DAD” already exists, the file is saved to the name “000123AAAAAAAAAAAA.DAD.”
 Description
 Structure Description
 Type Report data typeH_: Hourly, D_: Daily, W_: Weekly, M_: Monthly, HD: Hourly and daily, DW: Daily and weekly, DM: Daily and monthly
 H_, D_, W_, M_, HD, DW, DM
 Extension
 7-digit
 7-digit
 7-digit
 7-digit
 7-digit
 7-digit
 7-digit
 1-character delimiter
 Consists of a 6-digit number and 1-character delimiter.
 Display data :DADEvent data :DAEManual sampled data :DAM
 Report data :DARReport data :xml (Report template; release numbers 4 and later)Snapshot data :PNG
 NoteDifferences from the File Names up to Now• The“ID”itemattheendofthefilenameisdeletedanditsfunctionalityisincludedinthe
 “Separator” of the 7-digit sequence.
 000123_AAAAAAAAAAA050928_174633.DAD
 000123_AAAAAAAAAAA050928_1746330.DADDXs before release number 2:
 DXs with release number 2 or later:
 The “ID” functionarity has been shifted.
 Example
 • Thesequencesectionofthedisplaydataandeventdatafilenamesischangedto7digits,and the “ID” function is included in the “Separator” when using the “Batch name.”
 1.4DataStorageFunction
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 FileNamesonDXsbeforeReleaseNumber2The table below shows the file name that is assigned when the measured data is saved to the CF card.
 Date
 Serial
 Batch name
 Display dataEvent dataManual sampled dataSnapshot data
 Report data
 Display dataEvent dataManual sampled dataSnapshot data
 Report data
 .
 .
 .
 .
 .
 .
 Display dataEvent data
 Report data
 Manual sampled dataSnapshot data
 .
 Specified string
 Date
 Date ID
 ID
 ID
 ID
 ID
 ID
 ID
 Type
 Type
 TypeDate
 Extension
 Extension
 Extension
 Extension
 Extension
 Extension
 ExtensionDate
 Specified string
 Specified string
 Specified string
 Batch name
 Ex.: 000123_AAAAAAAAAAA050928_1746330.DAD
 Ex.: 000123_AAAAAAAAAAA0.DAD
 Ex.: 000123_AAAAAAAAAAAHD0.DAR
 Ex.: 123BBBBBBBBBBBBBBBBBBBBB0.DAD
 Ex.: 000123_050928_174633HD0.DAR
 Ex.: 000123_050928_1746330.DAM
 Ex.: 000123_AAAAAAAAAAA050928_174633DH0.DAR
 ItemDate YYMMDD_hhmmss Same as release number 2 and later.
 7-digit sequence 000001 to 999999
 3-digit sequence 001 to 999
 Consists of a 6-digit number and an underscore as a separator. A sequence number in the order of occurrence.
 Type
 ID
 Report data typeSame as release number 2 and later.
 H_, D_, W_, M_, HD, DW, DM
 Extension
 Description
 Structure Description
 7-digit
 7-digit
 7-digit
 7-digit
 3-digit
 7-digit
 7-digit
 A sequence number in the order of occurrence.
 0 to 9, A to Z When a file with the same name exists in the specified directory, the file is saved by changing the ID character to prevent overwriting.Example: If a file named “000123_AAAAA050907_1036480.DAD” already exists, the file is saved to the name “000123_AAAAA050907_1036481.DAD.”
 Except for xml, same as release numbers 2 and later.
 1.4DataStorageFunction
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 • SavingDatathroughKeyOperation You can carry out the following data save operations regardless of whether auto save
 or manual save is used.DataStorage DescriptionAll save Collectively saves all the data in the internal memory.Selective save Saves the specified display data or event data file.Manual sampled data save Collectively saves all the manual sampled data in the internal
 memory. Report data save Collectively saves all the report data in the internal memory.
 SaveDestination YoucanselectaCFcardorUSBflashmemory(/USB1option).
 DataSaveDestinationDirectory Creates a directory with the name of the data save destination directory name with the
 date/time added and saves the data. Directoryname: “Specifiedstring”_YYMMDD_HHMMSS Example: If the data is saved at 17 hours 6 minutes 42 seconds on September 30,
 2005, the data is saved to a directory named “DATA0_050930_170642.” “DATA0”isthespecifiedstring.
 NoteThe number of directories that you can create on the external storage medium varies depending on the length of the directory names. If the length of the “specified string” is 5 characters, approximately 170 directories can be created. If it is 20 characters, approximately 120 directories can be created. An error occurs, if you try to create directories exceeding this limit.
 OtherTypesofDataThatCanBeStored• SetupData ThesetupdataoftheDXissavedtoaCFcardorUSBflashmemory(/USB1option).
 The setup data is saved to the root directory.
 . PDLSpecified
 Example: ABCD10005.PDLName of the setup data file
 • SnapshotData ThescreenthattheDXdisplaysissavedtoaCFcardorUSBflashmemory(/USB1
 option) in PNG format. The data is saved to the same directory as the display data andeventdata.Forthefilename,seethepreviouspage.
 Time
 SnapshotData fileCF card or USB flash memory (/USB1 option)
 • CustomDisplaySetupData See the Custom Display User’s Manual, IM04L41B01-04E.
 SavingDataviatheEthernetNetworkDisplay data, event data, report data (/M1 or /PM1 option), and screen image data (snapshot data) can be automatically transferred and saved to an FTP server via the Ethernet network by using the FTP client function. Conversely, the DX can function as an FTP server. The DX can be accessed from a PC and the data files in the internal memory or the external storage medium can be retrieved to be stored on the PC.See the Communication Interface User’s Manual, IM 04L41B01-17E.
 1.4DataStorageFunction
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 1.5 Batch Function
 This section explains the DX batch function. For information about the multi batch function (/BT2 option), see the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 OverviewYou can add batch information to the display data and event data files. The files can be managed using the batch information.For the setting and operating procedure, see section 6.3.
 BatchInformation• BatchNumberandLotNumber Displaydataandeventdatafilescanbeidentifiedbytheir“batchnumber-lotnumber”
 (hereinafter referred to as batch name). The lotnumberdoesnothavetobespecified.• Batchnumber(upto32characters).
 • Lotnumber(upto8digits)
 • AutomaticIncrementoftheLotNumber The lot number can be automatically incremented when the memory sampling is
 stopped.
 • TextField Youcanentertextfieldsintoafile.Thereare24availabletextfields(releasenumber
 3 or later). Each textfieldconsistsofthefollowing:• Fieldtitle(upto20characters)• Fieldstring(upto30characters)
 ThetextfieldcanbeshownontheDXscreenthroughkeyoperation.
 • Batch Comment Threearbitrarycommentscanbeenteredinafile.Asinglecommentcanbeentered
 while memory sampling is in progress.• Comment1,Comment2,andComment3(upto50characterseach)
 UsingtheBatchFunctionSee the figure below. For example, enter the operator and administrator in the text field.
 Time
 Memory start Memory stop
 Data file
 CommentBatch number + lot number
 Text field
 Comment
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 1.6 EventActionandRemoteControlFunctions(/R1and/PM1Options)
 A specified action is carried out when an event occurs. This function is called event action. The remote control function (/R1 and /PM1 options) allows you to specify actions to be performed when the terminal receives a contact input or an open collector signal. The remote control function is configured using the event action function.For the setting procedure, see section 7.1.
 Events• Events Select from the following events.
 Event Level/Edge*1 DescriptionRemote Level/Edge ON/OFF of the remote control input.Output relay Level/Edge Activated/Deactivated condition of the alarm output relay.Relay-Off*3
 Internal switch Level/Edge The value, 0 (off) or 1 (on), of the internal switch.Switch-Off*3
 Timer Edge Timer timeout.Match time timer Edge When the time matches.Alarm Level/Edge The state in which any alarm is occurring and the state in
 which no alarm is occurring.Alarm-Off*3
 USER key Edge The operation of pressing the USER key.Event edge switch*2 Edge Can be caused by:
 •TheEdgeSwitchsoftkeyintheFUNCkeymenu.•AdedicatedcommunicationcommandorModbus
 communication.•Thecustomdisplay
 Event level switch*2 Level You can view the status of the switch in the event level switch status display. Can be caused by:
 EventLevelSwitch-Off*3
 •AdedicatedcommunicationcommandorModbuscommunication.•Thecustomdisplay.
 *1 For a description of level and edge, see “Miscellaneous” in this section.*2 This function is available for release numbers 3 and later.*3 This function is available for release numbers 4 and later.
 • OutputRelay,InternalSwitch,Alarm,EventLevelSwitch The output relay, internal switch, alarm, and event level switch have two states, state
 A and state B, which are explained in the table below. In explanations, “Output relay” and similar states are referred to as “ON events,” and “Relay-Off” and similar states are referred to as “OFF events.”Event StateA StateBOutput relay Deactivated ActivatedInternal switch OFF ONAlarm No alarms At least one alarmEvent level switch OFF ON
 WhenEdgeIsSelected An ON event occurs when state A changes to state B. An OFF event occurs when
 state B changes to state A. WhenLevelIsSelected If the action states that correspond to states A and B during an ON event are called
 “state 2” and “state 1,” respectively, the action states that correspond to states A and B during an OFF event will be state 1 and state 2, respectively.
 See “Miscellaneous” and “Level and Edge” in this section.
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 • Timers Four timers are available. The timers are also used with the TLOG computation
 function (/M1 and /PM1 options). TimerType
 Time
 Relative timerAbsolute timerSet the timerReset the timer
 B: IntervalTimeout
 TimeSet the timer Ref. time
 A: IntervalA BBA A A
 • AbsoluteTimeMode The timer expires at the times determined by the reference time and the interval. The
 reference time is set on the hour (00 to 23).Example: Reference time: 00:00 Interval: 10 min The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40
 min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36 min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and so on.
 • RelativeTimeMode Thetimerisstartedwhenthetimerisset,andthetimerexpireseveryspecified
 interval. In this mode, the timer stops when a power failure occurs.Example: Interval: 00:15 The timer expires every 15 minutes.
 • MatchTime You can set the time matching conditions for the four match time timers. Specify
 the date/time using the method described below. For each condition, you can select whether to use the condition once or continuously. The timers are also used with the TLOG computation function (/M1 and /PM1 options)SpecifiedDate/Time DescriptionY hour of the X day of the Z year The condition is met once a year. This function is available
 for release numbers 3 and later.Y hour of the X day The condition is met once a month.Y hour of the X day of the week The condition is met once a week.Y hour The condition is met once a day.
 1.6EventActionandRemoteControlFunctions(/R1and/PM1Options)
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 Action• Actions Select from the following actions.
 Action Level/Edge*1 DescriptionMemory start/stop Level Starts/stops memory sampling.Memory start Edge Starts the memory sampling.Memory stop Edge Stops the memory sampling.Event trigger*4 Edge Applies a trigger for starting the event data
 recording. This is valid when recording event data in trigger mode. See the next page.
 Alarm acknowledge Edge Releases the alarm output. This is valid when the use of the alarm ACK operation is enabled.
 Computation start/stop*2 Level It is used to start/stop the computation.Computation start*2 Edge Starts the computation.Computation stop*2 Edge Stops the computation.Computation reset*2 Edge Resets the computed values on all computation
 channels. Save display data Edge The display data being recorded is saved to the
 internal memory as a file. This is the same function as the data save operation using the FUNC key.
 Save event data Edge The event data being recorded is saved to the internal memory as a file. This is the same function as the data save operation using the FUNC key.
 Message Edge Writes a message. This action can be executed while memory sampling is in progress.
 Snapshot Edge Saves the screen image data.Switch the display rate Level Toggles between the trend interval and the
 secondary trend interval. This action is valid when the DX is configured to use trend interval switching.
 Manual sample Edge Executes manual sampling.Reset the relative timer Edge Resets the relative timer. The timer restarts from
 that point.Switch the display group Edge Switches the display group when the trend, digital,
 or bar graph is displayed.Flag*2 Level The flag is zero for normal conditions and 1 when an
 event occurs. When the event is an edge operation, the value alternates between 0 and 1 whenever an event occurs. The flag can be written in a calculation expression of a computation channel.
 Load the setup*4 Edge Loads the setup data file in the root directory of the CF card into the DX and updates the DX settings. See below.
 Adjustthetime Edge Synchronizes the time to the nearest hour. See the next page.
 Display comment*3 Edge Displays a preset text string (comment text block). For information about how to set comment text blocks, see section 5.18.
 Show favorite display*3 Edge Shows the display that is registered to the Favorite key. For information about how to register a display to the Favorite key, see section 5.15.
 Reset alarm display*3 Edge An operation for when you are using a double lock-in sequence (ISA-M) with the alarm annunciator function. Resets the alarm display. For information about annunciator settings, see section 3.12.
 *1 For a description of level and edge, see “Miscellaneous” in this section.*2 This is an option.*3 This function is available for release numbers 3 and later.*4 This action is not available on models with the /AS1 advanced security option.
 1.6EventActionandRemoteControlFunctions(/R1and/PM1Options)
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 ResettingtheRelativeTimer If the event is set to output relay, internal switch, match time timer, or alarm, the
 resetting of the timer is not considered a timeout. (The action is not executed even if the timer is used as an event.)
 LoadingtheSetup Canbespecifiedasanactiononlywhentheeventissettoremotecontrolinput. Loadsthesetupdatafile,LOAD1.PDL,LOAD2.PDL,orLOAD3.PDL,intheroot
 directory of the CF card into the DX and updates the DX settings. YoumustcreateasetupfileandsaveittotheCFcardinadvance.
 EventTriggerOperation When the event is set to output relay, internal switch, or alarm If the output relay is activated, the internal switch is 1, or the alarm is occurring during
 memory sampling, the event trigger is always activated. However, the number of times the trigger is activated depends on the event data mode (single or repeat).
 TimeAdjustment Timeadjustmentcanbespecifiedasanactiononlywhentheeventissettoremote
 controlinput.TheinternalclockoftheDXisadjustedtothenearesthourthroughremote control input.
 • OperationWhenMemorySamplingIsStoppedDifferencefromtheNearestHour Operation00 min 00 s to 01 min to 59 s Truncates the minutes and seconds. Example: 10 hours 01 min 50 s becomes 10 hours 00 min
 00 s.
 02 min 00 s to 57 min to 59 s The time is not changed.58 min 00 s to 59 min to 59 s Rounds up the minutes and seconds. Example: 10 hours 59 min 50 s becomes 11 hours 00 min
 00 s.
 • OperationduringMemorySampling If the time difference between the time the remote control signal is applied and
 the nearest hour is within the preset time, the time is gradually corrected. If the time difference exceeds the preset time but is less than two minutes, the time is immediately corrected. If the time difference is two minutes or more, the time is not corrected. For details, see section 1.10.
 OnDXswiththe/AS1AdvancedSecurityOptionandReleaseNumber4orLaterEvent ConditionsforExecutionOutput relay, internal switch, timer, match time timer, and alarm
 When these events occur, their corresponding actions are performed regardless of the user privilege settings and whether users are logged in.
 User Key The same as the key operation itself. In setting mode, memory start cannot be performed.
 Event edge switch and event level switch
 The same as the key operations themselves. Even in setting mode, memory start cannot be performed.
 Remote When a remote control signal is received, the corresponding action is performed regardless of the user privilege settings and whether users are logged in. In setting mode, memory start cannot be performed.
 1.6EventActionandRemoteControlFunctions(/R1and/PM1Options)
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 Miscellaneous• LimitationsontheCombinationsofEventsandActions The combinations that are checked in the table below can be used.
 Alarm ACKReset the relative timerLoad the settingsAdjust the timeReset the alarm displayOther actions
 RemoteEvent
 Action
 OutputRelay
 InternalSwitch
 Timer MatchTimeTimer
 Alarm UserKey
 EventEdge
 Switch
 EventLevel
 Switch
 • LevelandEdge Thecombinationsofeventsandactionsaresummarizedinthefigurebelow.
 Type Operation
 Level
 LevelState 1
 State 2 Operation executed
 Operation executed
 Edge Edge
 Edge
 Event
 Action
 OFF event
 Level
 Edge Edge
 EventActionExample The following is an example for when the event is Internal switch (Level or Edge) and
 the action is Memory start/stop (Level) or Manual sample (Edge).
 Event Action Operation
 OFFON
 OFF
 Memory start Memory stop ExecutionExecution
 EdgeLevel
 Even
 t(in
 tern
 al s
 witc
 h) Switch
 Action
 Memory start/stop Manual sample
 Switch-Off ON
 LevelandEdgeoftheRemoteControlInputSignal
 Level Edge
 ON
 OFF250 ms or more
 For contact inputs, the remote signal rises when the contact switches from open to closed and falls when the contact switches from closed to open. For open collector signals, the remote signal rises when the collector signal (voltage level of the remote terminal) goes from high to low and falls when the collector signal goes low to high. You can reverse the above operations (see section 7.3 for details).
 1.6EventActionandRemoteControlFunctions(/R1and/PM1Options)
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 1.7 SecurityFunction
 This section explains the DX security functions.ForinformationaboutthesecurityfunctionsonDXswiththe/AS1advancedsecurityoption,seetheAdvanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.
 KeyLockFunctionKey lock is a function that prohibits key operations. You enter a password to release the key lock.For the setting procedure, see section 8.1.
 KeyLockItems DescriptionKeys The following keys can be locked independently. START key, STOP key, MENU key, USER key, DISP/ENTER
 key (prohibits switching the operation screen), and Favorite key.
 Access to the storage medium Prohibits all operations listed below. • Manuallysavethedata • Loadthedisplaydataandeventdatafiles • Save/Loadsetupdatafiles • Listthefilesonthestoragemedium • Deletethefilesonthestoragemedium • Formatthestoragemedium
 Setup loading Prevents external storage medium access for the purpose of loading setup files (release number 3 or later).
 Function operation The following FUNC key operations can be locked independently.
 • [Alarm ACK], [Alarm DispRST]*1
 • [Message],[Freemessage],[Batch], [Add Message], [Add Free Message] [Text field] • [Mathstart],*2 [Math stop],*2 [Math reset],*2
 [Math ACK]*2
 • [Savedisplay],[Saveevent], [Manual sample], [Trigger], [Snap shot], [Timer reset], [Save stop], [Edge Switch],*1 [Match T Reset]*1
 • [E-Mailstart],[E-Mailstop],[E-Mailtest],[FTPtest], Operations to [Request] or [Release] network information • [SNTP],timesetting(operationinthesettingmode) • [Favoriteregist],[Standarddisplay], [Second speed], [Normal speed], [Builder]*1
 *1 Available for release numbers 3 and later.*2 Optional.
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 LoginFunctionOnly registered users can operate the DX. Access from communication functions can also be limited to users registered here.For the setting and operating procedure, see sections 8.2 and 8.3 respectively.• LoginandLogout You enter your user name and password to log into the DX in the following cases.
 MethodofAccessingtheDX LoginRequiredKeys • WhenthepoweristurnedON • Whenlogginginafterexitingthebasicsettingmode • Whenlogginginafterloggingout
 Communication When accessing the setting/measurement server, FTP server, maintenance/test server, or Web server.
 AutoLogout(WhenLoggedinUsingKeys) When logged in using keys, you are automatically logged out when there is no key
 operationforaspecifiedtime.Ifyouareautomaticallyloggedoutfromthesettingmode, the setting changes are cancelled. You are not automatically logged out during basic setting mode.
 OperationsThatCanBeCarriedOutWhenLoggedOut When logged out, you can switch the operation screen using the DISP/ENTER key,
 arrow keys and Favorite key.
 • UserLevels A user can be an “administrator” or a “user.” Administrator Administrators can perform all operations on the DX. At least one administrator must
 be registered to use the login function.Item DescriptionNumber of users that 5 can be registeredRange of operations All operations.Login method Select key operation, via communication, or Web server login.ID information User name and password
 UserItem DescriptionNumber of users that 30 can be registeredRange of operations Keyoperations
 Operation LimitationNot allowedNot allowedSpecified by user privilegesSpecified by user privileges
 Basic setting modeSetting mode
 Operation mode
 Customize menusOtherKey operation
 • Userprivileges You can set operation privileges for each user. The privileges are the
 same as with the key lock function. Operationsviacommunication See the Communications Interface User’s Manual.
 Login method Select key operation, via communication, or Web server login.ID information User name and password
 1.7SecurityFunction
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 1.8 ComputationandReportFunction(/M1and/PM1Options)
 ComputationFunctionEquations can be defined in computation channels by using the measured data or computed data as variables. The result of the computation can be displayed or stored.For the setting procedure, see section 9.1.• ChannelsDedicatedtoComputations
 Model NumberofChannels ChannelNumbersDX1002, DX1004, DX1002N, DX1004N 12 101 to 112DX1006, DX1012, DX1006N, DX1012N 24 101 to 124
 • ComputationTypes In the table below, [001] represents the measured value of channel 001.
 Type Example DescriptionoftheExampleFour arithmetic 001+002 Determines the sum of [001] and [002].operation 001-002 Determines the difference between [001] and [002]. 001*002 Determines the product of [001] and [002]. 001/002 Divides [001] by [002].Power 001**002 Determines [001] to the power of [002]. y = Xn
 Square root SQR(001) Determines the square root of [001].Absolute value ABS(001) Determines the absolute value of [001].Common logarithm LOG(001) Determines the common logarithm of [001]. y = log10xNatural logarithm LN(001) Determines the natural logarithm of [001]. y = lnxExponent EXP(001) Determines e to the power of [001]. y = ex
 Relational 001.LT.002 The result is 1 when [001] is less than [002] or 0 computation otherwise. 001.LE.002 The result is 1 when [001] is less than equal to [002] or 0 otherwise. 001.GT.002 The result is 1 when [001] is greater than [002] or 0 otherwise. 001.GE.002 The result is 1 when [001] is greater than equal to [002] or 0 otherwise. 001.EQ.002 The result is 1 when [001] is equal to [002] or 0 otherwise. 001.NE.002 The result is 1 when [001] is not equal to [002] or 0 otherwise.Logical computation 001AND002 The result is 1 when [001] and [002] are nonzero or 0 otherwise. 001OR002 The result is 1 when [001] or [002] or both are nonzero or 0 otherwise. 001XOR002 The result is 0 when [001] and [002] are nonzero or 1 otherwise. NOT001 The result is 1 when [001] is zero or 0 otherwise.TLOG computation* TLOG.SUM(001) Determines the sum of [001]. TLOG.MAX(001) Determines the maximum value of [001]. TLOG.MIN(001) Determines the minimum value of [001]. TLOG.AVE(001) Determines the average value of [001]. TLOG.P-P(001) Determines the difference between the maximum value and minimum value of [001].* See “Usage of TLOG Computations” in this section.
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 Type Example DescriptionoftheExampleCLOG computation CLOG.SUM(001.002.003) Determines the sum of [001], [002], and [003].
 CLOG.MAX(001.002.003) Determines the maximum value among [001], [002], and [003].
 CLOG.MIN(001.002.003) Determines the minimum value among [001], [002], and [003].
 CLOG.AVE(001.002.003) Determines the average value of [001], [002], and [003].
 CLOG.P-P(001.002.003) Determines the difference between the maximum value and the minimum value among [001], [002], and [003].
 Special computation PRE(001) Determines the previous value of [001]. 101=HOLD(001.GT.K01):TLOG.SUM(001) Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When [001] exceeds K01, the previous computed value is held.
 K01
 Description HOLD(a):b When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value is held.
 RESET(101.GT.K01):TLOG.SUM(001) Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When [101] exceeds K01, the previous computed value is reset, and TLOG.SUM(001) is carried out.
 K01 Reset
 Description RESET(a):b When a is zero, b is carried out to derive the computed value. Otherwise, the previous computed value is reset, and b is carried out to derive the computed value.
 CARRY(K01):TLOG.SUM(001) Under normal conditions, TLOG.SUM(001) is carried out to derive the computed value. When the computed value is greater than or equal to K01, the computed result is the excess (computed value – K01).
 K01
 Description CARRY(a):b Only TLOG.SUM can be specified for b. If the computed value X of b is less than a, the computed result is X. If X is greater than or equal to a, the computed result is the excess (X – a).
 Conditional equation [001.GT.K01?001:001+002] When [001] is greater than K01, the computed value is set to the value of [001]. Otherwise, the computed value is set to the value of [001] + [002]. Description [a?b:c] If the computed result of a is nonzero, b is carried out. Otherwise, c is carried out.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 • DataThatCanBeUsedinEquations The data listed below can be used.
 Data Notation DescriptionMeasurement channel data 001, etc. Specify the computed data using a channel number.Computation Channel data*1 101, etc. Specify the computed data using a channel number.Constant K01 to K60 A value.Communication input data C01 to C24 Data set through communications.Status of the remote control input*1
 D01 to D08*2 The value is 1 when the remote control input is ON or 0 when it is OFF.
 Pulse input*1 P01 to P08*2
 Q01 to Q08*2Counts the number of pulses per scan interval.Counts the number of pulses per second.
 Internal switch status S01 to S30 1 or 0.Alarm output relay status*1 I01 to I06 The value is 1 when activated or 0 when
 deactivated.Flag*1 F01 to F08 1 or 0. Set the flag using the event action function
 (see section 1.6).Recording (memory sampling) status
 M01 to M06 The value is 1 when recording is taking place and 0 when recording is stopped. When the multi batch function is not being used (release number 3 or later; /BT2 option), M01 indicates the recording (memory sampling) status. When the multi batch function is being used, M01 to M06 indicate the recording (memory sampling) statuses of each batch. The recording status of an inactive batch group is 0. This function is available for release numbers 3 and later.
 *1 An option. *2 Values such as 01 are terminal numbers.
 Only the data that are checked in the table below can be used in TLOG, CLOG, and PRE.
 TLOGCLOGPREOther computations
 Meas.Channel
 DataComp. Type
 Comp.Channel
 Constant Comm.Input
 Remote Pulse InternalSwitch
 Relay Flag
 Recordstatus
 Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.
 • ProcessingOrderofComputation Computation is processed in order from the smallest event action number for each
 scan interval. Example: If you specify 102 = 101 + 103, the value of the previous scan interval is
 used for the 103 value.
 • HandingoftheUnitinComputations In computations, measured values are handled as values without units. For example,
 if the measured data from channel 001 is 20 mV and the measured data from channel 002 is 20 V, the computed result of 001 + 002 is 40.
 • DisplayingtheComputedData The computed data is displayed by setting a measurement span for each computation
 channel. Computation channels can be displayed on various operation screens in the same fashion as the measurement channels.
 For the setting procedure, see section 9.3.
 • Alarm Up to 4 alarms can be assigned to each computation channel. The alarm types are
 high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit alarm (t).
 • SavingComputedData As with the measured data, the computed data can be saved to display data, event
 data, manual sampled data, and report data.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 • ComputationDataDropout A computation data dropout occurs if the computation is not completed within the scan
 interval. For the operating procedure, see section 9.4.• Thecomputationiconinthestatusdisplaysectionturnsyellow.• Whenacomputationdatadropoutoccurs,thecomputeddataofthescanintervalin
 which the dropout occurred is set to the data immediately before the dropout.• Ifcomputationdatadropoutoccursfrequently,lessentheloadontheCPUby
 reducing the number of computation channels or setting a longer scan interval.
 • NumericDisplayandRecording The range of displayed values of computed data is from –9999999 to 99999999
 excluding the decimal point. The decimal place corresponds to the decimal place of the lower limit span of the computation channel. On the numeric display, values are displayed if the computed result is within the above range regardless of the upper and lower limits of span. The following table indicates special displays.Display/Recording ComputedDataStatus+Over • +Displayover:Whenthecomputedresultexceeds99999999 • +Computationover:Whenthevalueexceedsapproximately
 1.79E+308 in the middle of the computation • Whenacomputationerror*occurs(select+Overor–Over.)
 –Over • –Displayover:Whenthecomputedresultislessthan–9999999 • –Computationover:Whenthevalueislessthanapproximately
 –1.79E+308 in the middle of the computation • Whenacomputationerror*occurs(select+Overor–Over.)
 * Computation error occurs when the following computation is carried out. • X/0,SQR(–X),orLOG(–X) • IfachannelnumbersettoskiporOffisusedintheequation
 • RollingAverage The rollingaverageofthecomputedresultoftheequationspecifiedforthe
 computation channel is determined, and the result is the computed data for that channel.Thenumberofsamplesandthesamplingintervalcanbespecifiedforeachcomputation channel. The rolling average is applied over the time corresponding to “the number of data samples × the sampling interval.” The maximum sampling interval is 1 hour, and the maximum number of samples is 1500.
 • StartingtheComputation YoucanconfiguretheDXtostartthecomputationwhenyoupresstheSTARTkey.
 • UsageofTLOGComputations TLOG computation determines the sum, maximum, minimum, average, or the
 differencebetweenthemaximumandminimumofaspecificchannelforeachintervaldetermined by a timer.
 TimersThatAreUsed The timer that is used is assigned to each channel.
 UnitofSumComputation Set the sum scale when using sum computation (TLOG.SUM). Select Off, /s, /min, or /h. For details, see page 1-49.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 ResettingtheTLOGComputedValue You can select whether to resettheTLOGcomputedvalueateachinterval.Thefigure
 below illustrates the reset operation for sum computation (TLOG.SUM). Example: Result of the TLOG.SUM computation
 1 2 3ResetReset Reset
 Reset: On
 Timer timeout
 Reset: Off
 When reset is On, the sum value is calculated over each interval. When set to Off, the sum value from computation start is calculated.
 PowerFailureOperation,HandlingofErrorData,andHandlingofOverflowData
 See “Special Data Handling” in this section.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 ReportFunctionThis function is used to create hourly, daily, weekly, and monthly reports.• ReportDataTypes You can select from four types among maximum value, minimum value, average
 value, sum value, and instantaneous value. The maximum, minimum, average, and sum values are calculated for each scan interval.
 • ReportTypeType DescriptionHourly report Creates report data every hour on the hour for the previous one hour.Daily report Creates report data every day at a specified time for the previous one day.Weekly report Creates report data every week at a specified time at a specified day of the
 week for the previous one week.Monthly report Creates report data every month at a specified time at a specified day for
 the previous one month.
 • CombinationsofReportsThatCanBeCreated You can select from hourly reports only, daily reports only, hourly and daily reports,
 daily and weekly reports, and daily and monthly reports.
 • SourceChannels You can select from measurement channels and computation channels. The report
 data are not created for channels that are set to Skip or Off.Model NumberofchannelsDX1002, DX1004, DX1002N, DX1004N 12DX1006, DX1012, DX1006N, DX1012N 24
 • UnitofSumComputation Inthesumcomputation,dataaresummedoverthescaninterval.However,forflow
 values that have units /s, /min, /h, or /day a simple summation results in the actual value not matching the computed result, because the scan interval and the unit of the input values are different. In such cases, set the sum scale to match the unit of the input value. In effect, the sum value with the same unit as that of the input value is calculated.
 For example, if the scan interval is 2 s, and the input value is 100 m3/min, a simple summation would add 100 every 2 s resulting in 3000 after one minute. However, if the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the value is added giving a result that has an m3/min unit.
 The following converting equations are used to compute the sum. The unit of the scan interval is seconds.Off: Σ(measureddataeveryscaninterval)/s: Σ(measureddataeveryscaninterval)×scaninterval/min: Σ(measureddataeveryscaninterval)×scaninterval/60/h: Σ(measureddataeveryscaninterval)×scaninterval/3600/day: Σ(measureddataeveryscaninterval)×scaninterval/86400
 • DisplayingtheReportData You can display the report data using keys. For the operating procedure, see section 4.5.
 • SavingtheReportData See section 1.4, “Data Storage Function.”
 • NumericDisplayandRecording The numeric range of the report data is from –9999999 to 99999999 excluding the
 decimal point (except –3.4E+38 to 3.4E+38 for sum values). For the data handling of special cases, see “Special Data Handling” in this section. Fordetailsonthereportfileformat,seeappendix3.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 SpecialDataHandlingThis section explains the handling of special data in TLOG computation, CLOG computation, and reports.• PowerFailureOperation(TLOGandReports) If a power failure occurs when the report function is enabled or in the middle of the
 TLOG computation, the report operation and TLOG computation resume when the DX recovers from the power failure. The operation varies depending on whether the DX recovers from the power failure before or after the time to create a report or TLOG data.TimeofRecovery OperationAfter the time to create the data The report or TLOG data is created immediately after the DX
 recovers. The measured data up to the time of the power failure is used. At the time the next report or TLOG data is created, the data after the recovery is used.
 Before the time to create the data After the DX recovers, report or TLOG data is created at the normal time to create the data. The measured data excluding the power failure period is used.
 • ErrorDataHandling(TLOG,CLOG,andReports) If an error occurs in the channel data, the error data is discarded, and the computation
 continues. If all the data are in error, an error results. The following types of data are considered error data.
 • ChannelssettoskiporOff.• Themeasuredresultonameasurementchannelsiserror(A/Dconverterfailure,
 etc.).• Theinputofthemeasurementchannelisinaburnoutcondition.• Thecomputedresultonacomputationchanneliserror.
 • HandlingofOverflowData** Refers to over range on a measurement channel and computation overflow on a computation
 channel.
 ForTLOG,CLOG,andReports Whenthechanneldataisoverflowdata,theDXhandlesthedataasfollows:
 ComputationType DescriptionAverage value or sum Set the handling to ERROR, SKIP, or LIMIT.value ERROR: Considers the data to be a computation error. SKIP: Discards the overflow data and continues the computation. LIMIT: Replaces the data with the limit value and continues the computation. The limit value is the span upper or lower limit or the scale upper or lower limit of the channel.
 Maximum, minimum, Set the handling to OVER or SKIP.Maximum – minimum OVER: Computes by using the overflow data. SKIP: Discards the overflow data and continues the computation.
 ForMultiplicationandRelationComputationEQandNEComputationType Computation ComputedResultMultiplication 0*(+Over) 0 0*(–Over) 0 (+Over)*0 0 (–Over)*0 0.EQ. (+Over).EQ.(+Over) 1 (–Over).EQ.(–Over) 1.NE. (+Over).NE.(+Over) 0 (–Over).NE.(–Over) 0
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 ReportTemplate(Releasenumbers4andlater)You can create report templates and use them to automatically create custom report files.Use Microsoft Office Excel (hereinafter referred to as “Excel”) to create report template files. Load a report template file that you have created into the DX internal memory. The DX will automatically create report files using the report template file.
 Internal memory
 Report template fileReport file based on the template
 Save Output
 For the setting procedure, see section 9.5.To create a report template, see section 9.6.To load or save a report template, see section 6.10.
 • ReportTemplateItem DescriptionFormat, extension XML spreadsheet format. The file name extension is .xml (lowercase).File name You can specify a file name.Type You need to create different report templates for each report file type.
 The different report file types are hourly, daily, weekly, monthly, hourly + daily, daily + weekly, and daily + monthly.
 • Template-BasedReportFileItem DescriptionFormat, extension XML spreadsheet format. The files can be opened in Excel. The file
 name extension is .xml (lowercase).File name Except for the extension, the file names of these files are the same as
 those of report files with .DAR extensions.For information about file names, see section 1.4, or see section 1.2 in the Advanced Security Function (/AS1) User’s Manual.
 Type The reports of each report file type are created using the appropriate template file.The number of report files that can be created depends on the report creation range settings (see section 9.5). For example, when the report settings are not configured for the creation of daily reports, you cannot use a template to create daily reports. However, regardless of the report settings, you can output all the different types of report computations (average, maximum value, minimum value, sum value, and instantaneous value.)
 • CreatingTemplate-BasedReportFiles Template-basedreportfilesarecreated(thecreationoftemplate-basedreportfileswill
 hereinafter be referred to as “template conversion”) in the following cases. AutoSave Whenareportfileiscreated(whenfiledivisionoccurs),templateconversionis
 performed,andthereportfileissavedtotheCFcard.Templateconversionisalsoperformed when recording stops (memory stop).
 ManualSave(Collectivelystoringunsaveddata) Whenyousaveareportfilemanually,templateconversionisperformedonthereport
 filesintheinternalmemorythathavenotyetbeenconverted.Convertedfilesaresaved to the external storage medium.
 CollectiveStoringofDatathroughKeyOperations When you execute ALL SAVE or REPORT SAVE, template conversion is performed
 onallthereportfilesintheinternalmemory.Convertedfilesaresavedtotheexternalstorage medium.
 1.8ComputationandReportFunction(/M1and/PM1Options)
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 1.9 FAIL/StatusOutputFunction(/F1Option)
 OutputRelayOperationAssignment(Releasenumbers4andlater)For this function, there are relays labeled “FAIL” and “Status” on the rear panel.You can assign the operations explained below to these two relays. On a relay that has been set to “Status relay,” you must also set the DX status that will be relayed.
 FAILOutputWhen a failure occurs in the CPU of the DX, a relay contact signal (1 signal) is output. The relay is energized when the CPU is normal and de-energizes when a CPU failure occurs. Therefore, relay output is carried out also when the power is turned OFF (including a power failure). You cannot change this behavior. RelayOperation
 NO C NCDuring normal operation
 NO C NCWhen a failure occurs
 NO C NCWhen power is turned OFF
 If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.
 MemorySampleRelay(OnlyonDXswiththe/AS1advancedsecurityoption)The relay is energized at memory start and de-energized at memory stop. You cannot change this behaviorWhen the multi batch function (/BT2 option) is being used, memory start is when memory start occurs for any of the batches, and memory stop is when memory stop occurs for all the batches.
 RelayOperation
 NO C NC
 Memory samplingNO C NC
 Memory sampling stoppedNO C NC
 When power is turned OFF
 InvalidUserRelay(OnlyonDXswiththe/AS1advancedsecurityoption)The relay is energized when the user is invalid and de-energized when you execute the Locked ACK command. You cannot change this behavior
 RelayOperation
 NO C NC
 NormalNO C NC
 Invalid userNO C NC
 When power is turned OFF
 UserLoginStatusRelay(OnlyonDXswiththe/AS1advancedsecurityoption)The relay is energized when a user is logged in (through key operations or through communication commands) to the DX. You cannot change this behavior
 RelayOperation
 NO C NC
 Not logged inNO C NC
 Logged inNO C NC
 When power is turned OFF

Page 65
						

1-53IM 04L41B01-01E
 Overview
 of Functions
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 StatusOutputOutputs the status below with a relay contact signal (1 relay). You can select whether each status is output to the relay. The relay is energized when the status occurs. You cannot change this behavior.For the setting procedure, see section 2.9.Status Description CorrectiveActionStatus of the internal memory or CF card
 Error in the internal memory. Contact your nearest YOKOGAWA dealer for repairs.
 WhentheautosavefunctiontotheCFcardisOn.• ThefreespaceontheCFcarddropped
 to 10% of the total size (only when the media FIFO (see section 1.4) is disabled).
 Replace the CF card.
 • ErrorintheCFcard. • ReplacetheCFcardwithanormal one.
 • FormattheCFcardontheDX (the data on the CF card will be erased).
 However, the status of the internal memory is output when the CF card is not inserted. • 10MBorlessofavailablespace*
 remaining in internal memory. • Thenumberoffilesininternalmemoryfor
 which Auto Save to the CF card has not been completed has exceeded 390.
 Insert a CF card.
 WhentheautosavefunctiontotheCFcardisOff.• 10MBorlessofavailablespace*
 remaining in internal memory. • Thenumberoffilesininternalmemory
 for which Manual Save has not been completed has exceeded 390.
 Save the data in the internal memory to the CF card.
 Measurement error Error in the A/D converter.Burnout is detected.
 Contact your nearest YOKOGAWA dealer for repairs.Replace the thermocouple that has burned out.
 Communication error A Modbus master or Modbus client communication error occurred.
 Check the error in the Modbus master or Modbus client screen and carry out the corrective action.
 A PROFIBUS-DP communication error occurred.
 Contact your nearest YOKOGAWA dealer for repairs.
 Memory stop When the memory sampling is stopped. Start the data acquisition.Alarm occurrence (Release number 3 or later)
 An alarm has occurred. Check the alarm.
 * The internal memory’s “available space” refers to the following quantities. • Unusedregions • RegionsofdataforwhichAutoSaveorManualSave(seepage1-31)hasbeen
 completed.
 RelayOperation
 NO C NC
 During normal operationNO C NC
 When specified status occursNO C NC
 When power is turned OFF
 1.9FAIL/StatusOutputFunction(/F1and/F2Options)
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 1.10 OtherFunctions
 TimeRelatedFunctions• TimeCorrection The DX internal clock can be changed in the following manner.
 Method DescriptionKey operation Sets the DX internal clock to the specified time.Event action function Synchronizes the DX internal clock to the nearest hour.SNTP client function Sets the DX internal clock to the time retrieved from an SNTP
 server.
 TimeCorrectionOperation The time correction operation varies depending on whether the memory sampling is in
 progress or not.Status OperationMemory sampling stopped The DX internal clock is changed immediately.Memory sampling The DX internal clock is gradually corrected. While the time is beinggraduallyadjusted,thedate/timeinthestatusdisplaysection is displayed in yellow.
 OperationofGraduallyCorrectingtheInternalClock If the time deviation between the time of the DX internal clock and the correct time (the
 specifiedtime)iswithinaspecifiedvalue,theDXclockisadjustedgraduallyat40msfor each second. Otherwise, the clock is corrected immediately. The maximum value oftimedeviation(tminthefigurebelow)canbeselectedintherangeof10sto5min.
 Time specified using keys or retrieved from an SNTP server
 Range in which the time is gradually adjusted
 Nearest hour
 Time deviation
 Time when the remote control signal is applied(Time on the DX)
 tm tmRange in which the time is gradually adjusted
 Time on the DX
 Time deviation
 tm tm
 Example: When changing the time to 12 hours 55 minutes 35 seconds when the internal clock is 12 hours 55 minutes 32 seconds
 Thetimedeviationof3secondsisadjusted40mspersecond.Theinternalclockwillbesynchronizedtothespecifiedtime75secondslater.
 • Date Format You can select the display format of the data from “2005/09/28,” “09/28/2005,”
 “28/09/2005,” and “28.09.2005.” For the setting procedure, see section 2.4.
 • Time Zone Set the time difference between the location where the DX is used and GMT. For the setting procedure, see section 2.2.
 • DST(DaylightSavingTime) If you are using the DX in an area with daylight saving time, enter the daylight
 saving time starting and ending dates, and the DX will automatically change the time accordingly.
 For the setting procedure, see section 2.1.
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 SystemDisplayDisplays the total number of inputs on the DX, the size of the internal memory, the communication functions, the external storage drive, the options, the remote controller ID, the operation of the devices connected to the USB ports (/USB1 option), the MAC address, and the firmware version number.For the operating procedure, see section 2.5.
 LanguageThe displayed language can be set to English, Japanese, German, French, or, Chinese. For the setting procedure, see section 2.6.
 24 VDC PowerSupplyforTransmitter(/TPS2or/TPS4Option)Provides 24-VDC power supply to up to two (/TPS2) or four (/TPS4) two-wire system transmitters. The measured values of the transmitter correspond to a current signal of 4 to 20 mA on the same cable. Therefore, the signal can be connected to the DX input terminal and displayed.
 –
 +
 +
 –
 Transmitter
 CurrentDX
 Transmitter power supply output terminal
 Input terminalShunt resistor: 250 Ω
 EasyTextEntryOption(/KB1and/KB2Options)You can control the DX using the keys on the remote control terminal.• SettheremotecontrollerIDontheDXandtheIDnumberontheremotecontrol
 terminal to the same value.• Youcansetavaluebetween0and31fortheremotecontrollerIDandIDnumber.• BychangingtheIDnumberontheremotecontrolterminal,youcancontrolDXswith
 different remote controller IDs from a single remote control terminal.For the operating procedure, see section 2.10.
 Light-receiving section
 Infrared signal output section
 DISP/ENTER
 N
 1.10OtherFunctions
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 USBInterface(/USB1option)You can connect keyboards, barcode readers, or USB flash memory to two USB ports, one on the front and one on the back of the DX.• YoucanoperatetheDXusingakeyboardorbarcodereader.• YoucansavemeasureddataandsetupdatatotheUSBflashmemoryandalsoload
 from it.For the operating procedure, see sections 2.11 and 2.12.
 TemperatureUnitYou can set the unit when measuring temperature with the thermocouple or RTD to °C or °F.For the setting procedure, see section 3.3.
 CustomDisplay(Releasenumbers3andlater)You can create a custom operation screen.See the Custom Display User’s Manual, IM04L41B01-04E.
 MultiBatchFunction(/BT2option;releasenumbers3andlater)You can use this function to simultaneously record the measured data from multiple batches.See the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 AdvancedSecurityFunction(/AS1option;releasenumbers4andlater)The advanced security option strengthens measurement security with login, audit trail, digital signature, and other functions.See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 1.10OtherFunctions
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 2.1 SettingtheDate/Time
 Set the date/time. If you are using the DX in a region that uses DST, specify the date/time for switching between DST and standard time.
 SetupScreen• Date/Time Press MENU (to switch to setting mode), and select the Menu tab > Date/Time >
 TimeSettings.
 • DST Press MENU (to switch to setting mode), and select the Menu tab > Date/Time >
 DaylightSavingTime.
 SetupItems• Time set Enter the date and time, select ENT, and press DISP/ENTER.
 • Daylightsavingstime>Use/Not To set a daylight saving time period, select Use.
 • Daylightsavingstime>Starttime Specify the date and time when daylight saving time starts.
 Item DescriptionMonth Specify the month.Day order (week order) Specify the week within the month. Specify [Last] for the last week in
 the month.Day of the week Specify the day of the week.Hour of the day Specify the hour using a value from 0 to 23.
 • Daylightsavingstime>Endtime Specify the date and time when daylight saving time ends. The settings here are the
 same as those for Start time.
 Chapter2 CommonOperations
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 2.2 SettingtheTimeDifferencefromGMT
 Set the time zone of the region in which the DX will be used. Make sure to set this value if you are using the Internet network functions or the DST function.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > TimeSettings.
 SetupItems• Timesettings>Timezone(HHMM) Set the time zone of the region in which the DX will be used in terms of the time
 differencefromGMT.Specifyavalueintherangeof–1300to1300(wherethefirsttwo digits denote the hour and the last two digits denote the minute). A negative value indicates that the local time is behind the GMT.
 Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case, enter “900.”
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 2.3 SettingtheTimeCorrectionOperationduringMemorySampling
 This function gradually corrects the time when the time is changed while Memory Sampling is in progress.For a description of the time correction operation, see section 1.10.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > TimeSettings.
 SetupItems• Timesettings>Timedeviationlimit
 Time deviation limit
 Current time Specified time
 WhenthetimedeviationbetweenthetimeontheDXandthespecifiedtimeiswithin±(thevaluespecifiedhere),thetimeontheDXisgraduallycorrected.Otherwise,the clock is corrected immediately. Note that time is not corrected on DXs with the Advancedsecurityfunction(/AS1option)whenthespecifiedtimeisoverthetimedeviation limit. (Firmware version numbers 4.11 and later)Settings Description10 s to 5 min The time deviation limit.Off Disables the function that gradually corrects the time.
 Example: If Timedeviationlimit is set to 10s and the time on the DX is 10 hours 21 minutes15seconds,thetimeontheDXisgraduallycorrectedifthespecifiedtimeisbetween 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25 seconds.
 Note On DXs with the Advanced security function (/AS1 option), you cannot change the time during memory sampling if the time deviation limit is set to OFF. (Firmware version number 4.11 and later)
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 2.4 SettingtheDateFormat
 Select the display format of the date.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > TimeSettings.
 SetupItems• Timesettings>Dateformat
 Settings DisplayExampleDatesotherthanthegridtimeofthetrenddisplay
 Timeatthegridpositioninthetrenddisplay(example:8O’clockonNov.30)*
 Y/M/D 2005/11/30 11/30 08M/D/Y 11/30/2005 11/30 08D/M/Y 30/11/2005 30/11 08D.M.Y 30.11.2005 30.11 08* Only if the trend interval is set greater than or equal to 1 h/div. A function available on DXs
 with release number 2 or later.
 AppliedRange The format is applied to the date displayed on the screen. It does not change the
 date format on the setup screen of the date/time, the date in the output data via communications,thedatesavedalongwiththedata,andthedateusedinthedatafilenames.

Page 73
						

Com
 mon O
 perations
 IM 04L41B01-01E 2-5
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 2.5 ViewingtheDXInformation
 Show the DX information on the system information screen and the network information screen.
 Procedure• DisplayingSystemInformationScreen
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Systeminfosoftkey.The system information screen is displayed.
 • DisplayingNetworkInformationScreen1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Networkinfosoftkey.The network information screen is displayed.
 Explanation• SystemInformationScreen
 ANALOG: Number of measurement channels (C) denotes the clamped input terminals (/H2 option).MATH: Number of computation channels (/M1 and /PM1 options)
 MEMORY: Internal memory sizeOptionsRemote controller ID (/KB1 and /KB2 option)USB HID (/USB1 option)MAC addressVersion: Firmware version
 The following items are displayed: • Numberofmeasurementchannels. • Numberofcomputationchannels. • Internalmemorysize • Options • RemotecontrollerID(/KB1and/KB2options) • ConnectedUSBHIDdevices(/USB1option) • MACaddress • Firmwareversion
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 • NetworkInformationScreen
 There are two pages of network information. Use the left and right arrow keys to switch the screen. The following items are displayed:
 • IPaddress • SubnetmaskIPaddress • DefaultgatewayIPaddress • MACaddress • DNSserverIPaddress • Hostname • Domainname • Theserverfunctionsettingconditionslistedbelow.
 FTP, Web, Modbus, SNTP, and EtherNet/IP • PROFIBUS-DPinformation(/CP1option)
 Node address and serial number (maintenance information)
 2.5ViewingtheDXInformation
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 2.6 ChangingtheDisplayedLanguage
 Set the displayed language.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > OperatingEnvironment.
 SetupItems• Operatingenvironment>Language Set the displayed language to English, Japanese, German, French, or Chinese.

Page 76
						

2-8 IM 04L41B01-01E
 2.7 SettingtheLCDBrightnessandBacklightSaver
 Change the LCD brightness. In addition, set the backlight saver function to prolong the service life of the LCD backlight.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Display > LCD.
 SetupItems• LCD>Brightness Select a value from 1 to 8 (2 by default). Larger the value, brighter the display
 becomes.
 • LCD>Backlightsaver>ModeSettings DescriptionOff Disables the backlight saver.Dimmer Dims the display if there is no operation for a given time.Timeoff Turns the backlight OFF if there is no operation for a given time.
 • LCD>Backlightsaver>Savertime Selectavaluefrom1minto1h.Ifthespecifiedtimeelapseswithoutanykey
 operationoralarmoccurrence,theLCDbacklightswitchestothespecifiedmode.
 • LCD>Backlightsaver>RestoreSettings DescriptionKey The backlight returns to the original brightness when a key is pressed.Key+Alm The backlight returns to the original brightness when a key is pressed or when an
 alarm occurs.
 Note• IfthebacklightisdimmedorturnedOFFbythebacklightsaverfunction,pressinganykey
 on the DX causes the backlight to return to the original brightness. In this operation, the key does not perform its intended function.
 • Thedegradationofthebrightnessandthediscolorationofthescreen(becomeyellowish)tend to progress faster as the brightness is set higher. Extended use at an unnecessary high setting should be avoided. It is also recommended that you use the backlight saver function.
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 2.8 InitializingSettingsandClearingtheInternalMemory
 Initialize the settings to default values. In addition, clear the data in the internal memory.For the default settings, see the DX1000/DX1000N Operation Guide (IM04L41B01-02E).
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the File/Initialize tab > Initialize. On DXs without the /AS1 advanced security option
 On DXs with the /AS1 advanced security option
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 SetupItems• Initialize OnDXswithoutthe/AS1advancedsecurityoption
 Settings DescriptionClear 1 Clears and initializes the data in the internal memory in the manner
 indicated on the screen.Clear 2Clear 3
 Internal Memory Data That Is Initialized or ClearedItem DescriptionBasic Settings
 Login Info The “Authority of user” settings in basic setting mode are initialized.
 Other Settings All settings in basic setting mode other than the “Authority of user” settings are initialized.
 Settings The setting mode settings are initialized.Measurement and Math Data Display, event, manual sampling, and report (/M1 and /PM1
 options) data is cleared.Display Data The custom display screen setup data is cleared.Log Data All the log data is cleared.
 OnDXswiththe/AS1advancedsecurityoptionSetting DescriptionClear 1 Clears and initializes the data in the internal memory in the manner
 indicated on the screen.Clear 2Clear 3Clear 4
 Internal Memory Data That Is Initialized or Cleared See the explanation for DXs without the /AS1 advanced security option.
 Procedure1. Press the Clear 1, Clear 2, Clear 3, or Clear 4 soft key.
 2. Press DISP/ENTER.A confirmation window opens.
 3. Select Yes and press DISP/ENTER.The specified operation is executed, and the DX returns to the operation mode.If you do not want to initialize, select No and press DISP/ENTER.
 2.8InitializingSettingsandClearingtheInternalMemory
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 2.9 OutputtingtheDXStatusviatheRelayContact(/F1Option)
 A signal is output to a dedicated relay when an error occurs in the DX CPU. In addition, a signal is output to a different relay when the a specified status occurs.For a description of the FAIL/status output function, see section 1.7.
 SetupScreen• AssigningRelayOperations Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Statusrelay> RelayAction.
 On DXs without the /AS1 advanced security option
 On DXs with the /AS1 advanced security option
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 • StatusRelayDetails Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > StatusRelay > StatusRelayDetails.
 SetupItems• RelayAction>FailRelay,StatusRelay(Releasenumbers4andlater) OnDXswithoutthe/AS1advancedsecurityoption
 Setting DescriptionFail Outputs a fail relay.Status relay Outputs a status relay. Even if you set both relays to “Status relay,” you
 cannot make them output different statuses.
 OnDXswiththe/AS1advancedsecurityoptionSetting DescriptionFail Outputs a fail relay.Status relay Outputs a status relay. Even if you set both relays to “Status relay,” you
 cannot make them output different statuses.Mem. sample* Relay output continues from memory start until memory stop.Invalid user Relay output continues from when a user is determined to be invalid until a
 Locked ACK command is executed.Login Relay output occurs whenever a user is logged in.* When the multi batch function (/BT2 option) is being used, relay output starts when memory
 start occurs for any of the batches, and relay output stops when memory stop occurs for all the batches.
 • StatusRelayDetails>Memory/Mediastatus On: The status of the internal memory and the CF card is relayed.
 • StatusRelayDetails>Measurementerror On: A relay signal is output when a measurement error occurs.
 • StatusRelayDetails>Communicationerror On: A relay signal is output when a communication error occurs.
 • StatusRelayDetails>Memorystop On: A relay signal is output when memory sampling stops.
 * When the multi batch function (/BT2 option) is being used, relay output starts when recording stops for all the batches.
 • StatusRelayDetails>Alarm(Releasenumbers3andlater) On: Outputs a relay signal when one or more alarms occur. Alarms whose indications
 are hidden (see section 3.6 for details) do not cause relay signal output. Relay output ceases after all alarms are released (if no other relay output conditions are met).
 2.9OutputtingtheDXStatusviatheRelayContact(/F1and/F2Options)
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 Procedure• FAILOutput There are no operations that are required. A signal is output to the relay contact when
 a CPU error is detected. A signal is also output to the relay contact when the DX is turned OFF.
 • StatusRelay Asignalisoutputtotherelaycontactwhenaspecifiedstatusoccurs.
 2.9OutputtingtheDXStatusviatheRelayContact(/F1and/F2Options)
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 2.10 ControllingtheDXwiththeRemoteControlTerminal(/KB1and/KB2Options)
 HandlingPrecautions• Iftheinfraredsignaloutputsectionoftheremotecontrolterminalorthelight-receiving
 section on the DX becomes dirty or receives scratches, it can hinder the transmission/reception of the infrared signal. Clean the infrared signal output section of the remote control terminal or the light-receiving section on the DX.
 • Whencleaning,wipeusingadrysoftcloth.Donotusechemicalssuchasbenzeneorthinner, since these may cause discoloring and deformation.
 • Donotapplyshocktotheremotecontrolterminal.• Donotoperatetheremotecontrolterminalwithwethands.• Thetransmission/receptionsensitivityoftheinfraredsignalmaydeteriorateifusedin
 the following types of locations.• LocationwherethereceiveroftheDXisexposedtodirectsunlightorfluorescent
 lamp.• Nearmagneticfieldsourcessuchasatransceiver.
 • Ifyoucarrytheremotecontrolunitinyourpocket,forexample,keysmaybepressedunintentionally and cause the DX to be controlled. Handle the remote control terminal properly so that keys are not pressed inadvertently.
 • WhenyouareneartheDX,pressthekeysontheremotecontrolterminalonlywhencontrolling the DX. If you are going to press the keys on the remote control terminal but do not wish to control the DX, take measures so that the signal does not reach the DX such as by covering the infrared signal output section of the remote control terminal.
 • ThedistanceatwhichtheDXcanbecontrolledusingtheremotecontrolterminalvaries depending on the operating environment such as the battery voltage and the presence or absence of external light.
 • ThereisapossibilitythatDXswiththesameremotecontrollerIDbecontrolledsimultaneously. It is recommended that different remote controller IDs be set on each DX.
 PreparingtheDXSet the remote controller ID.• SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > OperatingEnvironment.
 • Operatingenvironment>RemoteControllerID Select the remote controller ID from 0 to 31. When not using the remote control
 terminal, select Off.
 • CheckingtheRemoteControllerID You can check the DX remote controller ID on the system information screen. See section 2.5.
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 PreparingtheRemoteControlTerminal• NamesofParts
 Infrared signal output section
 Battery coverKeys
 • LoadingBatteries
 1. While pressing the projection on the battery cover, open the cover.
 2. Load the batteries.3. Close the battery cover.
 Positive polarity
 Positive polarity
 • SettingtheIDNumber Set the ID number of the remote control terminal to match the remote controller ID of
 the DX that you are to operate. The ID number of the remote control terminal is not displayed anywhere. If you are
 not sure which ID number the remote control terminal is set to, set the appropriate ID number according to the following procedure.
 1. Press ID.
 2. Enter the ID number (0 to 31) by pressing the keys from 1 (A1) to 0 (N0). Example For ID number “16” Operation: Press 1 (A1) and 6 (G6).3. Press ID.
 Note• IfyouenteranIDnumberotherthan0through31,theIDnumberretainstheoriginalsetting.• PressingtheIDkeyoncecausestheremotecontrolterminaltoentertheIDnumbersetup
 mode. If none of the keys on the remote control terminal is pressed for 8 s, the remote control terminal automatically exits from the ID number setup mode. In this case, the ID number of the remote control terminal retains the original setting.
 • Ifyouremovethebatteries,theIDnumberisresetto0.Afterloadingthebatteries,settheappropriate ID number again.
 • AffixingtheIDNumberLabel IfyouareusingtheremotecontrolterminalwithafixedIDnumber(suchaswhen
 there is a one-to-one correspondence between the DX to be controlled and the remote controlterminal),youcanentertheIDnumberonthelabelandaffixthelabelontheremote control terminal.
 Affix the ID number label on the battery cover of the remote control terminal.
 2.10ControllingtheDXwiththeRemoteControlTerminal(/KB1and/KB2Options)
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 ControllingtheDXControl the DX by pointing the infrared output section of the remote control terminal to the light-receiving section on the DX. Control the DX while checking the results on the DX screen.
 Note• TheremotecontrolterminalcannotbeusedtocontroltheFavoritekey.• WhenaspecifickeyoperationispossibleontheDX,thecorrespondingkeyontheremote
 control terminal is activated. For example, the operation for entering a character string is activated when a window for entering a character string is displayed on the DX screen.
 • YoucannotcontroltheDXusingtheremotecontrolterminal,iftheremotecontrolterminalisin the ID number setup mode.
 • Onmodelswiththe/M1mathoptionor/PM1pulseinputoption,usethekeysontheDXto enter the computing equation of the computation channel. Computing elements are not assigned to the keys on the remote control terminal.
 • CorrespondencewiththeDXKeys
 Right arrow key
 ESC key
 Left arrow key
 FUNC key
 DISP/ENTER key
 MENU key
 Soft keys
 User key Up arrow key
 START key
 Down arrow key
 Character input keys
 Character input keys
 Hold down SHIFT and press F3/F7.
 STOP key Character type switch key for character input keys (see the next page)
 Delete key Deletes the character at the cursor position when inputting characters.
 Space key Enters a space at the cursor position when inputting characters.
 2.10ControllingtheDXwiththeRemoteControlTerminal(/KB1and/KB2Options)
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 • EnteringStrings When a character input window is displayed on the DX screen, pressing the A/a/1
 key switches the character type assigned to the character input keys as shown in the followingfigure.
 Uppercase alphabet
 characters and symbolsLowercase alphabet characters and symbols
 Numbers
 • UppercaseAlphabetCharactersandSymbols/LowercaseAlphabetCharactersandSymbols
 Alphabet (A to Z or a to z)
 Number of timesthe key is pressed 1 2 3 4 5 6 7 8 9 10 11 12 13Symbol % # ° @ _ ( ) : [ ] + * /
 Press the MARK key to cycle through the following symbols:
 • Numbers
 Number (1 to 9 and 0) Decimal pointHowever, when setting a constant to be used in the computation on the DX with the /M1 or /PM1 option, the display switches in the order “.”, “+”, and “E” each time the key is pressed. The display switches in a cyclic pattern.Minus sign
 2.10ControllingtheDXwiththeRemoteControlTerminal(/KB1and/KB2Options)
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 TroubleshootingThe DX does not react when you try to control it using the remote control terminal.• Arethecorrectbatteriesloadedintheremotecontrolterminal? Check the voltage and polarity of the batteries.• Arethebatteriesflat? Replace the batteries with new ones.• DoestheIDnumberoftheremotecontrolterminalmatchtheremotecontroller
 IDoftheDXthatyouaretryingtocontrol? Check the remote controller ID on the DX, and set the ID number of the remote control
 terminal to the same value.• IstheremotecontrolterminalinIDnumbersetupmode(conditioninwhichthe
 IDkeyispressedonce)? Wait 8 seconds without pressing any keys to exit from ID number setup mode.• IstheremotecontrolterminaltoofarawayfromtheDX? Get closer to the DX. Control from as close to the front of the DX as possible.• Isastronglighthittingthelight-receivingsectionoftheDX? Take measures to prevent strong light from hitting the light-receiving section of the DX.• Isthereamagneticfieldsourcesuchasatransceivernearby? MovethemagneticfieldsourceawayfromtheDX.• Istheinfraredoutputsectionoftheremotecontrolterminalorthelight-
 receivingsectionontheDXdirty? Clean them.• IstheDXinaconditionthatallowstherelevantkeyoperation? Check the condition of the DX, and start from an operation that is possible.
 2.10ControllingtheDXwiththeRemoteControlTerminal(/KB1and/KB2Options)
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 2.11 ControllingtheDXwithaKeyboardorBarcodeReader(/USB1option)
 This section explains how to connect and use a USB keyboard or barcode reader. Barcode readers can be used if the DX release number is 3 or later.
 ConnectingandDisconnectingaKeyboardorBarcodeReader• Connection
 1. Connect the keyboard or barcode reader to a DX USB port.A display appears asking whether you have connected a keyboard or a barcode reader.
 CF CARD
 USB port
 USB CF CARD
 2. Select the type of device that you have connected, and then DISP/ENTER.You can now use the device that you connected.* If you change the display without selecting a device, the device type is automatically set to
 keyboard.* This setting is unrelated to the connection of USB flash memory.
 • Removal Remove the keyboard or barcode reader cable from the DX USB port.
 Note• Youcanconnectandremovekeyboardsandbarcodereadersatanytime,regardlessofthe
 display and whether the DX is on or off.• Youcanonlyconnectonehumaninterfacedevice(HID)totheDX.Youcannotusea
 keyboard and a barcode reader at the same time.• UseakeyboardthatmatchestheDXlanguagesetting.• The statuses of the Caps Lock and Num Lock keys are retained even if the USB keyboard is
 removed (release number 2 and later). However, if a bar code reader is connected, the key statuses will be initialized to off.
 • Thedevicethatiscurrentlyconnectedisindicatedinthesysteminformationdisplay(seesection 2.5 for details).
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 2.11ControllingtheDXwithaKeyboardorBarcodeReader(/USB1option)
 OperatingfromtheKeyboardUse the keyboard while watching the DX screen. An operation that can be carried out on the DX can be carried out from the keyboard. Example: Switchtosettingmode When the DX is in the operation mode, press Ctrl+M. The DX switches to setting mode, and the setting menu appears.
 • MappingoftheKeysontheDXtotheKeysontheKeyboard
 Enter DISP/ENTER Left arrow key Up arrow key Down arrow key Right arrow keyNum Enter DISP/ENTEREsc ESCF1 to 5 Soft key 1 to soft key 5F9 FUNCF12 Hold down FUNC for 3 secondsLeft-Windows MENURight-Windows MENUApplication Favorite keyCtrl+S STARTCtrl+P STOPCtrl+U USERCtrl+M MENUCtrl+F Favorite keyTab, Shift+Tab Arrow keys*
 Keys on the Keyboard104 Keyboard (US)for the PC
 Keys on the DX
 ←↑↓→
 * Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item. However, this does not work in the following screens: Operation screens, Menu screens for Setting mode and Basic setting mode, screens for entering values and characters, “Menu customize” and “Save/Load” screens in Setting mode, and “Load setting, Initialize” screen in Basic setting mode
 • EnteringAlphabets,Numbers,andSymbols When alphabets, numbers, and symbols can be entered on the DX, you can enter
 them from the keyboard. The operation is the same as with normal keys. However, symbols that cannot be used on the DX are invalid.
 SymbolsThatCanBeEnteredUsingtheKeyboard The symbols below can be entered. However, symbols that cannot be used on the DX
 are invalid. For example, the characters *, /, :, and ? cannot be used in the data save destination directory name.
 # % ( ) * + - . / : ? @ [ ] ^ _
 * Press “^” on the keyboard to enter the temperature degree symbol.
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 • InvalidKeys Keys enclosed in frames are invalid.
 The 104 Keyboard for a PC (US)
 2.11ControllingtheDXwithaKeyboardorBarcodeReader(/USB1option)
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 BarcodeReaderOperations(Releasenumber3orlater)When you scan communication commands with a barcode reader, the DX will respond as follows.• TheDXwillaccumulatekeycodesuntilitreachesaterminator.Thenitwillexecute
 the accumulated character string. The terminator is the enter key code.• TheDXcanaccumulateupto200characters,notincludingtheterminator.TheDX
 will process a character string when it reaches 200 characters in length.• TheDXcanreadASCIIcharacters(128characters:numbers,symbols,and
 uppercase and lowercase letters of the alphabet).
 Note• Barcodereaderoperationsaretreatedaskeyoperations.• Barcodereaderoperationsexcept the operation using UD command are limited by the
 settings of the key lock and login functions.
 • BarcodeReaderSettingsConfigurethebarcodereadertothesettingsinthetablebelow.USBhostparameter SettingUSB device type HID keyboard simulationUSB keyboard type English (U.S.) standard USB keyboard
 2.11ControllingtheDXwithaKeyboardorBarcodeReader(/USB1option)
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 • HowtoUse Follow the standard operating procedure for the barcode reader that you are using. Operate the barcode reader while checking the status of the DX. An operation can be
 carried out using the barcode reader when it can be carried out on the DX. Commands Scan the communication commands encoded in bar codes to operate the DX with
 a barcode reader. The communication commands that you can use are listed in the table below. For information about communication command syntax, see the Communication Interface User’s Manual, IM 04L41B01-17E.Command DescriptionKE Performs key operationsPS Starts or stops memory samplingEV Starts manual sampling
 Causes triggers to occurTakes snapshotsSaves display dataSaves event data
 MS Writes messagesTL Starts or stops computation
 Resets computationClears the computation data dropout display
 IR Resets the relative timerAK Releases alarm output (alarm ACK)CV Switches the trend intervalEM Starts or stops e-mailsCU Manually recovers the Modbus master or clientBJ Writes free messagesBV Inserts charactersBT Sets batch namesBU Sets batch commentsCL Executes manual SNTPLO Reads the setting mode setup dataLI Saves setup dataMA Resets the single match time timerYC Clears measured and computed data and initializes setup dataEJ Changes login passwordsYO Loads setup files (for basic setting mode)UD Switches the screenMH Writes batch text fields (release numbers 4 and later)BP Enters login information (/AS1 option; release numbers 4 and later)BQ Invalid user ACK operation (/AS1 option; release numbers 4 and
 later)EC Initialization (/AS1 option; release numbers 4 and later)
 CommandExample The command to write message number 8 in group 1 is: MS8,GRPUP,1. There must
 be a terminator (an enter key code) at the end.
 Note• Youcanreadmultiplecommands(asmanyas10)byputtingsubdelimiters(semicolons)
 between them. Example: PS0;MS8,GRPUP,1• Whenyouentercommandsusingbarcodes,youcanenterthemseparatedorallat
 once. You can separate commands however you want to. For example, you can separate the command to write message number 8 in group 1, MS8,GRPUP,1, into the following components: MS > 8 > , > GRPUP > , > 1 > ENTER key code.
 • Ifyouuseabarcodereaderthatautomaticallyattachesafooterandaheadertoeverytransmission, the result will be the same if MS is set to the header, the enter key code is set to the footer, and you scan 8,GRPUP,1.
 • WhentheDXreceivesanunsupportedkeycode,itclearsallofthekeycodesthatithasaccumulated so far.
 2.11ControllingtheDXwithaKeyboardorBarcodeReader(/USB1option)
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 2.12 UsingtheUSBFlashMemory(/USB1Option)
 Connecting/RemovingaUSBFlashMemory• ConnectingaUSBFlashMemory If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/
 DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 1. Connect a USB flash memory to the USB port on the DX.
 2. In operation mode, possible operations are shown. Select the desired operation using the arrowkeys and press DISP/ENTER.
 When set to auto save When set to manual save
 Setting DescriptionSave Manual Saves unsaved data in the internal memory to a USB flash memory
 device.DATA SAVE MODE Switches to the DATA SAVE MODE display. For the procedure
 to save the internal memory data, see section 4.8. This item only appears when the DX is configured to display DATA SAVE MODE in the display menu (release number 2 and later). You can change the item that is displayed here with the menu customize function.
 Load Settings Moves to the setup load display of setting mode. For the procedure to load the setup data, see section 6.9. Load Settings will not be displayed:• When Media/USB loading is locked (see chapter 8 for details).• When the DX is accessing storage media (formatting, saving, or
 FTP communication).Cancel Closes the operation selection window.
 • RemovingtheUSBFlashMemory1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Mediaeject soft key and then the USB soft key.A message “Media can be removed safely.” appears.
 3. Remove the USB flash memory.
 Note• OneUSBflashmemorycanbeconnected.• BesuretocarryouttheprocedureabovewhenremovingtheUSBflashmemory.Ifyou
 remove the USB memory without performing the above procedure, the data stored on it could be damaged.
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 SavingandLoadingDataThe following data save/load and file operations can be carried out.
 Save/Loadsetupdatafiles(seesection6.9).Savedisplaydataandeventdatafiles(seesections4.8and6.4).Loaddisplaydataandeventdatafiles(seesection6.8).Listfilesanddeletefiles(seesection6.7).Format (see section 6.7).
 2.12UsingtheUSBFlashMemory(/USB1Option)
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 2.13 SettingtheDecimalPointType(Releasenumber3orlater)
 You can set the decimal point type for the display and files saved in text format.
 SetupScreenPress MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > OperatingEnvironment.
 SetupItems• DecimalPointTypes
 Setting DisplayExamplePoint 1234.56Comma 1234,56
 Explanation• DecimalPointTypes Thedecimalpointtypesettingaffectsthefollowingkindsoffilesanddisplays.The
 decimalpointofanyfileorsettingnotlistedbelow(thesetupscreenforexample)isdisplayed using a period.Type ItemFile output Manual sampled data file
 Report fileDisplay Trend display
 Digital displayBar graph displayOverview displayHistorical trendReport data displayCustom display
 Webpage All channel displayE-mails The instantaneous value data in alarm e-mails and
 scheduled e-mails.The report data in report e-mails
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 2.14 ShowingorHidingtheMenuItemforSwitchingfromSettingModetoBasicSettingMode(Releasenumber3orlater)
 Set whether or not to display a menu item in the setting mode menu for switching to basic setting mode.
 SetupScreenPress MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > OperatingEnvironment.
 SetupItems• BasicSettingMode>Menudisplay
 Setting DescriptionOn Displays “Basic setting mode” in the setting mode menu.Off Basic setting mode is not displayed in the setting mode menu.
 OperationsWhen “Basic setting mode” appears in the setting mode menu, you can perform the following operation:
 1. Press MENU and select the Menu tab > Basicsettingmode. Then press DISP/ENTER. A confirmation window opens.
 2. Select Yes, and press DISP/ENTER. The basic setting mode menu appears.
 NoteRegardless of this setting, you can switch from setting mode to basic setting mode by holding down the FUNC key for 3 seconds.
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 3.1 SettingtheScanIntervalandtheIntegrationTimeoftheA/DConverter
 Select the scan interval and the integration time of the A/D converter.For a description of the scan interval and the integration time of the A/D converter, see section 1.1.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > A/D,Memory.
 SetupItems• Scaninterval>Scanmode Normal: Measures at the normal mode scan interval.
 * The scan mode is fixed at Normal when the multi batch function (/BT2 option; release numbers 3 and later) is being used.
 FAST: Measures at a scan interval of 25 ms (DX1002, DX1004, DX1002N, and DX1004N) or 125 ms (DX1006, DX1012, DX1006N, and DX1012N).
 • Scaninterval>Scaninterval The selectable settings appear.
 • Scaninterval>A/Dintegrate When the scan mode is set to Normal, select the A/D integration time as necessary.
 Only the selectable settings are displayed.Settings DescriptionAuto The DX automatically detects the power supply frequency and sets the integration
 time to 16.7 ms and 20 ms for 60 Hz and 50 Hz, respectively. Fixed to 20 ms on /P1 models that use the 24 VDC power supply.
 50Hz Sets the integration time to 20 ms.60Hz Sets the integration time to 16.7 ms.100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).600Hz The A/D integration time for fast sampling mode. You cannot change this value.
 Chapter3 MeasurementChannelsandAlarms
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 3.2 SettingtheBurnoutDetectionandtheReferenceJunctionCompensationoftheThermocoupleInput
 Set the function that detects burnouts in the sensor for thermocouple input and 1-5V input and the referencejunctioncompensationmethodofthethermocouple.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Burnout,RJC.
 SetupItems• First-CH,Last-CH Select the target channels.
 • Burnoutset Detects thermocouple and 1-5V input sensor burnouts.
 Settings DescriptionOff Does not detect burnouts in the sensor.Up When the sensor burns out, the measured result is set to +over range. The
 measured value displays “Burnout.” For 1-5V input, the DX assumes that the sensor has burned out when the
 measured value exceeds the scale upper limit by 10% of the scale width. (Example: When the measured value is greater than 110 when the scale is from 0 to 100)
 Down When the sensor burns out, the measured result is set to –over range. The measured value displays “Burnout.”
 For 1-5V input, the DX assumes that the sensor has burned out when the measured value falls below the scale upper limit by 5% of the scale width. (Example: When the measured value is less than –5 when the scale is from 0 to 100)
 • RJC>Mode Setsthereferencejunctioncompensationmethodofthethermocoupleinput.Select
 Internal or External.Settings DescriptionInternal UsesthereferencejunctioncompensationfunctionoftheDX.External Usesanexternalreferencejunctioncompensationfunction.Whensetto
 External,Volt is displayed.
 • RJC>Volt The compensation voltage to be added to the input. Set the value in the range of –
 20000 µV to 20000 µV.
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 3.3 SettingtheInputRange
 Set the input range for each channel.
 SetupScreen• TemperatureUnit Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > OperatingEnvironment.
 • InputRangeforEachChannel Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Range,Alarm.
 SetupItems• Temperature Select the temperature unit. The setting is applied to all temperature measurement
 channels.Settings DescriptionC Use CelsiusF Use Fahrenheit
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 • First-CH,Last-CH Select the target channels.
 • Range>ModeSettings DescriptionSkip Not measured.Volt, TC, RTD, DI, 1-5V Input type. Represents DC voltage, thermocouple, RTD, ON/OFF
 input, and 1-5V inputs, respectively.Delta, Scale, Sqrt Difference computation, linear scaling, and square root computation.
 Set the items with check marks in the table below according to the mode value.
 Volt TC RTD DI Delta Scale Sqrt 1-5V Skip Type Range Span Lower Span Upper Scale Lower Scale Upper Unit Ref. CH Low-cut Low-cut value
 Mode Setup Item
 • Range>Type Input type when Mode is Delta or Scale. See the description on Mode above.
 • Range>Range Input type details.
 Standard Standard20mV –20.000 mV to 20.000 mVDC60mV –60.00 mV to 60.00 mVDC200mV –200.00 mV to 200.00 mVDC2V –2.000 V to 2.000 VDC6V –6.000 V to 6.000 VDC20V –20.000 V to 20.000 VDC20V –50.00 V to 60.00 VDCPt Pt100JPt JPt100Level ON/OFF(Voltage)Contact ON/OFF(Contact)1-5V 0.800V to 5.200V
 R Type RS Type SB Type BK Type KE Type EJ Type JT Type TN Type NW Type WL Type LU Type UWRe type WRe
 Setting Input Type Notes NotesInput TypeSetting
 Cu10 (GE)Cu10 (L&N)Cu10 (WEED)Cu10 (BAILEY)Cu10: a = 0.00392 at 20°CCu10: a = 0.00393 at 20°CCu25: a = 0.00425 at 0°C
 Cu1Cu2Cu3Cu4Cu5Cu6Cu25
 Setting Input Type Notes/N3 option
 /N1 option
 Kp Kp vs Au7FePLATI PLATINELPR PR40-20NiMo NiNiMoW/WRe W/WRe26N2 Type N (AWG14)XK XK GOST*1
 Pt50 Pt50Ni1 Ni100 (SAMA)Ni2 Ni100 (DIN)Ni3 Ni120J263 J263*BCu53 Cu53Cu100 Cu100: a = 0.00425 at 0°CPt25 Pt25Pt100G Pt100 GOST*1
 Cu100G Cu100 GOST*1
 Cu50G Cu50 GOST*1
 Cu10G Cu10GOST*1
 Pt46G Pt46 GOST*1
 Setting Input Type Notes
 Pt200W Pt200(WEED)*2
 *1 A function available on DXs with release number 3 or later.*2 This function is available for release numbers 4 and later.
 3.3SettingtheInputRange
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 • Range>Span_L,Span_U Input range. The selectable range is displayed on the screen.
 Note• YoucannotsetthesamevaluetoSpanLower and SpanUpper.• WhentheMode is 1-5V or Sqrt, SpanLower must be less than SpanUpper.
 • Range>Scale_L,Scale_U Input range after converting the unit. The selectable range is from –30000 to 30000. The decimal place is determined by
 the ScaleLower setting. It can be set to the following positions: “X.XXXX,” “XX.XXX,” “XXX.XX,” “XXXX.X,” or “XXXXX.”
 Note• TheDXconvertsthemeasuredvaluetoavalueobtainedbyremovingthedecimalpoint
 from the value span specified by ScaleLower and ScaleUpper. For example, if the scale setting is “–5 to 5,” the value is converted to a value within the span of “10”; if the scale setting is “–5.0 to 5.0,” the value is converted to a value within a span of “100.” In this case, the resolution of the value converted to a span of “10” is lower than the value converted to a span of “100.” To prevent the display from becoming rough, it is recommended that the scale be set so that this value is greater than 100.
 • YoucannotsetthesamevaluetoScaleLower and ScaleUpper.• WhentheMode is 1-5V or Sqrt, ScaleLower must be less than ScaleUpper.
 • Range>Unit Set the unit (up to 6 characters, A a # 1).
 • Range>Ref.CH The reference channel for difference computation.
 • Range>Low-cut Select On to use the low-cut function.
 * The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.
 • Range>Value On a square root computation channel, set the low-cut value in the range of 0.0% to
 5.0% of the input span.
 Input value
 Low-cut value
 Result of square root computation
 Measured value
 3.3SettingtheInputRange
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 3.4 SettingtheMovingAverageoftheInput
 Set the moving average function of the measurement channel. This function suppresses the effects of noise.For a description of the function, see section 1.1.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Movingaverage.
 SetupItems
 Average value
 Scan Interval
 Count
 Average value
 • First-CH,Last-CH Select the target channels.
 • Movingaverage>On/Off To use moving average, select On.
 • Movingaverage>Count Set the number of data points of the moving average in the range of 2 to 400.
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 3.5 SettingtheAuxiliaryAlarmFunction
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Alarm > Basicsettings; Switch,Relay; or Hysteresis.•Basicsettings •Switch,Relay
 •Hystersis
 SetupItems• Basicsettings>Reflash Tosetthereflashoperationonthealarmoutputrelay,selectOn.Thereflashfunction
 issetonthefirstthreeoutputrelays.Setting DescriptionOff Reflash is not used.On Reflash is used. The relays are deactivated for approximately 500 ms.On-1s Reflash is used. The relays are deactivated for approximately 1 s.On-2s Reflash is used. The relays are deactivated for approximately 2 s.
 • Basicsettings>Rateofchange • Decrease
 Set the interval for the rate-of-change calculation of the low limit on rate-of-change alarm in terms of the number of sampled data points (1 to 32). The actual interval is obtainedbymultiplyingthevaluespecifiedherebythescaninterval.
 • Increase Set the interval for the rate-of-change calculation of the high limit on rate-of-change
 alarm in the same manner as the interval for the low limit on rate-of-change alarm.

Page 104
						

3-8 IM 04L41B01-01E
 • Basicsetting>Indicator You can choose to make the alarm displays behave in the following ways. When you
 use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.Settings DescriptionNonhold Clears the alarm indication when the alarm condition is released (returns to
 normal condition).Hold Holds the alarm indication until an alarm acknowledge operation is performed.
 • InternalSwitch>AND Select the internal switches that are to operate using AND logic. Set the range
 ofinternalswitches(fromthefirstinternalswitch)totaketheANDlogic.Allsubsequent switches will be set to OR logic.
 • Relay>AND Select the relays that are to operate using AND logic. Set the range of relays (from the
 firstalarmrelay)totaketheANDlogic.AllsubsequentrelayswillbesettoORlogic.Available settings are None, I01 (I01 only), I01-I02 (I01 and I02), I01-I03 (I01 to I03), etc. Only alarm output relays that are installed are valid.
 NoteWhen reflash is turned ON, the operation of the first three output relays is fixed to OR logic. Specifying AND produces no effect.
 • Relay>Action Select whether the alarm output relay is energized or de-energized when an alarm
 occurs. The setting applies to all alarm output relays.
 • Relay>Hold You can choose to make the alarm output relays behave in the following ways. This
 setting applies to all relays. When you use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.Settings DescriptionNonhold Turns the output relay OFF when the alarm condition is released (returns to
 normal condition).Hold Holds the output relay at ON until an alarm acknowledge operation is performed.
 NoteWhen reflash is turned ON, the operation of the first three output relays is set to nonhold. Specifying Hold produces no effect.
 3.5SettingtheAuxiliaryAlarmFunction
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 • Relay>RelayActiononAck You can select the relay output status that is enabled after the AlarmACK operation
 from the following two settings. When you use the alarm annunciator function (release number 3 or later), the setting follows the annunciator sequence.Settings DescriptionNormal The relay is deactivated when the alarm ACK operation is executed. If the
 condition for activating the alarm output relay is met in the next scan interval, the relay is activated. This operation is valid only when the alarm output relay is set to Hold.
 Reset The relay is deactivated when the alarm ACK operation is executed. If a new condition for activating the alarm output relay is met, the relay is activated.
 An example of the relay action when alarm ACK is executed is shown below. This example is for the case when the output relay AND item is set to None.
 Normal
 Alarm ACK
 Alarm output relay
 Alarm 2
 Alarm 1
 Relay is activated in the next scan interval
 Activated
 Alarm occurrence
 Alarm occurrence
 Deactivated
 Reset
 Alarm ACK
 Relay is activated on the next alarm occurrence
 Alarm output relay
 Alarm 2
 Alarm 1
 Activated
 Alarm occurrence
 Alarm occurrence
 Deactivated
 • Hysteresis>MeasCH • High/Low
 Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm specifiedonmeasurementchannels.
 Selectable range: 0.0% to 5.0% of the span or scaling width • DeltaHigh/Low
 Sets the hysteresis width of the alarm occurrence/release of the difference high/low limitalarmspecifiedonmeasurementchannels.
 Selectable range: 0.0% to 5.0% of the span
 • Hysteresis>MathCH(/M1and/PM1options) Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm
 specifiedoncomputationchannels.Selectable range: 0.0% to 5.0% of the measurement span
 3.5SettingtheAuxiliaryAlarmFunction
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 3.6 HidingtheAlarmIndication
 Select whether to enable the alarm hide function.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Alarm > Action.
 SetupItems• Alarmaction>Nologging To enable the function that turns off the alarm indicator and logging, select On. The
 Detect setup item is displayed in the alarm setting screen (see section 3.7).
 This function disables the alarm indicator and the logging of alarm events to the alarm summary. Alarms are also not displayed by the alarm annunciator (release number 3 or later).
 • SettingsforEachChannelandEachAlarm See section 3.7.
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 3.7 SettingAlarmsonChannels
 Set the alarms after setting the range. All alarm settings of a channel are cancelled in the following cases.• Whentheinputtype(Volt, TC, etc.) is changed.• Whentheinputrangeischanged.• Whentheupperorlowerlimitofthespanorscaleischangedonchannelsthatareset
 to linear scale, square root computation, or 1-5 V (including changes in the decimal point position).
 SetupScreen• AlarmsforEachChannel Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Range,Alarm.
 • AlarmDelayTime Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Tag,Memory,Delay.
 On DXs without the /AS1 advanced security option
 On DXs with the /AS1 advanced security option
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 • AlarmLevelsandColors(Releasenumber3orlater) Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Alarm > Alarmlevel/color.
 3.7SettingAlarmsonChannels
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 SetupItems• First-CH,Last-CH Select the target channels. The target channels are common with the other items that
 are displayed on the screen.
 • Alarm>1,2,3,and4 For each alarm, 1 to 4, select On to enable it.
 • Alarm>Type Select the alarm type.
 SettingsName DescriptionH High limit alarm –L Low limit alarm –h Difference high limit alarm Can be specified on channels set to difference computation.l Difference low limit alarm Can be specified on channels set to difference computation.R High limit on rate-of-change alarm –r Low limit on rate-of-change alarm –T Delay high limit alarm –t Delay low limit alarm –
 Alarms on channels set to difference computation are inserted at the following positions.
 Input value
 Measured value on the reference channel
 H, L, T, t R, r, h, l
 Measured value-
 • Alarm>Value Set the alarm value for the selected alarm type. WhentheModeoftheChannelIsSettoVolt,TC,RTD,orDI
 Type Value ExampleofaRangeofAlarmValuesH, L Value in the measurable range –2.0000 to 2.0000 V for 2 V rangeR, r 1 digit to the upper limit of the width 0.0001 to 3.0000 V for 2 V range
 of the measurable range However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
 excluding the decimal point.
 T, t Same as H and L. Same as H and L.
 WhentheModeoftheChannelIsSettoDeltaType Value ExampleofaRangeofAlarmValuesH, L Value in the measurable range –2.0000 to 2.0000 V for 2 V rangeh, l Value in the measurable range –1760.0 to 1760.0°C for thermocouple type RR, r 1 digit to the width of the measurable 0.0001 to 3.0000 V for 2 V range
 range However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
 excluding the decimal point.
 T, t Same as H and L. Same as H and L.
 WhentheModeoftheChannelIsSettoScale,Sqrt,or1-5VType Value ExampleofaRangeofAlarmValuesH, L –5% to 105% of the scale width. –5.0 to 105.0 when the scale is 0.0 to 100.0 However, within –30000 to 30000 –120.00 to 300.00 when the scale is –100.00
 excluding the decimal point. to 300.00
 R, r Within 1 to 30000 excluding the 0.1 to 3000.0 when the scale is 0.0 to 100.0 decimal point. 0.01 to 300.00 when the scale is –100.00 to 300.00
 T, t Same as H and L. Same as H and L.
 3.7SettingAlarmsonChannels
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 • Alarm>Relay Select whether to turn On or Off the relay output.
 • Alarm>No. Set the output relay number or internal switch number when performing relay output.
 • Alarm>Detect This item appears when the alarm hide function (see section 3.6) is turned On. Select
 whether to show or hide the alarm indication when an alarm occurs. If set to Off, a signal is output to the alarm output relay or internal switch when an alarm occurs, but it is not indicated on the screen. The alarm is also not recorded in the alarm summary, and alarms are not displayed by the alarm annunciator (release number 3 or later).
 • Alarmdelay>Time(fordelayhigh/lowlimitalarms) Set the alarm delay time using an integer in the range of 1 to 3600 s. On DXs with the /AS1 advanced security option, you can set the delay time to a value
 within the range of 1 to 3600 seconds or 1 to 24 hours.
 Note• Thealarmdelaytimetakesonavaluethatisanintegermultipleofthescaninterval.For
 example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay time is 6 s.
 • Thedelayalarmhasthefollowingspecialoperations.• Ifthecomputationisstoppedinaconditioninwhichthecomputedvalueisexceedingthe
 alarm setting when a delay alarm is set on a computation channel, the alarm is turned On after the specified period (delay period) elapses.
 • Thealarmdetectionoperationisresetifapowerfailureoccurs.Theoperationrestartsafter the power recovers.
 • Ifthealarmsettingofthedelayhighlimitalarmischangedwhenanalarmisalreadyactivated and the input is greater than or equal to the new setting, the alarm continues. For all other cases, the alarm detection operation starts at the new setting. This is also true for the delay lower limit alarm.
 • Alarmdelay>Unit(Fordelayhigh/lowlimitalarms) This setting is only available on DXs with the /AS1 advanced security option. Set the
 unit of the alarm delay time. You can select seconds or hours.
 • Alarmdisplay>Level(Releasenumber3orlater) When multiple alarms occur, the display of alarms with higher levels is given higher
 priority. This setting applies to all channels.Setting Description1>2>3>4 The order of alarm level preference, from highest to lowest preference, is 1,
 2, 3, 4.1>4>2>3 The order of alarm level preference, from highest to lowest preference, is 1,
 4, 2, 3.1>4>3>2 The order of alarm level preference, from highest to lowest preference, is 1,
 4, 3, 2.
 • Alarmdisplay>Color(Releasenumber3orlater) Determines the alarm color for each alarm level. This setting applies to all channels.
 Item Setting1 Sets the alarm level 1 color to red, orange, yellow, or pink.2 Sets the alarm level 2 color.3 Sets the alarm level 3 color.4 Sets the alarm level 4 color.
 3.7SettingAlarmsonChannels
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 3.8 ReleasingtheAlarmOutput(AlarmACKOperation)
 This operation is valid when the DX is set as follows:DX with release number 3 or later• WhenAnnunciatormode is set to On in the basic setting mode.• WhenAnnunciatormode is set to Off, the operation is the same as described for DX
 with release number 2 below.DX with release number 2• WhenIndicator is set to Hold in the basic setting mode.• WhenRelayHold is set to Hold and RelayactiononACK is set to Normal in the
 basic setting mode.• WhenRelayactiononACK is set to Reset in the basic setting mode.DXbeforereleasenumber2• WhenIndicator is set to Hold in the basic setting mode.• WhenRelayHold is set to Hold in the basic setting mode.For the procedure to set the relay action, see section 3.5.
 On a DX with advanced security (/AS1 option; release numbers 4 and later), you can perform separate alarm ACK operations on each alarm.For information about individual alarm ACK operations, see section 4.4.
 ProcedureThis operation is carried out after an alarm occurs.
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the AlarmACK soft key.The alarm output is released.
 Explanation• AlarmAcknowledge(ACK)Operation When an alarm acknowledge operation is carried out, the indications and outputs
 (relays and switches) of all activated alarms are cleared. In annunciator mode (release number 3 or later), the alarm indications and outputs
 follow the annunciator sequence.

Page 112
						

3-16 IM 04L41B01-01E
 3.9 PerformingCalibrationCorrection(/CC1Option)
 The input value is corrected using segments, and the result is used as a measured value.For a description of the function, see section 1.1.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Calibration correction.
 SetupItems
 True val
 Number of set points
 Calibration set points
 Y5Y4
 Y3Y2
 Y1
 MES val
 X1 X2 X3 X4 X5
 ConditionX1 < X2 < X3 < X4 < X5
 • First-CH,Last-CH Select the target channels. You can set consecutive channels whose range is set to
 thesamevalueasthefirstchannel.
 • Numberofsetpoints Select the number of points that make up the segments (including the start and end
 points) in the range of 2 to 16. To disable calibration correction, select Off.
 • Numberofsetpoints>MESval,Trueval Press the Input soft key and enter the value. For the MES value, set a value that is greater than the previous value. Press the Measure soft key to set the measured value at that point to MES val. If
 you press the Measure soft key when setting multiple channels simultaneously, the measuredvalueofthefirstchannelaresettotheMESvalofallchannels.
 SelectableRangeofMESandTrueValues • Channelsonwhichlinearscalingisspecified
 –30000 to 30000 (the decimal place is the same setting as the scale value) • Otherchannels
 Value in the measurable range of the selected range Example: –2.0000 to 2.0000 for 2 V range
 Note• ThecalibrationcorrectionsettingissettoOffifyouchangetheMode or Range setting.• CalibrationcorrectioncannotbespecifiedonchannelssettoSkip.
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 3.10 CountingPulses(/PM1Option)
 The pulses applied to the pulse input terminal are counted on a computation channel.For a description of the function, see section 1.1.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Expression,Alarm
 SetupItems• First-CH,Last-CH Select the target computation channels.
 • Math Select On.
 • Math>Calculationexpression Enter the equation using symbols. Q01 to Q08: Displays the number of pulses per second. P01 to P08: Displays the number of pulses per scan interval.
 * The numbers 01 to 08 correspond to the pulse input terminal numbers. For the procedure to set the computation channels, see section 9.1.
 The procedure is explained below using an example.• Example1:PulseSumValue Display the sum value of the pulse signal applied to pulse input terminal number 6.
 Number of pulses per scan interval
 TLOG.SUMPulse sum value
 Pulse inputScan interval
 Time
 (Sum)
 P6
 Expression Assign the computation channel and set the expression. Set the span lower/upper
 limit and unit according to the application.
 101 Sum of the number of pulses per scan interval Channel Equation Description
 TLOG.SUM(P6)
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 • Example2:NumberofPulsesperMinute Count the pulse signal applied to pulse input terminal number 6 on the DX1002 (scan
 interval set to 250 ms), and calculate and display the number of pulses per minute.
 Number of pulses per second
 101ch
 102ch Number of pulses per minute
 Pulse inputSampling interval
 (250 ms)
 Time
 (Moving average over a minute)
 (60x)
 Expression Assign the computation channel as shown below and set the expressions. Set the
 span lower/upper limit and unit according to the application.
 101 Q6 Number of pulses per second102 101*K01 Number of pulses per minute
 Channel Equation Description
 K01 60 Coefficient for converting the number of pulses per second to the number of pulses per minute
 Constant Value Description
 101 Sampling interval: 1s Moving average over a minute Number of samples: 60
 Channel Rolling average Description
 Channels The computation is performed in order from the channel with the smallest channel
 number in one scan interval. Use a channel of a channel number larger than that of the channel counting the
 number of pulses per second for the computation channel that is to calculate the number of pulses per minute.
 • Example3:ResetWhenthePulseSumValueExceedsaCertainValue Resetthesumvaluewhenthepulsesumvalueexceedsaspecifiedvalue(reset
 value) and carry over the value exceeding the reset value to the sum after the reset. Count the number of resets and calculate the total sum value up to that point.
 Expression Assign expressions to the computation channels as shown below and set the
 constants.Channel Expression Application101 ((102+P01).GE.K01)+101 Pulse sum value reset count102 CARRY(K01):TLOG.SUM(P01) Pulse sum value103 K01*101+102 Total sum value
 Symbol DescriptionP01 Counts the number of pulses per scan interval.K01 Constant. The reset value. The sum value is reset when this value is exceeded.
 3.10CountingPulses(/PM1Option)
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 0 0 1 1 1 2 2
 P01Number of pulses per scan interval
 102chSum value
 101chReset count
 Pulse inputScan interval
 Time
 K01reset value
 (Resets the value below the reset value)
 (Sum)
 Channel101:ResetCount Calculates the number of times the pulse sum value is reset. The expression “((102+P01).GE.K01)” is set to 1 when “the previous pulse sum value
 (102) + the current pulse count (P01)” is greater than the reset value (K01). Otherwise, the expression is set to 0. The value of channel 101 is incremented when the pulse sum value exceeds the reset value.
 Channel102:PulseSumValue Calculates the pulse sum value. Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When
 the pulse sum value is greater than or equal to the reset value (K01), the pulse sum value is set to the amount exceeding K01.
 Channel103:TotalSumValue Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value
 (102) to derive the total sum value.
 Note• Thecomputationisperformedinorderfromthechannelwiththesmallestchannelnumber
 in one scan interval. If the channel number in the expression is greater than or equal to the channel number in which the expression is assigned, the previous computed result (previous value) is used for the channel in the expression.
 • Ifthepulseinputvalueofthescanintervalisgreaterthantheresetvalue,correctcomputation cannot be achieved.
 3.10CountingPulses(/PM1Option)
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 3.11 SettingtheMethodofDetectingOver-RangeValuesofLinearlyScaledMeasurementChannels
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Input,Tag.
 SetupItems• Input>Valueonover-range
 Settings DescriptionFree The value is set to –over range if the value is less than –30000 and +over range
 if the value is greater than 30000 excluding the decimal point. The value is displayed as –Over and +Over, respectively.
 Over The value is set to –over range if the value is less than –5% of the scale and +over range if the value is greater than 105%. The value is displayed as –Over and +Over, respectively.
 Example: If the scale is 0.0 to 200.0, the value is set to –over range if the value is less than –10.0 of the scale and +over range if the value is greater than 210.0.
 NoteFor computations such as TLOG, CLOG, and report, the handling of the scale over-range value can be set in advance.See section 9.1.
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 3.12 UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
 This section explains how to use the alarm annunciator function.For a description of the function, see section 1.2.
 SetupScreen• AnnunciatorMode Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Alarm > Action.
 • AlarmLevelsandColors See section 3.7.
 • Display Press MENU (to switch to setting mode), and select the Menu tab > Display >
 Annunciator.
 SetupItems• Alarmaction>Annunciatormode Select On to use the annunciator function.
 • Alarmaction>Sequence Select the annunciator sequence. For details about the annunciator sequence, see
 “Explanation” in this section.Setting DescriptionISA-A-4 A no lock-in sequence.ISA-A A lock-in sequence.ISA-M A double lock-in sequence.
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 • Alarmaction>Timeoffcolor The window display color when no alarms are activated. You can select white or
 green.
 • LevelsandColors See section 3.7.
 • Annunciatorposition The position of the annunciator window. See the explanation for the next item.
 • Annunciatorposition>On/Off Set the annunciator position that you want to use to On. Starting with 1, consecutively set all annunciator positions that you want to use to On.
 After a position has been set to Off, all of the positions after it will also be turned off even if they are set to On. The annunciator display changes depending on how many annunciator windows you use. For details, see “Explanation.”
 • Annunciatorposition>Channel,Level You can assign alarms to annunciator windows by specifying channel numbers and
 alarm levels. YoucansetLevelto1,2,3,4,orAll.IfyouselectAll,allofthealarmsinthespecified
 channelareassignedtothespecifiedwindow.
 • Annunciatorposition>CommenttxtblockNo. You can select a text string (label) to display in the annunciator window by selecting a
 comment text block number. For information about how to set comment text blocks, see section 5.18.
 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
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 Procedure• OpeningtheDisplay The annunciator display appears when you turn on the power. You can switch to the
 annunciator display from other displays by following the procedure below.
 1. Press DISP/ENTER to show the display selection menu.
 2. Use the upanddownarrowkeys to select Annunciator, and then press DISP/ENTER.
 The display appears. The example below is for when there are four annunciator windows.
 Label
 Display window
 • AlarmACK Perform this operation after an alarm has occurred. This operation affects all alarms.
 1. In operation mode, press FUNC.The FUNC key menu appears.
 2. Press the AlarmACK soft key.The alarm indications and outputs are cleared according to the annunciator sequence. For details, see “Explanation.”
 • AlarmDisplayReset(WhentheannunciatorsequenceissettoISA-M) The alarm display reset operation will not take place unless the alarm ACK operation
 isperformedfirst.Thealarmdisplayresetoperationaffectsallalarms.
 1. In operation mode, press FUNC.The FUNC key menu appears.
 2. Press the AlarmDispRST soft key.The alarm displays are reset. They are reset according to the annunciator sequence. For details, see “Explanation.”
 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
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 Explanation• DisplayWindowLayoutsandLabels The annunciator display layouts and labels change as indicated in the table below.
 DisplayedWindows
 WindowLayoutVertical × Horizontal
 Labels(maxnumberofdisplayablecharacters)
 FontSize
 Lines Characters4 2 × 2 5 26 66 3 × 2 5 26 68 4 × 2 4 26 610 5 × 2 3 26 612 6 × 2 3 26 616 8 × 2 2 26 620 5 × 4 3 13 624 8 × 3 2 17 6
 DisplayPositions Annunciator windows are assigned to positions starting with the left column.
 Annunciator windows are assigned in ascending order. The example below is for an annunciator display with eight windows.
 Annunciatorposition number
 1
 2
 3
 4
 5
 6
 7
 8
 Labels The number of characters that can be displayed varies depending on the number of
 annunciator windows.
 • WindowColorsState ColorWhen an alarm is released “Time off color” (green or white)When an alarm is occurring The alarm color. If multiple alarms are occurring, the window is
 displayed using the color of the alarm with the highest priority.Displayed windows not in use Gray
 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
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 • AnnunciatorSequenceISA-A-4
 SequencediagramProcess
 SequenceDisplay
 Relay outputAlarm icon
 NormalNormalNormal
 DeactivatedNo display
 ProcessSequence
 DisplayRelay outputAlarm icon
 Deactivated
 ProcessSequence
 DisplayRelay outputAlarm icon
 Activated
 AbnormalAcknowledged
 On
 On (red) Blinking (red)
 FlashingAlarm
 Abnormal
 To abnormal
 Return to normal Return to normal
 Alarm ACK while abnormal
 Sequencepattern
 Alarm
 Display
 Relay output
 Alarm ACK
 Whenmultiplealarmshavebeenassignedtoasingleannunciatorwindow• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.
 WhentwoalarmshavebeenassignedtoasinglerelayWhentherelayissettoORlogic
 Alarm A Occurrence
 Alarm B Occurrence
 Release
 Release
 Relay Activated
 Deactivated
 ACK ACK
 An alarm has occurred, and the relay has been activated.
 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
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 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
 WhentherelayissettoANDlogic
 ACK ACK
 Alarm A Occurrence
 Alarm B Occurrence
 Release
 Release
 Relay Activated
 Deactivated
 Alarm B has occurred, so now all alarms have occurred.This causes the relay to be activated.
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 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
 ISA-ASequencediagram
 ProcessSequence
 DisplayRelay outputAlarm icon
 NormalNormalNormal
 DeactivatedNo display
 Process
 SequenceDisplay
 Relay outputAlarm icon
 Deactivated
 Process
 SequenceDisplay
 Relay outputAlarm icon
 Activated
 Abnormal
 AcknowledgedOn
 On (red) Blinking (red)
 FlashingAlarm
 Abnormal or normal
 To abnormal
 Return to normal
 Alarm ACK while abnormal
 Alarm ACK while normal
 Sequencepattern
 Alarm
 Display
 Relay output
 Alarm ACKAlarm ACK
 • If an alarm is released before the alarm ACK operation is performed, the annunciator blinks with the color that is displayed when no alarms are activated.
 • If an alarm is released before the alarm ACK operation is performed, the alarm icon blinks green.
 Whenmultiplealarmshavebeenassignedtoasingleannunciatorwindow• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.
 WhentwoalarmshavebeenassignedtoasinglerelayWhentherelayissettoORlogic
 ACK ACK
 Relay hold
 Alarm A Occurrence
 Alarm B Occurrence
 Release
 Release
 Relay Activated
 Deactivated
 An alarm has occurred so the relay has been activated.
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 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
 WhentherelayissettoANDlogic
 Relay hold
 ACK ACK
 Alarm A Occurrence
 Alarm B Occurrence
 Release
 Release
 Relay Activated
 Deactivated
 Alarm B has occurred, so now all alarms have occurred.This causes the relay to be activated.
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 ISA-MSequencediagram
 ProcessSequence
 DisplayRelay outputAlarm icon
 NormalNormalNormal
 DeactivatedNo display
 Process
 SequenceDisplay
 Relay outputAlarm icon
 Deactivated
 Process
 SequenceDisplay
 Relay outputAlarm icon
 Activated
 Abnormal or normal
 AcknowledgedOn
 On (red) Blinking (red)
 FlashingAlarm
 Abnormal or normal
 To abnormal
 Alarm ACK
 Alarm display reset while normal
 Sequencepattern
 Alarm
 Display
 Relay output
 Alarm ACK Alarm ACK
 Display reset Displayreset
 Displayreset
 Alarm
 Display
 Relay output
 Alarm ACK Alarm ACK
 Displayreset
 • Even if an alarm is released before the alarm ACK operation is performed, the annunciator continues to blink with the color that is displayed when an alarm has occurred.
 • Even if an alarm is released before the alarm display reset operation is performed, the annunciator continues to blink with the color that is displayed when an alarm has occurred.
 • Even if an alarm is released before the alarm ACK operation is performed, the alarm icon continues to blink red.• Even if an alarm is released before the alarm display reset operation is performed, the alarm icon stays red.
 Whenmultiplealarmshavebeenassignedtoasingleannunciatorwindow• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.
 WhentwoalarmshavebeenassignedtoasinglerelaySame as for ISA-A.
 3.12UsingtheAlarmAnnunciatorFunction(Releasenumber3orlater)
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 3.13 ManagingtheInputCalibrationInterval(/CC1option;releasenumbers4andlater)
 Manage the input calibration interval to make sure that calibration is performed regularly.For a description of the function, see section 1.1.
 SetupScreen Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > SetCalibration.
 SetupItems• SetCalibration>Use/Not Select whether to Use or Not use calibration management. When you select Use, the Set Calibration tab appears in setting mode.
 • SetCalibration>Notification(DayBfr) You can specify how many days before the calibration due date you want to display
 thecalibrationnotificationscreen.Youcansetthenumberofdaystoavaluebetween1 and 10.
 • SetCalibration>Renotification Youcanspecifytheperiodatwhichtodisplaythecalibrationnotificationscreen.The
 calibrationnotificationscreenwillcontinuetoappearuntilcalibrationiscompleted.Setting Description10min The screen will appear every 10 minutes.30min The screen will appear every 30 minutes.1h The screen will appear every hour.8h The screen will appear every 8 hours.24h The screen will appear every 24 hours.
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 3.13ManagingtheInputCalibrationInterval(/CC1option;releasenumbers4andlater)
 Procedure• ViewingtheCalibrationNotificationScreen
 The calibrationnotificationscreenonlyappearsoveroperationscreens.Itwillcontinueto appear until you perform calibration (Finish Calibration).
 YoucanclosethecalibrationnotificationscreenbypressingESC or DISP/ENTER. OperationExample WhenNotificationissetto1(DayBfr)andRenotificationissetto8h
 Notification screen display start Calibration due date
 Notification screen appears
 Renotification Renotification Renotification Renotification
 00:00 08:00 16:00 00:00 08:00
 Notification (DayBfr) setting
 Notification screen appears
 Notification screen appears
 Notification screen appears
 Note• Thecalibrationnotificationscreenwillcloseifyouchangescreenswhileitisdisplayed.• Ifthecalibrationduedatepassesbeforeyoucompletecalibration,thatinformationwillbe
 recorded in the login log (the operation log on DXs with the /AS1 option).
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 • CheckingtheCalibration Due Date Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode) > Set Calibration tab.
 The date on which the last calibration was completedDisplayed according to the date format (see section 2.4)
 Due date for next calibrationDisplayed according to the date format (see section 2.4)
 • ConfiguringCalibration Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode) > Set Calibration tab > Calibration Correction.
 The setup items are the same as in section 3.9, “Performing Calibration Correction.”
 For the setting procedure, see section 3.9.
 3.13ManagingtheInputCalibrationInterval(/CC1option;releasenumbers4andlater)
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 • FinishingCalibration Set the next calibration due date.
 1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode) > Set Calibration tab > Finish Calibration.
 A window for setting the calibration due date appears.
 2. Set the next calibration due date, and press DISP/ENTER.
 SoftKey DescriptionInput Enter the date directly.+1 Week Set the date by adding weeks to the current calibration due date.–1 Week Set the date by subtracting weeks from the current calibration due date.+1 Month Set the date by adding months to the current calibration due date.–1 Month Set the date by subtracting months from the current calibration due date.
 3. Use the arrowkeys to select Execute, and press DISP/ENTER.Calibration is complete.
 Note• Youcannotsetthecalibrationduedatetoadatebeforethecurrentday.• Wheneveryoucompletecalibration,alogisaddedtotheloginlog(theoperationlogonDXs
 with the /AS1 option).
 3.13ManagingtheInputCalibrationInterval(/CC1option;releasenumbers4andlater)
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 4.1 OperationsinOperationMode
 SwitchingtheScreenwiththeDISP/ENTERKeyandArrowKeysPress DISP/ENTER and arrowkeys to show the display selection menu and sub menu to switch the display. The flow of operation is indicated below.
 TREND
 GROUP 1 GROUP n
 GROUP n
 GROUP 1 GROUP n
 DIGITAL
 BAR
 OVERVIEW
 INFORMATION
 TRENDHISTORY
 LOG
 Login log, error log, communication log,FTP log, Web log, e-mail log, SNTP log,DHCP log, Modbus status log
 ALARMSUMMARY
 MESSAGESUMMARY
 MEMORYSUMMARY
 MODBUSMASTERMODBUSCLIENT
 GROUP 1
 DISP/ENTER key and arrow keysSec. 4.2
 Sec. 4.2
 Sec. 4.2
 Sec. 4.5
 To display, see 5.17Not displayed with the default settings.
 Appears when the annunciator function is being used.
 Display selection menuSub menu
 Sec. 4.6 Sec. 4.7 Sec. 4.8
 REPORT DATA
 COLUMN BAR
 RELAYSec. 4.5
 Sec. 4.10
 Sec. 4.5
 EVENT SWITCH
 Sec. 4.5
 Sec. 4.4
 CUSTOMDISPLAY
 IM04L41B01-04E
 AnnunciatorSec. 3.12
 Sec. 4.3
 Sec. 4.9
 About tag displayLong tags may not fit into their display areas.When this is the case, they are displayed as follows:• After the screen is displayed, the tag automatically
 scrolls through the display area once.• Press ESC to scroll the tag through the display
 area again.
 operation log (/AS1 option), and change settings log (/AS1 option)
 Chapter4 SwitchingOperationScreens
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 OperationsUsingOtherKeys
 Favorite key (see section 5.15)
 FUNC key (see below)
 Soft keys (see below)
 USER key (see section 7.1)START and STOP keys (see section 6.4)
 START USER FUNC ESC MENUSTOP
 OperationUsingtheFUNCKey Press FUNC to display the FUNC key menu at the bottom of the screen. Press the
 Next soft key to switch the menu. Press the desired softkey.
 FUNC key menu (Select using the soft keys)
 Next soft key
 4.1OperationsinOperationMode
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 Menu Item RefertoAlarm ACK Section 3.8Alarm DispRST Section 3.12Message Section 5.4Free message Section 5.4Mediaeject Sections 6.4 and 2.12Snap shot Section 6.6Manual sample Section 6.5Trigger Section 6.4Save display Section 6.4Save event Section 6.4Save stop Section 4.8Math start/stop Section 9.4Math reset Section 9.4Math ACK Section 9.4Edge Switch Section 7.1Timer reset Section 7.1Match T Reset Section 7.1Keylock Section 8.1Logout Section 8.3Locked ACK IM04L41B01-05ENPassword change Section 8.3Normal speed/Second speed Section 5.3Batch Section 6.3Text field Section 6.3Builder IM04L41B01-04Favorite regist Section 5.15Standard display Section 5.14System info Section 2.5Network info Section 2.5SNTP IM04L41B01-17EE-Mail start/stop IM04L41B01-17EE-Mail test IM04L41B01-17EFTP test IM04L41B01-17E
 CustomizingtheMenus The display selection menu that appears when the DISP/ENTER key is pressed and
 the FUNC key menu that appears when the FUNC key is pressed can be changed. See section 5.17.
 4.1OperationsinOperationMode
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 4.2 DisplayingtheMeasuredDataasWaveforms,Values,orBarGraphs
 This section explains how to use the trend, digital, and bar graph displays.For a description of the function, see section 1.3.
 Procedure• ShowingtheDisplay
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the arrowkeys to select TREND, DIGITAL, or BAR, and press DISP/ENTER.The selected display appears.
 • ChangingtheDisplayedContents1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrowkey to display the sub menu.
 3. Press the upanddownarrowkeys to select the sub menu item.
 SCALE ON: Displays the scaleSCALE OFF: Clears the scale
 AUTO ZONE ON: Displays trend waveforms separately by assigning each channel in the group to separate display areas (zones)AUTO ZONE OFF: Does not display waveforms in zones
 ALL CHANNEL: Displays the waveforms of all channelsGROUP CHANNEL: Displays the waveforms of the channels registered to groups
 DIGITAL OFF: Clears the numeric display sectionDIGITAL ON: Displays the numeric display sectionMESSAGE DISP1: Displays the messages using display method 1MESSAGE DISP2: Displays the messages using display method 2TREND SPACE ON: Inserts a space at the right edge (horizontal display) or the top edge (vertical display) in the waveform display areaTREND SPACE OFF: Does not insert a space
 AUTO SCROLL ON: Automatically switches the displayed groupsAUTO SCROLL OFF: Does not automatically switch the displayed groups
 Group name: Displays the group
 Trend display sub menu
 (Not displayed with the default settings.To display, see section 5.17.)
 FINE GRID ON: Displays the fine gridFINE GRID OFF: Clears the fine gridTAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display
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 Digital display sub menu
 AUTO SCROLL ON: Automatically switches the displayed groupsAUTO SCROLL OFF: Does not automatically switch the displayed groups
 Group name: Displays the group
 TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display.
 Bar graph display submenu
 Group name: Displays the group
 AUTO SCROLL ON: Automatically switches the displayed groupsAUTO SCROLL OFF: Does not automatically switch the displayed groups
 TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display.
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 • StartingtheWaveformDisplayoftheTrendDisplay/StoppingtheWaveformUpdating
 Press START to start the waveform display of the trend display. Press STOP to stop the waveform updating.
 • WritingMessages See section 5.4.
 • SwitchingtheDisplayedGroupUsingArrowKeys Press the rightarrowkey to switch the displayed group in ascending order. Press the
 leftarrowkey to switch the displayed group in reverse.
 • SwitchingtheTrend,Digital,andBarGraphDisplaysUsingtheArrowKeys
 Press the downarrowkey while showing the trend, digital, or bar graph display to switch the display in the order trend, digital, bar graph, trend, and so on. Press the uparrowkey to switch the display in reverse order.
 4.2DisplayingtheMeasuredDataasWaveforms,Values,orBarGraphs
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 Explanation• ALLCHANNEL/GROUPCHANNELontheTrendDisplay On the group display, the channels that are assigned to the group are displayed. In
 allchanneldisplay,thewaveformsofallchannelsthatareconfiguredtorecorddataare displayed on the current group display. The waveforms of channels that are not assigned to the group are displayed in the waveform display area, but the scales, current value marks, and digital values of the channels are not displayed.
 • SCALEON/OFFandDIGITALON/OFFontheTrendDisplay Select whether to show or hide the scale and numeric display sections.
 • AUTOSCROLLON/OFF Thedisplayedgroupscanbeautomaticallyswitchedataspecifiedintervalby
 selecting AUTOSCROLLON. The display switches in ascending group order. For the procedure to set the auto scroll interval of groups, see section 5.13.
 • MESSAGEDISP1andMESSAGEDISP2ontheTrendDisplay Switches the message display method.
 • AUTOZONE(Releasenumber3orlater) Displays trend waveforms separately by evenly dividing display areas (zones) among
 a group’s channels. With AUTO ZONE OFF With AUTO ZONE ON
 Waveform display area is divided evenly.
 • FINEGRID(Releasenumber3orlater) Displaythefinegridwhenthenormalgridistoowideforreadingmeasuredvalues.
 Thefinegridcanbeusedinthetrendandhistoricaltrenddisplays.Thefinegridplaces an additional four lines between the normal grid lines.
 With FINE GRID OFF With FINE GRID ON
 Fine grid
 4.2DisplayingtheMeasuredDataasWaveforms,Values,orBarGraphs
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 4.2DisplayingtheMeasuredDataasWaveforms,Values,orBarGraphs
 • TAGDETAILON/OFF(Releasenumber3orlater) WhenTAGDETAILissettoONandatagdoesnotfitintothetypicaltagdisplay
 space, it covers the alarm and measured values so that it can be displayed completely. Depending on display space limitations, it may not be possible to display theentiretag.Ifthetagcommentandnumberdonotfitwithinadisplayarea,theycanbe scrolled. The TAG DETAIL setting made in one display affects the settings in all of the other displays.
 Thefigurebelowshowsanexampleforwhensixchannelsarebeingdisplayed. WhentheTagNumberIsNotDisplayed If TAG DETAIL is on, the tag comment is displayed as much as possible. With TAG DETAIL OFF With TAG DETAIL ON
 Tag comment Tag comment
 Tag comment Tag comment
 Tag comment
 Tag comment
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 4.2DisplayingtheMeasuredDataasWaveforms,Values,orBarGraphs
 WhentheTagNumberIsDisplayed When TAG DETAIL is set to off, display priority is given to the tag number. If TAG
 DETAIL is on, the tag number and comment are displayed as much as possible. With TAG DETAIL OFF With TAG DETAIL ON
 Tag no. Tag no.
 Tag comment
 Tag no.
 Tag comment
 Tag no.
 Tag comment
 Tag no.
 Tag comment
 Tag no.
 Tag comment
 In the above digital value display example, because there is enough space for the tags, the display does not change whether TAG DETAIL is on or off.In the above bar graph display example, because space is limited, the display does not change whether TAG DETAIL is on or off.
 • TRENDSPACEON/OFF With TREND SPACE ON
 Space
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 4.3 DisplayingPastMeasuredData(HistoricalTrendDisplay)
 There are five methods to display the past measured data.For a description of the function, see section 1.3.
 Recall from the display selection menu (see this section).Display from the alarm summary (see section 4.6).Display from the message summary (see section 4.7).Display from the memory summary (see section 4.8).Show the measured data stored on an external storage medium (see section 6.8).
 Procedure• ShowingtheDisplay Carry out the procedure below while memory sampling is in progress.
 1. Press DISP/ENTER to show the display selection menu.2. Press the arrowkeys to select TRENDHISTORY, and press DISP/ENTER.
 The display appears.
 • ChangingtheDisplayedContents1. Press DISP/ENTER to show the display selection menu.2. Press the rightarrowkey to display the sub menu.3. Press the upanddownarrowkeys to select the sub menu item.
 ALL CHANNEL: Displays the waveforms of all channelsGROUP CHANNEL: Displays the waveforms of the channels registered to groups
 CURSOR TIME ON: Shows the time at the cursor position in the top right of the displayCURSOR TIME OFF: Displays the date/time of the data at the right edge of the screen
 Group name: Displays the group
 Historical trend display sub menu
 MESSAGE DISP2: Displays the messages using display method 2MESSAGE DISP1: Displays the messages using display method 1
 SCALE ON: Displays the scaleSCALE OFF: Clears the scale
 RELATIVE TIME: Displays the time that has elapsed since memory startABSOLUTE TIME: Displays the time when data was recorded
 CURSOR VALUE: With display data, shows the maximum data value at the cursor position. With event data, shows the data at the cursor position. DIGITAL MAX/MIN: Displays the maximum and minimum values at the cursor position and the maximum and minimum values within the displayed data in the digital value display area
 AUTO ZONE ON: Displays trend waveforms separately by assigning each channel in the group to separate display areas (zones)AUTO ZONE OFF: Does not display waveforms in zones
 FINE GRID ON: Displays the fine gridFINE GRID OFF: Clears the fine gridTAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display.
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 Displays the trend waveform and scale markers of the selectedchannel in front of all the others. (List items like “ABC-1” aretags.)
 Expands or reduces the time axis
 Displays the alarm summary in the loaded data file
 Switches to the specified display
 Returns to the display that was shown before the historical trend
 Displays the message summary contained in the loaded data fileDisplays information about the loaded data file
 Historical trend display sub menu
 Adjusts the display span of the selected channel.Select OFF to return to the original span. (List items like“ABC-1” are tags.)
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 INFORMATION: Shows information about the measured data that is currently displayed
 For an explanation of the other menu items, see section 4.6.
 Sub menu when the alarm summary is being displayed
 Sub menu when the message summary is being displayed
 INFORMATION: Shows information about the measured data that is currently displayed
 For an explanation of the other menu items, see section 4.7.
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 • MovingtheCursorandScrollingtheWaveform
 Cursor
 Cursor value mark
 Moves the cursor up by 1 dot.
 Moves the cursor down by 1 dot.
 Hold down an arrow key to move the cursor by 1 division at a time.
 Use the left and right arrow keys on the horizontal trend display.
 • DisplayingtheContinuingData Approximately one screen of data is shown on the historical trend display. The
 continuing data can be shown as follows:
 Move the cursor to the end of the waveform andcontinue to press the arrow key to shift a half apage and display the continuing data (release number 3 or later).
 Move the cursor to the end of the waveform andcontinue to press the arrow key to shift a half apage and display the continuing data (release number 3 or later).
 Use the left and right arrow keys on the horizontal trend display.
 Displayed
 • SpecifyingtheDisplayRange Specify the display range. Items inside the parentheses are for the horizontal trend
 display.* When you clear the scale (see page 4-9), the screen switching icons appear in its place.
 1. Press the right(up)arrowkey.The waveform of the entire data range is displayed at the right (top) section of the screen.
 All data display (all of the data in the display memory)
 Displayed highlighted. These icons are not displayed if the scale is displayed.
 Frame indicating the display range
 Loads as much of the continuous data as the display memory can hold and shows the data when switching to the all data display (Release number 2 or later).
 2. Press the upanddown(leftandright)arrowkeys to set the display position by moving the frame that indicates the display range. If you hold down one of the arrow keys, the frame that indicates the display range will move continuously in the direction of the arrow that you hold down.
 3. Press the left(down)arrowkey.The specified range is displayed.
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 • IftheDataDoesNotFitintheAllDataDisplay(ReleaseNumber2orLater) Specify the range to be displayed in the all data display. Below is the procedure to display data that is older than the data displayed currently.
 Items inside the parentheses are for the horizontal trend display.
 1. Press the right(up)arrowkey.The waveform of all the data in the display memory is displayed at the right (top) of the screen. At the same time, the data area in the internal memory that can be loaded is displayed. In addition, the data position of 8 MB that is displayed in the all data display is indicated using a rectangular frame in the loadable data area.
 All data display(all the display data in the display memoryamounting to 8 MB)The green arrow indicates that loadable data exists in the arrow direction.A frame indicating the 8 MB that is shown in the all data display.A frame indicating the range shown in the screen.
 Loadable data in the internal memory
 2. Press the down(left)arrowkey to move the frame indicating the display range to the edge of the all data display. If you press the down(left)arrowkey again, the message “Overwrite old data?” appears.
 3. Select Yes and press DISP/ENTER to replace 4 MB of data in the display memory.
 4. Press the up/down(left/right)arrowkey to move the frame indicating the display range to specify the range you want to display.
 5. Press the left(down)arrowkey.The specified range is displayed.
 • DividingtheScreenintoHalvesandDisplayingtheCurrentTrendandHistoricalTrendSimultaneously
 This operation is possible only when the historical trend of the display data is being displayed. Items inside the parentheses are for the horizontal trend display.* This operation is not possible when the scale is displayed.
 Press the left(down)arrowkey. The current trend is displayed in the top half (right half), and the historical trend is
 displayedinthebottomhalf(lefthalfji)ofthescreen.
 Current trend
 Historical trend
 To revert to the original screen, press the right(up)arrowkey.
 • WritingAddMessages For the operating procedure, see section 5.4.
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
 • DisplayingMeasuredDatafromtheSpecifiedDateandTime(Releasenumber3orlater)
 You can searchformeasureddatafromthespecifieddateandtimeanddisplaytheresults. You can search the display data or event data in the DX internal memory.
 1. Press DISP/ENTER to show the display selection menu.
 2. Select DATASEARCH using the arrowkeys, and then press DISP/ENTER. A calendar appears for the month of the data at the cursor position.
 3. Use the arrowkeys and the softkeys to change the date, and then press DISP/ENTER.If there is display data and event data at that date, a data type selection window appears.
 Changes the displayed year
 Changes the displayed month
 Red square: Indicates the selected dayUse the up, down, left, and right arrow keysto move the red square and select a day.
 D: Indicates that there is display dataE: Indicates that there is event data
 SearchableRange You can search for data between the year 2000 and the year 2079.
 Appearanceof“D”and“E” “D”appearswhenthereisdisplaydataforthespecifieddayandtheDXis
 configuredtorecorddisplaydata(seesection6.1fordetails). “E”appearswhenthereiseventdataforthespecifieddayandtheDXis
 configuredtorecordeventdata(seesection6.1fordetails).
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 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
 4. Select Display or Event, and press DISP/ENTER.A search time input window appears.
 5. Enter the time you want to search for, and press DISP/ENTER.If there is data for the time that you specify, the data appears in the historical trend display.
 Display Example
 DisplayConditions• Thecursorislocatedatthetimethatyouspecifyforthesearch.• Allotherdisplayconditionsarethesameasthoseofthedisplaybeforethesearch.• Ifthereisnodataatthedateandtimethatyouspecify,datafromalatertimeinthe
 same day is displayed. If there is no such data, an error message appears.• Ifthedisplaygroupthatwasbeingdisplayedbeforethesearchdoesnotexistinthe
 datathatyouhavespecified,thedisplaygroupinthedatawiththelowestnumberis displayed.
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 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
 • Youcanconfigurethecalendar so that weeks start with Sunday or Monday. Procedure Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to
 basic setting mode), and select the Menu tab > TimeSettings > Calendardisplay > 1stweekday.
 You can set the firstweekday(thedaythatappearsonthefarleftsideofthecalendar) to SUN (Sunday) or MON (Monday).
 • Signature(OnlyonDXswiththe/AS1advancedsecurityoption) See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
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 Explanation• ALLCHANNEL/GROUPCHANNEL In the group display, the waveforms of the channels that are registered to the group
 are displayed. In the all channel display, the waveforms of all channels that have been set to be recorded are displayed on the current group display. The waveforms of channels that are not registered to the group are displayed, without any additional information, in the waveform display area.
 The waveforms of allchannels are displayed.
 • AUTOZONE Displays trend waveforms separately by assigning display areas (zones) to the set
 channels. With AUTO ZONE OFF With AUTO ZONE ON
 Waveform display area is divided evenly.
 • SCALEON/OFF Select whether to display the scale. The current value mark of the scale indicates the
 value at the cursor position. With SCALE ON With SCALE OFF
 Scale
 Cursor position mark
 Time axis
 Time axis expansion/reduction rate
 Screen switching icons
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 FINEGRID With FINE GRID OFF With FINE GRID ON
 Fine grid
 • TAGDETAIL WhenTAGDETAILissettoONandatagdoesnotfitintothetypicaltagdisplay
 space, it covers the alarm and measured values so that it can be displayed completely. Ifthetagcommentandnumberdonotfitwithinadisplayarea,theycanbescrolled.The TAG DETAIL setting made in one display affects the settings in all of the other displays.
 Thefigurebelowshowsanexampleforwhensixchannelsarebeingdisplayed. WhentheTagNumberIsNotDisplayed If TAG DETAIL is on, the tag comment is displayed as much as possible. With TAG DETAIL OFF With TAG DETAIL ON
 Tag comment Tag comment
 WhentheTagNumberIsDisplayed When TAG DETAIL is set to off, display priority is given to the tag number. If TAG
 DETAIL is on, the tag number and comment are displayed as much as possible. With TAG DETAIL OFF With TAG DETAIL ON
 Tag no. Tag no.
 Tag comment
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 • MESSAGEDISP1,MESSAGEDISP2 Switch between message displays.
 • CURSORVALUE/DIGITALMAX/MIN Switchbetweennumericdisplays. With DIGITAL MAX/MIN With CURSOR VALUE
 The maximum and minimum measuredvalues at the cursor position
 The maximum and minimum waveformvalues in the current display
 Display data: Shows the maximum value at the cursor positionEvent data: Shows the measured value at the cursor position
 • CURSORTIME With CURSOR TIME ON
 The time at thecursor position
 • ABSOLUTETIME/RELATIVETIME With ABSOLUTE TIME With RELATIVE TIME
 The time when the datawas recorded The time that has elapsed
 since memory start•
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)

Page 150
						

4-20 IM 04L41B01-01E
 • TOPCHANNEL(Releasenumber3orlater) The following example is for when the top channel is set to channel 3. The displayed
 scale marker and grid are those of the channel selected as the top channel. If you switch from the trend history display to another display, the top channel setting
 is cleared. Channels other than the top channel are displayed in their assigned order within their group. (The order set by pressing MENU and then selecting the MENU tab > Groupset,Tripline).
 Channel 3
 • AUTOSPAN(Releasenumber3orlater) Before AUTO SPAN Using AUTO SPAN for channel ABC-1
 Channel ABC-1
 Channel ABC-1
 • TIMEAXIS>ZOOM+andZOOM-The time axis can be expanded or reduced around the cursor position.• Displaydata: 2timesthetrenddisplayto1/60minimum• Eventdata: Reductiononly,upto1/60minimum Theminimummagnificationandthefactorbywhichthedisplaycanbeexpanded
 or reduced with one operation vary depending on the trend interval for the display data and on the sampling interval for the event data. To expand or reduce further, repeat the procedure.
 With TIME AXIS ZOOM+ With TIME AXIS ZOOM-
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 • INFORMATION(InformationontheDisplayedMeasuredData) The following information is displayed.
 Page switch markUse the left and right arrow keys to switchthe page.
 Display DescriptionFile name Data in the internal memory is displayed as “Memory.” For a file on
 the external storage medium, the file name is displayed.File type Display corresponds to display data, and Event corresponds to
 event data.Serial number The serial number of the DX that was used.Batch number, Lot number Displayed when the file is created using the batch function.Start time, End time The start time and end time of recording.User name Name of the user who performed the operation. Displayed when the
 login function or /AS1 advanced security option was used.
 Comment A comment (when the batch function is in use).Text field A text field (when the batch function is in use).Signature Signature data (when the /AS1 advanced security option is in use).
 NoteWhen measured data on the external storage medium is displayed, the serial number corresponds to that of the DX that was used to save the data.
 • BackgroundColoroftheHistoricalTrend You can change the background color of the historical trend. For the procedure to change the background color of the historical trend, see section
 5.13.
 4.3DisplayingPastMeasuredData(HistoricalTrendDisplay)
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 4.4 DisplaytheStatusesofAllChannelsonOneScreen(OverviewDisplay)
 This section explains how to use the overview display.For a description of the function, see section 1.3.
 Procedure• ShowingtheDisplay
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the arrowkeys to select OVERVIEW, and press DISP/ENTER.The display appears.
 • ChangingtheDisplayedContents1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrowkey to display the sub menu.
 3. Press the upanddownarrowkeys to select the sub menu item.
 Overview display sub menu
 JUMP TO TREND: Switches to the trend display of the smallest group number that includes the channel selected with the cursor.JUMP TO DIGITAL: Switches to the digital display of the smallest group number that includes the channel selected with the cursor.JUMP TO BAR: Switches to the bar graph display of the smallest group number that includes the channel selected with the cursor.
 JUMP TO ALM SUM: Switches to the alarm summary
 CURSOR OFF: Clears the cursorCURSOR ON: Displays the cursor
 (Not displayed with the default settings. To display, see section 5.17)
 TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display.(Appears when Tag Number is set to Use. See section 5.2 for details.)
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 • ShowingtheTrend,Digital,BarGraphDisplayContainingtheSpecifiedChannel1. Press the arrowkeys to move the cursor, and select a channel.
 Cursor (white Frame)
 2. Switch to the trend, digital, or bar graph display according to the procedure described in “Changing the Displayed Contents.”
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 • IndividualAlarmACKOperation(OnlyonDXswiththe/AS1advanced securityoption) You can perform alarm ACK on individual alarms. This operation is referred to as
 “individual alarm ACK.” Individual alarm ACK can be performed when the settings are configuredintheexactmannerdescribedbelow.• Basicsetting>IndicatorissettoHold. For the setting procedure, see section 3.5.• Relay>RelayActiononAckissettoReset. For the setting procedure, see section 3.5 in the DX2000 User’s Manual.• AnnunciatorModeissettoOff. For the setting procedure, see section 3.12 in the DX2000 User’s Manual.
 1. Use the arrowkeys to move the cursor to a channel with active alarms.
 2. Press DISP/ENTER to show the display selection menu.
 3. Press the rightarrowkey to display the submenu.
 4. Use the arrowkeys to select an alarm, and press DISP/ENTER. The alarm output is released.
 Select a channel with active alarms.
 Select the alarm that you want to acknowledge.
 4.4DisplaytheStatusesofAllChannelsonOneScreen(OverviewDisplay)

Page 154
						

4-24 IM 04L41B01-01E
 • TAGDETAIL The same as the TAG DETAIL setting in other displays. The following example is for the DX1012 OVERVIEW display. WhentheTagNumberIsNotDisplayed(theTAGDETAILdoesnotappear) Tag comments are displayed.
 Tag comment
 WhentheTagNumberIsDisplayed When TAG DETAIL is set to off, display priority is given to the tag number. If TAG
 DETAIL is on, the tag number and comment are displayed as much as possible. With TAG DETAIL OFF With TAG DETAIL ON
 Tag no.
 Tag no.
 Tag comment
 4.4DisplaytheStatusesofAllChannelsonOneScreen(OverviewDisplay)
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 4.5 DisplayingVariousInformation
 This section explains how to display reports (/M1 and /PM1 options) and how to use the status display.For a description of the function, see section 1.3.
 Procedure• ShowingtheDisplay
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the upanddownarrowkeys to select INFORMATION.
 3. Press the rightarrowkey to display the sub menu.
 4. Press the upanddownarrowkeys to select the sub menu item.To close the menu without changing the displayed contents, press the ESC key.
 Information display submenu
 MODBUS CLIENT: Displays the Modbus client statusMODBUS MASTER: Displays the Modbus master statusRELAY: Displays the relay status
 REPORT DATA: Displays report data
 ALARM SUMMARY: Displays an alarm summary See section 4.6.
 (Not displayed with the default settings. To display, see section 5.17.)
 MESSAGE SUMMARY: Displays a message summary See section 4.7.MEMORY SUMMARY: Displays a memory summary See section 4.8.
 EVENT SWITCH: Displays the status of the event level switches.
 COLUMN BAR: Displays report data using stacked bar graphs
 5. Press DISP/ENTER.The display appears.
 • DisplayingtheReport • SwitchingtheDisplayedReportData
 The Index item on the report display shows “the number of the report data being displayed/the number of report data saved in the internal memory.” The largest report data number corresponds to the most recent report data.
 Number of the report data being displayedNumber of report data saved to the internal memory
 Start: Start date/time (Date/time of memory start)Timeup: Report date/time
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 Carry out the procedure below to switch the displayed report data. Uparrowkey: Report data being displayed + 1. Downarrowkey: Report data being displayed – 1. Leftarrowkey: Report data being displayed + 10. Rightarrowkey: Report data being displayed – 10.
 NoteThe display is not updated even if a new report is created while displaying the report data. Perform either of the operations below to display the most recent report data.• Holddowntheleftarrowkey until the latest report data is displayed.• PressDISP/ENTER and display the report data again from the display selection menu.
 • SwitchingtheReportChannels Up to 12 report channels can be shown on one screen. If there are more than 12
 report channels, you can switch the displayed report channels.
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrowkey to display the sub menu.
 3. Press the upanddownarrowkeys to select CHANGEREPORTCH.
 4. Press DISP/ENTER.The displayed report channels are switched.
 • RelayStatusDisplayLists the statuses of the alarm output relays and internal switches. You cannot change the settings on this display.
 Red: ON Green: OFF
 • ModbusStatusDisplay Lists the statuses of the Modbus client or Modbus master commands. For the operating procedure, see the Communication Interface User’s Manual,
 IM04L41B01-17E.
 Communication conditions
 Status Command
 Communication destination DX channels
 4.5DisplayingVariousInformation
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 • EventLevelSwitchStatusDisplay(Releasenumber3orlater) Displays the status of the event level switches. You cannot perform operations in this
 display.
 Red: On Green: Off
 4.5DisplayingVariousInformation

Page 158
						

4-28 IM 04L41B01-01E
 4.6 UsingtheAlarmSummary
 This section explains how to use the alarm summary.For a description of the function, see section 1.3.
 Procedure• ChangingtheDisplayedContents
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrowkey to display the sub menu.
 3. Press the upanddownarrowkeys to select the sub menu item.
 ASCENDING ORDER: Sorts in ascending orderDESCENDING ORDER: Sorts in descending order
 CHANGE SORT KEY: Sorts alarm information by channel or alarm time
 TO HISTORY (DISP): Switches to the display data historical trend displayTO HISTORY (EV): Switches to the event data historical trend display
 Display name: Switches to the specified display
 Sort symbol
 TO OVERVIEW: Switches to the overview display
 TAG DETAIL ON: When a tag does not fit into the typical tag display space, the alarm and measured values are covered so that the tag can be displayed completely.TAG DETAIL OFF: Priority is not given to tag display.
 Ascending sort Descending sort
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 • MovingtheCursor( )andScrollingtheAlarms
 Scrolls the alarm information up by half a pageMoves the cursor up
 Scrolls the alarm information down by half a page
 Moves the cursor down
 • RecallingtheHistoricalTrendDisplayatthePointWhentheAlarmOccurred1. Select an alarm with the cursor.
 2. Display the historical trend according to the procedure described in “Changing the Displayed Contents.”
 Explanation• CHANGESORTKEY,ASCENDINGORDER,andDESCENDINGORDER
 The alarms are sorted in ascending or descending order by the following keys. The sort symbol is displayed next the sortitem(seethefigureabove).• Channelnumber: Sortsthealarmsbychannelnumbereveniftagsarebeing
 used. Alarms in a channel are sorted by the alarm level number.• Timeofalarmoccurrence/release
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 4.6UsingtheAlarmSummary
 • TAGDETAIL The same as the TAG DETAIL setting in other displays. WhentheTagNumberIsNotDisplayed When TAG DETAIL is on, tag comments are displayed in their entirety. With TAG DETAIL OFF With TAG DETAIL ON
 Tag comment Tag comment
 WhentheTagNumberIsDisplayed Tag numbers and comments are displayed.
 Tag no.
 Tag comment
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 4.7 UsingtheMessageSummary
 This section explains how to use the message summary.For a description of the function, see section 1.3.
 Procedure• ChangingtheDisplayedContents
 1. Press DISP/ENTER to show the display selection menu.2. Press the rightarrowkey to display the sub menu.3. Press the upanddownarrowkeys to select the sub menu item.
 CHANGE DISP ITEM: Switches between displaying message times and groups and displaying the message user names
 ASCENDING ORDER: Sorts in ascending orderDESCENDING ORDER: Sorts in descending order
 DISP GROUP OFF: Displays the second of the time when the messages were writtenDISP GROUP ON: Displays the groups to which the messages were written CHANGE SORT KEY: Sorts messages by message number, time, group, or user name
 TO HISTORY (DISP): Switches to the display data historical trend display
 Display name: Switches to the specified display
 TO HISTORY (EV): Switches to the event data historical trend display
 Sort symbol Ascending sort Descending sort
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 • MovingtheCursor( )andScrollingtheMessages
 Scrolls the messages up by half a pageMoves the cursor up
 Scrolls the messages down by half a page
 Moves the cursor down
 • RecallingtheHistoricalTrendDisplayatthePointWhentheMessageWasWritten1. Select a message with the cursor.2. Display the historical trend according to the procedure described in “Changing the
 Displayed Contents.”
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 Explanation• CHANGEDISPITEM
 Switches between the following two message display methods.• Message,time,andgroup,orthesecondofthedateandtimewhenthemessage
 was written• Message,username
 • CHANGESORTKEY,ASCENDINGORDER,andDESCENDINGORDERThe messages are sorted in ascending or descending order by the respective key. The sort symbol is displayed next the sortitem(seethefigureabove).
 • DISPGROUPOFF/ON You can select what is displayed on the right of the screen: the groups that the
 messages were written to or the second of the time when the messages were written.
 4.7UsingtheMessageSummary
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 4.8 UsingtheMemorySummary
 This section explains how to use the memory summary.For a description of the function, see section 1.3.
 Procedure• ChangingtheDisplayedContents
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrowkey to display the sub menu.
 3. Press the upanddownarrowkeys to select the sub menu item.
 REPORT SAVE: Saves all report dataM.SAMPLE SAVE: Saves all manually sampled data
 SELECT SAVE: Saves the selected fileDATA SAVE MODE: Switches to data save mode
 ALL SAVE: Saves all data(Not displayed with the default settings. To display, see section 5.17.)
 FILENAME DISPLAY: Displays the file name For information about file names, see section 1.4.TIME DISPLAY: Displays the times of the first and last items of data in the file
 TO HISTORY: Switches to the historical trend display
 Display name: Switches to the specified display
 CHANGE DATA KIND: Switches between display data and event data
 The displayed data type isindicated with a green mark.
 4. Press DISP/ENTER to change the displayed contents.To close the menu without changing the displayed contents, press the ESC key.
 • MovingtheCursor( )andScrollingtheMemoryInformation
 Scrolls the memory information up by half a pageMoves the cursor up
 Scrolls the memory information down by half a page
 Moves the cursor down
 • DisplayingtheHistoricalTrendfortheDataSpecifiedbyMemorySummary1. Select the data with the cursor.
 2. Display the historical trend according to the procedure described in “Changing the Displayed Contents.”
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 • SavingtheData SavethedataintheinternalmemorytotheCFcardortheUSBflashmemory(/USB1
 option). For a description of the function, see section 1.4.
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrow key to display the submenu.
 3. Select DATASAVEMODE with the upanddownarrowkeys.
 4. Press DISP/ENTER.
 The display switches to DATA SAVE MODE.
 5. To save a specified file, select it with the cursor. This operation is not necessary in other cases.
 Cursor(move with the arrow keys)
 6. Press DISP/ENTER to show the display selection menu.
 7. Use the upanddownarrowkeys to select SELECTSAVE, ALLSAVE, M. SAMPLESAVE, or REPORTSAVE.
 8. Press DISP/ENTER.* If you are using a CF card and a USB flash memory (/USB1 option), the message “Which
 media do you want save to?” appears. Select the destination medium using the arrowkeys, and press DISP/ENTER.The measured data is saved.
 NoteTo abort the data saving operation in progress, carry out the procedure below.Press FUNC and press the SaveStop soft key.
 4.8UsingtheMemorySummary
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 ProgressDisplayWhenSavingAllDataoftheInternalMemory(ReleaseNumber2orLater)If you carry out All Save* on the memory summary screen, a pop-up window appearsshowing the progress of the save operation.
 * Function for saving all data in the internal memory to a CF card or USB flash memory.
 Note• Thepop-upwindowappearsonlywhenthememorysummarydisplayisshowing.• IfyoupresstheESCkey,thepop-upwindowclearstemporarilyandreappears
 approximately 10 seconds later.• Thetimeestimateforsavingalldataisindicatedinthetablebelow(whenthememoryisfull
 of data). It may take longer depending on the operating conditions of the DX.SaveDestination
 TimetoSaveAllData(Estimate)CF Card USB Flash Memory
 Standard memory (internal memory size suffix code -3) 20 minutes 40 minutes
 • Toabortthedatasavingoperationinprogress,carryouttheprocedurebelow. Press FUNC and press the SaveStop soft key.
 • DisplayingFileInformation(OnlyonDXswiththe/AS1advanced securityoption) See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 Explanation• Savedirectory
 • Thedataissavedbycreatingadirectoryeachtimethesaveoperationiscarriedout.
 Directoryname:Specifiedstring_YYMMDD_HHMMSS(whereYYtoSSisthedateof operation)
 Save directory
 File list example
 • Displaydataoreventdatathatisintheprocessofaddingdatacannotbesaved.• Thesaveoperationexplainedheremerelycopiesthedataintheinternalmemory.
 It does not save the unsaved data in the internal memory (see section 1.4).• Datasavingisabortedwhenthereisinsufficientfreespaceonthestoragemedium.
 Useastoragemediumwithsufficientfreespacewhensavingdata.
 4.8UsingtheMemorySummary
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 4.9 DisplayingaListofOperationLogs
 Displays the following operation logs.Login log*1, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP log, Modbus status log, operation log*2, and change settings log*2
 *1 Only on DXs without the /AS1 advanced security option*2 Only on DXs with the /AS1 advanced security option
 Procedure• DisplayingtheLog
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the upanddownarrowkeys to select LOG.* To show LOG on the menu, see section 5.17.
 3. Press the rightarrowkey to display the sub menu.
 4. Press the upanddownarrowkeys to select the sub menu item.To close the menu without changing the displayed contents, press the ESC key.Sub menu items are LOGIN, ERROR, COMMUNICATION, FTP, MAIL, WEB, SNTP, DHCP, and MODBUS.
 5. Press DISP/ENTER.The display appears.
 Explanation• LoginLog This log is only for DXs without the /AS1 advanced security option. DXs with the /AS1
 advanced security option use the operation log.
 The log number of the last line and the total number of logs
 User name
 Operation method (see the table below) Operation (see the table below) Date/time
 Action DescriptionLogin LoginLogout LogoutNewTime Time change while memory is stoppedTimeChg Time change through key operationPowerOff Power OFF (power failure occurred)PowerOn Power ON (recovered from a power failure)TrevStart StarttheoperationofgraduallyadjustingthetimeTRevEnd EndtheoperationofgraduallyadjustingthetimeTimeDST Switch the daylight savings timeSNTPtimset Time change by SNTPTimeDST Switch to or out of daylight saving timeCCSetEnd Completion of calibration correctionCCExpire Passing of the calibration due date without calibration having been completed
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 Factor DescriptionKEY Key operationCOM Operations via communicationREM Operation through the remote control functionACT Operation through event actionSYS Operation by the system
 • ErrorLog
 Error message* Error code* Date/time
 * See section 10.1, “A List of Messages.”
 • CommunicationLog
 Message* Input/output symbol (>: input, <: output)
 User ID number (0: serial, 1 to 3: Ethernet) Date/time
 * See the Communication Interface User’s Manual, IM04L41B01-17E.
 • FTPLog
 File Name FTP connection destination (P: primary, S: secondary) Error message (detail code)* Date/time
 * See section 10.1, “A List of Messages.”
 4.9DisplayingaListofOperationLogs
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 • WebLog
 Operation (see the table on the next page) Error code* Requested operation (see the table below) Date/time
 * See section 10.1, “A List of Messages.”
 Request DescriptionScreen Screen switchKey Key operationMessage Message assignment/writeBatch Screen Multi batch function (/BT2 option) screen change
 Parameter DescriptionTREND Trend displayDIGIT Digital displayBAR Bar graph displayHIST Historical trend displayOV Overview displayDISP DISP/ENTER keyUP Up arrow keyDOWN Down arrow keyLEFT Left arrow keyRIGHT Right arrow keyFAVOR Favorite keyMessages Character strings that have been writtenData Ref Searches for data from a specific date and time and displays the data in
 the historical trend display.
 • E-mailLog
 Recipient (mail address, message) Recipient (1: recipient 1, 2: recipient 2) Error code* Event (see the table below) Date/time
 * See section 10.1, “A List of Messages.”Type DescriptionAlarm Alarm mailTime Scheduled mailReport Report timeout mailFail Power failure recovery mailFull Memory full mailTest Test mailError Error message mailUser locked Invalid user mail (only on DXs with the /AS1 advanced security option)
 4.9DisplayingaListofOperationLogs
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 • SNTPLog
 Error message (detail code)* Error code* Date/time
 * See section 10.1, “A List of Messages.”
 • DHCPLog
 Error message (detail code)* Error code* Date/time
 * See section 10.1, “A List of Messages.”
 • ModbusStatusLog
 Command number, command type (R: read, W: write) Communication status* Communication type (C: client, M: master) Date/time
 * See the Communication Interface User’s Manual, IM04L41B01-17E.
 4.9DisplayingaListofOperationLogs
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 • OperationLog(OnlyonDXswiththe/AS1advancedsecurityoption)
 To switch displays, in the display selection menu, select LOG > CHANGE DISP ITEM, and press DISP/ENTER.
 Operation type*User nameOperation*Date and time
 Detailed display
 Additional information displayWhen you move the cursor to an item that has additional information, the Add.info. soft key appears at the bottom of the screen. Press the soft key to display the additional information. The additional information is displayed using the command syntax.See the Communication Manual, IM04L41B01-17E.
 Press ESC to close the additional information display.
 Cursor (blue arrow)Move the cursor with the arrow keys.
 * See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 • ChangeSettingsLog(OnlyonDXswiththe/AS1advancedsecurity option)
 Operation type (see the table below)User nameSaved setup file nameDate and time
 Operationtype DescriptionK Key operationsC Communication operations
 4.9DisplayingaListofOperationLogs
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 4.10 DisplayingStackedBarGraphs(/M1and/PM1options;releasenumber3orlater)
 This section explains how to use stacked bar graphs.
 Procedure• ChangingtheDisplayedContents
 1. Press DISP/ENTER to show the display selection menu.
 2. Press the rightarrow key to display the submenu.
 3. Press the upanddownarrowkeys to select the sub menu item.
 REPORT GROUP 1 through 6*: Select the report group that you want to display.* Varies according to the model. For information about report groups, see section 9.5.
 SELECT GROUP: Use the arrow keys to switch between displayed report groups.SELECT COLUMN: Use the arrow keys to select a bar graph.
 SINGLE GRAPH: Displays a single graphDUAL GRAPH: Displays two graphs
 Display name: Switches to the specified display
 4. Press DISP/ENTER to change the display setting. To close the menu without changing the display contents, press ESC.
 • ChangingGroups,SelectingBarGraphs,andMovingtheCursor The amount of data that the up and down arrow keys scroll through depends on the
 type of report data. For example, with an “H+D” report, you can use the arrows to scroll through the data one day at a time.
 SELECT GROUP: Switches to the display for the report group with the next smallest numberSELECT COLUMN: Moves the bar graph selection cursor to the leftSwitches to the previous day, week, or month's data
 SELECT GROUP: Switches to the display for the report group with the next highest numberSELECT COLUMN: Moves the bar graph selection cursor to the rightSwitches to the next day, week, or month's data
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 Explanation• SINGLEGRAPH/DUALGRAPH Youcandisplayoneortwobargraphs.Thesumsofthefirstchannelinagroupandof
 all other channels that have the same unit as it are displayed.• SINGLEGRAPH
 Numeric display section
 Display area 1 Display area 2
 The displayed report data varies depending on the report kind, which is set using the report function.
 Reportkind DisplayArea1 DisplayArea2Hour, H+D Sums for each hour Sums for the dayDay+Week Sums for each day Sums for the weekDay, D+M Sums for each day Sums for the month
 • DUALGRAPH Shows the data from two consecutive periods at the top and bottom of the display.
 Channel number or tagNumbers are abbreviated.
 Display area 1
 Display area 2
 Display area 4
 Display area 3
 The displayed report data varies depending on the report kind, which is set using the report function. Display areas 1 and 2 contain the same report data listed above for SINGLE GRAPH display.
 Reportkind DisplayArea1 DisplayArea2 DisplayArea3 DisplayArea4Hour, H+D Sums for each
 hourSums for the day Sums for each
 hourSums for the day
 (The data of the day before the data in display areas 1 and 2)
 Day+Week Sums for each day
 Sums for the week
 Sums for each day
 Sums for the week
 (The data of the week before the data in display areas 1 and 2)
 Day, D+M Sums for each day
 Sums for the month
 Sums for each day
 Sums for the month
 (The data of the month before the data in display areas 1 and 2)
 4.10DisplayingStackedBarGraphs(/M1and/PM1options;releasenumber3orlater)
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 Note The numbers on the vertical axis of display areas 3 and 4 and the dates on the horizontal
 axis are abbreviated. Display areas 3 and 4 can only display the data from the period immediately preceding that
 of display area 1 and 2.
 • SelectingaBar When SINGLE GRAPH is selected, you can move the cursor to a bar that you want to
 check, and view the sums of each channel.
 The sums of each channel and the sums of all channels of the report group at the cursor position
 Cursor
 • PowerFailureandTimeAdjustmentIndications
 Indicates a power failureA "C" appears if more than onereport has been filed for thesame time period.
 • Powerfailure A “P” indicates when a power failure occurred and a report was supposed to be
 filed.A“P”alsoindicateswhentheDXrecoveredfromapowerfailureandthenextreportwasfiled.
 • Timeadjustment Whenatimeadjustmentcausesareporttobefiledtwicebecausethetimewas
 movedback,thetimeadjustmentismarkedwitha“C,”andthebargraphofthereportthatwasfiledfirstisused.
 Ifthedataforaperioddoesnotexistbecauseofapowerfailureortimeadjustment,abar graph for the period will not be displayed.
 4.10DisplayingStackedBarGraphs(/M1and/PM1options;releasenumber3orlater)
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 5.1 SettingDisplayGroups
 Assign channels and set the group name for each display group. Set lines at specified positions in the waveform display range on the Trend display.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Groupset,Trip
 line.
 SetupItems• Groupnumber Select the target group number (1 to 10).
 • Group • On/Off
 Turn On the groups you want to use. • Groupname
 Set the group name. (up to 16 characters, A a # 1 ) • CHset
 Set up to six channels from measurement channels and computation channels (/M1 and /PM1 options).• Enterthechannelnumberusingtwoorthreedigits.• Separateeachchannelwithaperiod.• Tospecifyarangeofconsecutivechannelsnumbers,useahyphen. Example: To assign channels 1 and 5 to 8, enter “001.005-008.”
 Note• Thetrend,digital,andbargraphdisplaysareshowninthespecifiedorder.• Achannelcanbeassignedtomultiplegroups.• Thesamechannelcannotbeassignedmultipletimesinagroup.
 Chapter5 OperationsforChangingtheDisplayedContents
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 NoteThe channel settings of a display group can be copied to another group on a DX with release number 2 or later.
 Procedure1. Select the copy source channel settings.2. Press the Copy soft key.3. Select the copy destination channel settings.4. Press the Paste soft key. The channel settings are copied.
 • Tripline SetlinesatspecifiedpositionsinthewaveformdisplayrangeontheTrenddisplay. • On/Off
 Turn On the trip lines you want to display. • Position
 Set the position in the range of 0 to 100% of the display width. • Color
 The default colors are red, green, blue, and yellow. If you want to change the color, select from the 24 available colors.
 • Width Set the line width of the trip line in dots (1 to 3).
 5.1SettingDisplayGroups
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 5.2 DisplayingTagsorChannelNumbers
 Display the channels using tags or channel numbers. On DX release numbers 3 and later, tags have tag numbers and tag comments. The tag number is a fixed number that corresponds to the measurement source. The tag comment can be used to list details about the channel. You can choose whether or not to use tag numbers.
 SetupScreen• Tag/Channel Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
 basic setting mode), and select Environment > OperatingEnvironment.
 • TagNumberUse/Not(Releasenumber3orlater) Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Input,Alarm.
 • Tag Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Tag,Memory,Delay.
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 SetupItems• Operatingenvironment>Tag/Channel This setting applies to all channels.
 Setting DescriptionTag Displays tag numbers and comments. • Ifanallotteddisplayspaceisnotlargeenoughtodisplayatagnumberandatag
 comment, priority is given to the tag number. • Dependingondisplayspacelimitations,itmaynotbepossibletodisplaythe
 entire tag. • Ifachannelisnotconfiguredtodisplaytagnumbersorcomments,thechannel
 number is displayed.
 Channel Displays channel numbers.* Tag numbers are available for release numbers 3 and later.
 • TagBasicsettings>TagNo.Use/Not(Releasenumber3orlater) To display tag numbers, select “Use.” This setting applies to all channels.
 • First-CH,Last-CH Set the target channels. The target channels are common with the other items that are
 displayed on the screen.
 • Tag>Comment Sets the tag comment. On a DX with a release number of 3 or later, you can enter up
 to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 16 characters. The characters that can be entered are: A a # 1 .
 • Tag>No.(Releasenumber3orlater) This setting only appears when you have enabled the use of tag numbers. Sets the tag number. (Up to 16 characters: A a # 1 )
 • ItemsDisplayedforDifferentTagandChannelSettings Textisdisplayeddependingonthetagandchannelsettingsasshowninthefigure
 below.OperatingEnvironment
 TagBasicSettings
 Tag*1 DisplayedText
 Tag/Channel TagNo.Use/Not
 TagNo. TagComment
 Channel Number
 TagNumber
 TagComment
 Tag Use Input Input No Yes YesNot input No Yes No
 Not input Input Yes*2 No YesNot input Yes No No
 Not — Input No No YesNot input Yes No No
 Channel Use — — Yes No NoNot — — Yes No No
 “Yes” means that the item is displayed“No” means that the item is not displayed
 *1 “Input” means that characters are input. “Not input” means that no characters are input. “—“ means that the setting does not affect the display.*2 Channel numbers are displayed instead of tag numbers.
 5.2DisplayingTagsorChannelNumbers
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 5.3 SettingtheTrendIntervalandSwitchingtotheSecondaryTrendInterval
 Set the trend interval. Switch the trend interval to the secondary trend interval while the memory sampling is in progress. Automatically write messages when the trend interval is switched.For a description of the function, see section 1.3.
 SetupScreen• SwitchingtheTrendIntervalandWritingMessages(WhenUsingtheSecondaryTrendInterval)
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > View,Message.
 • Trendinterval[/div]andSecondaryinterval[/div] Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/
 Saveinterval.
 SetupItems• View>Trendrateswitching On: Enables the function that switches the trend interval while the memory sampling
 is in progress. The “Second interval [/div]” item is displayed in the setting mode.* When the trend rate switching function is On, the DX cannot be configured to record both the
 display and event data (see section 6.1).
 • Message>Changemessage On: Writes the time the interval is switched and the new trend interval as a message
 when the trend interval is switched. On DXs with the /AS1 advanced security option, a message is written even when the
 setting mode setup items are changed during memory sampling.Item MessageAlarm setting change AlarmSetAlarm delay time change AlmDlaySetCalibration change Calibration correction Setting
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 • Trendinterval[/div]andSecondinterval[/div] Select the time corresponding to 1 division of the time axis on the trend display from
 below: You cannot specify a trend interval that is faster than the scan interval. 5s*1, 10s*1, 15s*2, 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, and
 10h*1 Selectable on the DX1002, DX1004, DX1002N, and DX1004N (release number 3 or later).*2 Selectable on the DX1006, DX1012, DX1006N, and DX1012N when the scan interval is set
 to fast sampling mode (release number 3 or later).
 NoteIf the trend interval is set greater than or equal to 1h/div on a DX with release number 2 or later, the month, day, and hour at the grid position are displayed on the screen. The display format can be changed by setting the date format.
 Month, day, and hour at the grid position.
 Procedure• SwitchingtheTrendInterval
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Normalspeed soft key or Secondspeed soft key.The trend interval is switched. A message is written on the trend display (when the change message is turned ON).Display example: 10:53 1min/div
 • ChangingtheTrendDisplayTimeAxisWhileRecording(Memorysampling)IsinProgress(Releasenumber3orlater)
 On a DX whose release number is 3 or later, you can change the secondary trend interval even while recording (memory sampling) is in progress. If you are using the secondary trend interval to display waveforms and you change it, the time axis will change immediately afterwards.
 NoteOnly the displayed time axis changes when you switch to the secondary trend interval. The data sampling interval does not change.
 5.3SettingtheTrendIntervalandSwitchingtotheSecondaryTrendInterval
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 5.4 WritingMessages
 Write messages.
 SetupScreen• MessageWriteGroup Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > View,Message.
 • SettingtheMessages Press MENU (to switch to setting mode), and select the Menu tab > Message.
 SetupItems• Message • Writegroup
 This setting applies only for messages that are written using keys.Settings DescriptionCommon Write the message to all groups.Separate Write the message to the displayed group.
 If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 • Power-failmessage See section 5.16.
 • Changemessage See section 5.3.
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 • MessageNo. Select the message number (1 to 100). Messages 1 to 10 are common with free
 messages.* If a message is changed as a free message, the old message is overwritten.* Messages that are written by creating the message on the spot.
 • Message>Characters Set the message. (up to 32 characters, A a # 1 )
 Procedure• WritingMessages Messages cannot be written when the memory sampling is stopped.
 1. Display the group to write the message.• Ifascreenunrelatedtoagroupsuchastheoverviewisdisplayed,messages
 are written to all groups even when Writegroup is set to Separate.• MessagesarewrittentoallgroupsregardlessofthedisplayedscreenwhenWritegroup is set to Common.
 2. Press FUNC.The FUNC key menu appears.
 3. Press the Message soft key.
 4. Press the softkey corresponding to the desired message number range (example: [1-10]).A list of message is displayed.
 5. Press the softkey corresponding to the number of the message you want to write.A message mark, time, and message are shown on the trend display.
 Message
 5.4WritingMessages

Page 181
						

5-9IM 04L41B01-01E
 Operations for C
 hanging the Displayed C
 ontents
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 • WritingFreeMessages Create a message on the spot and write it.
 1. Display the group to write the message.
 2. Press FUNC.The FUNC key menu appears.
 3. Press the Freemessage soft key.
 4. Press a message number softkey.The message entry window appears.
 5. Enter the message. (up to 32 characters, A a # 1 )
 6. Select ENT and press DISP/ENTER.A message mark, time, and message are shown on the trend display.
 • WritingAddMessages Add messages to the past data positions. This operation can be carried out on the
 past section of the data that is currently being memory sampled.
 1. Carry out the procedure below to show the historical trend of the data that is currently being memory sampled.Press DISP/ENTER and select TRENDHISTORY > (groupname) > DISP/ENTER
 2. Press the arrowkeys to move the cursor to the position you want to write the message.
 3. Write the message according to the procedure given in “Writing Messages” or “Writing Free Messages.” Use the AddMessage or AddFreeMessage soft key.
 Add message
 Cursor (yellow line)
 Explanation• DisplayColorofMessages The message colors on the trend display are shown below. You cannot change them.
 No. 1 2 3 4 5 6 7 8 9 10Color Red Green Blue Blue violet Brown Orange Yellow-green Light blue Violet Gray
 The colors for messages 11 to 100 are repetitions of the colors above.
 • AddMessage• Themessagetimestampisthetimethatthemessageiswritten.Itisnotthetime
 stamp of the data at the position where the message is written.
 Add message (displayed in blue)
 Display example on the message summary
 • Upto50messagescanbewritten.• Messagescannotbeaddedtodataintheinternalmemorythathasalreadybeen
 savedtoafileordatathathasbeenloadedfromtheexternalstoragemedium.
 5.4WritingMessages
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 5.5 ChangingtheChannelDisplayColors
 Change the channel display colors. The settings are applied to the trend and bar graph displays.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Color.
 SetupItems• Groupofchannel Select the target channels.
 • Color To change the color, select from the following 24 colors. Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime,
 cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark gray, olive, dark cyan, and spring green
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 5.6 DisplayingChannelsinDisplayZones
 Specify a waveform display zone for each channel so that waveforms do not overlap.For a description of the function, see section 1.3.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Zone,Scale
 SetupItems• First-CH,Last-CH Select the target channels. The target channels are common with the other items that
 are displayed on the screen.
 • Zone>Lower,Zone>Upper Sets the zone in which the waveform is displayed. You can set Lower and Upper as
 a position (%) when taking the maximum display width to be 100%. Set Upper greater than Lower, and the zone width (Upper–Lower) greater than or equal to 5%.
 Lower: 0 to 95% Upper: 5 to 100%
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 5.7 DisplayingaScaleontheTrendDisplay
 Display a scale on the trend display.For a description of the function, see section 1.3.
 SetupScreen• ScalePositionandNumberofScaleDivisions Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Zone,Scale.
 • NumberofDisplayedScaleDigitsandCurrentValueIndicator Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend.
 • ShowingtheScales To show scales on the trend display, press DISP/ENTER (show the display selection
 menu) > the rightarrowkey (show the sub menu), and select SCALEON (see section 4.2).
 SetupItems• First-CH,Last-CH Select the target channels. The target channels are common with the other items that
 are displayed on the screen.
 • Scale>Position Select the scale display position on the trend display from 1 to 6. Select Off if you do
 not wish to display the scale.
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 • Scale>Division Set the number of divisions to make with the main scale marks on the trend display to
 a value from 4 to 12 or C10. C10: The scale is equally divided into 10 sections by main scale marks, and scale
 values are indicated at 0, 30, 50, 70, and 100% positions on the trend display. Thefigurebelowisanexampleinwhicheachscaleisdisplayedwiththeposition
 shifted. VerticalTrendDisplay
 Number of scale divisions: 4 Number of scale divisions: 5 Number of scale divisions: 6 Number of scale divisions: 7 Number of scale divisions: 8 Number of scale divisions: 9
 Number of scale divisions: 10 Number of scale divisions: 11 Number of scale divisions: 12 Number of scale divisions: C10
 Scale display position
 1 2 3 4 5 6
 HorizontalTrendDisplay
 6 5 4 3 2 1
 Number of scale divisions: 4 Number of scale divisions: 5 Number of scale divisions: 6 Number of scale divisions: 7 Number of scale divisions: 8 Number of scale divisions: 9
 Number of scale divisions: 10 Number of scale divisions: 11 Number of scale divisions: 12 Number of scale divisions: C10
 Scale display position
 5.7DisplayingaScaleontheTrendDisplay

Page 186
						

5-14 IM 04L41B01-01E
 Note• Ifthescalesofmultiplechannelsaresettothesameposition,thescaleofthechannel
 assigned first to the group is displayed. Example: If the order of assignment of a group is 003.002.001, and the scale display
 position of all channels is set to 1, the scale of channel 3 is displayed at display position 1.• Evenifsomeofthescaledisplaypositionsareskipped,thescaleispackedtowardsdisplay
 position 1. Example: Suppose the assignment of channels to a group is 001.002.003, and the display
 positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed at positions 1, 2, and 3, respectively.
 • Thescaleisdividedinto4to12sectionsbythemainscalemarks.Thesectionbetweenthe main scale marks is divided into 5 or 10 subsections by medium and small scale marks. However, small scale marks are not displayed in the following cases.• When the resolution of the input range is smaller than the total number of small scale marks.• Whenzonedisplayisused.• Whenpartialexpandeddisplayisused(numbersaredisplayedattheendsofthescale
 and at the boundary position).• Thescalevaluesaredisplayedaccordingtothefollowingrules.
 • Ifthenumberofscaledivisionsis4to6fortheverticaltrenddisplay,valuesaredisplayed at all main scale marks. If the number of scale divisions is greater, the values are displayed at every other main scale marks.
 • Scaleupperandlowerlimitsaredisplayedattheendsofthescale.• Scalevaluesaredisplayedupto3digitsexcludingtheminussign.However,ifthe
 integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2 digits are displayed.
 Example: If the scale is –0.05 to 0.50, the lower limit is “–0.0” and the upper limit is “0.5.”• Iftheintegerpartofeitherendofthescaleis2or3digits,thefractionalpartistruncated. Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”• Iftheintegerpartofeitherendofthescaleis4ormoredigits,thevalueisdisplayed
 using a 3-digit mantissa and exponent like “×10” or “×102”. Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 × 10”.
 • Theunitisdisplayednearthecenterofthescale.Ifpartialexpandeddisplayisused,the display position is offset from the center. For the vertical trend display, the number of characters that can be displayed is up to six. For the horizontal trend display, the number of characters that can be displayed is up to three. However, if the scale digit display is set to Fine, up to four characters are displayed.
 • Trend>Scale>Digit Fine: For example, if the scale range is “49.0 to 50.0” and you select “Normal,” the
 scale values are displayed using 2 digits (“49” for example, see Note above). If you select “Fine,” the scale values are displayed using 3 digits as shown below.
 • Trend>Scale>Value indicatorThe current value is displayed as a mark or a bar graph.
 Bar graph
 5.7DisplayingaScaleontheTrendDisplay
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 5.8 DisplayingAlarmPointMarksandColorScaleBandontheScale
 Display alarm point marks on the scale. Display the specified range with a color band.For a description of the function, see section 1.3.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Alarmmark or Color scale band. •Alarmmark •Colorscaleband
 SetupItems
 Alarm point mark Color band
 • First-CH,Last-CH Select the target channels. The target channels are common with the other items that
 are displayed on the screen.
 • Alarmmark Displays marks indicating the values of the high and low limit alarms, delay high and
 low limit alarms, and difference high and low limit alarms. This setting is common with the bar graph display.
 • Alarmmark>MarkkindSettings Description MarkAlarm The alarm mark is green under normal conditions. It changes to the
 specified alarm color when an alarm occurs (release number 3 or later; see section 3.7 for details).
 or
 Fixed Displays a fixed color.
 • Alarmmark>IndicateonScale To display alarm point marks, select On.
 • Alarmmarkcolor>Alarm1,Alarm2,Alarm3,andAlarm4 If the Mark kind is set to Fixed, specify the color of the alarm point marks. If one of the colors under Alarmmarkcolor is set to Auto, its corresponding point
 markwillappearinthespecifiedalarmcolor(releasenumber3orlater;seesection3.7 for details).
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 • Color scale band Displaysaspecifiedsectionofthemeasurementrangeusingacolorbandonthe
 scale. This setting is common with the bar graph display. • Colorscaleband>Bandarea
 Settings DescriptionIn Displays the area inside using the color band.Out Displays the area outside using the color band.Off Disables the function.
 • Colorscaleband>Color Set the display color.
 • Colorscaleband>Displayposition>Lower,Upper Specify the display position. Set a value within the span or scale range. Lower: Lower limit of the area. Upper: Upper limit of the area.
 5.8DisplayingAlarmPointMarksandColorScaleBandontheScale
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 5.9 PartiallyExpandingtheWaveform
 Partially expand a waveform (reduce the other sections) on the display.We recommend that you display the scale when viewing partially expanded channels. The numbers for the ends of the scale and the boundary position are displayed, and you can identify the expanded and reduced areas easily. However, numbers are not displayed for other scale marks.For a description of the function, see section 1.3.
 SetupScreen• TurningON/OFFthePartialExpandedDisplayFunction Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > View,Message.
 • PartiallyExpandedDisplayMethod Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Partial.
 SetupItems• View>Partial If you select On, the Partial setup item appears in the setting mode.
 • First-CH,Last-CH Select the target channels.
 • Partial>On/Off To enable partial expanded display, select On.
 • Partial>Expand SetthepositionwherethevaluespecifiedbyBoundary is to be displayed within the
 display span in the range of 1 to 99.
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 • Partial>Boundary Set the value that is to be the boundary between the reduced section and the
 expanded section in the range of “minimum span value + 1 digit to maximum span value – 1 digit.” For channels that are set to scaling, the selectable range is “minimum scale value + 1 digit to maximum scale value – 1 digit.”
 Example: Input range: –6 V to 6V. Expand: 30. Boundary: 0 The –6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V
 to 6 V range is displayed in the 30% to 100% range.
 5.9PartiallyExpandingtheWaveform
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 5.10 ChangingtheDisplayLayout,ClearingoftheWaveformatStart,MessageDisplayDirection,WaveformLineWidth,andGrid
 Change the display layout, clearing of the waveform at start, waveform line width, and grid.For a description of the function, see section 1.3.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend.
 SetupItems• Trend>Direction Set the display direction of the trends to Horizontal, Vertical, Wide, or Split.
 • Trend>TrendclearSettings DescriptionOn Clears the displayed waveform when the memory sampling is started.Off Does not clear the waveform when the memory sampling is started.
 • Trend>Messagedirection Set the display direction of messages to Horizontal or Vertical. When the trend is set
 to Vertical,themessagedirectionisfixedtoHorizontal.
 • Trend>Trendline Set the line width of the trend in dots (1 to 3).
 • Trend>Grid Select the number of grids to be displayed in the waveform display area of the trend
 display.Settings Description4 to 12 Displays a grid that divides the display width into 4 to 12 sections.Auto Displays the same number of grids as the number of scale divisions of the first
 assigned channel of the group.

Page 192
						

5-20 IM 04L41B01-01E
 5.11 ChangingtheBarGraphDisplayMethod
 Change the bar graph display method.For a description of the function, see section 1.3.
 SetupScreen• DisplayDirection Press MENU (to switch to setting mode), and select the Menu tab > Display > Bar
 graph.
 • BasePositionandtheNumberofScaleDivisions Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Bargraph.
 SetupItems• Bargraph>Direction Set the display direction of bar graphs to Horizontal or Vertical.
 • First-CH,Last-CH Set the target channels. The target channels are common with the other items that are
 displayed on the screen.
 • Bargraph>Baseposition Set the base position of bar graphs to Normal, Center, Lower,* or Upper.* The setting is applied when displaying the bar graph and when displaying the current
 value on the scale using the bar graph.* You can select Lower and Upper on DXs with release number 2.
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 WhentheDisplayDirectionoftheBarGraphIsVertical• Normal Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale
 lower limit or scale upper limit), whichever is less Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower
 limit or scale upper limit), whichever is greater Starting point of the bar: Bottom edge• Center Value at the bottom of the bar graph: Same as with Normal. Value at the top of the bar graph: Same as with Normal. Starting point of the bar: Center• Lower Value at the bottom of the bar graph: Span lower limit (or scale lower limit) Value at the top of the bar graph: Span upper limit (or scale upper limit) Starting point of the bar: Bottom edge• Upper Value at the bottom of the bar graph: Same as with Lower. Value at the top of the bar graph: Same as with Lower. Starting point of the bar: Top edge
 Normal Center Lower Upper
 VS
 VL
 VS
 VL
 Vlower
 Vupper
 Vlower
 Vupper
 Vupper: Span upper limit (or scale upper limit)Vlower: Span lower limit (or scale lower limit)VL: Vlower or Vupper, whichever is greaterVS: Vlower or Vupper, whichever is less : Starting point of the bar
 Normal Center Lower Upper
 0.0
 -100.0
 0.0
 -100.0
 –100.0
 0.0
 –100.0
 0.0
 Example: When the span lower and upper limits of the input range are 0.0 and –100.0, respectively
 5.11ChangingtheBarGraphDisplayMethod
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 WhentheDisplayDirectionoftheBarGraphIsHorizontalThe span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the span upper limit (or scale upper limit) becomes the right edge of the bar graph.• Startingpointofthebar Normal: Left edge or right edge, whichever is less Center: Center Lower: Left edge Upper: Right edge
 Center
 Normal
 Upper
 LowerVlower (Vlower < Vupper)
 (Vlower > Vupper)
 Vupper
 Vlower Vupper
 Vlower Vupper
 Vlower Vupper
 Vupper: Span upper limit (or scale upper limit)Vlower: Span lower limit (or scale lower limit) : Starting point of the bar
 ^?^?
 Center
 Normal
 Upper
 Lower
 0.0 –100.0
 0.0 –100.0
 0.0 –100.0
 0.0 –100.0
 Example: When the span lower and upper limits of the input range are 0.0 and –100.0, respectively
 WhenDisplayingtheCurrentValueontheScaleUsingtheBarGraph
 (Vlower < Vupper)
 Center
 Normal
 Upper
 Lower
 Vlower Vupper
 (Vlower > Vupper)
 Normal Center Lower Upper
 Vlower
 Vupper
 • Bargraph>Division Select the number of main scale marks from 4 to 12.
 5.11ChangingtheBarGraphDisplayMethod
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 5.12 ChangingtheBackgroundColoroftheDisplay
 Change the background color of the display. This setting is applied to the operation screens.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Display >
 Monitor.
 SetupItems• Monitor>Background>Display Set the background color of the operation screen to White (default setting) or Black.
 • Monitor>Background>Historicaltrend Select the background color of the historical trend display from the following: Settings: White, Black (default setting), Cream, and Lightgray
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 5.13 AutomaticallySwitchingDisplayGroups
 Automaticallyswitchthedisplayedgroupataspecifiedinterval.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Display >
 Monitor.
 SetupItems• Monitor>Scrolltime Set the switching interval from the available settings between 5 s and 1 min. The
 groups switch in ascending order. Select whether to automatically switch on the display selection menu. See section 4.2
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 5.14 AutomaticallySwitchingBacktotheDefaultDisplay
 Showapresetdisplaywhenthereisnooperationforaspecifictime.
 SetupScreen Press MENU (to switch to setting mode), and select the Menu tab > Display >
 Monitor.
 SetupItems• Monitor>Jumpdefaultdisplay Returns to a presetdisplayifthereisnokeyoperationforaspecifictime.
 Settings Description1min to 1h Time until switching the display.Off Disables the function.
 Procedure• SpecifyingtheDisplaytobeShown
 1. Show the operation display you want to designate.
 2. In the operation mode, press FUNC.The FUNC key menu appears.
 3. Press the Standarddisplay soft key.The display is registered.

Page 198
						

5-26 IM 04L41B01-01E
 5.15 UsingtheFavoriteKey
 Register a frequently used display to the Favorite key and enable the display to be shown through simple operation.
 Favorite key
 START USER FUNC ESC MENUSTOP
 SetupScreen• FAVORITEKeyaction(Releasenumber3orlater) Press MENU (to switch to setting mode), and select the Menu tab > Display >
 FAVORITEKeyaction.
 SetupItems• Action(Releasenumber3orlater)
 Setting DescriptionHistory The historical trend of the currently displayed data appears when you press
 the favorite key.Favorite The displays that have been registered to the favorite key appear when you
 press the favorite key.Select Favorite when you want to register displays to the favorite key and use it to switch between them.
 If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 • Groupdisplay(Releasenumber3orlater) Specify this setting when Action is set to Favorite.
 Setting DescriptionCurrent Of the displays that have been registered to the favorite key, those that
 display groups (the trend, digital, bar graph, and historical trend displays) are displayed using the currently displayed group.
 Saved Registered displays are displayed as they were registered.
 • Timeaxiszoom(Releasenumber3orlater) Specify this setting when Action is set to Favorite.
 Setting DescriptionCurrent Historical trend displays that have been registered to the favorite key are
 displayed using the current time axis zoom.Saved Historical trends are displayed using the time axis zooms that they were
 registered with.
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 Procedure• RegisteringtheDisplay Up to 8 displays can be registered.
 1. In the operation mode, show the display you want to register.
 2. Press FUNC.The FUNC key menu appears.
 3. Press the Favoriteregist soft key. Then, press a registration number softkey.
 4. Press the Regist soft key.A window appears for you to enter the display name.
 * To delete a registration, press the Delete soft key.
 5. Enter the display name (using up to 16 characters, A a # 1 ).
 6. Select ENT and press DISP/ENTER.The display is registered.
 • SwitchingtheDisplay WhenYouSetActiontoHistory The historical trend of the currently displayed data appears when you press the
 favorite key. Press the key again to return to the previous display.
 WhenYouSetActiontoFavorite The displays change in the order that they were registered in each time you press the
 favorite key. Pressing the favorite key after the last registered display appears returns the display to what it was before the favorite key was pressed.
 5.15UsingtheFavoriteKey
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 5.16 WritingaMessageWhentheDXRecoversfromaPowerFailure
 A message is written to the trend display when the DX recovers from a power failure while memory sampling is in progress.
 SetupScreen• Power-failmessage Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > View,Message.
 SetupItems• Message>Power-failmessage
 Settings DescriptionOn A message is written when the DX recovers from a power failure while memory
 sampling is in progress. Display example: 15:12 Power Off 2005/10/25 15:12:57
 Off Disables the function.
 If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
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 5.17 ChangingtheFUNCKeyMenuandDisplaySelectionMenu
 Change the FUNC key menu that appears when the FUNC key is pressed and the display selection menu that appears when the DISP/ENTER key is pressed.If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 SetupScreen• FUNCKeyMenu Press MENU (to switch to setting mode), and select the Menu tab > Menucustomize
 > Function menu.
 Number indicating the display order
 Menu name White: Used Gray: Not used
 • DisplayMenu Press MENU (to switch to setting mode), and select the Menu tab > Menucustomize
 > Displaymenu.
 Separator
 SetupItems• Enabling/DisablingtheFUNCKeyMenu Items whose menu name is white are shown.
 1. Press the arrowkeys to select a menu item.
 2. Press the View or Hide soft key.If you press the Hide soft key, the menu name is displayed in gray, and does not appear in the FUNC key menu.
 • ChangingtheDisplayOrderoftheFUNCKeyMenu Menu items are displayed in order by number. In addition, menu items appear when
 the corresponding function can be used.
 1. Press the arrowkeys to select a menu item.
 2. Press the Select soft key.The menu item is enclosed in a red frame.
 3. Press the arrowkeys to select the destination.
 4. Press the Transfer soft key.The menu item moves to the selected number position.
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 • DescriptionoftheFUNCKeyMenus For a description of each item, see section 4.1.
 • Enabling/DisablingtheDisplaySelectionMenuandSubMenu Items whose menu name is white are shown.
 1. Press the arrowkeys to select a menu item.
 2. Press the View or Hide soft key.If you press the Hide soft key, the menu name is displayed in gray, and does not appear in the display selection menu.
 • ChangingtheDisplaySelectionMenu/SubMenuPositions1. Press the arrowkeys to select a menu item.
 2. Press the Select soft key.The menu item is enclosed in a red frame.
 3. Press the arrowkeys to select the destination.
 4. Press the Transfer soft key.The menu item moves to the selected position.
 • Showing/HidingSeparators1. Press the arrowkeys to select a menu item.
 2. Press the Separate soft key.A separator (line) is displayed between the current item and the lower item.If you select a menu item whose separator is already shown, this operation hides the separator.You can set up to three separators in the display selection menu and each sub menu.
 5.17ChangingtheFUNCKeyMenuandDisplaySelectionMenu

Page 203
						

5-31IM 04L41B01-01E
 Operations for C
 hanging the Displayed C
 ontents
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 • DescriptionoftheDisplaySelectionMenusandSubMenus Items with asterisk (*) are set to Hide by default.
 DisplaySelectionMenu SubMenu ReferenceSectionTREND GROUP 1 to GROUP 10 Section 4.2 ALL CHANNEL/GROUP CHANNEL Section 4.2 SCALE ON/OFF Section 4.2 DIGITAL OFF/ON Section 4.2 MESSAGE DISP2/1 Section 4.2 * TREND SPACE ON/OFF Section 4.2 AUTO SCROLL ON/OFF Section 4.2 FINE GRID ON/OFF Section 4.2 AUTO ZONE ON/OFF Section 4.2 TAG DETAIL ON/OFF Section 4.2TREND HISTORY GROUP 1 to GROUP 10 Section 4.3DIGITAL GROUP 1 to GROUP 10 Section 4.2 AUTO SCROLL ON/OFF Section 4.2 TAG DETAIL ON/OFF Section 4.2BAR GROUP 1 to GROUP 10 Section 4.2 AUTO SCROLL ON/OFF Section 4.2 TAG DETAIL ON/OFF Section 4.2CUSTOM DISPLAY INTERNAL 1 to INTERNAL 3, IM04L41B01-04E EXTERNAL 1 to EXTERNAL 25 NEW IM04L41B01-04EOVERVIEW CURSOR OFF/ON Section 4.4 JUMP TO ALM SUM Section 4.4 JUMP TO TREND Section 4.4 * JUMP TO DIGITAL Section 4.4 * JUMP TO BAR Section 4.4 TAG DETAIL ON/OFF Section 4.4 ACK ALARM 1*2 Section 4.4 ACK ALARM 2*2 ACK ALARM 3*2 ACK ALARM 4*2
 ANNUNCIATOR — Section 3.12
 5.17ChangingtheFUNCKeyMenuandDisplaySelectionMenu
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 DisplaySelectionMenu SubMenu ReferenceSectionINFORMATION ALARM SUMMARY Section 4.5 MESSAGE SUMMARY Section 4.5 MEMORY SUMMARY Section 4.5 TAG DETAIL ON/OFF Section 4.6 * MODBUS CLIENT Section 4.5 * MODBUS MASTER Section 4.5 * RELAY Section 4.5 EVENT SWITCH Section 4.5 REPORT DATA Section 4.5 COLUMN BAR Section 4.10 TO HISTORY Sections 4.6, 4.7, and 4.8 TO HISTORY(DISP) Sections 4.6, 4.7, and 4.8 TO HISTORY(EV) Sections 4.6, 4.7, and 4.8 TO OVERVIEW Section 4.6 DISP GROUP OFF/ON Section 4.7 CHANGE SORT KEY Sections 4.6 and 4.7 ASCENDING ORDER/ Sections 4.6 and 4.7 DESCENDING ORDER DATA SAVE MODE Section 4.8 SELECT SAVE Section 4.8 * M.SAMPLE SAVE Section 4.8 * REPORT SAVE Section 4.8 ALL SAVE Section 4.8 CHANGE DISP ITEM Section 4.7 CHANGE DATA KIND Section 4.8 FILENAME DISPLAY/TIME DISPLAY Section 4.8 CHANGE REPORT CH Section 4.5 SINGLE GRAPH/DUAL GRAPH Section 4.10 SELECT COLUMN/SELECT GROUP Section 4.10 REPORT GROUP 1 to 6 Section 4.10
 *Log LOGIN*1 Section 4.9 Operation*2 Section 4.9 ERROR Section 4.9 COMMUNICATION Section 4.9 FTP Section 4.9 MAIL Section 4.9 WEB Section 4.9 SNTP Section 4.9 DHCP Section 4.9 MODBUS Section 4.9 Change settings*2 Section 4.9 CHANGE DISP ITEM*2 Section 4.9*1 Only on DXs without the /AS1 advanced security option*2 Only on DXs with the /AS1 advanced security option
 5.17ChangingtheFUNCKeyMenuandDisplaySelectionMenu
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 5.18 DisplayingComments(Releasenumber3orlater)
 Register text strings to comment text fields and combine comment text fields to create comment text blocks.• Youcandisplaythetextfromacomment text block when a certain event occurs (an
 alarm for example).• Youcanusecommenttextblocktextforannunciatorwindowlabels(seesection3.12
 for details).
 SetupScreen• EnteringComments Press MENU (to switch to setting mode), and select the Menu tab > Message,
 CommentText > Commenttextfields.
 Press MENU (to switch to setting mode), and select the Menu tab > Message,CommentText > Commenttxtblock.
 • DisplayingComments Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction. See section 7.1.
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 5.18DisplayingComments(Releasenumber3orlater)
 SetupItems• Commenttxtfieldno,Textinfo Youcanregisteracommenttoaspecifiedcommenttextfield(field1to100). Text info: you can enter up to 32 characters (A a # 1 ).
 • Commenttxtblockno,Commenttxtfieldno Youcanregisteracommenttoaspecifiedcomment text block (block 1 to 50).
 Registercommentstocommenttextblocksbycombiningupto5commenttextfields.Thetextfromtheselectedcommenttextfieldsappearsontherightofthescreen.
 • Logicboxnumber,Event,Action,CommentTxtBlockNo Use the event action function to specify the event that will cause a comment to be
 displayed. For information about how to set the event action function, see section 7.1. Example: If even one alarm occurs, the text from comment text block 2 is displayed.
 Item SettingEvent AlarmAction CommentDisplayComment Txt Block No 2
 A comment appears when an alarm occurs. Pressing any key makes the comment disappear.
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 6.1 SettingtheRecordingConditionsoftheMeasured Data
 Set the method for recording the measured data.For a description of the function, see section 1.4.
 SetupScreen• DataType Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > A/D,Memory.
 • MeasurementChannels Press MENU (to switch to setting mode), and select the Menu tab > Meas channel >
 Tag,Memory,Delay.
 • FileSaveInterval(DisplayData) Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/
 Saveinterval.
 Chapter6 SavingandLoadingData
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 • RecordingConditionsofEventData Press MENU (to switch to setting mode), and select the Menu tab > Datasave >
 Eventdata.
 SetupItems• Memory>Data kind
 Settings DescriptionDisplay Records display data.E+D Records display data and event data. This setting cannot be selected when
 the trend interval switching function is set to On. This setting cannot be selected when the multi batch function (/BT2 option) is being used or on DXs with the /AS1 advanced security option.
 Event Records event data.
 • Memorysample>On/Off Turn On the target channels.
 • Trend/Saveinterval>Trendinterval[/div](whenrecordingdisplaydata) See the table below. You can only set trend intervals that are longer than the scan
 interval you set in Basic Setting Mode.
 • Trend/Saveinterval>Saveinterval(whenrecordingdisplaydata) Selectthesizeofarecorddatafile.Therecordeddataisdividedbythefilesize
 specifiedhere.Theavailablesettingsvarydependingonthenumberofmemorysampling channels and the Trendinterval setting.Trendinterval*1 5 s*2 10 s*2 15 s*3 30 s 1 minSamplerate 125 ms 250 ms 500 ms 1 s 2 sSelectablerangeofautosaveinterval
 10 min to 12 hours
 10 min to 1 day
 10 min to 3 days
 10 min to 7 days
 10 min to 14 days
 Trendinterval*1 2 min 5 min 10 min 15 min 20 minSamplerate 4 s 10 s 20 s 30 s 40 sSelectablerangeofautosaveinterval
 10 min to 14 days
 10 min to 31 days
 10 min to 31 days
 10 min to 31 days
 1 hour to 31 days
 Trendinterval*1 30 min 1 h 2 h 4 h 10 hSamplerate 1 min 2 min 4 min 8 min 20 minSelectablerangeofautosaveinterval
 1 hour to 31 days
 1 hour to 31 days
 2 hours to 31 days
 4 hours to 31 days
 8 hours to 31 days
 *1 You cannot set a trend interval that corresponds to a sampling interval that is faster than the scan interval.
 *2 Selectable on the DX1002, DX1002N, DX1004, and DX1004N (release number 3 or later).*3 Selectable in fast sampling mode on the DX1006, DX1006N, DX1012, and DX1012N (release
 number 3 or later).
 • Trend/Saveinterval>Secondinterval[/div] See section 5.3.
 6.1SettingtheRecordingConditionsoftheMeasuredData
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 • Eventdata(whenrecordingeventdata) • Samplerate
 Select the data recording interval. Use the table under “Data length” for reference. • Mode
 Settings DescriptionFree Records data continuously.Single Records data when the trigger condition is met.Repeat Records data each time the trigger condition is met.* This setting is fixed at “Free” when the multi batch function (/BT2 option) is being used and on DXs with the /AS1 advanced security option.
 • Datalength Selectthesizeofarecorddatafile.Therecordeddataisdividedbythefilesize
 specifiedhere.Theavailabledatalengthsvarydependingonthenumberofmemory sampling channels and the Samplerate setting.Samplerate*1 25 ms*2 125 ms 250 ms 500 ms 1 sSelectablerangeofdatalength
 10 min to 4 hours
 10 min to 1 day
 10 min to 2 days
 10 min to 3 days
 10 min to 7 days
 Samplerate*1 2 s 5 s 10 s 30 s 1 minSelectablerangeofdatalength
 10 min to 14 days
 10 min to 31 days
 10 min to 31 days
 1 hour to 31 days
 1 hour to 31 days
 Samplerate*1 2 min 5 min 10 min 15 min*3 20 min*3
 Selectablerangeofdatalength
 1 hour to 31 days
 1 hour to 31 days
 1 hour to 31 days
 1 hour to 31 days
 1 hour to 31 days
 Samplerate*1 30 min*3
 Selectablerangeofdatalength
 1 hour to 31 days
 *1 You cannot choose an interval that is faster than the scan interval.*2 Selectable on the DX1002, DX1002N, DX1004, and DX1004N.*3 Release number 3 or later.
 • Pre-trigger Specify the range when recording data before the trigger condition is met. Select
 the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%. If you do not want to record the data existing before the trigger condition is met, select 0%.
 • Triggersignal>Key Select On if you want to activate the trigger using key operation.
 Note• Triggerscanbeappliedusingeventaction(seesection7.1).• IfthetriggerconditionisalreadymetwhenyoupressSTART,recordingstarts.
 6.1SettingtheRecordingConditionsoftheMeasuredData
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 6.2 SettingtheMethodforSavingtheData
 Set the method for recording the measured data to the storage medium.For a description of the function, see section 1.4.
 SetupScreen• Autosave Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Security,Mediasave.
 • Fileheader,Datafilename Press MENU (to switch to setting mode), and select the Menu tab > Datasave > File
 header,Filename.
 • Savedirectory Press MENU (to switch to setting mode), and select the Menu tab > Datasave >
 Savedirectory.
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 SetupItems• Save>Autosave
 Settings DescriptionOn Automatically saves the measured data to the CF card. Specify On to
 enable the media FIFO function.Off Does not automatically save the data. Save the measured data manually to
 the CF card or USB flash memory (/USB1 option).
 • Save>MediaFIFO(ReleaseNumber2orLater) This item appears if Auto save is set to On.
 Settings DescriptionOn Enable media FIFO. Constantly retains the most recent data files in the CF
 card.Off Disable media FIFO. Replace the CF card if the free space on the CF card
 drops low.
 • Fileheader>Characters Settheheadercommenttobewrittentothedatafile.(Upto50characters,A a # 1 )
 • Datafilename>Structure Sets the structureofthefilenamewhensavingdata.
 Settings DescriptionDate Serial number + user-assigned character string + dateSerial Serial number + user-assigned character stringBatch Serial number + batch name (when using the batch function)
 • Datafilename>IdentifiedstringsSettheuser-assignedsectionofthefilename.(Upto16characters,A a # 1 )
 Symbols that can be used: #, %, (, ), +, -, ., @, °, and _. Fordetailsonthedatafilename,seesection1.4.
 • Savedirectory>Directoryname Set the name of the directory on the storage medium for saving the data on the
 external storage medium. (Up to 20 characters, A a # 1 ) Symbols that can be used: #, %, (, ), +, -, ., @, °, and _. Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and
 LPT1 to LPT9.
 6.2SettingtheMethodforSavingtheData
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 6.3 UsingtheBatchFunction
 Set the batch function.For a description of the function, see section 1.5.
 SetupScreen• BatchFunction Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Batch.
 • Datafilename Press MENU (to switch to setting mode), and select the Menu tab > Datasave > File
 header,Filename.
 • TextField Press MENU (to switch to setting mode), and select the Menu tab > Datasave >
 Batchtext.
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 SetupItems• Batch>On/Off Select On to use the batch function. For details on MultiBatch, see IM04L41B01-03E.
 • Batch>Lot-No.digit Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the
 lot number.
 • Batch>AutoincrementSettings DescriptionOn Automatically sets the lot number of the next measurement to “the lot number of
 the current measurement + 1.”Off Disables the operation described above.
 • Datafilename>Structure Batch:Setsthenameofthedisplaydatafilesoreventdatafilesto“batchname.” Fordetailsonthedatafilename,seesection1.4.
 • Textfieldnumber Select a number from 1 to 24 on a DX whose release number is 3 or later. Select a
 number from 1 to 8 on a DX whose release number is 2 or earlier.
 • Textfield>TitleoffieldorCharacters Set the string. Titleoffield:(Upto20characters,A a # 1 ), Characters: (Up to 30 characters, A a # 1 )
 Procedure• SettingtheBatchName(Batchnumber+lotnumber)andComment
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Batch soft key.A window appears for you to enter the batch name and comment.
 3. Set the batch number. (Up to 32 characters, A a # 1 )Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
 If you are using the lot number, set the lot number.
 4. Set batch comments 1, 2, and 3. (Up to 50 characters each, A a # 1 )
 5. Press DISP/ENTER.
 Note• Batchnumbersandlotnumberscannotbechangedaftermemorystart.• Youcanchangethecommentasmanytimesasyouwishbeforeexecutingmemorystart.
 After memory start, only the comments that are not specified can be entered. You can change the comment as many times as you wish while the window for setting the comment is displayed. The last specified comment is valid.
 • Thecommentisclearedwhenmemorystopisexecuted.• Thetextfieldssetuponmemorystart(see“StartingRecording(MemoryStart)”onthenext
 page) are cleared upon memory stop.• Thebatchnumber,lotnumber,andcommentsaresavedtothedisplaydatafileorevent
 data file. They are not saved to the setup file.
 6.3UsingtheBatchFunction
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 • DisplayingtheTextFieldSettings If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/
 DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Textfield soft key.The text field settings are displayed.
 Page switch mark(release number 3 and later)Eight text fields are displayedon a single page.Use the left and right arrowkeys to switch the page.
 Thetextfieldcontentsaredisplayedonpage3.Usetheleftandrightarrowkeys to switch pages (release number 3 or later).
 • StartingRecording(Memorystart)1. Press START to open the start recording screen (release number 3 or later).
 * On DXs with the /AS1 advanced security option, recording will not start, even if you press START in setting mode.
 2. Enter the batch number, lot number, and comments.
 To edit the contents of a text field, proceed to step 3.
 6.3UsingtheBatchFunction
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 3. Select Input, and press DISP/ENTER. The text field screen appears (release numbers 4 and later).
 The settings that you made in setting mode appear here.
 Select a text field number, and enter text. However, you cannot specify the Tilte of field. (Firmware version numbers 4.11 and later)
 Press DISP/ENTER.The start recording screen will appear.
 If you press the +1 and –1 soft keys to increase and decrease the text field number, any text field numbers whose Title of field have not been set will be skipped. If you press the Input soft key to enter text field numbers directly, any text field numbers whose Title of field have not been set are also displayed.
 The text fields that you specify here will only be saved to the measured data file whose recording you are starting. The text fields that you set in setting mode (see page 6-6) will not change.
 4. Move the cursor (blue) to START, and then press DISP/ENTER.The internal memory icon in the status display section changes from the icon that indicates that memory sampling is stopped to the icon that indicates that memory sampling has started. • IfyouarerecordingdisplayoreventdatainFreemode,recordingwillstart. • Ifyouarerecordingeventdatainatriggermode(SingleorRepeat),theDXwillentera
 trigger-wait state.
 • StoppingRecording(Memorystop)1. Press STOP. A confirmation window opens.
 2. Select Yes, and press DISP/ENTER.If the DX is equipped with computation functions (/M1 and /PM1 options), select Mem+Math or Memory and press DISP/ENTER.On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm ACK operation has not been performed, a confirmation message will appear. Perform the alarm ACK operation as necessary.The internal memory icon in the status display section changes to the icon that indicates that memory sampling is stopped.
 6.3UsingtheBatchFunction
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 6.4 Starting/StoppingtheRecordingandSavingtheMeasuredData,SavingtheMeasuredDatathroughKeyOperation
 Start the recording and save the measured data to the external storage medium.For a description of the function, see section 1.4.
 Procedure• StartingtheRecording(MemoryStart) Press START. The internal memory icon in the status display section changes from
 the stop icon to memory sampling icon.• Whenrecordingdisplaydataoreventdatainfreemode,recordingstarts.• Whenrecordingeventdataintriggermode,theDXentersthetrigger-wait
 condition.* On DXs with the /AS1 advanced security option, recording will not start, even if you press
 START in setting mode.* For the procedures when using the batch function, see section 6.3. If you are using the multi
 batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.
 • ApplyingaTriggertoStarttheRecordingCarry out the procedure below when the DX is waiting for a trigger.
 TriggerthroughKeyOperation The procedure below can be carried out when recording event data in trigger mode
 andtheDXisconfiguredsothatthestarttriggerisappliedthroughkeyoperation.
 1. Press FUNC.The FUNC key menu appears.
 2. Press the Trigger soft key.The recording starts.
 TriggerbyanEvent(Eventactionfunctionmustbeconfigured.Seesection7.1.)
 Recording starts when an event occurs.• AutomaticallySavingMeasuredData Automatic saving takes place when Autosave is set to On (see section 6.2 for details). The save destination is the CF card. Have the CF card inserted in the slot at all times. While the memory sampling is in
 progress, the measured data recorded in the internal memory is automatically saved to the CF card.
 Action when Media FIFO is not enabled: If data storage to the storage medium is not completesuchasduetoinsufficientfreespace,theunsaveddataissavedthenexttime the data is automatically saved.
 • SavingtheDisplayDataorEventDataduringMemorySamplingthroughKeyOperation
 The save destination is the CF card. This operation can be carried out when recording display data or when recording
 event data in Free mode. Unsaved measured data is saved to the CF card.* If this operation is carried out when auto save is Off, the data in the internal memory is
 divided, and a file is created.
 1. In the operation mode, press FUNC.The FUNC key menu appears.
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 2. Press the Savedisplay or Saveevent soft key.The display data or event data is saved to the CF card.
 Time
 Saved the previous time
 Save operation
 FileFile FileSaved this time
 • SavingMeasuredDataManually(CollectivelyStoringUnsavedData) Automatic saving takes place when Autosave is set to Off (see section 6.2 for details). YoucansavetoaCFcardortoUSBflashmemory(/USB1option).Theprocedurefor
 saving unsaved data to a CF card is described below. FortheproceduretosavedatatotheUSBflashmemory,seesection2.12.
 1. Insert the CF card.A confirmation window containing the message “There is data which is not saved to media. Do you want to store to media?” appears.
 2. Select Yes and press DISP/ENTER.The unsaved data in internal memory will be saved to the CF card.
 3. Follow these steps to remove the CF card.Press FUNC (to display the FUNC key menu) > Mediaeject soft key > CF soft key.When the message “Media can be removed safely” appears, remove the CF card.
 Note• Ifthereisnotenoughfreespaceonthestoragemedium,themessage“Notenoughfree
 space on media” appears, and the data is not saved. If this message appears, replace the storage medium. Then, carry out the procedure again.
 • Youcannotabortthedatasaveoperationwhileitisinprogress.
 • StoppingtheRecording(MemoryStop)* For the procedures when using the batch function, see section 6.3.
 1. Press STOP. A confirmation window is displayed.
 2. Select Yes using the arrowkeys and press DISP/ENTER.On models with the computation function (/M1 or /PM1 option), select Mem+Math or Memory, and press DISP/ENTER.On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm ACK operation has not been performed, a confirmation message will appear. Perform the alarm ACK operation as necessary.The internal memory icon in the status display section changes to the stop icon.
 • SavingtheDataintheInternalMemoryCollectivelyorSelectivelythroughKeyOperation
 See section 4.8.
 6.4Starting/StoppingtheRecordingandSavingtheMeasuredData,SavingtheMeasuredDatathroughKeyOperation
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 Explanation• OperationsThatStartSimultaneouslywithMemoryStart
 • Waveformdisplayupdatingonthetrenddisplay.• Report(/M1and/PM1options)• Thecomputationfunction(/M1and/PM1options)canbeconfiguredtostart
 simultaneously with memory start. See section 9.4.
 • OperationsThatStopSimultaneouslywithMemoryStop• Waveformdisplayupdatingonthetrenddisplay.• Report(/M1and/PM1options)• Computationfunction(/M1and/PM1options):Whenselectedintheprocedure
 described above.
 • PerformanceWhileDataIsBeingSaved If the internal memory or external storage medium is continuously accessed, the
 following phenomena may occur. When such phenomena occur, the storage medium access indicator frequently illuminates.• Filesbeingsavedtotheexternalstoragemediumdropout.• AccessingtheDXthroughcommunicationstakesalongtimeIn such case, take the following measures.• Ifyouarecreatingdatafilesatshortintervalsconsecutivelyusingtheeventaction
 function,increasethedatafilesaveinterval.• Ifyouarecreatingnumerousfilesinasingledirectoryontheexternalstorage
 medium,changethedestinationdirectorynameatapproximatelyevery1000files.
 6.4Starting/StoppingtheRecordingandSavingtheMeasuredData,SavingtheMeasuredDatathroughKeyOperation
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 • ChangingSettingsandPerformingFileOperationsduringRecording (Memorysampling) If you are using the multi batch function (/BT2 option), if even one batch group is being
 recorded, the DX is recording (memory sampling). OnDXswithoutthe/AS1advancedsecurityoption You can change all settings except for the ones listed below.
 • Basicsettings• Inputrange• Memorysamplingon/off• Computationchannelcalculationexpressionsandconstants• TLOG• Trendinterval• Filesaveinterval• Timerandmatchtimetimer
 OnDXsWiththe/AS1AdvancedSecurityOption Youcanchangethefollowingsettingsandperformthefollowingfileoperations.The
 administrator can perform all operations. Users can only perform operations that have been permitted. The setting menu that appears varies depending on the operations that can be performed.
 SettingChanges• Dateandtimesettings• Alarmsettings• Alarmdelaytimesettings• Calibrationsettings• Destinationdirectorysettings• Administratorsettings*• Usersettings*
 * See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.
 FileOperations• Loadingdisplaydatafiles• Loadingeventdatafiles• Listingthefilesontheexternalstoragemedium
 6.4Starting/StoppingtheRecordingandSavingtheMeasuredData,SavingtheMeasuredDatathroughKeyOperation
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 6.5 ManuallySavingtheMeasuredData(ManualSample)
 Save the instantaneous values of all channels (excluding those set to Skip or Off) through key operation.For a description of the function, see section 1.4.
 Procedure1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Manualsample soft key.Manual sampling is executed.
 Explanation• NumberofManualSampledDataSetintheInternalMemory The number of manual sampled data set in the internal memory is displayed on the
 memory summary display (see section 1.9)
 • SavingManualSampledData• IfautosaveisOn, the manual sampled data is saved to the CF card when you
 carry out manual sampling.• IfautosaveisOff, save the manual sampled data to the CF card according to the
 procedure for manually saving the data (see section 6.4).• ThemanualsampleddatacanbesavedmanuallytoaCFcardorUSBflash
 memory (/USB1 option) regardless of whether the auto save function is set to On/Off. For the manual save operation, see section 4.8.
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 6.6 SavingtheScreenImageData(Snapshot)
 Save the current screen image data to the CF card or USB flash memory (/USB1 option). This operation is called snapshot, and the screen image data file is called snapshot data file.For a description of the function, see section 1.4.
 Procedure1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Snapshot soft key.The snapshot data file is saved to the CF card or USB flash memory (/USB1 option). See “Save Destination“ in “Explanation.”Image of the soft keys and the message window are not saved.
 NoteIf you assign the snapshot function to the USER key, you can carry out snapshots in all modes (operation mode, setting mode, and basic setting mode). However, error messages are not saved.
 Explanation• FileFormat ThesnapshotdatafileisinPNGformat.
 • FileName See section 1.4.
 • SaveDestination SnapshotodataissavedtotheCFcardandUSBflashmemorywhenbothareinuse.
 NoteThe save destination of the snapshot data is a CF card only on the recorder with a version 4.15 or earlier.
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 6.7 ManagingtheFilesontheStorageMedium
 This section explains how to display a list of files on the storage medium, check the free space, delete files and directories, and format the storage medium.
 Procedure• DisplayingaListofFilesontheStorageMedium,DeletingFiles,andCheckingtheFreeSpaceCarry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Filelist,delete > press the CF or USB soft key* > and press DISP/ENTER.* When a CF card and a USB flash memory (/USB1 option) are being used.
 DisplayingaListofFilesinaDirectoryandCheckingtheFreeSpace Press the arrowkeys to select a directory, and press DISP/ENTER.Thefilesinthe
 directory are displayed. The root directory is denoted by [/].
 SortingFilesandDirectories(ReleaseNumber2orLater) Thefilesanddirectoriescanbesortedbytheupdatedate/time. Each time you press the Sortsoftkey,thefilesanddirectoriesaresortedinorderfrom
 the oldest or the latest update date/time. A mark indicating the sort order is displayed by Date/Time.
 IftheFileNameDoesNotFitintheDisplaySpace(ReleaseNumber2orLater) Press the softkeyoncetoshiftthefilenametotheleftbyacharacter. Press the softkeyoncetoshiftthefilenametotherightbyacharacter.
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 DeletingaFile Press the arrowkeystoselectthefiletobedeleted,andpresstheDelete soft key. A
 confirmationwindowappears.SelectYes, and press DISP/ENTER. Thefileisdeleted. ThisoperationcannotbeperformedonDXswiththe/AS1advancedsecurity
 option.
 DeletingaDirectory First,deleteallthefilesinthedirectory. Select the directory you want to delete. The rest of the procedure is the same as
 deletingafile. ThisoperationcannotbeperformedonDXswiththe/AS1advancedsecurity
 option.
 CheckingtheFreeSpace The free space on the storage medium is shown at the lower right of the screen.
 • FormattingtheStorageMedium Formatting will remove the contents of the storage media. ThisoperationcannotbeperformedonDXswiththe/AS1advancedsecurity
 option.
 1. Carry out the procedure below to show the display. Press MENU (to switch to setting mode), and select the File tab > Format. Press
 the CF or USB soft key*, and then press DISP/ENTER. * When a CF card and a USB flash memory (/USB1 option) are being used.
 2. Enter the volume name and press DISP/ENTER. (Up to 11 characters, A 1 )A confirmation window opens.
 3. Select Yes and press DISP/ENTER.The storage media is formatted.
 Explanation• FormatType
 Size TypeStorage medium smaller than or equal to 512 MB FAT16Storage medium greater than 512 MB FAT32
 6.7ManagingtheFilesontheStorageMedium
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 6.8 LoadingandDisplayingtheMeasuredDataintheStorageMedium
 Load the display or event data file saved on the external storage medium and display the waveform. The loaded data is shown on the historical trend display.For the operations on the historical trend display, see section 4.3.
 Procedure• LoadingaFile
 1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Loaddisplaydata or Loadevent data. Press the CForUSB soft key*, and then press DISP/ENTER.* When a CF card and a USB flash memory (/USB1 option) are being used.
 2. Press the arrowkeys to select a directory, and press DISP/ENTER. The files in the directory are displayed. The root directory is denoted by [/].
 3. Press the arrowkeys to select a file, and press DISP/ENTER.The file is loaded, and the waveform is displayed in the historical trend.
 Note• Asshowninthetablebelow,thedisplaydataandeventdatafilenameextensionschange
 depending on whether or not the /AS1 advanced security option is installed.AdvancedSecurity DisplayDataFiles EventDataFilesNot installed .DAD .DAEInstalled .DSD .DSE
 • FordetailsonhowtousetheSort, , and soft keys, see section 6.7.
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 6.9 Saving/LoadingtheSetupData
 Save the setup data to the external storage medium or load the setup data from the external storage medium.
 Procedure• SavingtheSetupData
 1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Savesettings. Press the CF or USB soft key*, and then press DISP/ENTER.* When a CF card and a USB flash memory (/USB1 option) are being used.
 2. Set the file name. (Up to 32 characters, A a # 1 )Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.To cancel the operation, press ESC.
 3. Press DISP/ENTER.The setup data is saved.
 • LoadingtheSetupDatafortheSettingMode1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Loadsettings. Press the CF or USB soft key*, and then press DISP/ENTER.
 2. Use DISP/ENTER and arrowkeys to select the setup file to be loaded.* Setup data files are stored in the root directory [/].
 To cancel the operation, press ESC.
 3. Press DISP/ENTER.The setup data is loaded.
 NoteFor details on how to use the Sort, , and keys, see section 6.7.
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 • LoadingtheSetupDatafortheSettingModeandBasicSettingMode1. Carry out the procedure below to show the display.
 On DXs without the /AS1 advanced security option
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the File/Initialize tab > Loadsettings. Press the CF or USB soft key*, and then press DISP/ENTER.* When you are using a CF card and USB flash memory (/USB1 option).
 On DXs with the /AS1 advanced security option
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the File/Initialize tab > Loadsettings > Allsettings, Logininfoonly, or Othersettings. Press the CF or USB soft key*, and then press DISP/ENTER.* When you are using a CF card and USB flash memory (/USB1 option).
 2. Use DISP/ENTER and arrowkeys to select the setup file to be loaded.* Setup data files are stored in the root directory [/].
 To cancel the operation, press ESC.
 3. Press DISP/ENTER.The setup data is loaded.
 NoteFor details on how to use the Sort, , and keys, see section 6.7.
 6.9Saving/LoadingtheSetupData
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 Explanation• SetupDataFile OnDXswithoutthe/AS1advancedsecurityoption
 • Thesetupdatafileextensionis.PDL.• Themaximumsetupdatafilesizeisapproximately250KB.• Thefollowingsettingsarealsosaved.
 • Currentmonitordisplayconditions• Defaultdisplayregistrationdata• Favoritekeyregistrationdata
 OnDXswiththe/AS1advancedsecurityoption• Thesetupdatafileextensionis.PEL.• Themaximumsetupdatafilesizeisapproximately250KB.• Thefollowingsettingsarealsosaved.
 • Currentmonitordisplayconditions• Defaultdisplayregistrationdata• Favoritekeyregistrationdata
 • LoadingSetupData OnDXswithoutthe/AS1advancedsecurityoption
 • Onlythesetupdataofthesettingmodeisloadedinthesettingmode.However,settings that contradict the setup data of the basic setting mode are not loaded.
 • Themonitordisplayconditions,defaultdisplay,andfavoritekeysarealsoloaded.• Ifthecontentsoftheloadedsetupdataisinvalid,checktheerrorlog(seesection
 4.9).• Operationsthroughkeys,communications,andremotecontrolinputarenot
 executed while the setup data is being loaded.
 OnDXswiththe/AS1advancedsecurityoption• Ifthesetupdataischangedbyloadingnewsetupdata,theoriginalsetupfile
 is automatically saved to CF card. If no CF card is inserted, an error message appears and the operation cannot be completed.
 • Allsettings,Logininfoonly,andOthersettingsThe“Loadsettings”option
 Description
 All settings The DX loads all setting mode and basic setting mode settings. However, the login password is not loaded. The password is set to the default password.
 Login info only The DX only loads the login settings. However, the login password is not loaded. The password is set to the default password.
 Other settings The DX loads all setting except for the login settings.
 • Insettingmode,onlythesettingmodesettingsareloaded.However,settingsthatcontradict the basic setting mode settings are not loaded.
 • Inanycase,theoptionto“Loadsettings”alsoloadsmonitordisplayconditions,thedefault display, and favorite keys.
 • Iftheloadedsetupdataisnotapplied,checktheerrorlog(seesection4.9).
 Note• Whileloadingthesetupdata,keyoperations,operationsviacommunications,and
 operations via remote input are not available.• Whileloadingthesetupdata,actionsoftheEventActionfunctionaredisabled.Events
 occurring while loading the setup data are ignored.
 6.9Saving/LoadingtheSetupData
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 6.10 LoadingandSavingReportTemplates(/M1and/PM1options;releasenumbers4andlater)
 This section explains the procedures for loading a report template (.xml extension) from an external storage medium and for saving a report template from the internal memory to an external storage medium.
 Procedure• LoadingaTemplateFile
 1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Loadtemplate. Press the CF or USB soft key*, and then press DISP/ENTER.* When you are using a CF card and USB flash memory (/USB1 option).
 Under Template File Status, the check boxes of the template files that are stored in the internal memory are selected.
 2. Press a softkey to select a report type, and press DISP/ENTER.The directories on the external storage medium appear. “/” is the root directory.
 3. Use the arrowkeysto select a directory, and press DISP/ENTER.The files in the directory will appear in a list.
 4. Use the arrowkeys to select the file that you want to load, and press DISP/ENTER.The report template file is loaded, and the screen from step 1 appears. The check boxes that are selected under Template File Status will match the file type that you loaded.If the DX fails to load the file, it will display an error message.
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 • SavingaTemplateFile1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Savetemplate. Press the CF or USB soft key*, and then press DISP/ENTER.* When you are using a CF card and USB flash memory (/USB1 option).
 Under Template File Status, the check boxes of the template files that are stored in the internal memory are selected.
 2. Press a softkey to select a report type, and press DISP/ENTER.The directories on the external storage medium appear. “/” is the root directory.
 3. Use the arrowkeys to select a directory, and press DISP/ENTER.
 4. Enter the file name (up to 32 characters, A a # 1 ).Symbols that can be used: #, %, (, ), +, –, ., @, °, and _.Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.To cancel the operation, press ESC.
 5. Press DISP/ENTER.The report template file is saved.
 6.10LoadingandSavingReportTemplates(/M1and/PM1options;releasenumbers4andlater)
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 Explanation• ReportTemplateFiles
 • Thereporttemplatefilenameextensionis.xml.• TheDXcanonlyhandletemplatefilesthatare400KBorsmaller.
 • ReportTypesandTemplatesUsedReportSettings TemplateTypeReportkind FiletypeHour Combine/Separate The hourly report templateDaily Combine/Separate The daily report templateHour+Day Separate The hourly report and daily report templates
 Combine The hourly + daily report templateDay+Week Separate The daily report and weekly report templates
 Combine The daily + weekly report templateDay+Month Separate The daily report and monthly report templates
 Combine The daily + monthly report template
 6.10LoadingandSavingReportTemplates(/M1and/PM1options;releasenumbers4andlater)
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 7.1 SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
 A specified action is carried out when an event occurs. This function is called event action. The remote control function (/R1 option) and the USER key are set by the event action.For a description of the function, see section 1.6.
 SetupScreen• EventandAction Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction.
 • Timer Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Timer.•Whensettorelaivetime •Whensettoabsolutetime
 • MatchTime Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Match time timer.
 Chapter7 CustomizingActionsUsingtheEventActionandRemoteControlFunctions(/R1and/PM1Options)
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 SetupItems• Logicboxnumber You can set up to 40.
 • Eventaction>Event The condition to execute the action.
 Settings DescriptionNone Not use.Remote Select the remote control input terminal number.Relay Select the alarm output relay number.During Edge operation, a change from deactivated to activated is an event.
 Relay-Off*2 Select the alarm output relay number. During Edge operation, a change from activated to deactivated is an event. During Level operation, the action states that correspond to “activated” and “deactivated” are the opposite of when you select “Relay.”Switch Select the internal switch number.During Edge operation, a change from off to on is an event.Switch-Off*2 Select the internal switch number. During Edge operation, a change from on to off is an event. During Level operation, the action states that correspond to “on” and “off” are the opposite of when you select “Switch.”Timer Select the timer number.Matchtime Select the match timer number.Alarm During Edge operation, a change from “no alarms are active” to “at least one alarm is active” is an event.Alarm-Off*2 During Edge operation, a change from “at least one alarm is active” to “no alarms are active” is an event. During Level operation, the action states that correspond to “at least one alarm is active” and “no alarms are active” are the opposite of when you select “Alarm.”UserKey -Edge*1 Select the event switch number (1 to 30). This function is available for
 release numbers 3 and laterLevel*1 Select the event switch number (1 to 30). During Edge operation, a change from off to on is an event.LevelOff*2 Select the event switch number (1 to 30). During Edge operation, a change from on to off is an event. During Level operation, the action states that correspond to “on” and “off” are the opposite of when you set the event to “Level.”
 *1 Available for release numbers 3 and later.*2 Available for release numbers 4 and later.
 7.1SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
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 • Eventaction>Action The action to be executed when an event occurs.
 Settings DescriptionMemory -Start -Stop -Trigger* Can be specified when the DX is configured to record event data.AlarmACK Cannot be specified when the event is set to Relay, Switch, or Alarm.Math Can be specified on /M1 and /PM1 options.MathStrt Start computation. Can be specified on /M1 and /PM1 options.MathStop Stop computation. Can be specified on /M1 and /PM1 options.Math rst Reset computation. Can be specified on /M1 and /PM1 options.SaveDisp Can be specified when the DX is configured to record display data.SaveEvt Can be specified when the DX is configured to record event data.Message Set the message number to write the message and the destination. Set the message destination to all groups (All) or a group number.Snap SnapshotRate1/2 Can be specified when the function for switching between the trend interval and the secondary trend interval is enabled.M.sample Manual samplingTimerRst Cannot be specified when the event is set to Timer.Group Specify the number of the group to be displayed.Flag Can be specified on /M1 and /PM1 options.Timeadj CanbespecifiedonlywhentheeventissettoRemote.PnlLoad* Can be specified only when the event is set to Remote.Comment Specify the comment text block number to display. This function is available for
 release numbers 3 and later.Favorite Choose which registered display to switch to. This function is available for release
 numbers 3 and later.
 Setting DescriptionKey Performs the same operation as
 pressing the favorite key.Select>Favorite Screen No Displays the specified favorite screen.* If you configure the settings so that the Favorite action and the Group action
 occur at the same time, only the action whose event action number is largest will be executed.
 AlarmRst This action can only be specified when using the double lock-in sequence of the alarm annunciator function (see section 3.12), and the event is Remote, UserKey, or Edge. This function is available for release numbers 3 and later.* This action is not available on DXs with the /AS1 advanced security option.
 7.1SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
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 • Timer Timer used by event action. Used also in the TLOG computation of the computation
 function.* The timer cannot be changed while memory sampling or computation is in progress.
 • TimerNo. Up to four timers (1 to 4) can be set.
 WhenUsinganAbsoluteTimer • Mode
 Select Absolute. • Interval
 Select the interval from the available settings between 1min to 24h. • Ref.time
 Set the time in the range of hour 0 to hour 23.
 WhenUsingaRelativeTimer • Mode
 Select Relative. • Interval
 Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours). • ResetatMathStart
 On: Resets the timer when computation is started. The resetting of the timer is not considered to be a timeout. Even if the timer is used as an event, the action is not executed.
 • Match Time Timer Set the time match condition used in event action.
 * The condition cannot be changed while memory sampling or computation is in progress.
 • Timernumber You can set up to four match time conditions (1 to 4).
 7.1SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
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 • KindSetting DescriptionDay The condition is matched once a day.Week The condition is matched once a week.Month The condition is matched once a month.Year The condition is matched once a year. This function is available for release
 numbers 3 and later.
 Set the items with check marks in the following table depending on the Kind setting.
 Day Week Month Year
 DayDay of weekHour:Minute
 TypeSetting
 Month
 • Month Specify the month.
 • Day Set the day.
 • Dayoftheweek Set the day of the week.
 • Hour:Minute Set the time in the range of 00:00 to 23:59.
 • Timer actionSettings DescriptionSingle Executes the action once when the condition is met.Repeat Executes the action at every specified time.
 Procedure• ResettingtheRelativeTimer
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Timer reset soft key.
 3. Press the softkey corresponding to timer you want to reset. Select All to reset all timers.The relative timer is reset.
 • OperatingEventSwitches(Releasenumber3orlater) OperatingEventLevelSwitches You can operate an event level switch using:
 • Acustomdisplayswitch.• Acommunicationcommand.
 OperatingEventEdgeSwitches You can operate an event edge switch using:
 • TheFUNCkey(theprocedureforoperatingtheswitchwiththeFUNCkeyisdescribed below).
 • Acustomdisplaypushbutton.• Acommunicationcommand.
 OperatingtheEventEdgeSwitchUsingtheFUNCKey
 1. In operation mode, press FUNC.The FUNC key menu appears.
 2. Press the EdgeSwitch soft key.
 3. Press the switch number softkey.The switch will turn on briefly and then turn off again.
 7.1SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
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 • DisplayinganEventLevelSwitchStatusList(Releasenumber3orlater) Display the status of the event level switch. For the operating procedure, see section
 4.5.
 • ResettingtheMatchTimeTimer(Releasenumber3orlater) Operation ends when a match time timer whose timer action is set to single expires.
 To use such a match time timer again, you must reset it.
 1. In operation mode, press FUNC.The FUNC key menu appears.
 2. Press the MatchTReset soft key.* This soft key appears when a match timer whose timer action is set to single has expired.
 3. Press the softkey with the match time timer number of the timer that you want to reset.The match time timer that you specify is reset.
 Explanation• ResettingtheRelativeTimer Restarts the timer.
 • Theresettingofthetimerisconsideredtobeatimeout.(Ifthetimerisusedasanevent, the action is executed.)
 • IfthetimerisusedinTLOGcomputationonthe/M1or/PM1mathoptionandTLOGcomputedvalueresetateachintervalisspecified,thecomputedresultisreset.
 • ResettingtheMatchTimeTimer(Releasenumber3orlater) This operation resets an expired match time timer so that it can operate again.
 • Theresettingofamatchtimetimerdoesnotcountasatimerexpiration(anditwillnot count as an event action event).
 • Thisoperationcanbeusedwithmatchtimetimerswhosetimeractionissettosingle.
 • IfthetimerisusedinTLOGcomputationonthe/M1or/PM1mathoptionandTLOGcomputedvalueresetateachintervalisspecified,thecomputedresultisreset.
 7.1SettingtheEventActionFunction(Includingtheremotecontrolfunctionofthe/R1and/PM1optionsandtheUSERkey)
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 7.2 SetupExamplesofEventAction
 Example1:Starting/StoppingtheMemorySamplingthroughRemoteControl(/R1Option)
 Starts/Stops the memory sampling when a signal is applied to remote control input terminal 2. Use logic box number 1.
 • SetupScreenandSetupItems Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction.
 <Operation>If the input to the remote control input terminal 2 is turned ON when memory sampling is stopped, memory sampling starts. If the remote control input is turned OFF when memory sampling is in progress, memory sampling stops.
 Example2:WritingaMessageWhenanAlarmOccursWrite the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1. Use logic box number 2.
 • SetupScreenandSetupItems Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction.
 <OtherSettings>• Setanalarmtochannel1andoutputtointernalswitch3.• Register“Channel1alarm”inmessagenumber4.For the procedure to set the alarm, see section 3.7.For the procedure to set the message, see section 5.4.
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 Example3:SavingtheDataEveryDayatHour17Save the recorded data to the CF card every day at hour 17. Use logic box number 3. Use match time condition 1.
 • SetupScreenandSetupItems Logicboxnumber3 Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction.
 Match Time Condition Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Match time timer.
 <OtherSettings>Set the display data to be saved automatically. Set the file save interval to 1day or longer. If a file save interval shorter than 1day is specified, the data is also saved at the file save interval.For the procedure to set the recording conditions of the display data, see section 6.1.
 7.2SetupExamplesofEventAction
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 Example4:ReleasingtheAlarmOutputUsingtheUSERKey(AlarmAcknowledgeOperation)
 Release the activated alarm output by pressing the USER key. Use logic box number 4.
 • SetupScreenandSetupItems Press MENU (to switch to setting mode), and select the Menu tab > Timer,Event
 action > Eventaction.
 <Operation>Press the USER key to release the activated alarm indication and relay output.
 <RelatedSettings>Set the alarm indication and alarm output relay operation to Hold.For the procedure to set the alarm indication operation and alarm output relay operation, see section 3.5.
 7.2SetupExamplesofEventAction
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 7.3 ChangingtheResponsetoRemoteContactInputOpeningandClosing(/R1and/PM1options;releasenumber3orlater)
 Set the remote contact input operation.
 SetupScreenPress MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Remote.
 SetupItems• RemoteInput>1to8 Specify an operation for each remote control terminal. Five remote control terminals
 can be used for pulse input (/PM1 option).Setting DescriptionN.O The remote signal rises when the contact input switches from open to
 closed, and it falls when the contact input switches from closed to open.N.C The remote signal rises when the contact input switches from closed to
 open, and it falls when the contact input switches from open to closed.
 TypeRemotecontactinput
 Operation
 Control operation
 N.C
 N.O Closed
 ClosedClosed
 OFF
 ON
 Open
 Open
 Open
 NoteOn models with the pulse input option (/PM1), the remote control input terminals can be used for pulse input. When pulses are counted, the number of rising pulse edges is counted, regardless of the Remote Input setting.
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 8.1 DisablingtheKeyOperation(KeyLockFunction)
 Disable the key operation.For a description of the function, see section 1.7.ThisoperationcannotbeperformedonDXswiththe/AS1advancedsecurityoption.
 SetupScreen• SelectingtheKeyLockFunction Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Security,Mediasave.
 • KeyOperationtoBeDisabled Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Keylock > KeyAction,Media or ActionofFunction.
 •Keyaction,Media •ActionofFunction
 SetupItems• Security>Key Select Keylock.
 Settings DescriptionKeylock Enables the key lock function. The Keylock item is displayed in the basic setting
 mode menu.Login Enables the login function. See section 8.2.
 • Keylock>Password The password used to release the key lock. (Up to 8 characters, A a # 1 ) The password is displayed as “********” (release number 3 or later).
 Chapter8 UsingtheSecurityFunction
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 • Keyaction,Media/USBorActionofFunction Select whether to lock each item.
 Settings DescriptionFree Key lock not applied.Lock Disables the operation.
 Procedure• LockingtheKeys
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Keylock soft key.The key lock is activated. The key lock icon appears in the status display section.
 • ReleasingtheKeyLock1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Keylock soft key.A window appears for you to enter the password.
 3. Enter the password and press DISP/ENTER.The key lock is released. The key lock icon in the status display section disappears.* The password that you entered is displayed as “********.”
 8.1DisablingtheKeyOperation(KeyLockFunction)
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 8.2 EnablingOnlyRegisteredUserstoOperatetheDX(LoginFunction)
 Only registered users can operate the DX.For a description of the function, see section 1.7.ForinformationaboutusingthisfunctiononaDXwiththe/AS1advancedsecurityoption,seetheAdvanced Security Function (/AS1) User’s Manual,IM04L41B01-05EN.
 SetupScreen• LoginFunction Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Security,Mediasave.
 • LogoutMethod Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Login > Basicsettings.
 • RegisteringAdministrators Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Login > Adminsettings.
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 • RegisteringUsers Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Login > Usersettings.
 • UserPrivileges Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Login > Authorityofuser >KeyAction,Media or ActionofFunction.
 SetupItemsThe login function can be set separately for login through keys and login through communications.• Security>Key Select Login.
 Settings DescriptionLogin Enables only registered users to operate the DX using keys. The Login item is
 displayed in the basic setting mode menu.Keylock Enables the key lock function. See section 8.1.Off Disables the security functions.
 • Security>CommunicationSettings DescriptionLogin Enables only registered users to operate the DX via communications. The
 Login item is displayed in the basic setting mode menu.Off Disables the security functions.
 • Userbasicsettings>AutologoutSettings DescriptionOff Does not log out until the logout operation is executed.1min to 10min Automatically logs out when there is no key operation for a specified time.
 8.2EnablingOnlyRegisteredUserstoOperatetheDX(LoginFunction)
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 • Userbasicsettings>Operationwithoutlogin Sets the operation that the user can carry out when logged out.
 Settings DescriptionOff Only login operation is available.Display Allows the user to switch the operation screen in addition to the login operation.
 • Adminnumber Uptofiveadministrators can be registered. Be sure to register at least one
 administrator. At least one administrator must be registered to use the login function.
 • Adminsettings>Mode The available settings vary depending on the Security setting.
 SettingsDescriptionOff Not register.Key Log into the DX using keys.Comm Log into the DX via communications.Web Log into the operator page and monitor page of the DX using a Web browser.Key+Comm Log into the DX using keys and via communications.
 • Adminsettings>Username Set the user name. (Up to 20 characters, A a # 1 )
 • Youcannotregisterusernamesthatarealreadyregistered.• Youcannotregister“quit”orausernamecontainingallspaces.
 • Adminsettings>Password Set the password. (Release numbers 3 and later: up to 8 characters. Release
 numbers 4 and later: up to 20 characters. A a # 1 ) Unregistered password is displayed as “????????.” An entered password is displayed
 as “********.”• Youcannotregister“quit”orapasswordcontainingallspaces.
 • Usernumber Up to 30 users can be registered.
 • Usersettings>Mode The available settings vary depending on the Security setting.
 Settings DescriptionOff Not register.Key Log into the DX using keys.Comm Log into the DX via communications.Web Log into the monitor page of the DX using a Web browser.Key+Comm Log into the DX using keys and via communications.
 • Usersettings>Username,Password See the explanation for the administrator user name and password.
 • AuthorityofuserSettings DescriptionOff No limitations on the operation.1 to 10 Registration number of the operation limitation.
 • Authorityofuser>Keyaction,Media/USB,ActionofFunction Select the “authority of user” preset number from 1 to 10. See section 8.1.
 8.2EnablingOnlyRegisteredUserstoOperatetheDX(LoginFunction)
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 8.3 LogginginandLoggingOut
 This section explains the procedure to log into the DX using keys. For the procedure to log into the DX via communications, see the Communication Interface User’s Manual, IM04L41B01-17E.ForinformationaboutusingthisfunctiononaDXwiththe/AS1advancedsecurityoption,seethe Advanced Security Function (/AS1) User’s Manual, IM04L41B01-05EN.
 Procedure• LoggingIn
 1. In the operation mode, press FUNC.A list of registered user names appears.
 2. Press the arrowkeys to select a user name, and press DISP/ENTER.A window appears for you to enter the password.
 3. Enter the password* and press DISP/ENTER.The DX is ready to be operated using keys. The name of the user that is logged in is displayed in the status display section.
 * The password that you enter is displayed as “********.”
 • LoggingOut UsingKeys
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Logout soft key.You are logged out from the DX. The user name in the status indication section disappears.
 AutoLogout If auto logout is enabled, you are automatically logged out if there is no key operation
 foraspecifiedtime.
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 • ChangingthePassword UsingKeys
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Passwordchange soft key.A window appears for you to enter the current password.
 3. Enter the current password, select ENT, and press DISP/ENTER.A window appears for you to enter the new password.
 4. Enter the new password, select ENT, and press DISP/ENTER.A window appears for you to enter the new password again.
 5. Enter the new password, select ENT, and press DISP/ENTER.The window closes, and the new password is activated.
 8.3LogginginandLoggingOut
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 9.1 SettingtheExpression,MeasurementRange,Alarm,Tag,andDataStorageonComputationChannels
 This section explains how to set a computation channel’s expression, measurement range, tag, alarm, and recording On/Off. You cannot set expressions or constants while memory sampling or computation is in progress.For a description of the function, see section 1.8.
 SetupScreen• ExpressionandAlarm Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Expression,Alarm.
 • ConstantsUsedinExpressions Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Constant.
 • Tag,MemorySamplingOn/Off,andAlarmDelayTimeofComputation Channels Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Tag,Memory,Delay.
 Chapter9 ComputationandReportFunctions(/M1and/PM1Options)
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 • ConditionsofTLOGComputationandRollingAverage Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 TLOG,Rollingaverage.
 • DisplayforComputationErrorsandHandlingofOverflowDatainStatisticalComputation
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic setting mode), and select the Environment tab > Math.
 SetupItems• First-CH/Last-CH Set the target channels.
 • Expression/Span • MathOn/Off
 Select On for channels to be used. • Calculationexpression
 Enter the expression using up to 120 characters. Pressing the Input soft key displays a window used to enter the expression. Press the M1/M2 soft key to switch between a screen used to enter values
 and characters and a screen used to enter operators and functions. Use softkeys, arrowkeys, and DISP/ENTER to enter an expression.
 For details on how to write expressions, see section 9.2.
 NoteYou cannot use both the USB keyboard (/USB1 option) and the DX keys to enter the equation. If you press a DX soft key, for example, while you are entering an equation from the USB keyboard, the entered equation is cleared.
 9.1SettingtheExpression,MeasurementRange,Alarm,Tag,andDataStorageonComputationChannels
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 • Span_L,Span_U Set the measurement range. Selectable range of values: –9999999 to 99999999 Selectable decimal places: X.XXXX, XX.XXX, XXX.XX, XXXX.X
 • Unit Set the unit of the computed value (Up to 6 characters, A a # 1 ).
 • Alarm The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
 and delay low limit alarm. The range of alarm values is as follows:
 Type ValueH, L, T, t Within –9999999 to 99999999 excluding the decimal point
 For details on setting alarms, see section 3.7.* If the Math On/Off or calculation expression is changed, the alarms for that channel are turned
 Off.
 • Alarmdelay>Time Set the alarm delay time using an integer in the range of 1 to 3600 s.
 • Tag>Comment Sets the tag comment. On a DX with a release number of 3 or later, you can enter up
 to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 16 characters. The characters that can be entered are: A a # 1 .
 • Tag>No.(Releasenumber3orlater) This setting only appears when you have enabled the use of tag numbers. Sets the tag number. (Up to 16 characters: A a # 1 )
 • Constant • Numberofconstant
 Select the constant (K01 to K60) to set. • Value
 The selectable range is as follows: –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29 Thenumberofsignificantdigitsofaconstantisfive.Whenspecifyingtheconstant
 using exponential notation, set the mantissa less than or equal to 5 digits and the exponent less than or equal to 2 digits.
 • TLOG • Timertype
 You can set the timer type to Timer or Match T (match time timer). • TimerNo.
 Select the timer number to use. For details on setting the timer, see section 7.1. For match time timer setting instructions, see section 7.1.
 • Sumscale Set the sum scale to /s to /h to match the unit of the measured value. Example: If the unit of the measured value is “m3/min,” select /min. Off: Sums as-is the measured data per scan interval.
 • Reset To reset the TLOG computed value at each interval, select On.
 9.1SettingtheExpression,MeasurementRange,Alarm,Tag,andDataStorageonComputationChannels
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 • Rollingaverage • On/Off
 To take the rolling average of the measured results, select On. • Interval
 Select the sampling interval when taking the rolling average from the following: The sampling interval takes on a value that is an integer multiple of the scan interval. For example, if the sampling interval is set to 5 s when the scan interval is 2 s, the actual sampling interval is 6 s.
 • Numberofsamples Set the number of samples for the rolling average using an integer between 1 and
 1500. The rolling average time is equal to the sampling interval × the number of samples.
 Note• Ifthenumberofdatapointstobeaveragedhasnotreachedthespecifiednumberof
 samples immediately after computation is started, the average of the available data is calculated.
 • Computationerrordataisexcludedfromtherollingaveragecomputation.• Ifthecomputeddataexceedstheupperorlowerlimit,thedataisclippedattheupperor
 lower limit, and the rolling average is computed. The upper and lower limit is “±100000000” excluding the decimal point. The decimal place is the same as that of the span lower limit.
 • Memorysample>On/Off Select On to record the computed data of the target channels.
 • Math • ValueonError
 Specify whether to set the display for a computation error to +Over or –Over. • ValueonOverflow>SUM,AVE
 Specify how to handle overflowdatawhenitisdetectedintheSUMorAVEcomputation of TLOG or CLOG. This setting is also applied to report generation.
 Settings DescriptionError Sets the computed result to computation error.Skip Discards the overflow data and continues the computation.Limit Uses a limit value in place of the overflow data and continues the computation.
 • ValueonOverflow>MAX,MIN,P-P SpecifyhowtohandleoverflowdatawhenitisdetectedintheMAX,MIN,orP-P
 computation of TLOG or CLOG. This setting is also applied to report generation.Settings DescriptionOver Uses the overflow data as-is.Skip Discards the overflow data and continues the computation.
 9.1SettingtheExpression,MeasurementRange,Alarm,Tag,andDataStorageonComputationChannels
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 9.2 WritingExpressions
 This section explains the meaning and how to write expressions.
 Common ItemsFollow the rules below when writing expressions.• Useupto120characterstowriteexpressions.• Theprecedenceofcomputingtermscanbespecifiedusingparentheses.• Specifythechannelsintheexpressionusingchannelnumbers. Example: 1, 12, and 101• Theone-digitnumberofconstants(K),communicationinputdata(C),remoteinput
 terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status (I),flag(F),andrecording(memorysampling)status(M)intheexpressioncanbedenoted as in “01” and “1.”
 Example: K01, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, I01, I1, F01, and F1.• Thedataofthepreviousscanisusedinthecomputationforitsownchannelnumber
 and channel numbers greater than its own channel number in the expression.• Specialcomputation(HOLD,RESET,andCARRY)andconditionalexpressionsare
 written at the beginning of the expression.
 OrderofPrecedenceinComputationsThe order of precedence of computation in expressions is as follows:
 Type ComputingElement (high order of precedence)Function ABS(), SQR(), LOG(), LN(), EXP(),
 TLOG.MAX(), TLOG.MIN(), TLOG.AVE(), TLOG.SUM(), TLOG.P-P(), CLOG.MAX(), CLOG.MIN(), CLOG.AVE(), CLOG.SUM(), CLOG.P-P()
 Special computation and conditional expression PRE, HOLD, RESET, CARRY, [a?b:c]Power **Logical negation NOTMultiplication and division *, /Addition and subtraction +, –Greater than and less than .GT., .LT., GE., LE.Equal and not equal .EQ., .NE.Logical product ANDLogical sum and exclusive logical sum OR, XOR (low order of precedence)
 LimitationsThe following limitations exists in writing expressions.
 Type LimitationsTLOG computation A computing element cannot be written inside the parentheses.
 Only one TLOG computation can be specified in a single expression.CLOG computation Number of channels that can be written in the parentheses is 30 channels or less.
 A computing element cannot be written inside the parentheses.Only one CLOG computation can be specified in a single expression.
 PRE A computing element cannot be written inside the parentheses.HOLD(a):b Can only be written at the beginning of an expression.
 Only one HOLD computation can be specified in a single expression.RESET(a):b Can only be written at the beginning of an expression.
 Only one RESET computation can be specified in a single expression.CARRY(a):b Can only be written at the beginning of an expression.
 Only one CARRY computation can be specified in a single expression.Only TLOG.SUM can be written in “b.”
 Conditional equation[a?b:c]
 RESET, CARRY, or HOLD cannot be written to “a,” “b,” or “c.” Other computing elements cannot be combined (example: [a?b:c]+001). However, coditional equations can be specified for a, b, and c.
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 FourArithmeticOperationExpressionExample• Addition 001+002 (Determines the sum of the measured values of channel 1 and channel 2.)• Subtraction 001–002 (Determines the difference of the measured values of channel 1 and
 channel 2.)• Multiplication 001*K03 (Multiplies constant K03 to the measured value of channel 1.)• Division 001/K02 (Divides the measured value of channel 1 by constant K02.)
 PowerandOtherComputationsExpressionExample• Power 001**002 (Determines the measured value of channel 1 to the power of
 the measured value of channel 2.)• Squareroot SQR(002) (Determines the square root of the measured value of channel 2.)• Absolutevalue ABS(002) (Determines the absolute value of the measured value of
 channel 2.)• Commonlogarithm LOG(001) (Determines the common logarithm (log10) of the measured
 value of channel 1.)• Naturallogarithm LN(001) (Determines the natural logarithm of the measured value of
 channel 1.)• Exponent EXP(001) (Determines e to the power of the measured value of channel 1.)
 RelationalComputationExpressionExample002.LT.003If the measured value of channel 2 is less than the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 002.GT.003If the measured value of channel 2 is greater than the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 002.EQ.003If the measured value of channel 2 is equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 002.NE.003If the measured value of channel 2 is not equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 002.GE.003If the measured value of channel 2 is greater than or equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 002.LE.003If the measured value of channel 2 is less than or equal to the measured value of channel 3, the computed result is “1.” Otherwise, the result is “0.”
 9.2WritingExpressions

Page 255
						

9-7IM 04L41B01-01E
 Com
 putation and Report Functions (/M
 1 and /PM1 O
 ptions)
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 LogicalComputationChecks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-zeroes, and computes according to the conditions.ANDLogical product(Syntax) e1ANDe2(Condition) If the two data values e1 and e2 are both non-zeroes, the computed
 result is “1.” Otherwise, it is “0.”(Explanation) e1=0,e2=0 → e1ANDe2=0 e1≠0,e2=0 → e1ANDe2=0 e1=0,e2≠0 → e1ANDe2=0 e1≠0,e2≠0 → e1ANDe2=1
 ORLogical sum(Syntax) e1ORe2(Condition) If the two data values e1 and e2 are both zeroes, the computed result is
 “0.” Otherwise, it is “1.”(Explanation) e1=0,e2=0 → e1ORe2=0 e1≠0,e2=0 → e1ORe2=1 e1=0,e2≠0 → e1ORe2=1 e1≠0,e2≠0 → e1ORe2=1 XORExclusive OR(Syntax) e1XORe2(Condition) If the two data values e1 and e2 are zero and non-zero or non-zero and
 zero, the computed result is “1.” Otherwise, it is “0.”(Explanation) e1=0,e2=0 → e1XORe2=0 e1≠0,e2=0 → e1XORe2=1 e1=0,e2≠0 → e1XORe2=1 e1≠0,e2≠0 → e1XORe2=0 NOTLogical negation(Syntax) NOTe1(Condition) The result is the inverse of the status of data e1 (zero or non-zero).(Explanation) e1=0 → NOTe1=1 e1≠0 → NOTe1=0
 ExpressionExample01-02OR03.GT.04Determines the OR of the computed results of “01-02” and “03.GT.04”.
 9.2WritingExpressions
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 TLOGComputationIn the explanation below, an expression containing a computing element in e1, an internal switch (S), a relay (I), or flag (F) cannot be written. In addition, only one TLOG computation can be specified in a single computing equation.TLOG.MAX()Maximum value(Syntax) TLOG.MAX(e1)(Condition) Determines the maximum value of channel e1.
 TLOG.MIN()Minimum value(Syntax) TLOG.MIN(e1)(Condition) Determines the minimum value of channel e1.
 TLOG.AVE()Average value(Syntax) TLOG.AVE(e1)(Condition) Determines the average value of channel e1.
 TLOG.SUM()Sum value(Syntax) TLOG.SUM(e1)(Condition) Determines the sum of channel e1.
 TLOG.P-P()Maximum - minimum value(Syntax) TLOG.P-P(e1)(Condition) Determines the maximum - minimum value of channel e1.
 ExpressionExampleTLOG.MAX(01)+K01*SQR(02)
 ExamplesofEquationsThatAreNotAllowedTLOG.AVE(01)+TLOG.AVE(02)Reason: TLOG appears twice in one equation.
 TLOG.AVE(ABS(01))Reason: A computing element is used inside the parentheses.
 9.2WritingExpressions
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 CLOGComputationOnly data of measurement channels and computation channels can be used in the CLOG computation. Up to 30 channels can be written in the parentheses.In the explanation below, an expression containing a computing element cannot be written to e1, etc. In addition, only one CLOG computation can be specified in a single computing equation.CLOG.SUM()Sum value(Syntax) CLOG.SUM(e1.e2.e4-e6)(Condition) Determines the sum of the data of channels e1, e2, e4, e5, and e6 that
 are measured at the same time.
 CLOG.MAX()Maximum value(Syntax) CLOG.MAX(e1.e2.e4-e6)(Condition) Determines the maximum value among the data of channels e1, e2, e4,
 e5, and e6 that are measured at the same time.
 CLOG.MIN()Minimum value(Syntax) CLOG.MIN(e1.e2.e5.e7)(Condition) Determines the minimum value among the data of channels e1, e2, e5,
 and e7 that are measured at the same time.
 CLOG.AVE()Average value(Syntax) CLOG.AVE(e1-e6)(Condition) Determines the average value among the data of channels e1 to e6 that
 are measured at the same time.
 CLOG.P-P()Maximum - minimum value(Syntax) CLOG.P-P(e1.e2.e5.e7)(Condition) Determines the difference between the maximum and minimum values
 among the data of channels e1, e2, e5, and e7 that are measured at the same time.
 ExpressionExampleCLOG.MAX(001.002.104-106)+K01*SQR(002)
 ExamplesofEquationsThatAreNotAllowedCLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)Reason: CLOG appears twice in one equation.
 CLOG.AVE(001.ABS(001))Reason: A computing element is used inside the parentheses.
 9.2WritingExpressions
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 SpecialComputationPRE()(Syntax) PRE(e1)(Condition) Determines the previous value of e1.
 HOLD(a):b(Syntax) HOLD(a):b(Condition) When a is zero, b is carried out to derive the computed value.
 Otherwise, the previous computed value is held.
 RESET(a):b(Syntax) RESET(a):b(Condition) When a is zero, b is carried out to derive the computed value.
 Otherwise, the previous computed value of b is reset, and b is carried out to derive the computed value.
 CARRY(a):b(Syntax) CARRY(a):b(Condition) Only TLOG.SUM can be specified for b. If the computed value X of b is
 less than a, the computed result is X. If X is greater than or equal to a, the computed result is the excess (X – a).
 (Description) When a value such as the flow rate is summed and the threshold value is reached or exceeded, the sum value is reset while carrying over the amount that exceeded the threshold value.
 ExpressionExampleExpression that sums the values of channel 1 and resets the value when it reaches or exceeds 10000K01 = 10000CARRY(K01):TLOG.SUM(001)
 ExamplesofEquationsThatAreNotAllowed002+HOLD(K01):TLOS.SUM(001)Reason: HOLD is not at the beginning of the expression.
 RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002Reason: RESET appears twice in one equation.
 ConditionalExpression[a?b:c](Syntax) [001.GT.K01?002:003](Condition) If the measured value of channel 1 is greater than constant K01, the
 computed result is the measured value of channel 2. Otherwise, the computed result is the measured value of channel 3.
 ExamplesofEquationsThatAreNotAllowed[001.GT.K01?002:003]*K02Reason: Used in combination with another computing element.
 NestedConditionalExpressionsA conditional expression can be written to Expression1, Expression2, and Expression3 in the equation [Expression1?Expression2:Expression3]. For example, the following expression is allowed: [Equation1?[Equation2-1?Equation2-2:Equation2-3]:[Equation3-
 1?Equation3-2:Equation3-3]]Expressions can be nested as long as the number of characters of the expression does not exceed 120 characters.
 9.2WritingExpressions
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 9.3 DisplayingtheComputationChannels
 Computation channels can be assigned to groups and displayed in a similar manner to measurement channels.For a description of the function, see section 1.8.
 SetupScreen• Color Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Color.
 • ZoneDisplayandScaleDisplay Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Zone,Scale.
 • BarGraphDisplay Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Bar.
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 • PartialExpandedDisplay Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Partial.* The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.
 • AlarmMarks Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Alarmmark.
 • ColorScaleBand Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Color scale band.
 9.3DisplayingtheComputationChannels
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 SetupItems• Groupofchannel,First-CH,andLast-CH Select the target channel range.
 • Color See section 5.5.
 • Zone See section 5.6.
 • Partial See section 5.9.
 • Bargraph See section 5.11.
 • Scale See section 5.7.
 • AlarmmarkcolorandColorscaleband See section 5.8.
 9.3DisplayingtheComputationChannels
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 9.4 Starting/StoppingComputation,ResettingComputation,andReleasingComputationDataDropoutDisplay
 SetupScreen• ActionTakenWhentheSTARTKeyIsPressed Press MENU (to switch to setting mode), and select the Menu tab > Math channel >
 Math start action.
 SetupItems• Mathstartaction>Mathstart
 Settings DescriptionOff Does not start the computation even when the START key is pressed.Start Starts the computation when the START key is pressed.Rst+St Resets the computed result up to then and starts the computation when the
 START key is pressed.
 Procedure• StartingtheComputation • StartingtheComputationSimultaneouslywiththeMemorySampling
 Press START. Computation starts simultaneously with the start of the memory sampling. The computation icon appears in the status display section.* Math start must be set to Start or Rst+St.
 • StartingOnlytheComputation1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Math start soft key.Computation starts, and the computation icon is displayed in the status display section.
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 • StoppingtheComputation • StoppingtheComputationSimultaneouslywiththeMemorySampling
 1. Press STOP.A confirmation dialog box appears.
 2. Select Mem+Math and press DISP/ENTER.The memory sampling and computation stop, and the computation icon in the status display section disappears.
 • StoppingOnlytheComputation1. In the operation mode, press FUNC.
 The FUNC key menu appears.
 2. Press the Mathstop soft key.The computation stops, and the computation icon in the status display section disappears.
 NoteWhen the computation is stopped, the computed data of the computation channel is held at the value that existed immediately before the computation is stopped. When memory sampling is in progress, the held value is recorded.
 • ResettingtheComputedResultsonAllComputationChannels This operation can be carried out when the computation is stopped. You can carry out this
 operation even while the computation is in progress on DXs with release number 2 or later.
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the Math reset soft key.The computed results of all computation channels are reset.
 • ReleasingtheComputationDataDropoutDisplay This operation can be carried out when a computation data dropout occurs. When a
 computation data dropout occurs, the computation icon turns yellow.
 1. In the operation mode, press FUNC.The FUNC key menu appears.
 2. Press the MathACK soft key.The computation icon returns to white.
 * MathACK is displayed in the FUNC key menu only when a computation data dropout occurs.
 NoteA computation data dropout occurs when the computation process cannot be completed within the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by reducing the number of computation channels or setting a longer scan interval. If a computation data dropout occurs during memory sampling, the data immediately before the dropout is recorded as the computed data of the scan interval in which the dropout occurred.
 9.4Starting/StoppingComputation,ResettingComputation,andReleasingComputationDataDropoutDisplay

Page 264
						

9-16 IM 04L41B01-01E
 9.5 CreatingReports
 Set how the reports are created.For a description of the function, see section 1.8.
 SetupScreen• ReportComputationType Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Environment tab > Report.
 • ReportTypeandTimeofCreation Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Report > Basicsettings.
 • SourceChannels Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
 setting mode), and select the Menu tab > Report > Reportsettings.

Page 265
						

9-17IM 04L41B01-01E
 Com
 putation and Report Functions (/M
 1 and /PM1 O
 ptions)
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 SetupItems• Report>Reportselect>1,2,3,and4 Select the type of data to output as reports. The only data type that can be set more
 than once is Off. You cannot set 1 to Off.Settings DescriptionOff Does not output reports.Ave Outputs the average value.Max Outputs the maximum value.Min Outputs the minimum value.Sum Outputs the sum value.Inst Outputs the instantaneous value.
 • Report>Filetype Set this item when creating two types of reports such as daily report and monthly
 report.Settings DescriptionSeparate Saves each type of report to a separate file.For information about how files are divided, see section 1.4.Combine Saves the report data of two types in a single file.Seprt2 Saves each type of report to a separate file. For information about how files are divided, see section 1.4, or see section 1.2 in the Advanced Security Function (/AS1) User’s Manual. You cannot select Use Template when Seprt2 is selected.When you change the setting from Combine or Separate to Seprt2, or vice versa, the report data in the internal memory is cleared.
 • Report>UseTemplate When you want to use a report template to create reports, select Use. You cannot use
 this function when Report > Filetype is set to Seprt2.ThesettingisfixedatNot.
 • Reportset>Reportkind Select the type of report to be created.
 Settings DescriptionHour Creates hourly reports.Day Creates daily reports.H+D Creates hourly and daily reports.Day+Week Creates daily and weekly reports.D+M Creates daily and monthly reports.
 • Reportset>Date/Dayoftheweek,Time(hour) Set the date or day of the week and the time when the report is to be created. The
 specifieddate/timeiswhenthereportfileisdivided.Setthevaluesintherangeindicated below. Items with a dash are invalid.ReportType Date DayofWeek TimeHour - - 0 to 23Day 1 to 28* - 0 to 23H+D - - 0 to 23Day+Week - SUN to SAT 0 to 23D+M 1 to 28* - 0 to 23* You cannot specify 29, 30, or 31.
 ReportTimeandDate/TimeWhentheReportFileIsDivided Example: When the Date of a daily report is set to 1 and the Time(hour) is set to
 18:00 A daily report is created every day at hour 18. Thefilestoringthereportisdividedat18:00onday1ofeachmonth.
 9.5CreatingReports
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 • Reportchannelnumber The report is output in order by this number.
 • Reportchannelnumber>On/Off Select On for the report channels to be used.
 • Reportchannelnumber>Channel Set the channel to assign to the report channel. All channels can be assigned, but
 reports are not created for channels set to Skip or Off even if they are assigned. In the stacked bar graph display (see section 4.10 for details), report data is displayed
 inthefollowinggroups.However,onlychannelsthathavethesameunitasthefirstchannel in the group are displayed.
 ReportGroup DX1002,DX1004, DX1002N,DX1004N
 DX1006,DX1012, DX1006N,DX1012N
 1 R01 to R06 R01 to R062 R07 to R12 R07 to R123 - R13 to R184 - R19 to R24
 • Reportchannelnumber>Sumscale Set the sum scale to /s to /day to match the unit of the measured value. Example: If the unit of the measured value is “m3/min,” select /min. Off: Sums as-is the measured data per scan interval.
 • HandlingofOverflowData Overflowdataishandledinthesamewayasitisinstatisticalcomputations(TLOG
 and CLOG). See section 9.1.
 Procedure• Starting/StoppingtheReportFunction Starting the memory sampling starts the report function. Likewise, stopping the
 memory sampling stops the report function.
 • DisplayingtheReports See section 4.5.
 • SavingtheReports See section 1.4.
 9.5CreatingReports
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 9.6 CreatingaReportTemplate(Releasenumbers4andlater)
 This section explains how to make a report template.To create a report template, you put keywords and text into cells in Excel.Keywords specify the data that will be entered into a cell. Other text is included in the report as it is written. Save the report templates that you create in XML spreadsheet format. The report template file name extension is .xml.For a description of the function, see section 1.8.For the setting procedure, see section 9.5.To load or save a report template, see section 6.10.TemplateExample
 Channel Number $Ch(R01)$ $Ch(R02)$Name Tank1temperature Tank1pressureUnit $Unit(R01)$ $Unit(R02)$$ReportDataTime(Hour)$ $ReportDataInst(Hour,R01)$ $ReportDataInst(Hour,R02)$$Repeat$ $Repeat$ $Repeat$$Repeat$ $Repeat$ $Repeat$
 ReportExample
 Channel Number TIC-001 PIC-002Name Tank1temperature Tank1pressureUnit °C kPa2010/04/01 00:00:00 76.5 45.6
 2010/04/01 01:00:00 78.9 56.7
 2010/04/01 02:00:00 77.7 50.8
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 KeywordFormatKeywords are written by themselves or with parameters.
 $ Keyword(parameter)$ Example: $ReportDataSum(Hour,R01,00,23)$
 • BasicRules• Thedollarsignontheleftindicatesthestartofakeyword,andthedollarsignon
 the right indicates the end of a keyword.• Youcanonlywritekeywordsusinglettersofthealphabet,dollarsigns,parentheses,
 commas, and spaces. You can put a space after an opening parenthesis, before and after a comma, and before a closing parenthesis. There is no distinction between uppercase and lowercase letters. You cannot use a dollar sign inside of a keyword.
 • Themaximumlengthofakeyword,includingspaces,is100characters.
 • ParameterRules• Parametersareenclosedinparentheses.• Multipleparameters(upto4)areseparatedbycommas.• Examplesofhowparameterscanbeomittedareshownbelow.
 $ReportDataSum(Hour, R01, ,23)$ The third parameter is omitted.$ReportDataSum(Hour, R01, 01, )$ or The fourth parameter is omitted.$ReportDataSum(Hour, R01, 01)$
 • RulesThatRelatetoExcel• Setthedataformatbysettingthecellformat.• Settheproperformatforeachkeyword’scellinthecell’sNumberproperties.• Thekeywordinacellisonlyvalidwhenthekeywordnameandparametersare
 all in the same format. When a keyword’s font size or some other property is not consistent, it is invalid.$ReportDataSum(Hour, R01, 00, 23)$ The font size of “Hour” is different, so the
 keyword is invalid.
 • Whenasinglecellcontainstextandakeyword,onlytheformatofthekeywordhasto be consistent. The format of the text can be different.Date and time: $DateTime$ The format of the keyword is consistent,
 so it is valid.
 9.6CreatingaReportTemplate(Releasenumbers4andlater)
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 KeywordDefinitionsFor examples of how to use the keywords, see “Report Template Examples.”
 • SystemKeywords One keyword produces one item of data.
 Keyword Description FormatTime Current time on the DX TimeDate Current date on the DX DateDateTime Current date and time on the DXDateTimeString Current date and time on the DX Character stringSerial DX serial numberFileHeader DX file headerCh Channel number*1
 Tag Tag comments*1
 ChId (ChId) Tag number*1
 Unit Unit*1
 *1 The parameter is the report channel number (it cannot be omitted).
 • ReportDataKeywords One keyword produces multiple items of data.
 Keyword Description FormatReportDataDate Report creation date*1 DateReportDataTime Report creation time*1 TimeReportDataDateTime Report creation date and time*1 DateReportDataDateTimeString Report creation date and time*1 Character stringReportDataStatus Report data status*2 Character stringReportDataSum Report data sum*2 Number or character string*3ReportDataInst Instantaneous report data value*2ReportDataAve Average report data value*2ReportDataMax Maximum report data value*2ReportDataMin Minimum report data value*2*1 List the parameters in this order: report type (cannot be omitted), report start date and time
 (can be omitted), report end date and time (can be omitted).*2 List the parameters in this order: report type (cannot be omitted), report channel number
 (cannot be omitted), report start date and time (can be omitted), report end date and time (can be omitted).
 *3 The decimal point type (dot or comma) depends on whether the converted data is a value or character string.
 Whether the converted data is a value or character string depends on the format of the cell that the keyword is written in. When the cell format is numerical, the decimal point type is determined by the cell format. When the cell format is text, the decimal point type matches the format of the report data.
 • SpecialKeywordsKeyword Description FormatRepeat Specifies the output location of the data that
 corresponds to a report data keyword.The same as the corresponding keyword.
 Comment Adds comments to the template. Nothing is displayed after template conversion.
 –
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 • ParametersParameter Format Range DescriptionReport kind Hour Hourly report
 Day Daily reportWeek Weekly reportMonth Monthly report
 Report channel number Rxx (xx are numerals)
 R01 to R60 (varies by model)
 DX report channel
 Start date or time xx (xx are numerals)
 00 to 23 Specifies the start time01 to 31 Specifies the start date
 End date or time xx (xx are numerals)
 00 to 23 Specifies the end time01 to 31 Specifies the end date
 StartingandEndingDatesandTimesUse the start date and time and end date and time to specify the parts of the report file’s report data that you will output to the file that you create with the template. You can specify the starting and ending dates (for daily reports) or times (for hourly reports).Example when the report type is hourly and the report was created at 18:00.
 18:00 19:00
 Report file 1 Report file 2
 Report creation time
 $ReportDataSum(Hour,R01,20,22)$ $ReportDataSum(Hour,R01,16,19)$
 20:00 21:00 22:00 16:00 17:00 18:00 19:00
 Keyword:$ReportDataSum(Hour,R01,20,22)$ From the hourly data from 19:00:01 to 22:00:00, the report data (sums) of report
 channel R01 for 20:00, 21:00, and 22:00 is output.
 Keyword:$ReportDataSum(Hour,R01,16,19)$ From the hourly data from 15:00:01 to 19:00:00, the report data (sums) of report
 channel R01 for 16:00, 17:00, and 18:00 is output. Because the report data for 19:00isinanotherreportfile,itisnotoutput.
 Keyword:$ReportDataSum(Hour,R01)$ Onefile’sworth(18:00:01to18:00:00)ofdatafromreportchannelR01isoutput,
 starting from 19:00. When you omit the start and end times for an hourly report, the data for the hour
 after the report creation time until the 24th hour is output. For daily reports, the data for the day after the report creation time until the end of the month is output.
 Keyword:$ReportDataSum(Hour,R01,08)$ From the hourly data from 07:00:01 to 18:00:00, the report data (sums) of report
 channel R01 for 08:00 to 18:00 is output.
 9.6CreatingaReportTemplate(Releasenumbers4andlater)
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 ReportTemplateExamples• SystemKeywordExamples Mixingakeywordandtext
 File header: $FileHeader$
 Date and time: $DateTime$↓
 File header: DX2000
 Date and time: 2010/01/01 12:00:000
 Mixingmultiplekeywordsandtext
 Device number: $Serial$ File Header: $FileHeader$
 ↓Device number: ABCDEFG File Header: DX2000
 • ReportDataKeywordExamples The following examples are for when the hourly report data for report channel R01 is
 101, 102, 103, 104, and 105 and the hourly report data for report channel R02 is 201, 202, 203, 204, 205, and 206.
 The $Repeat$ command applies to the closest keyword above the command in the same column.
 $ReportDataInst(Hour,R01)$ 101$Repeat$ 102$Repeat$ 103$Repeat$ → 104$ReportDataInst(Hour,R02)$ 201$Repeat$ 202$Repeat$ 203$Repeat$ 204$Repeat$ 205
 The $Repeat$ command applies to the keyword above it in the same column, even when that keyword is not directly above the command.
 $ReportDataInst(Hour,R01)$ 101$Unit(R01)$ °C
 $Repeat$ 102$Unit(R01)$ → °C
 $Repeat$ $Unit(R01)$ 103 °C
 Youcanmixsystemkeywords,reportdatakeywords,andtext.Ifthedataspecifiedbya keyword does not exist, nothing is output.
 $ReportDataInst(Hour,R01)$($Unit(R01)$) 101(°C)$Repeat$ 102$Repeat$ 103$Repeat$($Unit(R01)$) → 104(°C)$Repeat$(°C) 105(°C)$Repeat$
 9.6CreatingaReportTemplate(Releasenumbers4andlater)
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 Keywords in merged cells are affected by the leftmost cells above them.
 $ReportDataInst(Hour,R01)$ $ReportDataInst(Hour,R02)$$Repeat$ $Repeat$
 $Repeat$ $Repeat$$Repeat$ $Repeat$↓101 201102 202
 203103 204
 When a keyword is written incorrectly or its formatting is wrong, the keyword will be outputtothefileasitiswritten.
 $ReportDataInst(Hour,R)$ $ReportDataInst(Hour,R)$→
 $ReportDataInst(Hour,R02)$ 201$Repeat$ $Repeat$$Repeat$ 202$Repeat$ 203$Repeat$ 204
 $ReportDataInst(Hour,R01)$$ReportDataInst(Hour,R02)$
 *1 101$ReportDataInst(Hour,R02)$
 *1 When there are multiple system keywords in the same cell, only the first keyword is valid.
 9.6CreatingaReportTemplate(Releasenumbers4andlater)
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 10.1 AListofMessages
 There are cases in which error codes and messages are displayed on the screen during operation. A list of the possible error codes and messages are given in the table below. Communication error codes and messages are also listed.Error responses to communication commands are output in English.
 ErrorsRelatedtoParameterSettings• SettingErrorsCode Message Explanation/Countermeasures/Ref.section1 System error. Contact your nearest YOKOGAWA dealer.2 Incorrect date or time setting. Enter a correct value.3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.
 Specify a channel that is installed.4 Incorrect function parameter. See chapter 3 the communication manual.5 The input numerical value exceeds the set range. Enter a proper value.6 Incorrect input character string. Enter a proper character string.7 Too many characters. Enter the correct number of characters.8 Incorrect input mode. Specify a correct mode.
 See section 3.3.9 Incorrect input range code. Specify a correct range code.
 See section 3.3.11 Range settings are not same within the selected channels. Specify channels with the same range setting.
 See section 3.9.12 A disabled batch group is selected. Set the last batch group greater than the first batch
 group.See section 2.2 in IM04L41B01-03E.
 13 Cannot set a trip line for a display group that is OFF. Check the display group settings.See section 5.1 and section 2.2 in IM04L41B01-03E.
 21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.See section 3.7.
 22 The upper and lower span limits are equal. Cannot be set to the same value.See section 3.3.
 23 The upper and lower scale limits are equal. Cannot be set to the same value.See section 3.3.
 24 The lower limit of the span band is greater than the upper limit. Set the lower limit less than the upper limit.See section 3.3.
 25 The lower limit of the scale band is greater than the upper limit. Set the lower limit less than the upper limit.See section 3.3.
 30 The partial boundary value exceeds the range of the span. Set the boundary value in the range of “the minimum span value + 1 digit” to “the maximum span value – 1 digit.”See section 5.9.
 31 Partial-expansion display is set ON for a SKIPPED channel. Cannot be specified on channels set to Skip.See sections 3.3 and 5.9
 35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.See section 5.6.
 36 The lower limit of the display band is greater than the upper limit.
 Set the upper limit greater than the lower limit + 5.See section 5.6.
 37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.See section 5.6.
 40 Incorrect group set character string. Check the syntax.See section 5.1.
 41 There is no specified input channel. Specify a channel that is installed.Operation Guide and section 5.1.
 42 Exceeded the number of channels which can be set. Up to 6 channels per group.See section 5.1.
 Chapter10 Troubleshooting
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 Code Message Explanation/Countermeasures/Ref.section43 A channel number cannot repeat in a group. Check that a channel is not registered twice.
 See section 5.1.45 There is no character string saved in the clipboard. Copy a character string to the clipboard.46 The character string saved in the clipboard is too long. Paste a character string with the specified number of
 characters.47 Start and end time cannot match. Check the starting and ending times.
 See section 2.1.48 Invalid or missing DST time settings. Check the starting and ending times.
 See section 2.1.61 There is no channel specified by the MATH expression. Check the channel number specified by the expression.
 See sections 1.8 and 9.1.62 MATH expression grammar is incorrect. Check that the expression grammar is correct.
 See section 9.2.63 MATH expression sequence is incorrect. Check that the operator used in the expression in
 relation to the applicable operands meets the grammar requirements.See section 9.2.
 64 MATH upper and lower span values are equal. Set the upper limit not equal to the lower limit.See section 9.1.
 65 Too many operators for MATH expression. The maximum number of operators in an expression has been exceeded. Reduce the number of operators, such as by splitting up the expression into multiple computation channels.See section 9.2.
 70 Nonexistent constant specified in MATH expression. Check the constant number specified by the expression. See section 9.1.
 71 Set range of the MATH constant is exceeded. Check the selectable range.See section 9.1.
 80 This username is already registered. Register another user name.See section 8.2.
 81 All space or ‘quit’ string cannot be specified. Change the character string.See section 8.2.
 83 This user ID and password combination is already in use. Change the user ID or the password.See section 2.1 in the advanced security manual.
 84 The login password has not been set up. Set a password.See section 8.2.
 85 The login password is incorrect. Check the password. If you lost the password, ask your administrator to reset it.See sections 8.2 and 8.3.
 86 The key-lock release password is incorrect. Check the password. If you lost the password, it must be reset.See section 8.1.
 87 This key is locked. Release the key lock.See section 8.1.
 88 This function is locked. Release the key lock.See section 8.1.
 89 Press [FUNC] key to login. Log in.See section 8.3.
 90 No permission to enter to the SETUP mode. Check the keylock or login settings.See sections 8.2 and 8.3.
 91 Password is incorrect. Enter the correct password. If you lost the password, it must be reset.See sections 8.2 and 8.3.
 92 Press [ESC] key to change to the operation mode. Press the ESC key.93 String including space or all space cannot be specified. Spaces are not allowed in the Web browser user name
 and password.See section 1.5 in the communication manual.
 94 More than one address cannot be specified. Only a single sender is allowed.See section 1.4 in the communication manual.
 95 Number entered exceeds channel number range. Use another command.
 Check the syntax of the Modbus command.See sections 1.10 and 2.6 in the communication manual.
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 Code Message Explanation/Countermeasures/Ref.section96 This menu is locked. Check the key lock setting. Release the key lock.
 See section 8.1.97 This function is locked. To use the function, login as a user who has permission
 to use it.See section 8.2 in the advanced security manual.
 100 IP address doesn’t belong to class A, B, or C. Check the IP address.See section 1.3 in the communication manual.
 101 The result of the masked IP address is all 0s or 1s. Check the subnet mask.See section 1.3 in the communication manual.
 102 SUBNET mask is incorrect. Check the subnet mask.See section 1.3 in the communication manual.
 103 The net part of default gateway is not equal to that of IP address.
 Check the IP address.See section 1.3 in the communication manual.
 105 This port number is already in use. Please enter a different number.
 Enter a different port number for each function.See section 6.1 in the communication manual.
 110 This user name is not registered. Log in as a registered user.See section 8.2 and section 2.1 in the advanced security manual.
 111 The login user ID is incorrect. Enter the correct user ID.See the advanced security manual.
 112 Password must use more than 6 alphanumeric characters. The password must be between 6 and 20 characters in length.See section 2.1 in the advanced security manual.
 113 Password entered is incorrect. Enter the correct password.See section 8.3 and section 2.2 in the advanced security manual.
 114 This user name is invalid. Have a system administrator clear the “invalid user” status.See the advanced security manual.
 116 This user name cannot be specified. The user name is reserved.See section 8.2 and the advanced security manual.
 117 This password is not effective. Because the wrong password has been entered consecutively for more than the permissible number of times, this user is invalid. Have an administrator clear the “invalid user” status.See section 2.2 in the advanced security manual.
 119 This user name is unable to use this mode. A user-level user cannot enter the Basic Setting modeSee section 8.2.
 120 Measured value is incorrect. (in ascending order) Set the calibration correction value to a value greater than the previous value.See section 3.9.
 121 A user is already logged in. Another user has logged in with the same name or is logging in.See section 1.3 in the advanced security manual.
 122 Measured value exceeds the range setting. Check the channel input or the channel range setting.See sections 3.3 and 3.9.
 124 Password entry cannot be performed. You cannot use bar codes to enter a password.See section 2.9 in the advanced security manual.
 125 Character entry cannot be performed. The DX is not showing a display used to enter character strings.See section 2.11.
 126 You cannot use the same password. Specify a different password.See section 8.3.
 127 Report kind overlaps and cannot be set up. Change the overlapped report data type.See section 9.5.
 128 “Logout” cannot be set to “Hide”. See sections 5.17 and 8.3.129 IP address is not set. Set the IP address of the DX.
 See section 1.3 in the communication manual131 You have exceeded the available channel capacity. You cannot connect more than 240 channels.
 See section 1.10 in the communication manual
 10.1AListofMessages
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 Code Message Explanation/Countermeasures/Ref.section132 You have exceeded the available number of commands. The maximum number of commands that can be sent is
 16. The modules that can be set with a single command are consecutive modules that can be automatically set. Change the MW100 module configuration so that there are no empty slots.See section 1.10 in the communication manual.
 133 External I/O auto setting information is not available. Below are the possible causes. Check them.•TheMW100isincalibrationmode.Changetothe
 setting mode or measurement mode.•Themeasurementmodulemaynothavebeen
 detected. Perform system reconfiguration.•Therearenomodulesthatcanbeautomaticallyset.
 Check the modules.•AnIPaddresshasnotbeenassignedtotheMW100.
 Set the IP address.•TheModbusserveroftheMW100isturnedOFF.Turn
 ON the server.See section 1.10 in the communication manual.
 134 Auto setting has already been executed. You cannot set an MW100 that has been automatically set.See section 1.10 in the communication manual.
 135 External I/O cannot be found. Check the Ethernet connection.See section 1.3 in the communication manual.
 136 External I/O start cannot be executed. The current MW100 settings do not allow the measurement to be started. Check the settings.See section 1.3 in the communication manual.
 137 DNS for this device is not set. Set the DNS of the DX.See section 1.3 in the communication manual.
 138 Cannotcreateobject.Themaximumallowednumberwasexceeded.
 This occurs when the custom display is generated.See section 2.2 in IM04L41B01-04E.
 139 This dependency is not possible. This occurs when the custom display is generated.See section 1.10 in IM04L41B01-04E.
 140 You cannot set this while you are logged in. You cannot change the registered settings of a user that is logged in.See the advanced security manual.
 141 You cannot set multiple channels. During memory sampling, you cannot configure settings for multiple consecutive channels at the same time.See section 1.5 in the advanced security manual.
 142 Another user is configuring settings. You can perform operations after the user who is in setting mode or basic setting mode logs out or returns to operation mode.See the section 1.3 in advanced security manual.
 10.1AListofMessages
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 • ExecutionErrorsCode Message Explanation/Countermeasures/Ref.section150 This action is not possible because sampling is in progress. Stop the memory sampling and then execute.
 See section 6.4.151 This action is not possible during sampling or calculating. Stop the memory sampling and then execute.
 See sections 6.4 and 9.4.152 This action is not possible because saving is in progress. Wait until the saving is complete.153 This action is not possible because formatting is in progress. Wait until the formatting is complete.154 Message not accepte because message limit was reached. The limit is 50 messages.
 See section 5.4.155 The message is not written while sampling is stopped. Start the memory sampling and then execute.
 See section 6.4.156 There are no channels to be saved to the memory. Set the channels to be saved.
 See sections 6.1 and 9.1.157 This function is not possible at this time. Check the DX status.158 Exceeds time deviation setting. When synchronizing the clock through remote control.
 When you specified time that exceeds the time deviation limit on DXs with Advanced security function (/AS1 option). (Firmware version number 4.11 and later)See section 2.3.
 159 It is outside the postscript message write-in range. Add message can be written to the past section of the data being memory sampled.See section 5.4.
 162 Data storage is already started. Memory sampling is in progress on the batch group.See section 3.2 in IM04L41B01-03E.
 163 Data storage is already stopped. Memory sampling on the batch group has already been stopped.See IM04L41B01-03E.
 164 This action is not possible because there is a bar code data error.
 Check the text that the barcode reader scanned.See section 2.11.
 170 End process can’t proceed, because setting file is not saved to Media.
 When you switch from setting mode to operation mode or basic setting mode, the DX automatically saves the changed settings to the CF card. This message appears when the DX cannot save the changed settings. Check the CF card.See section 1.5 in the advanced security manual.
 173 Data save is not possible because of insufficient media capacity.
 Change the external storage medium.
 174 Cannot execute because of failure to save unsaved setting file. The DX cannot save an unsaved setting file to the CF card. Check the CF card.See the advanced security manual.
 175 The calibration due date has not been set properly. Check the year, month, and day of the calibration due date.See section 3.13
 700 The specified command does not exist. The command specified from the custom display is not registered. Register commands whose command type is “E-M,” and specify the numbers of those commands in the custom display.See section 1.10 in the communication manual.See section 2.32 in IM04L41B01-04E.
 701 Saving data. The previous transmission is not finished.See section 1.10 in the communication manual.
 702 Failed to save data. Check for communication errors or Modbus server errors.See section 1.10 in the communication manual.
 760 Cannot find KDC server. The KDC server cannot be found in the same domain.See section 1.14 in the communication manual.
 761 KDC server connection error. An error occurred while the DX was connecting to the KDC server.See section 1.14 in the communication manual.
 764 Not supported by this machine. Not supported by the DX.See section 1.14 in the communication manual.
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 Code Message Explanation/Countermeasures/Ref.section765 Preauthentication failed. Preauthentication failed. Check the information that you
 entered.766 The encryption type is not supported by this machine. Use the same encryption method on the DX and the
 server.See section 1.14 in the communication manual.
 767 Failed to receive authentication from KDC server. Check the DX and server settings.See section 1.14 in the communication manual.
 768 Change the password. The password has expired.See section 1.14 in the communication manual.
 769 The time difference with the KDC server exceeds the limit. There is a time difference of 5 minutes or more between the DX and the server. Eliminate this time difference.See section 1.14 in the communication manual.
 771 The host principal is not registered. The DX account is not registered on the server.See section 1.14 in the communication manual.
 772 The host principal is invalid. Check the DX account that is registered on the server.See section 1.14 in the communication manual.
 773 The host password is incorrect. Make sure that the password set on the DX matches the server password.See section 1.14 in the communication manual.
 774 Preauthentication failed. An internal error occurred during preauthentication. Disable the server's preauthentication function.
 775 The realm is incorrect. Set the correct realm name on the DX.See section 1.14 in the communication manual.
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 OperationErrorsCode Message Explanation/Countermeasures/Ref.section200 Operation aborted because an error was found in media. Use another storage medium or format it.
 See section 6.7.201 Not enough free space on media. There is not enough free space on media or the number
 of directories exceeded the limit. Use another storage medium.See section 1.4.
 202 Media is read-only. Make it writable.210 Media has not been inserted. Insert a storage medium into the drive.211 Media is damaged or not formatted. Remove the medium and set it again. If an error still
 occurs, replace or format the medium.See section 6.7.
 212 Format error. Try formatting again.See section 6.7.
 213 The file is read-only. Access another file or make the file writable.214 There is no file or directory. Specified a file in which data is being added. Tried to
 save a file which does not exists in the internal memory. 215 Exceeded the allowable number of directories or files. Replace a storage medium. Delete unneeded files and
 directories. See section 6.7.
 216 The file or directory name is incorrect. Use alphanumeric characters and symbols.See section 6.2.
 217 Unknown file type. Check the extension.See section Appendix 2.
 218 This directory or file now exists. Delete it or change the name. See section 6.2.219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to
 delete a directory containing files.Delete the files and directories in the directory first before executing the operation.See section 6.7.
 220 The file is already in use. Try again later. Wait until the file is accessible.221 This action is not possible because FTP transmission is in
 progress.Execute after FTP data transfer is complete.
 222 Media is not recognized. Remove and reset the storage medium.231 Abnormal setting exists in file. Specify another file.232 There is no available data. Appears when displaying historical trends. Specify
 another file.233 The specified historical data do not exist. Appears when switching to historical trend from
 information display. See section 4.5.
 234 The specified channel is not assigned to the display group. Appears when switching to trend, digital, or bar graph from overview. See sections 4.4 and 7.6.
 235 There is no data for the chosen date. Select a day of the month that has “E” or “D” displayed. See section 4.3.
 236 There is no data after the selected time for this day. Select an earlier time.Section 4.3.
 237 The specified screen cannot be displayed The DX display mode and the Web display mode are different, or a display group that does not exist has been specified from the Web. See IM04L41B01-03E.
 240 You cannot sign this record because a signature is already present.
 You cannot overwrite a signature.See section 1.6 in the advanced security manual.
 245 This function cannot be used in the historical trend display. Close the historical trend display.246 This function cannot be used due to no data file saved in
 media.Insert a storage medium. Make sure that the storage medium is formatted.
 247 This function cannot be used in setting mode. Exit setting mode.249 You cannot sign, because some batch data is missing. When the process type is batch, you cannot use the DX
 to sign the measured data unless everything from the start to the stop of measurement is contained in a single file.Use DAQSTANDARD to sign the data.See the advanced security manual.
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 Code Message Explanation/Countermeasures/Ref.section250 Failed to load template file. The template file that you attempted to load is 400 KB
 or larger. Load a template file that is smaller than 400 KB.
 251 There is no template file. There is no template file in the internal memory. Load a template file.
 252 The template file is incorrect. Check the template file format.
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 CommunicationApplicationErrors• ErrorsRelatedtoE-mailandWebServer260 IP address is not set or ethernet function is not available. The IP address is not specified.
 Check the IP address.See section 1.3 in the communication manual.
 261 SMTP server is not found. Occurs when the SMTP server is specified by name.• ChecktheDNSsetting.• ChecktheSMTPservername.See sections 1.3 and 1.4 in the communication manual.
 262 Cannot initiate E-mail transmission. • ThehostnameoftheDXisnotcorrect.Checkthehostname.
 • TheportnumberoftheSMTPserverisnotcorrect.Check the port number.
 See sections 1.3 and 1.4 in the communication manual.263 Sender’saddressrejectedbytheserver. Check the sender’s address.
 Section 1.4 in the communication manual264 Some recipients’ addresses are invalid. Check the recipients’ addresses.
 See section 1.4 in the communication manual.265 SMTP protocol error. May occur if a network failure (cable problems, duplicate
 addresses, network device failure, and so on) occurs in the middle of the e-mail transmission.
 266 Ethernet cable is not connected. Check the cable connection.See section 1.3 in the communication manual.
 267 Could not connect to SMTP server. • ChecktoseethattheSMTPserverisconnectedtothenetwork.
 • IftheSMTPservernameisspecifiedusinganIPaddress, check to see that the IP address is correct.
 See section 1.4 in the communication manual.268 E-mail transmission request failed. Contact your nearest YOKOGAWA dealer.269 E-mail transfer error. May occur if a network failure (cable problems, duplicate
 addresses, network device failure, and so on) occurs in the middle of the e-mail transmission.
 270 Could not connect to POP3 server Check the connection settings.See section 1.4 in the communication manual.
 271 Not able to login to the POP3 server. Check the login name and the password.See section 1.4 in the communication manual.
 272 SMTP authentication failed. Make sure that the user name and password that you are using for authentication are recognized by the server.See section 1.4 in the communication manual.
 273 The server requested an unsupported authentication method.
 Change the server configuration.See section 1.4 in the communication manual.
 275 The current image cannot be output to the Web. The setup display cannot be output to the Web browser. This message is displayed on the Web browser.
 276 Image data currently being created. Unable to perform key operation.
 Try again a little later.This message is displayed on the Web browser.
 277 Could not output screen to Web. Failed to create the image.This message is displayed on the Web browser.
 278 Web control denied because a user has control. You cannot control the DX from a browser when:• Thereisauserwhoislogginginorwhohasloggedinto
 the DX through key operations.• ThereisauserwhohasloggedintotheDXthrough
 communication commands.See section 1.5 in the communication manual.
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 • ErrorsRelatedtoFTPClientFor a description of the FTP client function of the DX, see the Communication Interface User’s Manual, IM 04L41B01-17E. The detail code does not appear in the error message on the screen. You can view the code on the FTP log display of the DX or using the FTP log output via communications.
 Code Message280 IP address is not set or FTP function is not available.
 Further details are provided by the character string that appears after error code 280.CharacterStringandDetailsHOSTADDR
 An IP address has not been assigned to the DX. Check the IP address.
 DORMANT Internal processing error.*1
 LINK Data link is disconnected. Check the cable connection.
 281 FTP mail box operation error.Further details are provided by the character string that appears after error code 281.CharacterStringandDetailsMAIL Internal processing error.*1
 STATUS Internal processing error.*1
 TIMEOUT Internal processing error.*1
 PRIORITY Internal processing error.*1
 NVRAM Internal processing error.*1
 282 FTP control connection error.Further details are provided by the character string that appears after error code 282.CharacterStringandDetailsHOSTNAME Failed the DNS lookup (search the IP address corresponding to the host name). Check the DNS setting and the destination host name.TCPIP Internal processing error.*1
 UNREACH Failed to connect to a control connection server. Check the address setting and that the server is running.OOBINLINE
 Internal processing error.*1
 NAME Internal processing error.*1
 CTRL The control connection does not exist. Check that the server does not drop the connection and that it responds within the proper time
 period.IAC Failed to respond in the TELNET sequence. Check that the server does not drop the connection and that it responds within the proper time
 period.ECHO
 Failed to transmit data on the control connection. Check that the server does not drop the connection and that it responds within the proper time
 period.CharacterStringandDetailsREPLY
 Failed to receive data on the control connection.
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 Code Message Check that the server does not drop the connection and that it responds within the proper time
 period.SERVER
 The server is not in a condition to provide the service. Check that the server is in a condition in which service can be provided.
 283 FTP command was not accepted.Further details are provided by the character string that appears after error code 283.CharacterStringandDetailsUSER Failed to verify the user name. Check the user name setting.PASS
 Failed to verify the password. Check the password setting.
 ACCT Failed to verify the account. Check the account setting.TYPE Failed to change the transfer type. Check that the server supports the binary transfer mode.CWD Failed to change the directory. Check the initial path setting.PORT Failed to set the transfer connection. Check that the security function is disabled.PASV Failed to set the transfer connection. Check that the server supports PASV commands.SCAN Failed to read the transfer connection settings. Check that proper response to the PASV command is received from the server.
 284 FTP transfer setting error.Further details are provided by the character string that appears after error code 284.CharacterStringandDetailsMODE Internal processing error.*1
 LOCAL Internal processing error.*1
 REMOTE The destination file name is not correct. Check that you have the authority to create or overwrite files.ABORT File transfer abort was requested by the server. Check the server for the reason for the abort request.
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 Code Message285 FTP data connection error.
 Further details are provided by the character string that appears after error code 285.CharacterStringandDetailsSOCKET Failed to create a socket for the transfer connection.*2
 BIND Failed the transfer connection command.*2
 CONNECT Failed the transfer connection.*2
 LISTEN Failed the transfer connection reception.*2
 ACCEPT Failed to accept the transfer connection.*2
 SOCKNAME Internal processing error.*1
 RECV Failed to receive data over the transfer connection.*2
 SEND Failed to send data over the transfer connection.*2
 286 FTP file transfer error.287 FTP is failed because of file acquirement from external media.290 SNTP access failure.
 Further details are provided by the character string that appears after error code 290.CharacterStringandDetailsDORMANT
 Internal processing error.*1
 LINK Data link is disconnected. Check the cable connection.
 291 SNTP server does not respond.Further details are provided by the character string that appears after error code 291.CharacterStringandDetailsTIMEOUT Check that the server is running.*2
 292 Incorrect SNTP server setting.Further details are provided by the character string that appears after error code 292.CharacterStringandDetailsHOSTNAME Failed the DNS lookup (search the IP address corresponding to the host name). Check the DNS setting and the SNTP server name.TCPIP Internal processing error.*1
 293 Invalid SNTP server reply.Further details are provided by the character string that appears after error code 293.CharacterStringandDetailsSEND A correct IP address has not been assigned to the DX. Check the IP address.BROKEN There is a problem with the SNTP server. If this error occurs even after executing SNTP manually several times, check the SNTP server.
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 Code Message294 No time correction because excess time deviation with SNTP server.
 Further details are provided by the character string that appears after error code 294.CharacterStringandDetailsOVER This error occurs when periodic SNTP is executed by the auto setting of the clock and the clockisnotadjustedbecausethetimedifferencebetweentheDXandtheSNTPserverisgreater than or equal to 10 minutes.
 Check the time on the DX and the SNTP server.295 IP address was released because DHCP setting is invalid.
 Further details are provided by the character string that appears after error code 295.CharacterStringandDetailsREJECT Address obtained by DHCP is inappropriate.
 296 DHCP access failure.Further details are provided by the character string that appears after error code 296.CharacterStringandDetailsESEND Failed to transmit to the DHCP.ESERVER
 DHCP server not found.ESERVFAIL
 No response from the DHCP server.ERENEWED Addressrenewalrejected.EEXTENDED Addressleaseextensionrejected.
 EEXPIRED Address lease period expired.
 297 Registration of the hostname to the DNS server failed.Further details are provided by the character string that appears after error code 297.CharacterStringandDetailsINTERNAL Failed to register the host name (transmission error, reception timeout, etc.).
 FORMERR Failed to register the host name (format error: DNS message syntax error).
 SERVFAIL Failed to register the host name (server failure: DNS server processing error).
 NXDOMAIN Failed to register the host name (non existent domain).
 NOTIMP Failed to register the host name (not implemented).
 REFUSED Failed to register the host name (operation refused).
 YXDOMAIN Failed to register the host name (name exists).
 YXRRSET Failed to register the host name (RR set exists).
 NXRRSET Failed to register the host name (RR set does not exist).
 NOTAUTH Failed to register the host name (not authoritative for zone).
 NOTZONE Failed to register the host name (different from zone section).
 NONAME Host name not entered on the DX.
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 Code Message298 Deletion of the hostname to the DNS server failed.
 Further details are provided by the character string that appears after error code 298.CharacterStringandDetailsINTERNAL Failed to delete the host name (transmission error, reception timeout, etc.).
 FORMERR Failed to delete the host name (format error: DNS message syntax error).SERVFAIL Failed to delete the host name (server failure: DNS server processing error).NXDOMAIN Failed to delete the host name (non existent domain).
 NOTIMP Failed to delete the host name (not implemented).
 REFUSED Failed to delete the host name (operation refused).
 YXDOMAIN Failed to delete the host name (name exists).YXRRSET Failed to delete the host name (RR set exists).
 NXRRSET Failed to delete the host name (RR set does not exist).NOTAUTH Failed to delete the host name (not authoritative for zone).
 NOTZONE Failed to delete the host name (different from zone section).
 NOTLINKED4 Physical layer was disconnected when removing the host name.
 700 The specified command does not exist.701 Saving data.702 Failed to save data.
 *1 Contact your nearest YOKOGAWA dealer.*2 These errors may occur if the network experiences trouble during the data transmission
 (bad cable connection, duplicate addresses, network equipment failure).
 Note• TheFTPclientfunctionontheDXhasatimerfunctionthatdropstheconnectionifthereis
 no data transfer for two minutes. If the server does not respond within this time period, the transfer fails.
 • TheFTPclientfunctionontheDXoverwritesfileswithoutawarningiffileswiththesamename exist at the transfer destination unless the server returns a negative response.
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 CommunicationErrorsFor information regarding the communication function of the DX, see the Communication Interface User’s Manual, IM 04L41B01-17E.
 • ErrorsduringSettingandBasicSettingModes,OutputCommunicationCommandExecution,andSetupDataLoading
 Code Message300 Command is too long.301 Too many number of commands delimited with ‘;’.302 This command has not been defined.303 Data request command can not be enumerated with sub-delimiter.350 Command is not permitted to the current user level.
 351 This command cannot be specified in the current mode.352 The option is not installed.353 This command cannot be specified in the current setting.354 This command is not available during sampling or calculating.
 • MemoryAccessErrorsduringSettingandBasicSettingModesandOutputCommunicationCommandExecution
 An English error message is returned via the communication interface. It is not displayed on the screen.
 Code Message362 There are no data to send ‘NEXT’ or ‘RESEND’.363 All data have already been transferred.
 • MaintenanceandTestCommunicationCommandErrorsAn English error message is returned via the communication interface. It is not displayed on the screen.
 Code Message390 Command error.391 Delimiter error.392 Parameter error.393 No permission.394 No such connection.395 Use ‘quit’ to close this connection.396 Failed to disconnect.397 No TCP control block.398 Format error.
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 • OtherCommunicationErrorsAn English error message is returned via the communication interface. It is not displayed on the screen.
 Code Message400 Input username.
 Enter the name of a user that is registered on the DX and that is allowed to log in to the DX through communication.401 Input password.
 Enter the password.402 Select username from ‘admin’ or ‘user’.
 Select “admin” or “user” to specify the user level to connect to.403 Login incorrect, try again!
 The login failed. Enter the information again, starting with the user name.404 No more login at the specified level is acceptable.
 Connecting would cause the maximum number of simultaneous connections (administrator: 1, normal user: 2 or setting: 1, monitoring: 2) to be exceeded. Connect to a different level, or exit by entering “quit.”
 405 Input user ID.Enter a user ID.
 406 Select function from ‘setting’ or ‘monitor’.Select “setting” (to connect to the setting function) or “monitor” (to connect to the monitoring function).
 407 Password has expired. Please enter a new password.The password has expired. Enter a new password.
 408 Enter password again for confirmation.Enter the password again for confirmation.
 409 This password is not correct or was already used.The password is incorrect or has already been used.
 410 Login successful. (The special user level)You have logged in to the administrator level.
 411 Login successful. (The general user level)You have logged in to the user level.
 420 Connection has been lost.The connection has been lost.
 421 The number of simultaneous connection has been exceeded.The maximum number of simultaneous connections has been reached, so no further connections can be made.
 422 Communication has timed-out.Communication timed out so the connection was closed.
 450 This entry is incorrect.You cannot currently log in. This may happen for one of the following reasons:•Theusernameisnotregistered.•Theusernameisinvalid.•TheuserIDiswrong.
 451 Login prohibited because another user is logged in.Another user is already logged in. This may happen for one of the following reasons:•Someonehasalreadyloggedinwiththesameusername.•Whenthemulti-loginfunctionisnotenabledandsomeonehasloggedinthroughkeyoperations.
 452 This command must be used with LL command.Use the LL command.
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 StatusMessagesCode Message500 Execution is complete.501 Please wait a moment...503 Data are being saved to media...504 File is being loaded from media...505 Formatting...506 Memory save to media was interrupted.508 There is no file or directory.509 Press [DISP/ENTER] key to display file name.510 Range cannot be changed during sampling or calculating.511 MATH expression cannot be changed during sampling or calculating.513 Post process in progress.514 Now loading historical data.515 Data save is completed.516 Files are now being sorted.520 Connecting to the line...521 The data file is being transferred.530 Media can be removed safely.531 Media was removed compulsorily.532 USB device has been connected.533 USB device cannot be recognized.534 There was no data which is not saved to media.535 Media was recognized.542 Media read error.543 Flash write error.550 The A/D calibration is being executed...551 FTP test is being executed...552 E-mail test is being executed...553 Review and sign functions cannot be used when the file is divided.554 Signature functions are being executed.555 Login prohibited because software login is active.556 Press [FUNC] key to login.557 This user is not allowed to change a setting.558 Setting changes are aborted while data is saved.559 This command must be used with LL command.560 Now connecting to SNTP server...561 Nowadjustingthetime.
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 Code Message562 Ethernet cable is disconnected.
 Further details are provided by the character string that appears after error code 562.CharacterStringandDetailsON
 Detected that an Ethernet cable was connected.OFF
 Detected that an Ethernet cable was disconnected.563 The command is sent to DHCP.
 Further details are provided by the character string that appears after error code 563.CharacterStringandDetailsRENEW
 Requesting address renewal to the DHCP server.564 The response was received from DHCP.
 Further details are provided by the character string that appears after error code 564.CharacterStringandDetailsRENEWED
 Address renewal complete.EXTENDED Address release extension request complete.RELEASED Address release complete.
 565 IP address was set.Further details are provided by the character string that appears after error code 565.CharacterStringandDetailsIPCONFIG
 Assigned the IP address.566 It is a setting that doesn’t register hostname to the DNS server.
 Further details are provided by the character string that appears after error code 566.CharacterStringandDetailsNOREQUEST Configured not to register the host name.
 567 The hostname was registered to DNS server.Further details are provided by the character string that appears after error code 567.CharacterStringandDetailsUPDATE Registered the host name to the DNS server.
 568 The hostname was deleted from DNS server.Further details are provided by the character string that appears after error code 568.CharacterStringandDetailsREMOVE Assigned the IP address.OFF
 Removed the host name from the DNS server.571 Querying KDC server.572 Saving template file.573 Loading template file.
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 WarningMessagesCode Message Ref.Section600 Measured data and Settings have been initialized. –601 Measured data have been initialized. –610 This usernema is already registered. See section 8.2.611 There is no user who can enter to the SETUP mode. –612 Please acknowledge all active alarms before stopping this record. This message appears if you try to stop
 recording when there is an alarm that the alarm ACK operation has not been performed on. You can either stop recording or perform the alarm ACK operation and then stop recording. See the See sections 6.3 and 6.4 in the advanced security manual.
 614 Calibration settings are reset because of range setting change. See section 3.9.615 Noise may influence measurement in test mode. See section 3.1.
 For information about messages whose codes are in the 700s, see page 11-5.
 SystemErrorsServicing is required when a system error occurs. If this happens, contact your nearest YOKOGAWA dealer for repairs.
 Code Message901 ROM failure.902 RAM failure.910 A/D memory failure for all input channels.921 Channel 1 A/D calibration value error.925 A/D calibration error.930 Memory acquisition failure.940 The Ethernet module is down.950 Incorrect number for the A/D calibration.951 Failed to write A/D calibration value.
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 10.2 Troubleshooting
 Is the power supply connected properly?
 Is the power supplied properly?
 NO
 NO
 NO
 YES
 YES
 YES
 Does not function (nothing is displayed).
 Is the power switch turned ON? Does the switch work properly?
 Connect properly.
 Turn ON the power properly.
 Contact your nearest YOKOGAWA dealer.
 O.G.
 O.G.
 O.G.: Operation Guide
 O.G.
 Supply the power at the specified voltage and frequency.
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 Does the input meetthe specifications?
 NO
 NO
 NO
 NO
 NO
 YES
 YES
 YES
 YES
 • Large measurement errors• Trend or digital wave value fluctuation• Trend going off the scale beyond either 0% or 100%
 YES
 • Adjust the span and range settings (section 3.3).• If you use input calibration (/CC1 option), check the set values for correction points (section 3.9).
 Change the input wiring to meetthe specifications.
 Is the input wiring correct?
 • Attach the input terminal cover correctly. • Protect the input terminal from fans and other sources of wind.• Keep the temperature fluctuation near the input terminal to a minimum.
 Are the range/spansettings appropriate?
 Are you takingmeasures against noise?
 Areyou keeping
 the environmental temperatureconstant (TC
 input)?
 • Separate the input wiring from the noise source.• Ground the recorder.• Ground the measured object.• Insulate the TC from the measured object.• Use shielded cables for input.• Change the integration time of the input A/D converter (section 3.1). • Use the moving average of the input (section 3.4).
 • Wire correctly (O.G.)• Install the terminal block correctly.• Fasten the terminal screws correctly.• Insulate the RTD from the ground.• If burnt, replace the TC.
 Is the input wiring parallelwith other equipment?
 NO
 NO
 YES
 YES
 Is the RJC settingcorrect (TC input)?
 • Stop the TC burnout upscale/ downscale function of other equipment.• Ground the DX and other equipment at one point.• Disconnect parallel wiring (for example, use a double-element TC)
 Configure correctly.
 Contact your nearest YOKOGAWAdealer to have your DX serviced.
 Section 3.2
 Section 12.1
 O.G.: Operation guide
 10.2Troubleshooting
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 Taking measures against noise?
 NO
 YES
 • Move the input and communication wires away from the noise source.• Ground the recorder.• Use shielded cables for input and communication wires.• Insert an isolation transformer into the power line.• Insert a power line filter into the power line.• If an inductive load is used in the alarm output line, insert a serge suppressor in the line.
 Contact your nearest YOKOGAWA dealer.
 Display and other functions do not work properly.
 Are all ofthe typical conditions for
 displaying the itemsatisfied?
 NO
 YES
 • Make sure that the menu item is set to be displayed using the menu customize function. If the item is not set to be displayed, then set it to be displayed (see section 5.17). • Confirm that the DX is equipped with the options required for that menu item. Contact your nearest YOKOGAWA
 dealer to have your DX serviced.
 Items on the display selection menu orFUNC key menu are not displayed.
 10.2Troubleshooting

Page 295
						

11-1IM 04L41B01-01E
 Calibration
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 11.1 PeriodicInspection
 Check the operation periodically to keep the DX in good working order. Perform the following checks and replace worn parts as needed.• Isthedisplayandstoragefunctioningproperly? If not, see chapter 11, “Troubleshooting” in the DX1000/DX1000N User’s Manual.• HasthebrightnessoftheLCDbacklightdeteriorated? If replacement is necessary, see “Recommended Replacement Periods for Worn
 Parts” in the DX1000/DX1000N Operation Guide, IM 04L41B01-02E.
 Chapter11 Calibration
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 11.2 CalibratingtheDX
 It is recommended that the DX be calibrated once a year to assure its measurement accuracy.Calibration service is also provided by YOKOGAWA dealers.For details, contact your nearest YOKOGAWA dealer.
 RequiredInstrumentsCalibration instruments with the following resolution are required for calibrating the DX.RecommendedInstruments• DCvoltagestandard: Fluke9100orequivalent Mainspecifications Output accuracy: ±(0.005% + 1 µV)• Decaderesistancebox: YokogawaMeters&InstrumentsModel2793-01
 or equivalent Mainspecifications Accuracyofoutputrange0.1to500Ω:±(0.01%
 +2mΩ) Resolution:0.001Ω• 0°Cstandard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent Mainspecifications Standard temperature stability accuracy: ±0.05°CFor information on purchasing the calibration instruments, contact your nearest YOKOGAWA dealer.
 CalibrationProcedure1. Wire the DX and the calibration instrument as shown in the following figure, and
 adequately warm up the instruments (the warm-up time of the DX is at least 30 minutes).
 2. Check that the operating environment such as ambient temperature and humidity is within the standard operating conditions (see section 13.6).
 3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input range and calculate the errors from the readings.If the error does not fall within the accuracy range of the specifications, contact your nearest YOKOGAWA dealer.
 NoteFor thermocouple inputs, you must measure the temperature of the input terminal and apply a voltagetakingintoaccountthereferencejunctiontemperature.
 DCVoltageMeasurement(ExamplefortheDX1012)
 DC voltage standard
 +
 +-
 -
 Input terminal
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 TemperatureMeasurementWhenUsinganRTD(ExamplefortheDX1012)
 Decade resistance box
 The resistance of three lead wires must be equal.
 (Model 2793-01 from Yokogawa Meters & Instruments Corporation)
 b
 B
 A
 Input terminal
 TemperatureMeasurementWhenUsingaThermocouple(ExamplefortheDX1012)
 Thermocouple wires or TC extension wires
 Thermocouple wires
 Copper wires
 Copper wires
 DC voltage standard+
 +-
 (0 °C standard temperature device ZC-114/ZA-10 by Coper Electronics)
 Input terminal
 -
 RJCofTCInputAs the measurement terminal of the DX is generally at room temperature, the actual output of the thermocouple is different from the values given on the thermoelectromotive force table based on 0°C. The DX performs compensation by measuring the temperature at the input terminal and adding the corresponding thermoelectromotive force to the actual output of the thermocouple. Therefore, when the measurement terminal is shorted (equivalent to the case when the detector tip is 0°C), the measured value indicates the temperature of the input terminal.When calibrating the DX, this compensation voltage (thermoelectromotive force of 0°C reference corresponding to the input terminal temperature) must be subtracted from the output of the standard generator before application. As shown in the figure, by using the 0°Cstandardtemperaturedevicetocompensatethereferencejunctionat0°C,youcaninput the thermoelectromotive force of 0°C reference from the DC voltage standard and perform the calibration.
 11.2CalibratingtheDX
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 11.3 PullingOuttheInnerInstrument(DX1000N)
 The inner instrument of the DX1000N can be pulled out.Because some areas inside the DX have high voltages, be sure to pull out the inner instrument correctly. For the procedure, see the Daqstation DX1000/DX1000N/DX2000 Service Manual, SM 04L41B01-01E.
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 12.1 SignalInputandAlarm
 MeasurementInputItem Specifications
 Number of inputs, scan interval, and A/D integration time
 DX1002, DX1002NDX1004, DX1004NDX1006, DX1006NDX1012, DX1012N
 25 ms246
 12
 Fast Sampling Mode*Normal Mode
 Numberof
 InputsModel
 Scan Interval
 A/D converter integration time 60 Hz/50 Hz/100 ms60 Hz/50 Hz
 1 s, 2 s, 5 s
 600 Hz (fixed)
 125 ms
 125 ms, 250 ms
 2 s, 5 s
 * When using the multi batch function (/BT2) the DX do not have a fast sampling mode.Input Type DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI),
 and DC current (by adding an external shut resistor)Measurement range and measurable range
 DC voltage 20 mV –20.000 to 20.000 mV 60 mV –60.00 to 60.00 mV 200 mV –200.00 to 200.00 mV 2 V –2.0000 to 2.0000 V 6 V –6.000 to 6.000 V 20 V –20.000 to 20.000 V 50 V –50.00 to 50.00 V 1-5V 1 to 5 V*6 0.800 to 5.200 VThermocouple R*1 0.0 to 1760.0°C S*1 0.0 to 1760.0°C B*1 0.0 to 1820.0°C K*1 –200.0 to 1370.0°C E*1 –200.0 to 800.0°C J*1 –200.0 to 1100.0°C T*1 –200.0 to 400.0°C N*1 –270.0 to 1300.0°C, on models with release numbers 3 and later. 0.0 to 1300.0°C, on models with release numbers 2 and earlier. W*2 0.0 to 2315.0°C L*3 –200.0 to 900.0°C U*3 –200.0 to 400.0°C WRe*4 0.0 to 2400.0°CRTD Pt (Pt100)*5 –200.0 to 600.0°C JPt (JPt100)*5 –200.0 to 550.0°CDI Level 0: Less than 2.4 V. 1: 2.4 V or higher (judged at the 6 V range) Contact*7 0: Open. 1: Closed (parallel capacitance of 0.01 µF or less)*1: R, S, B, K, E, J, T, N: IEC 60584-1, DIN EN 60584-1, JIS C1602*2: W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988*3: L: Fe-CuNi, DIN 43710, U: Cu-CuNi, DIN 43710*4: WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)*5: Pt100: JIS C1604, IEC 60751, DIN EN 60751 JPt100: JIS C1604, JIS C1606 Measuring current: i = 1mA (Pt100, JPt100)*6: The range for linear scaling of 1-5V inputs. Burnout detection and low-cut functions are available.*7: The detected current value is approx. 10 μA.
 32 to 3200°F32 to 3200°F32 to 3308°F–328 to 2498°F–328.0 to 1472.0°F–328.0 to 2012.0°F–328.0 to 752.0°F–454 to 2372°F, on models with release numbers 3 and later.32 to 2372°F, on models withrelease numbers 2 and earlier.32 to 4199°F–328.0 to 1652.0°F–328.0 to 752.0°F32 to 4352°F–328.0 to 1112.0°F–328.0 to 1022.0°F
 Measurable RangeRangeInput Type
 Chapter12 Specifications
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 Item SpecificationsThermocouple burnout* Burnout upscale/downscale selectable (for each channel).
 Normal:2kΩorless.,Burnout:100kΩormore(parallelcapacitanceof0.01µForless)Detection current: Approx. 10 µA
 1-5 range burnout* Burnout upscale/downscale selectable (for each channel).Burnout detection: Greater than “scale upper limit + 10% of scale width“ (upscale) ,or “
 scale lower limit – less than 5% of scale width“ (downscale)TCreferencejunctioncompensation
 InternalreferencejunctioncompensationorexternalreferencejunctioncompensationFilter function Takes the moving average of the input values (for each channel). Moving average data points: 2 to
 400Computation
 Difference computation Computable range: DC voltage, TC, RTD, and DILinear scaling Computable range: DC voltage, TC, RTD, and DI
 Scalable range: –30000 to 30000. The decimal place is within 4 digits to the right of the decimal point.
 Unit: 6 digits or lessOver value detection: The value can be set to over value when ±5% of the scale range
 is exceeded.Square root computation Takes the square root of the input and apply linear scaling
 Computable type: DC voltageScalable range and unit: Same as linear scalingLow-cut: Set the low-cut value in the range of 0.0% to 5.0% of the span.Over value detection: Same as linear scaling
 1-5V Computable range: 1-5Scalable range and unit: Same as linear scalingLow-cut: The low-cut point is fixed to the span lower limit.Over value detection: Same as linear scaling
 * In fast sampling mode, burnouts on all measurement channels cannot be detected within a scan interval. Burnout may not be detected until the number of measurements indicated below is carried out if measurement is started in a burnout condition or after a burnout occurs.
 DX1002, DX1004, DX1002N and DX1004N: Up to 4 measurements. DX1006, DX1012, DX1006N and DX1012N: Up to 2 measurements.
 AlarmsItem Specifications
 Number of alarms Up to four alarms (level) for each measurement channelsLevels and colors You can change the alarm colors and display order by setting priorities and colors for each alarm
 (release number 3 or later). The alarm level and color settings are shared by all channels.
 Alarm type High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low limit on rate-of-change alarm, delay high limit, and delay low limit
 Alarm delay time 1 to 3600 s (for each channel)Rate-of-change calculation interval of rate-of-change alarms 1 to 32 times the scan interval (common to all channels)
 Alarm output Output to the internal switch Number of internal switches: 30 Internal switch operation: AND/OR operation selectable
 Hysteresis High and low limit alarm: 0.0 to 5.0% of the span (common to all channels) Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)
 Display Displays the status on the respective operation screen and an alarm icon on the status display section when an alarm occurs.
 Display operation: Hold or not hold the display until the alarm acknowledge operation.
 Alarm hide function (alarm no logging function) Not display alarms nor record to the alarm summary (for each channel)
 Alarm information Displays a log of alarm occurrences on the alarm summary.Alarm Annunciator function (release number 3 or later) Alarm displays and relay output operations can be made to follow an alarm sequence. There are three supported alarm sequences: ISA-A-4, ISA-A, and ISA-M. First-out display function: none
 12.1SignalInputandAlarm
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 12.2 DisplayFunction
 DisplayItem SpecificationsDisplay* TFT color LCD, 240 × 320 dots, 5.7-inch (DX1000), 5.5-inch (DX1000N)Brightness 8 levelsBacklight saver function Dim or turn off the LCD backlight if there is no key operation for a specified time.* A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform
 due to the characteristics of the LCD. This is not a malfunction.
 DisplayedInformationItem SpecificationsDisplay groups Assign channels to groups on the trend display, digital display, and bar graph display and display. Number of groups 10 Number of channels that can be assigned to each group
 Up to sixDisplay color Channel: Select from 24 colors Background: Select white or black (excludes the Overview, Alarm annunciator, and Custom displays. See the item on the Historical trend display for information on that display.)Trend display Waveform line width Select from 1, 2, and 3 dots Display method Orthogonal axis display with time axis (T) and measured value axis (Y) Layout: Vertical, horizontal, wide, or split Trend intervals: 5 s*, 10 s* , 15 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h,
 and 10 h/div for the DX1002, DX1002N, DX1004, and DX1004N. 15 s (only in fast sampling mode*), 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, and 10 h/div for the DX1006, DX1006N, DX1012, and DX1012N.
 * release number 3 or later Switchable to the secondary trend interval. Scale Display a scale for each channel. Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.
 Others Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, partial expanded display, auto zone display (release number 3 or later), fine grid (release number 3 or later), and tag detail display (release number 3 or later)
 Digital Display Displays measured values numerically Update rate 1 s (scan interval if the scan interval is greater than 1 s)Bar graph display Displays the measured value on a bar graph
 Direction Vertical or horizontal Base position End or center Update rate 1 s (scan interval if the scan interval is greater than 1 s) Scale Display a scale for each channel Color scale band, and alarm point marks can be displayed on the scale.
 Historical trend display Redisplays the display data or event data in the internal memory or external storage medium. Display formats All screen or half screen (only when the display data is being redisplayed) Top channel (release number 3 or later): Displays the specified channel in front of all the
 others. Autospandisplay(releasenumber3orlater): Automaticallyadjuststhedisplayspanofthe
 specified channel. Auto zone display (release number 3 or later): Displays channels in different zones. Time axis operation The time axis can be reduced or expanded, and data can be displayed continuously. The time
 display can be switched from absolute to relative time (release number 3 or later). Add message Messages can be added. Background color Select from white, cream, black, or light gray.
 Data search Waveforms from the internal memory can be displayed through the specification of a date and time (release number 3 or later).
 Overview Display Displays the measured values of all channels and the alarm statuses.
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 Information display Alarm summary display Displays a log of up to 1000 alarms. Specifyanalarmwiththecursorandjumptothecorrespondingsectiononthehistoricaltrend
 display. Message summary display
 Time and content of up to 450 messages (including 50 add messages) Specifyamessagewiththecursorandjumptothecorrespondingsectiononthehistoricaltrend
 display. Memory summary display Displays the information of the data in the memory. Specifyafilewiththecursorandjumptothecorrespondingsectiononthehistoricaltrenddisplay. Save the data in the internal memory to the external storage medium using keys. Report (/M1 and /PM1) Displays report data from the internal memory
 Stacked bar graph (/M1 and /PM1; Release number 3 or later) Displays the report data of each report group in a stacked bar graph. Display formats: H+D (hourly data is used for the display), Day+Week (daily data is used for the
 display), D+M (daily data is used for the display) Report groups: Report channels are arranged in groups of sixes starting with the first channel
 (R001). The group arrangements are fixed. Scale/grid: Fixed at four divisions Update interval: 1 s The report data of the channels in the specified group is displayed in a stacked bar graph.
 However, only channels that have the same unit of measurement as the first channel in the group are displayed.
 Status Display Relay status display: Displays the ON/OFF status of the alarm output relay and internal switch. Modbus client status: Displays the communication status on the Modbus client Modbus master condition: Displays the communication status on the Modbus master Event switch display (release number 3 or later): Displays the status of the event level switches.
 Log display Displays the login log (only for the DX without /AS1), error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP log, Modbus log, operation log (/AS1 option; release numbers 4 and later), and change settings log (/AS1 option; release numbers 4 and later)..
 Alarm annunciator display (release number 3 or later) Display windows: 24 max. Display window label characters: 32 characters × 5 lines max. Comment text blocks are used.Customdisplay Throughoperationssuchassizeadjustmentsandattributeconfigurations,displaycomponents
 (such as the trend, digital, and bar graph displays) can be arranged to create a custom display. The display data that is created can be saved to internal memory or to an external medium (CF). The saved data can be loaded and displayed.
 Number of displays: 28 (3 in the internal memory and 25 in a CF card)
 System information display Displays the number of measurement and computation channels, options, remote controller ID, MAC address, firmware version, and internal memory capacity.
 Network information display Displays the DX network setup information.
 12.2DisplayFunction
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 OtherDisplayedInformationItem Specifications
 Tag display Tag numbers and comments can be displayed. Tag numbers (release number 3 or later) Up to 16 characters Displayable characters: Alphanumeric characters Tag numbers can be enabled or disabled. Tag comments 32 characters on a DX with a release number of 3 or later. 16 characters on a DX with a release
 number of 2 or earlier. Displayable characters: Alphanumeric characters
 Message Write messages to the trend display. Number of messages 100 Maximum number of saved messages 400 Character Up to 32 alphanumeric characters Write method Write a preset message or write an arbitrary message on the spot. Write destination Select only the displayed group or all groups. Auto message Write a message when the DX recovers from a power failure while memory sampling is in progress. Write a message when the trend interval is switched during memory sampling.
 Add message Write messages to the past data positions. Message The same as the “Message” item above Maximum number of saved messages 50
 Status display section Displays the DX status at the upper section of the display. Displayed contents Year, month, day, time, displayed group name/display name, user name (when using the login
 function), batch name (when using the batch function), internal memory status, external storage medium status, alarm status, and function usage status (key lock , computation function, and e-mail)
 Auto switching of displayed groups Switches the display group at a given interval. Interval: Select from the available settings between 5 s and 1 min.
 Default display Specify the display to be shown automatically when keys are not operated. Time until the display switches: Select from the available settings between 1 min and 1 h.
 Favorite display Register frequently used displays to the Favorite key and show them through simple operation. Up 8 displays can be registered.
 Language Select English, Japanese, German, French, or, Chinese.Display selection menu customization Show/hide and change the positions of each item in the display menus and sub menus Insert/delete separators.
 FUNC key menu customization Show/hide and change the display positions of each item.
 Comments display (release number 3 or later) Displays comments (from a comment text block) when events occur. Comment text blocks 50 Comment text block contents Comment text blocks consist of 5 comment text fields. Comment text fields 100 Characters: up to 32 characters Displayable characters: Alphanumeric characters
 12.2DisplayFunction
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 12.3 DataSavingFunction
 ConfigurationItem SpecificationsInternal memory Temporarily saves various types of data. Medium Flash memoryExternal storage medium Medium CF card Format FAT32 or FAT16
 DataTypeItem SpecificationsDX data types and file extensionsDataType Extension NotesDisplay data .DAD
 .DSD /AS1, release numbers 4 and laterEvent data .DAE
 .DSE /AS1, release numbers 4 and laterManual sampled data .DAMScreen image data .PNGSetup data .PDL
 .PEL /AS1, release numbers 4 and laterReport data .DAR /M1 and /PM1
 .xml /M1 and /PM1, release numbers 4 and laterCustom display setup data .CDC Release numbers 3 and laterChange settings log data .TXT /AS1, release numbers 4 and later
 DisplayDataandEventDataItem SpecificationsInternal memory File storage capacity 400 MB (standard memory; release numbers 4 and later) Number of files Up to 400 Operation FIFO (First In First Out)Display data Target Measurement/computation input channel Sampling intervals Determined by the sample rate. 25 ms, 125 ms, 250 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20
 min and 30 min (15 min, 20min, and 30min are only available on releases 3 and later) An interval that is shorter than the scan interval cannot be set. Description Maximum or minimum value per sampling interval Data size Measurement input channel data: 4 bytes/data value. Computation channel data: 8 bytes/
 data value. File size Up to 8 MB Data format Binary Recording Records data at all times.Event data Target Measurement/computation input channel. Sampling interval Select from the available settings between 25 ms to 600 s. Description Data per sampling interval Data size Measurement input channel data: 2 bytes/data value. Computation channel data: 4 bytes/
 data value. File size Up to 8 MB Data format Binary Mode Free: Records data at all times. Trigger: Starts recording data when a certain event occurs and records for the specified interval.Combinations of saved data Display data only, event data only, or display data and event data.File size See appendix 1.
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 ManualSampledDataItem Specifications
 Item Measured value at an arbitrary timeMaximum number of data values that the internal memory can store 400Data format Text
 ReportData(/M1and/PM1)Item Specifications
 Item Report at each scheduled time of reportMaximum number of reports that the internal memory can store 100Data format Text or XML spreadsheet (release numbers 4 and later)
 SnapshotDataItem Specifications
 Item Displayed screen image dataData format PNGOutput destination CF card, USB flash memory, or communication output
 SavingDatatotheExternalStorageMediumItem Specifications
 Data Saving Saves the data in the internal memory to the external storage medium. Manual save Saves when the external storage medium is inserted with a key operation. Auto save Display data: Every file save interval Event data: Every data length Manual sampled data: When manual sampling is executed. Report data: When report is created. Snapshot data: When a snapshot is taken Auto save operation Select “save data only if there is sufficient free space on the CF card” or “constantly retain the most recent data files in the CF card (media FIFO)” (release number 2 or later).
 File name Select from “sequence number+user-assigned string+date,” “sequence number+user-assigned string,” or “sequence number+batch name.”
 Save destination Auto save: CF card. Manual save: CF card or USB flash memory (/USB1) Directory name: Specify using up to 20 characters.
 ChangeSettingsLogData(/AS1;releasenumbers4andlater)Item SpecificationsItem Log of setting changesMaximum number of data values that the internal memory can store
 200
 Data format TextOutput destination (auto save) SET0 directory on the CF card
 A file name that includes the execution date is automatically attached.
 SetupDataItem Specifications
 Item DX setup dataData format BinaryFile name Specify using up to 32 characters.Output/read destination (for saving/loading) CF card or USB flash memory (/USB1)Output destination (auto save; when the settings are changed on a DX with the /AS1 option) SET0 directory on the CF card A file name that includes the execution date is automatically attached.
 12.3DataSavingFunction
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 CustomDisplaySetupDataItem Specifications
 Contents Custom display layout settingsFormat TextFile name Up to 32 charactersSave/load destination CF card
 DataFileLoadingItem Specifications
 Function Load and show the display data or event data in a CF card or USB flash memory (/USB1).
 MiscellaneousItem Specifications
 Header comment Add up to 50 characters of comment to display data, event data, manual sampled data, or report data file.
 12.3DataSavingFunction
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 12.4 OtherStandardFunctions
 EventActionFunctionItem Specifications
 Event action Execute a specified operation when a given event occurs.Number of settings 40Events Remote control input, etc. Timer Number of timers: 4 Match time timer Number of timers: 4
 Action Specify memory start/stop, alarm ACK, etc. There are limitations on the combinations of events and actions.
 SecurityFunctionItem Specifications
 Key lock function Limitations to key operation, access to the external storage medium, and various operationsLogin function Only registered users can operate the DX. System administrators 5 administrators Users 30 users
 TimeRelatedFunctionsItem Specifications
 Clock With a calendar function Accuracy ±10 ppm (0 to 50°C), excluding a delay (of 1 second, maximum) caused each time the power is
 turned on.
 Time setting Using key operation, communication command, event action function, or SNTP client functionTimeadjustmentmethod While memory sampling Corrects the time by 40 ms for each second. Limitinwhichthetimeisgraduallyadjusted:Selectfromtheavailablesettingsbetween10sand5
 min. If the time is outside the limit, the time is immediately corrected. Cannot be used after hour 0 on January 1st, 2038. While memory is stopped Immediately change the time.
 DST The date/time for switching between standard time and DST can be specified.Time zone Sets the time difference from GMT.Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.
 TypesofCharactersThatCanBeHandledItem Specifications
 Characters Alphabet characters, numbers, and symbols (limitation exists)
 MiscellaneousItem Specifications
 Decimal point type (release number 3 or later) Period or comma
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 Communication FunctionsItem Specifications
 Electrical and mechanical specifications Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).
 Medium Ethernet (10BASE-T)Implemented protocols TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and DX-dedicated protocolsE-mail client Automatically send e-mail at specified times. FTP client Automatically transfer data files to the FTP server. Applicable files: Display data, event data, screen image data, and report data
 FTP Server Transfer files, delete files, manipulate directories, and output file lists of the DX.Web server Shows the DX display on a Web browser.SNTP client Inquires the time to the SNTP server and sets the DX. Cannot be used after hour 0 on January 1st, 2036.
 SNTP server Outputs the DX time. Time resolution: 5 ms Cannot be used after hour 0 on January 1st, 2036.
 DHCP client Automatically obtain the network address settings from the DHCP server.Modbus client Reads data from another device and writes to the registers.Modbus server Loads measurement and computation channel data Loads and writes communication input data Some control commands such as memory start Modbus client register access limitations
 Setting/Measurement server Operate, set, and output data of the DX using a dedicated protocol.Maintenance/test server Outputs connection information and network information.Instrument information server Outputs information (serial number, model name, etc.) of the connected DX.
 EtherNet/IPserver CanjoinanEtherNet/IPnetworkasanadapter(server) Loads measurement and computation channel data Loads and writes communication input data
 Batch FunctionItem Specifications
 Function Data management using batch names. Enter text fields and batch comments in the data file.Batch name Added to the file name of the display data and event data. Structure Batch number (up to 32 characters) + lot number (up to 8 digits)
 Text field Adds text to the display data and event data. There are 24 available text fields for release numbers 3 and later. There are 8 available text fields for release numbers 2 and earlier. Up to 20 title characters and 30 other characters can be entered per field.
 Batch comment Adds text to the display data and event data. Up to 3 comments with 50 characters or less.
 12.4OtherStandardFunctions
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 12.5 Options
 AlarmOutputRelay(/A1,/A2,and/A3)Item Specifications
 Action Outputs relay contact signals from the terminals on the rear panel when alarms occur.Number of outputs 2 outputs (/A1), 4 outputs (/A2), and 6 outputs (/A3)Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)Output format NO-C-NCRelay operation Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.
 RS-232Interface(/C2)andRS-422/485Interface(/C3)Item Specifications
 Connection EIA RS-232(/C2) or EIA RS-422/485(/C3)Protocol Dedicated protocol or Modbus protocolSynchronization Start-stop synchronizationTransmission mode (RS-422/485) Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bpsData length 7 or 8 bitsStop bit 1 bitParity Odd, even, or noneHandshaking Off:Off, XON:XON, XON:RS, and CS:RSCommunication distance (RS-422/485) 1200 mModbus communication Operation modes: Master or slave
 FAIL/StatusOutputRelay(/F1)Item SpecificationsRelay operation assignment You can select which operations to assign to the two relays (release numbers 4 and later).
 FAIL output Relay contact output on CPU error Relay operation Energized during normal operation and de-energized on system error.
 Status output Output a relay contact signal when a selected condition occurs. A combination of the following conditions can be selected: Low memory, memory failure, media error, A/D hardware error, burnout detection, communication
 error (Modbus master or client communication error), alarm occurrence Relay operation Relay is energized when a condition occurs.
 Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)
 ClampedInputTerminal(Detachable)(/H2)Item Specifications
 Input terminal Make the input section clamp input terminals (detachable). Recommended wire size: 0.08 to 1.5 mm2 (AWG 28 to 16)
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 DesktopType(/H5[])Item SpecificationsConstruction With carrying handle. /H5D, /H5F, /H5R, /H5J, /H5H: Power Inlet connector. With a power cord. /H5: Can only be specified when /P1 is simultaneously specified. Screw type power terminal.
 Without power cord.
 ComputationFunction(includingthereportfunction)(/M1)Item SpecificationsNumber of computation channels DX1002, DX1004, DX1002N, and DX1004N: 12 channels (101 to 112) DX1006, DX1012, DX1006N, and DX1012N: 24 channels (101 to 124)Operation General arithmetic operations: Four arithmetic operations, square root, absolute, common logarithm,
 natural logarithm, exponential, and power Relationaloperations: <,≤,>,≥,=,and≠ Logic operations: AND, OR, NOT, and XOR Statistical operations: TLOG or CLOG Special operations: PRE, HOLD, RESET, and CARRY Conditional operation: [a?b:c]Computation accuracy Double-precision floating point Data that can be used Channel data Measurement and computation channels Constants 60 constants Communication input data 24 Remote control input status 0/1 (/R1) Pulse input Counts the number of pulses (/PM1) Status input Internal switch, alarm output relay (/A[ ]), flags, and recording (memory sampling) status (release
 number 3 or later)
 Rolling average Performs moving average on the computed results.Measurement range –9999999 to 99999999 Decimal place: 0 to 4 digits to the right of the decimal pointAlarms High limit, low limit, delay high limit, and delay low limit Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.Display Same as the measurement channelsData saving Same as the measurement channelsReport function Number of report channels: 12 or 24 (same as the number of computation channels) Computation types: Average, maximum, minimum, sum, or instantaneous value Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly Report templates (report output according to templates in XML spreadsheet format; release numbers 4 and later). Templates (xml files) are available on Excel 2003 or later.
 12.5Options
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 Cu10,Cu25RTDInput/3LegIsolatedRTDInput(/N1)Item SpecificationsFunction In addition to the standard input, the DX can also receive Cu10 and Cu25 input. On the DX1006, DX1012, DX1006N, and DX1012N, all the RTD input terminals (A, B,and b) are isolated on each channel.Measurement/display accuracy Under standard operating conditions
 Input TypeMeasurement
 RangeSetting
 AccuracyGuaranteed
 Range
 Measurement Accuracy Max.ResolutionA/D integration time:
 16.7 ms or moreA/D integration time:
 1.67 msCu10 (GE)Cu10 (L&N)Cu10 (WEED)Cu10 (BAILEY)Cu10:α=0.00392 at 20°CCu10:α=0.00393 at 20°CCu25:α=0.00425 at 0°C
 Cu1Cu2Cu3Cu4Cu5Cu6Cu25
 –70.0 to 170.0°C–75.0 to 150.0°C–200.0 to 260.0°C
 –200.0 to 300.0°C
 –200.0 to 300.0°C
 * Measuring current i = 1 mA
 ±(0.4% of rdg + 1.0°C)
 ±(0.3% of rdg + 0.8°C)
 ±(0.8% of rdg + 5.0°C)
 ±(0.5% of rdg + 2.0°C)
 0.1°C
 Inputsourceresistance 1Ωorlessperwire(Theresistanceofallthreewiresmustbeequal).Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater) ±(0.2% of range + 2 digits) or lessInputsourceresistance Withvariationof1Ωperwire(resistanceofallthreewiresmustbeequal):±(0.1%ofrdg+1digit)
 or less Withmaximumdifferenceof40mΩbetweenwires:Approx.1°C
 12.5Options
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 3LegIsolatedRTDInput(/N2)Item Specifications
 Input terminal All the RTD input terminals (A, B, and b) are isolated on each channel. Applies to DX1006, DX1012, DX1006N, and DX1012N Note: On the DX2004 and DX2008 standard models, all the terminals (A, B, and b) are already isolated on each channel
 ExtendedInputType(/N3)Item Specifications
 Measurement/display accuracy Under standard operating conditions
 Kp vs Au7Fe 0.0 to 300.0K
 PLATINEL 0.0 to 1400.0°C
 PR40-20 0.0 to 1900.0°C
 NiNiMo 0.0 to 1310.0°CW/WRe26 0.0 to 2400.0°C
 Type N(AWG14) 0.0 to 1300.0°CXK GOST*2 –200.0 to 600.0
 Pt50 –200.0 to 550.0°CNi100(SAMA) –200.0 to 250.0°CNi100(DIN) –60.0 to 180.0°CNi120 –70.0 to 200.0°CJ263*B 0.0 to 300.0K
 Cu53 –50.0 to 150.0°CCu100 –50.0 to 150.0°CPt25 –200.0 to 550.0°CPt100GOST*2 –200.0 to 600.0°CCu100 GOST*2 –200.0 to 200.0°CCu50 GOST*2 –200.0 to 200.0°CCu10 GOST*2 –200.0 to 200.0°CPt46 GOST*2 –200.0 to 550.0°CPt200 (WEED)*3 –100.0 to 450.0°C
 *1 Measuring current i = 1 mA*2 Available for release numbers 3 and later.
 MeasurementRange
 Measurement AccuracyMax.
 ResolutionInput Type
 Thermocouple
 RTD*1
 0 to 20 K Within ±4.5 K20 to 300 K Within ±2.5 K±(0.25% of rdg + 2.3°C)0 to 450°C Accuracy not guaranteed450 to 750°C ±(0.9% of rdg + 3.2°C)750 to 1100°C ±(0.9% of rdg + 1.3°C)1100 to 1900°C ±(0.9% of rdg + 0.4°C)±(0.25% of rdg + 0.7°C)0 to 400°C ±15.0°C400 to 2400°C ±(0.2% of rdg + 2.0°C)±(0.2% of rdg + 1.3°C)–200 to –100°C ±(0.25% of rdg +1.0°C)–100 to 600°C ±(0.25% of rdg + 0.8°C)±(0.3% of rdg + 0.6°C)±(0.15% of rdg + 0.4°C)±(0.15% of rdg + 0.4°C)±(0.15% of rdg + 0.4°C)0 to 40 K Within ±3.0 K40 to 300 K Within ±1.0 K±(0.15% of rdg + 0.8°C)±(0.2% of rdg + 1.0°C)±(0.15% of rdg + 0.6°C)±(0.15% of rdg + 0.3°C)±(0.15% of rdg + 0.3°C)±(0.4% of rdg + 0.5°C)±(1.5% of rdg + 3.0°C)±(0.3% of rdg + 0.8°C)±(0.3% of rdg + 0.6°C)
 Within ±13.5 KWithin ±7.5 K±(0.25% of rdg + 8.0°C)Accuracy not guaranteed±(0.9% of rdg + 15.0°C)±(0.9% of rdg + 6.0°C)±(0.9% of rdg + 3.0°C)±(0.5% of rdg + 3.5°C)±30.0°C±(0.4% of rdg + 4.0°C)±(0.5% of rdg + 7.0°C)±(0.5%of rdg +5.0°C)±(0.5%of rdg +4.0°C)±(0.6% of rdg + 3.0°C)±(0.3% of rdg + 2.0°C)±(0.3% of rdg + 2.0°C)±(0.3% of rdg + 2.0°C)Within ±9.0 KWithin ±3.0 K±(0.3% of rdg + 4.0°C)±(0.4% of rdg + 5.0°C)±(0.3% of rdg + 3.0°C)±(0.3% of rdg + 1.5°C)±(0.3% of rdg + 1.5°C)±(0.8% of rdg + 2.5°C)±(3.0% of rdg + 15.0°C)±(0.6% of rdg + 4.0°C)±(0.6% of rdg + 3.0°C)
 0.1K
 0.1°C
 0.1K
 0.1°C
 A/D integration time: 16.7 ms or more A/D integration time:1.67 ms
 *3 Available for release numbers 4 and later. Double the resistance of a 100 ohm Platinum (TCR = .003902 ohms/ohm/°C) Curve A resistor made by Weed Instrument.
 Inputsourceresistance Thermocoupleinput: 2kΩorless RTDinput: 1Ωorlessperwire(Theresistanceofallthreewiresmustbeequal).Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater) TCinput ±(0.1%ofrdg+0.05%ofrange)orless,excludingtheerrorofreferencejunctioncompensation RTD input ±(0.2% of range + 2 digits) or lessInput source resistance TCinput Withvariationof+1kΩ:±10µVorless RTDinput Withvariationof1Ωperwire(resistanceofallthreewiresmustbeequal):±(0.1%ofrdg+1digit)
 or less Withmaximumdifferenceof100mΩbetweenwires: Approx.1°C
 12.5Options
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 RemoteControl(/R1)Item Specifications
 Number of input terminals 8Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input
 terminals, and shared common.Input type and signal level Voltage-freecontact Contactclosedat200Ωorlessandcontactopenat100kΩorgreater. The remote contact input operation can be set to normal open or normal close (release number 3 or
 later) Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or lessAllowable input voltage 5 VDCSignal type Level or edge (250 ms or more)Action Executes a specified action by applying a given signal to the remote signal input terminal. Action assignment: Set using the event action function
 24VDCTransmitterPowerSupply(/TPS2and/TPS4)Item SpecificationsNumber of loops 2 (/TPS2) or 4 (/TPS4)Output voltage 22.8 to 25.2 VDC (under rated load current)Rated output current 4 to 20 mADCMax. output current 25 mADC (overcurrent protection operation current: approx. 68 mADC)Allowable conductor resistance RL≤(17.8–minimumtransmitteroperationvoltage)/0.02A where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5 V when the load
 shuntresistanceis250Ωfromtheminimumoutputvoltageof22.8VMax. length of wiring 2 km (when using the CEV cable)Insulationresistance 20MΩormoreat500VDCbetweenoutputterminalandgroundDielectric strength 500 VAC (50/60 Hz, I = 10mA) for one minute between output terminal and ground 500 VAC (50/60 Hz, I = 10mA) for one minute between output terminals
 EasyTextEntry(/KB1and/KB2)Item SpecificationsRemote control terminal (438227) Operating temperature range 0 to 40°C Operation humidity range 20% to 80% RH (at 5 to 40°C no condensation) Power supply 3 VDC AA dry batteries × 2 Weight Approx. 60 g (excluding the batteries) External dimensions 170 (H) × 50 (W) × 23.7 (D) mm Signal InfraredCombination with the DX Number of units that can be controlled individually Up to 32 units by setting the ID number Communication distance Up to 8 m from the front of the light receiving section of the DX (reference value)* Directional characteristics See the figure below (reference characteristics)* * Varies depending on the operating environment such as the battery voltage and the presence or
 absence of external light. Standard accessories (/KB1) Remote control unit, two alkaline dry batteries, and ID number label
 Distance (m)
 Horizontal Vertical0
 0 0
 30
 15 1510 105 51 1
 -30-45
 -60
 45
 60
 90-90
 Distance (m)
 030
 15 1510 105 51 1
 -30-45
 -60
 45
 60
 90-90
 (+)(+)
 ( ) ( )--
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 USBInterface(/USB1)Item SpecificationsUSB port Complies with Rev. 1.1 and host functionNumber of ports 2 (one each on the front panel and rear panel)Power supply 5 V , 500 mA (per port) Devices which need more than 500 mA total bus power for 2 ports can not be connected at the
 same time.Connectable devices Only connect the devices listed below to prevent damage to the devices. Keyboard Complies with HID Class Ver. 1.1 104 keyboard/89 keyboard (US) and 109 keyboard/89 keyboard (Japanese) Number connectable units: 1 External medium USB flash memory Does not guarantee the operation of all USB flash memories. External medium such as a hard disk, ZIP, MO, and optical discs are not supported. Number connectable units: 1 Barcode reader (release number 3 or later) USB HID Class Ver. 1.1 compatible English (U.S.) standard USB keyboard compatible
 PulseInput(/PM1)Item Specifications
 Pulse input Number of inputs 3 (8 when using the remote control input terminals) Input type Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the
 input terminals. Shared common for pulse inputs. InputtypeandsignallevelVoltage-freecontact Contactclosedat200Ωorlessandcontactopenat100kΩorgreater Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when
 OFF: 0.25 mA or less Counting Counts the rising edges of pulses. For voltage-free contact input: Contact open to contact close For open collector: Voltage level of the terminal H from high to low Allowable input voltage 30 VDC Max. sampling pulse period 100 Hz Minimum detected pulse width 5 ms or more for both low (closed) and high (open) Pulse detection period Approx. 3.9 ms (256 Hz) Pulse measuring accuracy ±1 pulse Pulse count interval Scan interval or 1 s Miscellaneous Pulse input terminals can be used as remote control input terminals, isolated from remote control input terminals
 Remote control Number of inputs: 5. Same as remote control (/R1) for the other specificationsComputation function Same as the computation function (/M1)
 CalibrationCorrection(/CC1)Item Specifications
 Calibration correction method Corrects the measured value of each channel using segment linearizer approximation. Number of segment points: 2 to 16 (including the start and end points)
 Calibration management A function to make sure that calibration is performed regularly (release numbers 4 and later)
 12.5Options
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 DC/AC24Vpowersupply(/P1)Item Specifications
 Rated supply voltage 24 VDC and 24 VAC (50/60Hz)Allowable power supply voltage range 21.6V to 26.4 VDC/ACInsulationresistance Betweenpowerterminalandearth:20MΩorgreaterat500VDC.Withstand voltage Between power terminal and earth: 500 VAC at 50/60 Hz for one minuteRated power supply frequency (for AC) 50/60 Hz Allowable power supply frequency range (for AC) 50 Hz ±2%, 60 Hz ±2%Power supply fluctuation (for AC) With variation within 21.6 to 26.4 VDC/AC: ±1digit or less With variation of ±2 Hz from rated power supply frequency (at 24 VAC): ±(0.1% of rdg+1digit) or lessRated power consumption 28 VA (for DC), 45 VA (for AC)Power consumption
 Supplyvoltage LCDbacklightoff Normal Maximum24 VDC 8 VA 15 VA 28 VA24 VAC (50/60Hz) 15 VA 24 VA 45 VA
 Multibatchfunction(/BT2;releasenumber3orlater)Item Specifications
 Function Individual recording start/stop and file generation operations can be performed for each batch. Equippable models: DX1006, DX1012, DX1006N, and DX1012NNumber of batches 2 to 6Batch single operations Recording start/stop, computation reset, message writeBatch overview operations Computation start/stop, report start/stop, manual sampling, setup data save/loadScan interval Maximum speed of 1 s in normal mode only (same for all batches)Data type Display or event data only. Trigger mode cannot be used for event data.Data recording interval Same for all batchesData files Can be displayed or made into an event data file separately for each batchNumber of display groups Up to six per batch The maximum number of channels per group is six. Channels in a display group are sampled for display or event data.Timers and match time timers 12 max.Batch single settings Group, trip line, file header, data file name, text field, batch number, and lot number
 PROFIBUS-DP(/CP1option;releasenumber3orlater)Item Specifications
 Function A PROFIBUS-DP master device can access internal data in the following ways: Load measurement channel data Load computation channel data Write to communication input data (for up to 32 channels)Data mapping
 Buffer Description Maximum Size
 Input Measurement channels are arranged at the start of the buffer. As many computation channels as can be placed into the buffer are inserted after the measurement channels.
 128 bytes
 Output Up to 32 communication input data values are arranged. 128 bytes
 Node address 0 to 125Interface PROFIBUS-DP-V0 SlaveTransmission medium Two dedicated cables (one for each signal line)Transmission speed/distance 9.6 kbps/1200 m to 12 Mbps/100 mTerminator No internal terminator (must be terminated externally)
 12.5Options
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 AdvancedSecurityFunction(/AS1;releasenumbers4andlater)Item SpecificationsLogin function Only registered users can operate the DX.
 Administrators 5 administratorsUsers 90 usersUser identification User name, user ID, and password
 Password management function Password management feature that uses Windows Server 2003 or 2008 Active Directory featureSupports login authentication through a Kerberos authentication server
 Audit trail functionOperation log storage The operation history from the previous memory stop to the current memory stop is attached
 to a data file.Maximum operation logs: 2000
 Change settings log and setup file storageA setup file and change settings log are saved to the CF card when the settings are changed.
 Signature function (digital signature) Attaches approval information to measured data files.Information that can be attached User name, date and time, pass/fail, commentNumber of signatures Up to 3 per fileSignature record Can be set for each user
 The attached approval information cannot be deleted or changed.Applicable files Display data files and event data files in the internal memory
 When the process type is “Batch”: Undivided data files (one data file per batch)When the process type is “Continue”: Each data file
 Measured Data File Protection Measured data files are protected through operation logs, setup file storage, and encryption.Data Formats and Extensions Files that use this function have special extensions.
 Display data: .DSD, event data: .DSE, setup data: .PEL, change settings log data: .TXTMiscellaneous (main differences from DXs without the /AS1 option)
 Data types Display or event data only. Trigger mode cannot be used for event data.Individual alarm ACK ACK operations can be performed on individual alarms.Alarm delay time Up to 24 hEvent Action The “PnlLoad” action is not availableKey lock NoDeletion of external storage medium files
 Not allowed.Formatting of external storage media
 Not allowed.Loading of setup files You can choose whether or not to load login information.FAIL/status output relay (/F1 and /F2 options)
 You can choose from five operations to assign to the two output relays.Automatic messages A message is written when the setting mode setup items are changed during memory
 sampling.Logs There is no login log. There is an operation log and a change settings log.
 12.5Options

Page 317
						

12-19IM 04L41B01-01E
 Specifications
 1
 2
 3
 4
 5
 6
 7
 8
 9
 10
 11
 12
 App
 Index
 12.6 GeneralSpecifications
 ConstructionItem SpecificationsMounting Flush panel mounting (on a vertical plane) (excluding the desktop type)Mounting angle Inclined backward up to 30 degrees from a horizontal plane.Allowable panel thickness 2 to 26 mmMaterial Case: Metal plate Bezel and display cover: PolycarbonateColor Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent) Bezel: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)Front panel Water and dust proof: Complies with IEC529-IP65 and NEMA No.250 TYPE 4 (except External Icing Test) (Style number 2 or later), except side-by-side mountingExternal dimensions 144 (W) × 144 (H) × 229 (D) mm (D: depth from the panel mounting plane)Weight DX1000: Approx. 2.9 kg excluding options, DX1000N: Approx. 3.7 kg excluding options
 NormalOperatingConditionsItem SpecificationsSupply voltage 90 to 132, 180 to 250 VACPower supply frequency 50 Hz ± 2%, 60 Hz ± 2%Ambient temperature 0 to 50°CAmbient humidity 20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)Vibration 10 to 60 Hz, 0.2 m/s2
 Shock Not allowedMagnetic field 400 A/m or less (DC and 50/60 Hz)Noise Normal mode (50/60 Hz) DC voltage The peak value including the signal must be less than 1.2 times the measuring range. Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal electromotive force. RTD 50 mV or less Common mode noise 250 VACrms or less for all ranges (50/60 Hz)Maximum noise voltage between channels 250 VACrms (50/60 Hz) or lessMounting position Can be inclined up to 30 degrees backward. Left and right horizontal.Warm-up time At least 30 minutes after power onInstallation location IndoorsOperating altitude 2000 m or less
 PowerSupplyItem SpecificationsRated supply voltage 100 to 240 VACAllowable power supply voltage range 90 to 132, 180 to 264 VACRated power supply frequency 50 Hz, 60 HzPower consumption Supplyvoltage LCDbacklightoff Normal Maximum
 100 VAC 15 VA 24 VA 45 VA240 VAC 25 VA 32 VA 60 VA
 Allowable interruption time Less than 1 cycle of the power supply frequency
 IsolationItem SpecificationsInsulationresistance BetweentheEthernet,RS-422/485,andinsulationterminalsandearth:20MΩorgreaterat500VDCWithstand voltage Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute Mutually between measurement input terminals: 1000 VAC (50/60 Hz) for one minute (excluding
 the RTD input terminal of DX1006, DX1012, DX1006N and DX1012N)
 Between the remote input terminal and earth: 1000 VDC for one minute Between the pulse input terminal and earth: 1000 VDC for one minuteGround Groundingresistance:100Ωorless
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 TransportandStorageConditionsItem SpecificationsAmbient temperature –25 to 60°CAmbient humidity 5 to 95%RH (no condensation)Vibration 10 to 60 Hz, 4.9 m/s2 maximumShock 392 m/s2 maximum (in packaged condition)
 SupportedStandardsItem SpecificationsCSA CSA22.2 No.61010.1, CSA C22.2 No.61010-2-030, installation category II*1, pollution degree 2*2, and measurement category II*3
 UL UL61010-1, UL 61010-2-030 (CSA NRTL/C)CE EMC directive EN61326-1 compliance, Class A, Table 2 (For use in industrial locations) EN61000-3-2 compliance EN61000-3-3 compliance EN55011 compliance, Class A, Group 1 Low voltage directive EN61010-1, EN 61010-2-030 compliance, installation category II*1, pollution degree 2*2, and measurement category II*3
 EMC regulatory arrangement in Australia and New Zealand EN55011 compliance, Class A, Group 1KC marking Electromagnetic wave interference prevention standard, electromagnetic wave protection standard complianceWEEE directive Compliant*4
 *1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. Iimplies the regulation for impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation like a distribution board.
 *2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface resistivity is adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.
 *3 Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power from fixed equipment such as electric switchboards.
 *4 DX1000N is excluded.
 12.6GeneralSpecifications
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 StandardPerformanceItem SpecificationsMeasurement/display accuracy Standard operating conditions: Temperature: 23 ± 2°C Humidity: 55% ± 10%RH Power supply voltage: 90 to 132 or 180 to 250 VAC Power supply frequency: 50/60 Hz ± 1% Warm-up time: At least 30 minutes. Other ambient conditions such as vibration should not adversely affect the operation.
 Input Type Range
 20 mV 60 mV200 mV
 2 V1-5 V6 V20 V50 V
 R
 S
 B
 K
 EJTN
 WLU
 WRe
 Pt100JPt100VoltageContact
 A/D integration time: 16.7 ms or more±(0.05% of rdg + 12 digits)
 ±(0.05% of rdg + 3 digits)
 ±(0.05% of rdg + 12 digits)
 ±(0.05% of rdg + 3 digits)
 ±(0.15% of rdg + 1°C)R, S 0 to 100°C:±3.7°C, 100 to 300°C:±1.5°CB 400 to 600°C:±2°C, Accuracy not guaranteedfor values less than 400°C.±(0.15% of rdg + 0.7°C)–200 to –100°C: ±(0.15% of rdg + 1°C)±(0.15% of rdg + 0.5°C)–200 to –100°C: ±(0.15% of rdg + 0.7°C)
 ±(0.15% of rdg + 0.7°C)–200 to 0°C: ±(0.35% of rdg + 0.7°C)Accuracy not guaranteed for values lessthan –200°C.±(0.15% of rdg + 1°C)±(0.15% of rdg + 0.5°C)–200 to –100°C: ±(0.15% of rdg + 0.7°C)±(0.2% of rdg + 2.5°C)0 to 200°C: ±4.0°C
 ±(0.15% of rdg + 0.3°C)
 Threshold level (Vth=2.4 V) accuracy ± 0.1 VWith parallel capacitance of 0.01 µF or less, 1 kΩ or less: 1 (ON). 100 kΩ or more: 0 (OFF).
 A/D Integration Time: 1.67 ms±(0.1% of rdg + 40 digits)
 ±(0.1% of rdg + 15 digits)
 ±(0.1% of rdg + 40 digits)
 ±(0.1% of rdg + 15 digits)
 ±(0.2% of rdg + 4°C)R, S 0 to 100°C: ±10°C, 100 to 300°C: ±5°CB 400 to 600°C: ±7°C, Accuracy not guaranteed for valuesless than 400°C.±(0.2% of rdg + 3.5°C)–200 to –100°C:±(0.15% of rdg + 6°C)±(0.2% of rdg + 2.5°C)–200 to –100°C: ±(0.2% of rdg + 5°C)
 ±(0.3% of rdg + 3.5°C)–200 to 0°C: ±(0.7% of rdg + 3.5°C)Accuracy not guaranteed for values lessthan –200°C.±(0.3% of rdg + 7°C)±(0.2% of rdg + 2.5°C)–200 to –100°C: ±(0.2% of rdg + 5°C)±(0.3% of rdg + 10°C)0 to 200°C: ±18.0°C
 ±(0.3% of rdg + 1.5°C)
 DC voltage
 Thermocouple (Not includingthe accuracy ofreferencejunctioncompensation;when burnoutdetectionfunction is off.)
 RTD
 Max. Resolutionof Digital Display 1 μV 10 μV 10 μV 100 μV 1 mV 1 mV 1 mV 10 mV
 0.1°C
 Measurement Accuracy (Digital Display)
 DI
 12.6GeneralSpecifications
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 Item SpecificationsMeasuring accuracy in case of scaling Accuracy during scaling (digits) = measurement accuracy (digits) × multiplier + 2 digits (rounded up) * Fractions rounded up where the multiplier = scaling span (digits)/measuring span (digits). Example For 1-5 V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to
 5.000 V, and scaling span of 0.000 to 2.000 The measuring accuracy for 5 V input is as follows. Measuring accuracy (1-5 Vrange) = ±(0.05% × 5 V + 3 digits) = ±(0.0025 V [3 digits] + 3
 digits) = ±6 digits Multiplier = 2000 digits (0.000 to 2.000)/4000 digits (1.000 to 5.000) = 0.5 Thus, accuracy during scaling = ±(6 × 0.5 + 2) digits = 5 digits (rounded up)Referencejunctioncompensationaccuracy When measuring temperature greater than or equal to 0 °C and when input terminal temperature is balanced Type R, S, W, WRe: ±1.0°C Type K, J, E, T, N, L, and U: ±0.5°C. Type B: Internal reference compensation is fixed to 0°CMaximum input voltage ±60 VDC (continuous)Inputresistance 200mVrangeorlessandTC: 10MΩormore 2Vrangeorhigher: Approx.1MΩInput source resistance Volt,TC 2kΩorless RTDinput 10Ωorlessperwire(Theresistanceofallthreewiresmustbeequal).Bias current 10 nA or less (except when burnout detection function is enabled)Maximum common mode noise voltage 250 VACrms (50 Hz/60 Hz)Maximum noise voltage between channels 250 VACrms (50 Hz/60 Hz)Interferenceacrosschannels120dB(whentheinputsourceresistanceis500Ωandtheinputtootherchannelsis60VDC)CommonmoderejectionratioWhen the A/D integration time is 20 ms 120dB(50Hz±0.1%,500Ωunbalanced,betweentheminusterminalandground) When the A/D integration time is 16.7 ms 120dB(60Hz±0.1%,500Ωunbalanced,betweentheminusterminalandground) When the A/D integration time is 1.67 ms 80dBorhigher(50/60Hz±0.1%,500Ωunbalanced,betweentheminusterminalandground)Normalmoderejectionratio When the A/D integration time is 20 ms 40 dB or more (50 Hz ± 0.1%) When the A/D integration time is 16.7 ms 40 dB or more (60 Hz ± 0.1%) When the A/D integration time is 1.67 ms Notreject50/60Hz
 EffectsofOperatingConditionsItem SpecificationsAmbient temperature (applies when the A/D integration time is 16.7 ms or greater, with temperature variation of 10°C) DC voltage, TC range ±(0.1% of rdg + 0.05% of range) or less * Excludingtheerrorofreferencejunctioncompensation RTD range ±(0.1% of rdg + 2 digits) or lessPower supply fluctuation With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz): Accuracy specifications are satisfied. With variation of ±2 Hz from rated power frequency (power supply voltage 100 VAC): Accuracy specifications are satisfied.Magnetic field AC (50/60 Hz) and DC 400 A/m fields: ±(0.1% of rdg + 10 digits) or lessInput source resistance DCvoltagerange Withvariationof+1kΩ: 200 mV range or less: ±10 µV or less 2 V range or higher: ±0.15% of rdg or less TCrange Withvariationof+1kΩ: ±10µVorless RTD range (Pt100) Withvariationof10Ωperwire(resistanceofallthreewiresmustbeequal):±(0.1%ofrdg+1digits)orless Withmaximumdifferenceof40mΩbetweenwires: Approx.0.1°C
 Effects of vibration Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an acceleration of 0.2 m/s2: ±(0.1% of rdg + 1 digit) or less
 12.6GeneralSpecifications
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 MiscellaneousItem SpecificationsMemory backup A built-in lithium battery backs up the settings and runs the clock Battery life: Approximately 10 years (at room temperature)
 12.6GeneralSpecifications
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 12.7 ExternalDimensions
 See the DX1000/DX1000N Operation Guide (IM04L41B01-02E).
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 Appendix1 FileSizeofDisplayDataandEventData
 This section explains how to calculate the file size of display data files and event data files. The calculation examples are given for the display data only and event data only cases. If you are recording both display and event data, calculate the data size of each and add them together.Use the calculated file size as a rough guide.These calculation examples only apply to DXs that do not have the /AS1 advanced security option.
 FileSizeAfileconsistsofthefollowingdata. Informationotherthanthesampleddata+thesampleddataThe maximum size of a single display data file or event data file is 8 MB.
 SizeofInformationOtherThantheSampledDataItem Size[Bytes]
 File header 216Channel information 88×N + 32Group information 96×10 + 32 = 992Message information 104*50 + 32 (an add message area is reserved by default)Batch information 832Sampled data header 80 + 32 + N×8 + 16 + 2Alarm information header 24 + 8 (add the size of this item even if there is no alarm)Message information Up to 104×1050 (varies depending on the number of messages)Alarm information Up to 32×5000 (varies depending on the number of alarms)Release number 3 expansion information
 1696 + 80×NExpansion information is always stored.
 N is the number of channels (measurement channels + computation channels).
 Example1: If display data of 12 measurement channels and 24 computation channels is recorded. There are no messages or alarms.
 216 + (88 × 36 + 32) + 992 + (104 × 50 + 32) + 832 + (80 + 32 + 36 × 8 + 16 + 2) + (24 + 8) + 4,576
 = 15,498 bytes
 SampledDataSize• DataSizeofDisplayDataandEventData
 Channel DisplayData EventDataMeasurement channel 4 bytes/channel 2 bytes/channelComputation channel 8 bytes/channel 4 bytes/channel
 Time data common to all channels is added for each sample.Time data 8 bytes/sample
 • DataSizeperSample DisplayData (Number of measurement channels×4 bytes) + (number of computation channels×8
 bytes) + 8 bytes (time data)
 EventData (Number of measurement channels×2 bytes) + (number of computation channels×4
 bytes) + 8 bytes (time data)
 Appendix
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 • SampledDataSizeperFile DisplayData
 Datasizepersample×filesaveinterval/samplinginterval The sampling interval is determined by dividing the trend interval (in seconds) by 30 (40
 if the trend interval is 5 or 10 s).
 Example2: If the display data of 12 measurement channels and 24 computation channels is recorded with a trend interval of 30 min/div (the sampling interval of displaydatais60s)andafilesaveintervalof1day(24h)
 (12×4 bytes + 24×8 bytes + 8 bytes)×24 h×60×60/60 s = 248 bytes×24 h×60×60/60 s = 357,120 bytes
 EventData Data size per sample×data length/sample rate
 Example3: If the event data of 12 measurement channels and 24 computation channels is recorded with a sample rate of 1 s and data length of 2 h
 (12×2 bytes + 24×4 bytes + 8 bytes)×2 h×60×60/1 s = 128 bytes×2 h×60×60/1 s = 921,600 bytes
 SizeperFileThe size per file is the sum of the size of information other than the sampled data and the size of the sampled data. DisplayData Example4: If recording under the conditions of examples 1 and 2 From examples one and two, we obtain 15,498 + 357,120 = 372,618 bytes = 0.355
 MB
 EventData Example5: If recording under the conditions of examples 1 and 3 From examples one and three, we obtain 15,498 + 921,600 = 937,098 bytes = 0.893
 MB
 Appendix1FileSizeofDisplayDataandEventData
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 SaveDurationtotheCFCardWe will estimate the duration over which measured data can be saved to a CF card when measured data is being saved automatically.DisplayData SavedurationtotheCFcard(estimate)=(SizeoftheCFcard/sizeofafile)×[filesave
 interval] Example6: We will estimate the save duration to the CF card under the conditions
 of examples 1 and 2. In this example, the size of the CF card is assumed to be 256 MB.
 256 MB/0.355 MB × 24 h = 17,307 h = 721 days
 EventData SavedurationtotheCFcard(estimate)=(SizeoftheCFcard/sizeofafile)×[data
 length] Example7: We will estimate the time until the CF card needs to be replaced
 under the conditions of examples 1 and 3. In this example, the size of the CF card is assumed to be 256 MB.
 256 MB/0.893 MB × 2 h = 573 h = 23 days
 NoteIf you format a 256-MB CF card, you will be able to use approximately 246 MB.
 TimeuntiltheInternalMemoryBecomesFullIf you are manually saving the measured data in the internal memory, old data is overwritten when the internal memory is full. You must save the measured data to the CF card before the data is overwritten.DisplayData Time until the internal memory becomes full (estimate) = (Size of the internal memory/
 sizeofafile)×[filesaveinterval] Example8: We will estimate the time until the internal memory becomes full under
 the conditions of examples 1 and 2. The size of the internal memory is 400 M bytes.
 400 MB/0.355 MB × 24 h =1,126files×24h Becausethemaximumnumberofthefilesthatcanbeheldintheinternalmemoryis
 400,thetimeuntiltheinternalmemorybecomesfullis400files×24h=400days.
 EventData Time until the internal memory becomes full (estimate) = (Size of the internal memory/
 sizeofafile)×[datalength] Example9: We will estimate the time until the internal memory becomes full under
 the conditions of examples 1 and 3. The size of the internal memory is 400 M bytes.
 400 MB/0.893 MB × 2 h =447files×2h Becausethemaximumnumberofthefilesthatcanbeheldintheinternalmemoryis
 400,thetimeuntiltheinternalmemorybecomesfullis400files×2h=800h=33days.
 Appendix1FileSizeofDisplayDataandEventData
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 Appendix2 TypesofDataFilesThattheDXCanCreateandTheirApplication
 This section explains the types of datafilesthattheDXcancreateandtheirapplication.DataType Extension Format DisplayMethod*1
 DX DAQ ApplicationDisplay data DAD Binary (undisclosed) Yes Yes Yes*2, *3
 DSD Yes Yes Yes*2, *3
 Event data DAE Binary (undisclosed) Yes Yes Yes*2, *3
 DSE Yes Yes Yes*2, *3
 Report data DAR Text (see appendix 3) - Yes Yesxml XML spreadsheet - - Yes
 Manual sampled data DAM Text (see appendix 3) - - YesSetup data PDL Binary (undisclosed) - - -
 PEL - - -Snapshot data PNG PNG (general format) - - YesCustom display setup data CDC Text - - -Change settings log TXT Text - - Yes*1 DX: DX main unit, DAQ: DAQSTANDARD, Application: Software application*2 The data format can be converted on DAQSTANDARD and displayed on a software application
 such as Microsoft Excel.*3 The data can be retrieved from the DX using the communication function and displayed on a
 software application.
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 Appendix3 TextFileDataFormat
 This section explains the format of text files. The text files that the DX can create are manual sampled data files and report files.In the explanation below, CRLF represents a terminator.
 FormatoftheManualSampleDataFile• Themanual sampled data is output using numerical values and strings in text format
 delimited by tabs.• ValuesofmeasurementchannelssettoSkip and computation channels set to Off are
 not output.• Thedataisappendedtothefileeachtimemanualsampleoperationisperformed.
 FormatYRECCRLF
 Manual Sample Data Version 1.02.00 CRLF
 Model DX1000 CRLF
 Language Code shift-JIS CRLF
 File Status ffffffff CRLF
 Serial No. III···I CRLF
 File Header HHH···H CRLF
 Ch ccccc ccccc ··· cccccCRLF
 Ch Id ddd···d ddd···d ··· ddd···dCRLF
 Tag ttt···t ttt···t ··· ttt···tCRLF
 Unit uuuuuu uuuuuu ··· uuuuuuCRLF
 yyyy/mo/dd hh:mi:ss nnn···n nnn···n ··· nnn···nCRLF* Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or
 later.
 ffffffff File status (8 characters)Complete Completed.(Afilewith100manuallysampled
 data acquisitions that is now complete.)Progress Dataisbeingadded.(Anincompletefilethat
 does not yet have 100 manually sampled data acquisitions.)
 Decrease Thefileisdefective.(Afilethatismissingsomeof the manually sampled data that was stored on it.)
 III···I Serial number of the DX (16 characters)HHH···H File header (50 characters)ccccc Channel number (5 characters)ddd···d Tag number (16 characters)ttt···t Tag comment (32 characters)uuuuuu Unit (6 characters)yyyy/mo/dd hh:mi:ss Sampling year, month, day, and time (19 characters)nnn···n Measured value (13 characters)
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 FileOutputExampleBelow is a manual sample data example of channels 1, 2, 3, and 4.
 YREC
 Manual Sample Data Version 1.02.00
 Model DX1000
 Language Code shift-JIS
 File Status Progress
 Serial No. S5E701600
 File Header
 Ch CH001 CH002 CH003 CH004
 Ch Id TI-101 OUT-102 FI-103 VA-204
 Tag abc def hij klmn
 Unit °C V m3/h %
 2005/10/01 08:57:22 213.8 0.517 368.4 68.9
 2005/10/01 08:57:28 208.6 0.494 363.0 68.1
 Note• Outputwhenerrordata,overrangedata,orcomputationoverflowdataisdetected
 Channel Data OutputMeasurement channels Error (Space)
 +over range (includes burnout detection) 99999–over range (includes burnout detection) –99999
 Computation channel Error 999999999Positive computation overflow 999999999(when the value exceeds 99999999)Negative computation overflow –999999999(when the value falls below –9999999)The decimal place that was specified when the span for the channel was specified applies to the output values. For example, if the span setting of the channel is “200.0,” then “999999999” is output when the value exceeds “9999999.9” and “–999999999” is output when the value is below “–999999.9.”
 • Anewmanualsampleddatafileiscreatedinthefollowingcases.• AmeasurementchannelischangedtoSkip from a range other than Skip.• AmeasurementchannelischangedfromSkip to a range other than Skip.• AcomputationchannelischangedfromOn to Off or Off to On.• Theunitischanged.
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 ReportFileFormat• Thehourly,daily,weekly,andmonthlyreportsareoutputusingnumericvaluesand
 strings in text format delimited by tabs.• ValuesofmeasurementchannelssettoSkip and computation channels set to Off are
 not output.• Thedataisappendedtothisfileeverytimeareportiscreated.
 FormatYRECCRLF
 Report Data Version 1.02.00 CRLF
 Model DX1000 CRLF
 Language Code shift-JIS CRLF
 File Status ffffffff CRLF
 Serial No. III···I CRLF
 File Header HHH···H CRLF
 Report Set RRR···R CRLF
 File Data rrr···r CRLF
 Math Set MMM MMM MMM MMMMCRLF
 Start Time YYYY/MO/DD HH:MI:SS CRLF
 Ch ccccc ccccc ··· cccccCRLF
 Ch Id ddd···d ddd···d ··· ddd···dCRLF
 Tag ttt···t ttt···t ··· ttt···tCRLF
 Unit uuuuuu uuuuuu ··· uuuuuuCRLF
 Data Type sss···s CRLF
 Time yyyy/mo/dd hh:mi:ss CRLF
 Status eeeeeeeeee CRLF
 Ave nnn···n nnn···n ··· nnn···nCRLF
 Max nnn···n nnn···n ··· nnn···nCRLF
 Min nnn···n nnn···n ··· nnn···nCRLF
 Sum nnn···n nnn···n ··· nnn···nCRLF
 * Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or later.
 ffffffff File status (8 characters) Complete Completed.(Afilewiththenecessarynumberof
 acquisitions for its report type, for example one acquisition for an Hourly report type, that is now complete.)
 Progress Dataisbeingadded.(Anincompletefilethatdoesnot yet have the necessary number of acquisitions for its report type.)
 Decrease Thefileisdefective.(Afilethatismissingsomeofthe report data that was stored on it.)
 III···I Serial number of the DX (16 characters)HHH···H File header (50 characters)RRR···R Report setting (setting on the DX) (13 characters) Hourly
 Daily
 Hourly+Daily
 Daily+Weekly
 Daily+Monthly
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 rrr···r Contentsofthereportfile(13characters) Hourly
 Daily
 Hourly+Daily
 Daily+Weekly
 Daily+Monthly
 Example: When the DX is set to Hourly+Daily and Combine, Hourly+Daily is output. When the DX is set to Hourly+Daily and Separate, the hourly report is output as Hourly, and the daily report as Daily.MMMM Report items (16 characters (including tabs that are counted
 as one character each), up to four types) Ave
 Max
 Min
 Sum
 Inst Instantaneous valueYYYY/MO/DD HH:MI:SS Report start year, month, day, and time (19 characters)ccccc Channel number (5 characters)ddd···d Tag number (16 characters)ttt···t Tag comment (32 characters)uuuuuu Unit (6 characters)eeeeeeeeee Status (output the events that occurred while creating report
 data) (10 characters) Bo Burn out detected Er Error (error detection) Ov Over(overrange/computationoverflowdetection) Pw Power failure (power failure occurrence) Cg Change (time change present) SSS···S Report type (7 characters) Hourly
 Daily
 Weekly
 Monthly
 yyyy/mo/dd hh:mi:ss Report year, month, day, and time (19 characters)nnn···n Average, maximum, minimum, sum, or instantaneous value
 (13 characters)
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 FileOutputExampleBelow is an example of an hourly report of 4 channels while creating hourly and daily reports and saving each type of report to a separate file.
 YREC
 Report Data Version 1.02.00
 Model DX1000
 Language Code shift-JIS
 File Status Complete
 Serial No. S5E701600
 File Header
 Report Set Hourly+Daily
 File Data Hourly
 Math Set Ave Max Min Sum
 Start Time 2005/10/01 08:10:56
 Ch Id TI-101 OUT-102 FI-103 VA-204
 Tag abc def hij klmn
 Unit °C V m3/h %
 Data Type Hourly
 Time 2005/10/01 09:00:00
 Status
 Ave 91.5 -0.039 241.1 48.6
 Max 259.8 0.726 416.5 76.6
 Min -59.9 -0.727 83.4 23.3
 Sum 3.293636E+05 -1.392980E+02 8.680871E+05 1.748983E+05
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 Note• Whenthechanneldataisintheconditionshowninthetablebelow,theEr, Ov, or Bo status
 is output to a report.
 DataCondition StatusError Er
 Measurement channelsPositive over range Ov
 Negative over range Ov
 Burn out detection Bo
 Computation channelsPositive computation overflow (when the value exceeds 1.79E + 308) Ov
 Negative computation overflow (when the value falls below –1.79E + 308) Ov
 • ThereportoutputvalueofAve, Max, Min, Sum, and Inst varies depending on the channel data condition as shown in the table below.
 Item DataConditionofMeasurementChannels Report OutputValueAve When all of the data are errors or over range (Space)Max, • Whenallofthedataareerrors (Space)Min, • For+overrange(includesburnoutdetection) 99999Inst • For–overrange(includesburnoutdetection) –99999Sum • Whenallofthedataareerrorsoroverrange (Space) • Whenthesumvalueexceedsapprox.3.4E+38 9.999999E+99 • Whenthesumvalueisbelowapprox.–3.4E+38 –9.999999E+99
 Item DataConditionofComputationChannels Report OutputValueAve When all of the data are errors or computation overflow (Space)Max, •Whenallofthedataareerrors (Space)Min, • Whenthemaximumvalueorinstantaneousvalue 999999999
 exceeds 99999999Inst • Whentheminimumvalueorinstantaneousvalueis –999999999
 less than –9999999Sum •Whenallofthedataareerrorsorcomputationoverflow (Space) •Whenthesumvalueexceedsapprox.3.4E+38 9.999999E+99 •Whenthesumvalueisbelowapprox.–3.4E+38 –9.999999E+99* The decimal place that was specified when the span for the channel was specified
 applies to the maximum and minimum values or the instantaneous values. For example, if the span setting of the channel is “200.0,” then “999999999” is output when the value exceeds “9999999.9” and “–999999999” is output when the value is below “–999999.9.”
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 FormatoftheChangeSettingsLog(/AS1option)• Thechangesettingslogisoutputasatab-separatedtextfile.• Eachtimeareportiscreated,dataisaddedtothefile.
 FormatYRECCRLF
 Setting Change Data Version 1.00.00CRLF
 File Status ffffffffCRLF
 Serial No. III•••ICRLF
 Changed yyyy/mo/dd hh:mi:ssCRLF
 Contents ccc•••cCRLF
 File Info ddd•••d nnn•••nCRLF
 User Info ppp•••p ttt•••t uuu•••uCRLF
 ffffffff File status (8 characters) Complete Completed(Afilewith100changesettings
 log entries that is now complete.) Progress Dataisbeingadded.(Anincompletefilethat
 does not yet have 100 change settings log entries.)
 III•••I Serial number (up to 16 characters)yyyy/mo/dd hh:mi:ss Year, month, day, and time when the setting change was
 executed (19 characters)ccc•••c The following are connected with pluses (16 characters).
 Eng Changing of setting mode settingsSys Changing of basic setting mode settingsLogin Changing of login information
 ddd•••d File serial number (10 characters)nnn•••n File name (12 characters)ppp•••p Type of setting change (10 characters)
 Manual Settings changed by the userttt•••t Input method (8 characters)
 Key Settings changed by the userCommunication Settings changed by the user
 uuu•••u User name (20 characters)
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 FileOutputExampleBelow is an example of a change settings log file with two change settings log entries.
 YREC
 Setting Change Data Version 1.00.00
 File Status Progress
 Serial No. S5H907377
 Changed 2010/04/01 00:55:44
 Contents Sys
 File Info 209 40100550.PEL
 User Info Manual KEY
 Changed 2010/04/02 00:56:18
 Contents Login
 File Info 210 40100560.PEL
 User Info Manual KEY Admin1
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 Symbols** ............................................................................................. 9-6[a?b:c] ................................................................................... 9-10-Over ..................................................................................... 1-15+Over .................................................................................... 1-15
 Numerics3 leg isolated RTD input ..................................................... 12-1424 VDC transmitter power supply ....................................... 12-1524 V power supply .............................................................. 12-17
 AABS ........................................................................................ 9-6absolute time ........................................................................ 4-19absolute time mode .............................................................. 1-38action .................................................................................... 1-39added messages .................................................................. 1-17A/D integration time ................................................................ 3-1administrator ................................................................. 1-43, 8-5advanced security function ....................................... 1-56, 12-18advanced security option ...................................................... 1-40alarm............................................................................. 1-4, 12-2alarm ACK .................................................................... 1-7, 3-15alarm acknowledge................................................................. 1-7alarm acknowledge operation............................................... 3-15alarm annunciator ......................................................... 1-8, 3-21alarm colors ............................................................................ 1-5alarm delay time ........................................................... 3-14, 9-3alarm hide function ................................................................. 1-5alarm indication ...................................................................... 1-5alarm levels ............................................................................ 1-5alarm mark indication ........................................................... 5-15alarm output relay ................................................1-6, 3-8, 12-11alarm settings ........................................................................3-11alarm summary ........................................................... 1-20, 4-28alarm value ........................................................................... 3-13all channel ............................................................................ 4-17all channel display ........................................................ 4-6, 4-17all data display ...................................................................... 4-13AND ........................................................................................ 9-7AND/OR .................................................................................. 1-6annunciator display............................................................... 3-23annunciator sequence ................................................ 3-21, 3-25annunciator windows ............................................................ 3-23auto increment ........................................................................ 6-7auto logout ............................................................ 1-43, 8-4, 8-6automatic message writing ................................................... 1-12auto save ...................................................................... 1-31, 6-5auto scroll ............................................................................... 4-6auto span .............................................................................. 4-20auto span display.................................................................. 1-18auto zone ............................................................ 1-13, 4-6, 4-17
 Bbackground color ........................................................ 1-25, 5-23background color (historical trend) ....................................... 4-21backlight saver.............................................................. 1-25, 2-8barcode reader ..................................................................... 2-22bar graph display .......................................................... 1-16, 4-4base position (bar graphs) .................................................... 5-20basic setting mode................................................................ 2-27batch comment ............................................................. 1-36, 6-7
 batch function ............................................................. 6-7, 12-10batch name ............................................................................. 6-7brightness ..................................................................... 1-25, 2-8burnout ......................................................................... 1-15, 3-2burnout Detection ................................................................... 1-2
 Ccalculate the file size ..........................................................App-1calendar ................................................................................ 4-16calibration ..............................................................................11-2calibration correction ........................................ 1-3, 3-16, 12-16calibration due date .............................................................. 3-32calibration management ......................................................... 1-3calibration notification screen ............................................... 3-31CARRY ................................................................................. 9-10change message .................................................................... 5-5change settings log..................................................... 4-39, 12-7changing settings during recording....................................... 6-13channel (computation) .......................................................... 1-44channel display colors .......................................................... 5-10channel number ...................................................................... 5-3clamped input terminal ........................................................12-11CLOG computation ................................................................. 9-9color scale band ................................................................... 5-16comma .................................................................................. 2-26comment text block............................................................... 5-34comment text field ................................................................ 5-34communication application errors ......................................... 10-9communication errors ......................................................... 10-15communication functions .................................................... 12-10communication log................................................................ 4-36computation channel .............................................................. 9-1computation data dropout ........................................... 1-47, 9-15computation error ................................................................... 9-4computation function ................................................ 1-44, 12-12computation types ................................................................ 1-44conditional expression .......................................................... 9-10configuration (storage).......................................................... 12-6construction (DX) ................................................................ 12-19continuing data ..................................................................... 4-12count (moving average) .......................................................... 3-6Cu10, Cu25 RTD input ....................................................... 12-13current value display............................................................. 5-14cursor (historical trend) ......................................................... 4-12cursor time ............................................................................ 4-19custom display ...................................................................... 1-56custom display setup data .......................................... 1-35, 12-8customizing the display selection menus ............................. 5-29customizing the FUNC key menus ....................................... 5-29customizing the menus ................................................. 1-24, 4-3
 Ddata display section ................................................................ 1-9data file loading .................................................................... 12-8data files that the DX can create ........................................App-4data kind ................................................................................. 6-2data length .............................................................................. 6-3data save mode .......................................................... 2-24, 4-33data that can be used in equations....................................... 1-46data type ............................................................................... 12-6data types ............................................................................. 1-26date format ................................................................... 1-54, 2-4date/time ................................................................................. 2-1
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Indexdecimal point type................................................................. 2-26de-energize............................................................................. 1-7delay high limit alarm .............................................................. 1-4delay low limit alarm ............................................................... 1-4deleting a file ........................................................................ 6-17desktop type ....................................................................... 12-12detect (alarm hide function) .................................................. 3-14DHCP log .............................................................................. 4-38difference computation ........................................................... 1-3difference lower limit alarm ..................................................... 1-4difference upper limit alarm .................................................... 1-4digital display ................................................................ 1-15, 4-4digit (scale value).................................................................. 5-14directory (data save) ............................................................. 1-31display color (channels) ........................................................ 5-10display color (messages) ........................................................ 5-9display comments ................................................................. 5-33display data ............................................... 1-261-56, 1-28, 12-6display direction (bar graphs) ............................................... 5-20display direction (messages) ................................................ 5-19display direction (trend) ........................................................ 5-19displayed information............................................................ 12-3displayed language............................................................... 1-55display group .......................................................................... 5-1display (LCD) ........................................................................ 12-3display menu ................................................................ 4-1, 5-31display positions ................................................................... 3-24display selection menu ................................................. 4-1, 5-31display window ..................................................................... 3-24display zone...........................................................................5-11divided (report file) ................................................................ 9-17division (scale) ...................................................................... 5-13DST (daylight saving time) ........................................... 1-54, 2-1
 Eeasy text entry .......................................................... 1-55, 12-15effects of operating conditions ............................................ 12-22e-mail log .............................................................................. 4-37energize .................................................................................. 1-7EQ .......................................................................................... 9-6error codes ........................................................................... 10-1error data .............................................................................. 1-50error log ................................................................................ 4-36error messages..................................................................... 10-1errors related to parameter settings ..................................... 10-1event ..................................................................................... 1-37event action ........................................................ 1-37, 7-1, 12-9event data ......................................................... 1-26, 1-28, 12-6event level switch status ....................................................... 1-24event level switch status display........................................... 4-27EXP ........................................................................................ 9-6expressions (computation) ..................................................... 9-5extended input type ............................................................ 12-14extension (file) ...................................................................... 1-33external dimensions............................................................ 12-24external storage medium ...................................................... 1-31
 FFAIL output ................................................................. 1-52, 2-13FAIL/status output relay .......................................................12-11fast sampling mode ................................................................ 1-1favorite key ................................................................. 1-24, 5-26file header ............................................................................... 6-5file name ............................................................................... 1-33file size................................................................................App-1fine grid ......................................................................... 4-6, 4-18firmware version ..................................................................... 2-5first weekday......................................................................... 4-16
 fixed (alarm mark) ................................................................. 5-15flag ........................................................................................ 1-46flow of data recording and storage ....................................... 1-27format of the change settings log ..................................... App-11formatting.............................................................................. 6-17format type............................................................................ 6-17four arithmetic operation ......................................................... 9-6free (event data) ........................................................... 1-29, 6-3free messages .............................................................. 1-12, 5-9free space ............................................................................. 6-17FTP log ................................................................................. 4-36FUNC key menu ........................................................... 4-2, 5-30
 GGE .......................................................................................... 9-6gradually correcting the internal clock .................................. 1-54graph display .......................................................................... 1-9grid........................................................................................ 5-19groups..................................................................................... 5-1group set................................................................................. 5-1GT ........................................................................................... 9-6
 Hhistorical trend display .................................................. 1-17, 4-9HOLD.................................................................................... 9-10hold (alarm indication) ............................................................ 1-5hold (alarm output relay)......................................................... 1-7hysteresis ....................................................................... 1-4, 3-9
 Iidentified strings...................................................................... 6-5ID number ............................................................................. 2-15indicator .................................................................................. 3-8individual alarm ACK operation ............................................ 4-23information on the displayed measured data........................ 4-21initialize ................................................................................. 2-10inner instrument .....................................................................11-4input calibration interval ........................................................ 3-30input processing ..................................................................... 1-2input range.............................................................................. 3-3input type ........................................................................ 1-1, 3-4integration time ....................................................................... 1-1internal memory .................................................................... 1-27internal switch ....................................................... 1-7, 1-37, 3-8interval (rate-of-change alarm) ....................................... 1-4, 3-7invalid keys ........................................................................... 2-21invalid user relay................................................................... 1-52ISA-A .................................................................................... 3-27ISA-A-4 ................................................................................. 3-25ISA-M .................................................................................... 3-29isolation .............................................................................. 12-19
 Jjumpdefaultdisplay .............................................................. 5-25
 Kkeyboard ............................................................................... 2-20key lock......................................................................... 1-42, 8-1keywords .............................................................................. 9-20
 LLE ........................................................................................... 9-6limitations (expressions) ......................................................... 9-5linear scaling........................................................................... 1-3line width of the trend ........................................................... 5-19list of files .............................................................................. 6-16
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 IndexLN ........................................................................................... 9-6loading a file ......................................................................... 6-18loading a template file........................................................... 6-22loading setup data ................................................................ 6-21LOG ........................................................................................ 9-6log display............................................................................. 1-24logging in ................................................................................ 8-6logging out .............................................................................. 8-6logical computation ................................................................. 9-7login function ................................................................ 1-43, 8-4login log ................................................................................ 4-35log into the DX ........................................................................ 8-6lot-No. digit ............................................................................. 6-7lot number............................................................................. 1-36low-cut ............................................................................ 1-3, 3-5LT ............................................................................................ 9-6
 MMAC address .......................................................................... 2-5maintenance ..........................................................................11-1maintenance and test communication command errors ..... 10-15manuals .......................................................................................imanual sampled data ............................. 1-26, 1-30, 6-14, 12-7manual sampled data (format)............................................App-5manual save ......................................................................... 1-32match time timer ........................................................... 1-37, 7-4math start action ................................................................... 9-14measurement channel ............................................................ 1-1measurement input ............................................................... 12-1measure soft key .................................................................. 3-16media FIFO................................................................... 1-32, 6-5memory backup .................................................................. 12-23memory sample ...................................................................... 6-2memory sample relay ........................................................... 1-52memory start ......................................................................... 6-10memory stop ..........................................................................6-11memory summary ....................................................... 1-22, 4-32message colors ...................................................................... 5-9message display ........................................................... 4-6, 4-19message display methods .................................................... 4-31messages ..................................................................... 1-12, 5-7messages (errors, status, etc) .............................................. 10-1message summary ..................................................... 1-21, 4-30modbus client status display................................................. 1-24modbus master status display .............................................. 1-24modbus status display .......................................................... 4-26modbus status log ................................................................ 4-38mode (input range) ................................................................. 3-4moving average .............................................................. 1-2, 3-6multi batch function................................................... 1-56, 12-17
 NNE........................................................................................... 9-6network information ................................................................ 2-5next soft key ........................................................................... 4-2No logging ............................................................................ 3-10non-hold (alarm indication) ..................................................... 1-5non-hold (alarm output relay) ................................................. 1-7normal operating conditions ............................................... 12-19NOT ........................................................................................ 9-7number of pulses per minute ................................................ 3-18numeric display............................................................. 1-15, 4-6
 Ooperating event switches ........................................................ 7-5operation errors .................................................................... 10-7operation log ......................................................................... 4-39
 operation logs ....................................................................... 4-35operations that can be carried out when logged out............. 1-43OR .......................................................................................... 9-7order of precedence (computation) ........................................ 9-5overflow data ................................................................ 1-50, 9-4overview display ......................................................... 1-19, 4-22
 Pparameters ........................................................................... 9-22partial expanded display ............................................. 1-14, 5-17parts replacement ..................................................................11-1password change ................................................................... 8-7password (login function)........................................................ 8-5point ...................................................................................... 2-26power computations ............................................................... 9-6power-fail message .............................................................. 5-28power failure operation ......................................................... 1-50power supply ...................................................................... 12-19power supply for transmitter ................................................. 1-55PRE ...................................................................................... 9-10preset display ....................................................................... 5-25pre-trigger ............................................................................... 6-3pretrigger .............................................................................. 1-29processing order of computation .......................................... 1-46PROFIBUS-DP ................................................................... 12-17progress of the save operation ............................................. 4-34pulse input .................................................................. 1-3, 12-16pulse sum value.................................................................... 3-17
 Rrange (input range) ................................................................. 3-4rate-of-change alarm .............................................................. 1-4recommended replacement periods for worn parts ...............11-1recording conditions (display data) ....................................... 1-28recording conditions (event data) ......................................... 1-29ref. CH .................................................................................... 3-5reference channel ................................................................... 3-5referencejunctioncompensation.................................... 1-2, 3-2reflash ............................................................................. 1-6, 3-7relational computation ............................................................ 9-6relative time .......................................................................... 4-19relative time mode ................................................................ 1-38relay action ........................................................................... 2-12Relay Action on Ack ................................................................ 3-9relay status display ..................................................... 1-24, 4-26release number.......................................................................... iiireleasing the key lock ............................................................. 8-2remote contact input operation ............................................. 7-10remote control function ................................................. 1-37, 7-1remote controller ID ...................................................... 2-5, 2-14remote control (/R1)............................................................ 12-15remote control terminal ......................................................... 2-15repeat (event data) ............................................................... 1-29report .................................................................................... 9-16report channel....................................................................... 9-18report data .............................................. 1-23, 1-26, 1-30, 12-7report data keyword examples ............................................. 9-23report data keywords ............................................................ 9-21report display ........................................................................ 4-25report file (format) ...............................................................App-7report function....................................................................... 1-49report group .......................................................................... 9-18report template ................................................. 1-51, 6-24, 9-19RESET .................................................................................. 9-10resets the computed result (Rst+St) ..................................... 9-14reset the sum value .............................................................. 3-18resetting the computed results ............................................. 9-15resetting the match time timer ................................................ 7-6
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Indexresetting the relative timer .............................................. 7-5, 7-6reset (TLOG) ........................................................................ 1-48revisions ..................................................................................... iirolling average .............................................................. 1-47, 9-4RS-232 interface..................................................................12-11RS-422A/485 interface ........................................................12-11
 Ssample rate ............................................................................. 6-3save directory ......................................................................... 6-5save duration to the CF card ..............................................App-3save interval ........................................................................... 6-2saving a template file ............................................................ 6-23saving data to the external storage medium......................... 1-31saving measured data (automatically) .................................. 6-10saving measured data (manually) .........................................6-11saving setup data ................................................................. 6-19saving the data ..................................................................... 4-33scale ................................................................... 4-6, 4-17, 5-12scale lower.............................................................................. 3-5scan interval ................................................................... 1-1, 3-1screen image data ...................................................... 1-26, 6-15scroll time ............................................................................. 5-24search for measured data..................................................... 4-14secondary interval .................................................................. 5-6security ................................................................................... 8-4security function.................................................................... 12-9selecting a bar ...................................................................... 4-42separators............................................................................. 5-30setup data ......................................................... 1-26, 1-35, 12-7single/dual graph display ...................................................... 4-41single (event data) ................................................................ 1-29snapshot ..................................................................... 6-15, 12-7snapshot data ............................................................. 1-26, 1-35SNTP log .............................................................................. 4-38sort item ...................................................................... 4-28, 4-31span lower .............................................................................. 3-5Special computation ............................................................. 9-10special data .......................................................................... 1-50special keywords .................................................................. 9-21SQR ........................................................................................ 9-6square root computation ......................................................... 1-3stacked bar graph ....................................................... 1-23, 4-40standard display soft key ...................................................... 5-25standard performance ........................................................ 12-21standards ............................................................................ 12-20standard temperature device .................................................11-2starting the computation ....................................................... 9-14start the recording................................................................. 6-10status display section ........................................................... 1-10status messages................................................................. 10-17status output ................................................................1-53, 2-11status relay ........................................................................... 2-13stopping the recording ...........................................................6-11structure of the file name ........................................................ 6-5style number .............................................................................. iiisub menu ...................................................................... 4-1, 5-31sum scale ............................................................................. 1-49symbols that can be entered ................................................ 2-20system display ...................................................................... 1-55system errors ...................................................................... 10-19system information ................................................................. 2-5system keyword examples ................................................... 9-23system keywords .................................................................. 9-21
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